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3 1. Descrizione generale

Configurazione del sistema

Pacchetto 
microfono 
wireless  

UWP-D21 
UWP-D22 
UWP-D26  
(ricevitore: 
URX-P40)

Adattatore slitta 
Multi-interface 

SMAD-P5

Ricevitore 
microfono wireless 

URX-P03D

Adattatore slitta 
Multi-interface 

SMAD-P3D

Kit adattatore XLR 
XLR-K3M

Luce video 
HVL-LBPC

Obiettivo PL S35
Maniglia dotata di slitta MI  
(A-5012-165-) Maniglia

Modulo mirino

Pacco batteria 
BP-GL95B

Adattatore CA 
AC-DN10A

Unità telecomando 
RM-30BP/1BP 

RCP-1530/3100/3500/3501

MPC-2610

Schede di memoria  
CFexpress Type B

Adattatore per supporto a spalla 
VCT-FSA5

Impugnatura di telecomando 
GP-VR100

Scheda SD

Adattatore attacco PL

Obiettivo anamorfico 
(attacco PL)

Obiettivo full-frame 
(attacco PL)

Obiettivo E-mount

Adattatore per  
ottiche A-mount 

LA-EA4 
LA-EA5

Microfono
ECM-680S*, ECM-678, 
ECM-674, ECM-MS2
*	 Richiede EC-0.5X5F3M

Lettore di schede 
CFexpress Type B /  

lettore di schede SD

Morsetto asta  
(A-2182-621-) 
Gruppo portamicrofono 
(A-5012-206-)
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Posizione e funzione delle parti

Lato comandi operatore

LOCK

MFAF

ND STEP ND VARIABLE

FULL MENU

ND ON

1 2

3

CLEAR

DISP

AUTO

A

B

CLIPS

CH-1

CH-2AUTO

SLOT
SEL

MENU

BACK

REC

SD

4 7 92 10

14151718
16

1920

21

23

28

25

26
27

24

22

1 3 65 8

12
13

11

Sezione slot per schede 
CFexpress Type B (pagina 5)

1.	 Selettore FOCUS (pagina 96)

2.	 Selettore LOCK
Blocca il funzionamento dei pulsanti.
Se bloccato, l’indicatore del selettore è 
illuminato con luce arancione.

3.	 Manopola ND VARIABLE (pagina 103)

4.	 Altoparlante incorporato (pagina 79)

5.	 Apertura ingresso aria

[Nota]
Non coprire l’apertura di ingresso dell’aria.

6.	 Pulsante MENU (pagina 30, 35)
Premere il pulsante MENU per visualizzare 
la schermata di stato. Premere e mantenere 
premuto il pulsante MENU per visualizzare il 
menu completo.
Premere il pulsante mentre è visualizzata 
la schermata di stato o la schermata del 
menu completo per tornare alla schermata 
precedente.

7.	 Selettori CH1/CH2 (AUTO/MAN) 
(pagina 106)

8.	 Antenna Wi-Fi

[Nota]
La comunicazione Wi-Fi potrebbe interrompersi se 
questa parte viene coperta con una mano o un oggetto 
metallico.

9.	 Manopole AUDIO LEVEL (CH1/CH2) 
(pagina 106)

10.	 Pulsante CLIPS (pagina 76)
Premere per visualizzare i clip presenti 
sul supporto di memoria selezionato per 
la riproduzione nella schermata dei clip e 
abilitare le operazioni di riproduzione. Quando 
è visualizzata la schermata dei clip, premere 
per tornare alla schermata di ripresa.

11.	 Indicatori di accesso A/B (pagina 19)

12.	 Pulsante SLOT SELECT (selezione della 
scheda di memoria CFexpress Type B) 
(pagina 79)

13.	 Connettore per cuffia (mini jack stereo)
Consente il collegamento di cuffie per il 
monitoraggio audio. È possibile monitorare 
l’audio di ingresso durante la ripresa o la 
riproduzione o l’audio di riproduzione durante 
la riproduzione (pagina 79).

14.	 Slot per scheda Utility SD / Indicatore di 
accesso (pagina 21)

15.	 Microfono interno (pagina 106)
Microfono di narrazione per la registrazione 
dell’audio ambientale.

16.	 Pulsante BACK
Durante la visualizzazione del menu, annulla 
l’impostazione del menu e si sposta al livello 
superiore nell’albero dei menu. Durante la 
visualizzazione dell’esecuzione o l’attesa di un 
processo, annulla il processo in esecuzione o 
in attesa.

17.	 Interruttore di alimentazione
Spostare su  (ON) per accendere. Spostare su 
 (Standby) per spegnere.

[Note]
•• L’unità utilizza una piccola quantità di energia 

elettrica per mantenersi in modalità standby anche 
mentre è spenta. Rimuovere il pacco batteria se si 
prevede di non utilizzare l’unità per un periodo di 
tempo prolungato.

•• Prima di rimuovere il pacco batteria o scollegare 
l’alimentazione DC IN, spostare l’interruttore di 
alimentazione sulla posizione STANDBY e controllare 
che la spia di alimentazione sia spenta. La rimozione 
della sorgente di alimentazione mentre l’interruttore 
di alimentazione si trova nella posizione ON potrebbe 
causare un malfunzionamento dell’unità o delle 
schede di memoria.

18.	 Spia di alimentazione (pagina 90)

19.	 Spia REC ACTIVE
Questa spia si illumina con luce verde quando 
il pulsante REC è abilitato.

20.	Pulsante/spia REC (avvio/arresto 
registrazione)

Premere per avviare la registrazione, 
accendendo la spia REC. Premere nuovo per 
arrestare la registrazione, spegnendo la spia 
REC (pagina 90).

21.	 Spia tasto programmabile ASSIGN 3 
(pagina 108)

La spia si illumina con luce arancione quando 
la funzione è attiva, oppure è spenta quando 
la funzione non è attiva.

22.	 Manopola multifunzione (pagina 108)
Premere durante la visualizzazione 
dell’immagine nel monitor LCD per 
visualizzare ed interagire con il Direct Menu.
Durante la visualizzazione del menu nel 
monitor LCD, ruotare la manopola per spostare 
il cursore verso l’alto o il basso e selezionare 
voci di menu o impostazioni. Premere per 
applicare la voce selezionata.
Quando non è visualizzato il menu, la 
manopola può essere utilizzata anche come 
manopola programmabile.
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[Informazione]
Per impostazione predefinita, è possibile utilizzare la 
manopola per la regolazione del diaframma quando è 
montato un obiettivo E-mount.

23.	 Selettore multiplo (pulsante direzionale 
D-Pad a 8 posizioni e pulsante di 
conferma)

Consente di selezionare un riquadro di 
riconoscimento del soggetto durante la 
messa a fuoco automatica, spostare l’area di 
messa a fuoco, nonché spostare la zona di 
ingrandimento mentre è attiva la funzione 
di ingrandimento della messa a fuoco. Può 
anche essere utilizzata anche per l’utilizzo 
del menu mentre il monitor LCD si trova in 
modalità di monitoraggio video (pagina 22).

[Informazione]
Il funzionamento del selettore multiplo dell’impugnatura 
di telecomando (opzione) e del telecomando LANC 
(opzione) è analogo a quello di questo selettore 
multiplo.

24.	 Pulsante DISPLAY (visualizzazione a 
schermo) (pagina 23)

25.	 Pulsanti/Spie programmabili ASSIGN 1/2 
(pagina 108)

La spia si illumina con luce arancione quando 
la funzione è attiva, oppure è spenta quando 
la funzione non è attiva.

26.	 Pulsanti ND FILTER POSITION su/giù / Spia 
ND CLEAR (pagina 103)

Quando il filtro ND è impostato su CLEAR, la 
spia ND CLEAR si illumina.

27.	 Selettore ND STEP/VARIABLE 
(pagina 103)

28.	 Adattatore attacco PL (pagina 16)

Sezione slot per schede CFexpress Type 
B (pagina 19)

Gli slot per le schede CFexpress Type B si 
trovano dietro il coperchietto.

1

1.	 Slot A e B per schede CFexpress Type B

Lato connettore

SDI OUT  1

SDI OUT  2
INPUT LINE

MIC
MIC + 48V

TC

OUT
IN

REF

12V

REMOTE GRIP

VF

7

1

INPUT
2

LINE
MIC

MIC + 48V

3 4

13 12 11 10

14

15

1 2

6
5

7

9
8

1.	 Spia di registrazione/tally (pagina 90)
Illuminata con luce fissa durante la 
registrazione e lampeggiante quando 
la capacità rimanente del supporto di 
registrazione o la carica della batteria è bassa.

2.	 Connettore USB-C® (pagina 83, 87, 
118)

3.	 Pulsante/Spia programmabile ASSIGN 7 
(pagina 108)

La spia si illumina con luce arancione quando 
la funzione è attiva, oppure è spenta quando 
la funzione non è attiva.

4.	 Gancio per metro a nastro
Il gancio del metro a nastro si trova sullo 
stesso piano del sensore immagine. Utilizzare 
questo gancio come punto di riferimento per 
misurare con precisione la distanza tra l’unità 
e il soggetto. Fissare l’estremità di un metro 

a nastro a questo gancio per misurare la 
distanza del soggetto.

5.	 Antenna Wi-Fi

[Nota]
La comunicazione Wi-Fi potrebbe interrompersi se 
questa parte viene coperta con una mano o un oggetto 
metallico.

6.	 Selettore INPUT 1 (LINE/MIC/MIC+48V) 
(pagina 106)

7.	 Connettore INPUT 1 (ingresso audio 1) 
(pagina 106)

8.	 Selettore INPUT 2 (LINE/MIC/MIC+48V) 
(pagina 106)

9.	 Connettore INPUT 2 (ingresso audio 2) 
(pagina 106)
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10.	 Attacco impugnatura di telecomando
Punto di montaggio dell’impugnatura di 
telecomando (opzione).

11.	 Apertura uscita aria

[Nota]
Non coprire l’apertura per l’uscita dell’aria.

12.	 Connettore dell’impugnatura di 
telecomando

Consente il collegamento dell’impugnatura di 
telecomando (opzione).

13.	 Connettore REMOTE
Per il collegamento a un accessorio generico 
dotato di jack LANC.

14.	 Selettore TC/REF IN/OUT (pagina 116)
Consente di selezionare la funzione dei due 
connettori sul retro. Le opzioni disponibili sono 
TC IN/REF IN e TC OUT/REF OUT.

15.	 Connettore mirino (pagina 11)

Lato anteriore

3

1

3

2

1.	 Contatto elettrico dell’obiettivo PL 
(superiore)

2.	 Contatto elettrico dell’obiettivo PL 
(laterale)

3.	 Pulsante programmabile ASSIGN 3 
(pagina 108)

Ogni pressione del pulsante attiva o disattiva 
(abilita o disabilita) la funzione programmata.
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Lato posteriore

12
11

10

1
2

3

4

5

6

7

9 88

1.	 Connettore HDMI OUT (pagina 115)

2.	 Connettore SDI OUT 1 (pagina 115)
Supporta l’uscita 12G-SDI.

3.	 Connettore SDI OUT 2 (pagina 115)
Supporta l’uscita 3G-SDI.

4.	 Connettore TC IN/TC OUT (entrata/uscita 
codice temporale) (pagina 116)

5.	 Connettore REF IN/REF OUT (entrata/
uscita segnale di sync)

Utilizzati per una delle applicazioni descritte 
di seguito, in base alla posizione del selettore 
TC/REF IN/OUT.
IN: Consente l’ingresso di un segnale di 

riferimento esterno per sincronizzare in 
genlock l’unità con una sorgente esterna 
oppure agganciare a una sorgente esterna 
il codice temporale dell’unità.

OUT: Emette un segnale di sincronizzazione 
per la sincronizzazione di dispositivi 
esterni. Il connettore REF OUT emette 
sempre un segnale di sincronizzazione HD.

6.	 Connettore di rete (RJ-45)
Consente il collegamento a una rete LAN 
cablata mediante un cavo LAN (non fornito) 
per assicurare la stabilità della connessione in 
rete (pagina 83).

[Nota]
Non può essere utilizzato contemporaneamente a Wi-Fi.

7.	 Connettore DC IN (XLR a 4 pin) 
(pagina 14)

Connettore DC IN di ingresso 
dell’alimentazione c.c. dell’unità proveniente 
da una sorgente esterna (XLR 4 pin, maschio). 
Consente l’ingresso di una tensione di 12 Vcc 
(da 11 Vcc a 17 Vcc).

N. Segnale

1 GND

2 NC

3 NC

4 12 Vcc (da 11 Vcc a 17 Vcc)

8.	 Apertura ingresso aria

[Nota]
Non coprire l’apertura di ingresso dell’aria.

9.	 Spia di registrazione/tally
Illuminata con luce fissa durante la 
registrazione e lampeggiante quando 
la capacità rimanente del supporto di 
registrazione o la carica della batteria è bassa.

10.	 Terminale di connessione della batteria 
(pagina 14)

11.	 Aggancio pacco batteria (pagina 14)

12.	 Levetta di rilascio della batteria 
(pagina 14)
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Vista dall’alto

22

1

1.	 Connettore della maniglia
Consente il collegamento di una maniglia 
dotata di slitta MI.

2.	 Fori per viti di montaggio accessori
Tipo di vite: 1/4-20UNC (8)
Tipo di vite: 3/8-16UNC (6)
Lunghezza di inserimento max.: 10 mm

Vista dal basso

1

2

1.	 Fori di fissaggio piastra cavalletto
Tipo di vite: 1/4-20UNC (4)
Tipo di vite: 3/8-16UNC (4)
Lunghezza di inserimento max.: 9 mm

2.	 Apertura ingresso aria

[Nota]
Non coprire l’apertura di ingresso dell’aria.
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Monitor LCD

H&V FLIP

8

9

10

HOME

11

1 32

245

10

6

7

9
8

1.	 Pulsante programmabile ASSIGN 11 
(pagina 108)

2.	 Pulsanti ITEM da 1 a 6 (pagina 26)
Consentono di azionare la schermata Home e 
la schermata di riproduzione.

3.	 Blocco dell’ingranditore (pagina 12)

4.	 Touchscreen
È possibile disabilitare il funzionamento 
del touchscreen usando un pulsante 
programmabile o il menu (pagina 10).

5.	 Selettore H&V FLIP (ON/OFF)
Consente di scegliere la visualizzazione 
dello schermo tra normale (OFF) e rovesciata 
orizzontalmente o verticalmente (ON).

6.	 Pulsante programmabile ASSIGN 8 
(pagina 108)

7.	 Pulsante programmabile ASSIGN 9 
(pagina 108)

8.	 Selettore multiplo (pulsante direzionale 
D-Pad a 8 posizioni e pulsante di 
conferma)

Consente di controllare la visualizzazione dei 
contenuti sul monitor LCD.

9.	 Pulsante programmabile ASSIGN 10 
(pagina 108)

10.	 Pulsante HOME (pagina 22)
Premere per tornare alla schermata Home.

[Informazione]
È possibile passare dalla modalità di monitoraggio video, 
che consente l’esecuzione di varie operazioni sulla 
schermata di ripresa, alla modalità di visualizzazione 
delle informazioni, che consente invece di verificare e 
modificare le impostazioni nella schermata Home.
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Utilizzo del touchscreen

Precauzioni per l’utilizzo del 
touchscreen

Il monitor LCD dell’unità è un pannello 
touchscreen che può essere utilizzato 
semplicemente toccando le varie opzioni con 
un dito.
•• È sufficiente toccarlo leggermente con il 

dito. Non esercitare forte pressione sul 
pannello né toccarlo con oggetti taglienti o 
appuntiti (unghie, penne a sfera, spilli, ecc.).

•• Nelle circostanze descritte di seguito, il 
touchscreen potrebbe non rispondere 
correttamente al contatto. Si osservi inoltre 
che tali azioni potrebbero dar luogo a 
malfunzionamenti.

•• 	Se si tocca con la punta delle unghie 
delle dita

•• 	Se si tocca mentre altri oggetti sono in 
contatto con la sua superficie

•• 	Se si tocca mentre è applicata una 
pellicola adesiva di protezione o 
un’etichetta

•• 	Se si tocca mentre sono presenti gocce 
di condensazione o d’acqua sulla sua 
superficie

•• 	Se si tocca con dita bagnate o sudate

Gesti del touchscreen

Tocco
Toccare leggermente un elemento, ad 
esempio un’icona o una voce del menu, e 
sollevare immediatamente il dito.

Trascinamento
Toccare lo schermo e spostare il dito mentre 
rimane in contatto con lo schermo fino a 
raggiungere la posizione desiderata, quindi 
sollevare il dito.

Scorrimento rapido
Toccare lo schermo e trascinare il dito con un 
gesto rapido verso l’alto, il basso, a sinistra o 
a destra.

[Informazione]
Se i contenuti si estendono oltre i bordi dello schermo, 
è possibile scorrerli trascinandoli lentamente o con un 
gesto rapido.

Configurazione del touchscreen

Il funzionamento del touchscreen può essere 
attivato o disattivato tramite la voce Touch 
Operation (pagina 64) del menu Technical.



11 2. Operazioni preliminari

Montaggio della maniglia e del mirino

Montaggio della maniglia

1	 Allineare la maniglia con i quattro fori per 
le viti nella sezione anteriore o posteriore 
del lato superiore dell’unità.

2	 Fissare utilizzando quattro viti a testa cava 
esagonale, stringendo a una coppia di 1,4 
N·m una chiave esagonale (3/16 pollici).

Rimozione della maniglia

Svitare le quattro viti utilizzando una chiave 
esagonale e rimuovere la maniglia.

Montaggio del mirino

1	 Con la maniglia fissata all’unità, ruotare la 
manopola di bloccaggio del braccetto del 
mirino in senso antiorario per rilasciare il 
braccetto, quindi ruotare il braccetto di 
180° verso la parte anteriore dell’unità.

	 [Informazione]
Se la manopola di bloccaggio viene a trovarsi in 
una posizione che rende difficoltosa la rotazione, 
estrarre la manopola di bloccaggio e spostarlo in 
una posizione più comoda. Reinserire quindi la 
manopola di bloccaggio.

2	 Ruotare la manopola di bloccaggio in 
senso orario per fissarlo in posizione.

Manopola di 
bloccaggio

Braccetto
Vite a 
testa cava 
esagonale

	 [Nota]
Se l’asta di fissaggio del braccetto ruota rispetto 
alla maniglia, stringere la vite a testa cava 
esagonale (3 mm) sul lato inferiore della maniglia 
usando una chiave esagonale (coppia di serraggio: 
1,6 N·m).

3	 Montare l’adattatore di montaggio del 
mirino sul retro del monitor LCD, quindi 
ruotare la manopola di bloccaggio in 
senso orario per fissarlo in posizione.
Adattatore di montaggio del mirino

Manopola di bloccaggio

4	 Mantenendo premuto il perno del 
braccetto con un dito, inserire l’adattatore 
di montaggio del mirino sul braccetto, 
quindi ruotare la manopola di bloccaggio 
in senso orario per fissarlo in posizione.

Pernetto Manopola di 
bloccaggio

Adattatore di montaggio 
del mirino

	 [Nota]
Se il braccetto si allenta troppo quando si svita la 
manopola di bloccaggio dell’accessorio, regolare la 
vite di bloccaggio utilizzando una chiave esagonale 
(2,5 mm).

Vite di blocco

5	 Allineare l’indicatore  presente sul 
connettore del mirino dell’unità con il 
corrispondente indicatore  dello spinotto 
del cavo del monitor LCD, quindi inserire il 
cavo.
Prima dell’inserimento, controllare che 
l’indicatore  si trovi sul lato esterno.

6	 Inserire il cavo nei tre fermacavi.

Fermacavi
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7	 Montare l’ingranditore del mirino 
inserendolo nell’apposita slitta presente 
sul lato superiore del monitor LCD, come 
mostrato in figura.

8	 Spingere l’ingranditore del mirino nella 
direzione indicata dalla freccia per 
chiuderlo.

Rimozione dell’ingranditore del mirino

Premere il fermo dell’ingranditore del 
mirino, sollevare l’ingranditore per aprirlo , 
spingere nella direzione della freccia il blocco 
dell’ingranditore  e mantenerlo in posizione, 
quindi fare scorrere l’ingranditore nella 
direzione opposta a quella di inserimento per 
estrarlo .

Blocco  
dell’ingranditore

Fermo

Rimozione del mirino

1	 Rimuovere il cavo dai fermacavi, quindi 
estrarre lo spinotto esercitando una 
pressione su entrambi i lati per scollegare 
il cavo.

2	 Allentare la manopola di bloccaggio del 
mirino e rimuovere il mirino ripetendo la 
procedura di montaggio in senso inverso.

Montaggio del mirino (quando 
non si utilizza l’ingranditore)

1	 Con la maniglia fissata all’unità, ruotare la 
manopola di bloccaggio del braccetto in 
senso antiorario per rilasciare il braccetto, 
quindi ruotare il braccetto di 180° verso la 
parte anteriore dell’unità.

2	 Ruotare la manopola di bloccaggio in 
senso orario per fissarlo in posizione.

Manopola di 
bloccaggio

Braccetto
Vite a 
testa cava 
esagonale

	 [Nota]
Se l’asta di fissaggio del braccetto ruota rispetto 
alla maniglia, stringere la vite a testa cava 
esagonale (3 mm) sul lato inferiore della maniglia 
usando una chiave esagonale (coppia di serraggio: 
1,6 N·m).

3	 Montare l’adattatore di montaggio del 
mirino sul lato del monitor LCD, quindi 
ruotare la manopola di bloccaggio in 
senso orario per fissarlo in posizione.
Adattatore di 
montaggio 
del mirino

Manopola di bloccaggio

4	 Mantenendo premuto il perno del 
braccetto con un dito, inserire l’adattatore 
di montaggio del mirino sul braccetto, 
quindi ruotare la manopola di bloccaggio 
in senso orario per fissarlo in posizione.

Pernetto
Manopola di 
bloccaggio

Adattatore di montaggio 
del mirino

	 [Nota]
Se il braccetto si allenta troppo quando si svita la 
manopola di bloccaggio dell’accessorio, regolare la 
vite di bloccaggio utilizzando una chiave esagonale 
(2,5 mm).
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Vite di blocco

5	 Allineare l’indicatore  presente sul 
connettore del mirino dell’unità con il 
corrispondente indicatore  dello spinotto 
del cavo del monitor LCD, quindi inserire il 
cavo.
Prima dell’inserimento, controllare che 
l’indicatore  si trovi sul lato esterno.

6	 Inserire il cavo nei tre fermacavi.

Fermacavi

Esempio di configurazione quando si 
utilizza il monitor LCD come pannello di 
controllo

Il monitor LCD può essere montato fissando 
al braccetto il lato dell’adattatore per il 
montaggio del mirino, come mostrato di 
seguito. Questa configurazione è molto 
comoda quando si utilizza il monitor LCD 
come pannello di controllo.

Adattatore di 
montaggio 
del mirino
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Alimentazione
È possibile utilizzare un pacco batteria o 
un’alimentazione CA da un adattatore CA.
Per sicurezza, utilizzare esclusivamente i 
seguenti pacchi batterie e adattatori CA Sony.

Pacchi batteria agli ioni di litio
BP-GL95B

Adattatore CA
AC-DN10A

Utilizzo del pacco batteria

Appoggiare il pacco batteria sull’apposito 
attacco dell’adattatore della batteria 
(pagina 7), quindi spingerlo verso il basso 
per bloccarlo in posizione.
Per rimuovere il pacco batteria, sbloccarlo 
mantenendo premuta la levetta di rilascio 
della batteria (pagina 7), quindi farlo 
scorrere verso l’alto.

[Note]
•• Prima dell’uso, caricare il pacco batteria con il 

caricabatteria.
•• Può non essere possibile ricaricare un pacco  

batteria completamente se questo è ancora calda, 
immediatamente dopo il suo utilizzo.

•• Rimuovere l’adattatore della batteria afferrando 
saldamente l’unità con la mano.

Controllo della capacità rimanente

Durante la registrazione o la riproduzione con 
alimentazione mediante un pacco batteria, il 
monitor LCD visualizza la durata residua e la 
tensione erogata dalla batteria.
L’unità indica la durata residua in minuti, 
calcolando il tempo disponibile sulla base 
del consumo attuale del pacco batteria in 
modalità operativa.

Se il livello di carica residua della 
batteria scende

Se, durante l’utilizzo, la carica residua della 
batteria si riduce fino a raggiungere un 
determinato livello, l’indicatore della carica 
residua della batteria e la spia REC cominciano 
a lampeggiare come avvertimento.
Se il livello di carica residua scende oltre un 
certo valore e non è più possibile mantenere 
acceso il dispositivo, viene visualizzato un 
messaggio di batteria esaurita.
Sostituire il pacco batteria con un altro 
completamente carico.

Modifica dei livelli di avviso

Modificare i livelli con la voce Technical 
>Camera Battery Alarm (pagina 66) nel 
menu completo.

Utilizzo dell’alimentazione CA 
(alimentazione DC IN) 

L’unità può essere alimentata anche dalla 
rete elettrica utilizzando un adattatore CA da 
100 W.
Può essere utilizzata una tensione di 
alimentazione in ingresso compresa fra 11 V e 
17 V.
Qualora la tensione di ingresso scenda al di 
sotto di un certo livello predeterminato, verrà 
visualizzato un allarme. È possibile modificare 
i livelli con la voce Technical >Camera DC IN 
Alarm (pagina 67) nel menu completo.

[Nota]
Per garantire la sicurezza nella commutazione, se si 
desidera passare direttamente all’alimentazione DC 
IN durante il funzionamento a batteria, assicurarsi che 
l’alimentazione utilizzata abbia una tensione compresa 
fra 12 V e 17 V.

Utilizzo contemporaneo di pacco 
batteria e alimentazione DC IN

Se sono presenti contemporaneamente 
un’alimentazione mediante pacco batteria e 
un’alimentazione DC IN, l’alimentazione DC IN 
ha la priorità.

[Nota]
Nel passaggio dall’alimentazione a batteria 
all’alimentazione DC IN, l’unità potrebbe arrestarsi nei 
casi indicati di seguito.
•• Contatto incerto o intermittente al momento 

dell’inserimento del connettore DC
•• Caduta di tensione al passaggio da una sorgente di 

alimentazione all’altra (di maggiore entità in caso di 
consumi di potenza elevati)
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Impostazione dell’orologio
Alla prima accensione dell’unità, la schermata 
delle impostazioni iniziali viene visualizzata sul 
monitor LCD.
Impostare la data e l’ora dell’orologio interno 
in questa schermata.

Time Zone

Il valore indica la differenza di orario rispetto 
all’UTC (Coordinated Universal Time). 
Impostare questo valore secondo il caso.

[Nota]
Cambiando il valore di Time Zone, cambieranno in base 
alla differenza oraria anche le impostazioni dell’orologio.

Impostazione della data e dell’ora

Selezionare le voci e i valori desiderati 
ruotando la manopola multifunzione 
(pagina 4), quindi premere la manopola 
per applicare la selezione impostata. Al 
termine, salvare le impostazioni dell’orologio 
spostando il cursore su “Set” e premendo la 
manopola. La schermata di impostazione 
scompare.
Se necessario, è possibile modificare le 
impostazioni di Time Zone e orologio anche 
dopo la scomparsa della schermata delle 
impostazioni iniziali utilizzando la voce 
Maintenance > Clock Set (pagina 72) nel 
menu completo.

[Note]
•• Se le impostazioni dell’orologio vengono perdute 

in seguito all’esaurimento della batteria di riserva 
mentre il dispositivo non è collegato ad altro sistema 
di alimentazione (pacco batteria o collegamento DC 
IN), verrà visualizzata la schermata delle impostazioni 
iniziali alla successiva riaccensione dell’unità.

•• Mentre viene visualizzata la schermata delle 
impostazioni iniziali, non è possibile eseguire alcuna 
operazione ad eccezione dello spegnimento, fino 
al completamento delle impostazioni richieste da 
questa schermata.

[Informazione]
È anche possibile utilizzare il selettore multiplo.
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Per informazioni sulle ottiche disponibili, rivolgersi a un 
rappresentante di assistenza Sony.

[Attenzione]
Non lasciare l’obiettivo rivolto verso il sole. 
La luce solare diretta condotta dalle ottiche 
dell’obiettivo può mettersi a fuoco all’interno 
dell’unità e causare incendi.

[Note]
•• Spegnere l’alimentazione prima di montare o 

rimuovere ottiche o adattatori.
•• Gli obiettivi sono componenti di elevata precisione. 

Non appoggiare mai un obiettivo su una superficie 
con il suo innesto rivolto verso il basso. Montare 
sempre il coperchietto di protezione fornito.

•• L’interfaccia per ottiche PL dell’unità è configurata, 
per impostazione predefinita, per ottiche con 
connettore tipo Cooke. Per utilizzare ottiche che 
non dispongono di un connettore di tipo Cooke, 
impostare Technical >Lens >PL-Mt Interface Position 
(pagina 65) nel menu completo su Off.

Montaggio di un obiettivo con 
attacco PL

1	 Rimuovere il coperchietto dall’attacco PL 
dell’obiettivo ruotando la levetta 
dell’attacco PL in senso antiorario.

Levetta 
attacco PL

Coperchietto 
attacco PL

	 [Nota]
Ruotare la levetta dell’attacco PL in senso antiorario 
fino alla posizione di arresto.

2	 Inserire l’obiettivo nell’attacco allineando 
il recesso dell’obiettivo con il pernetto di 
riferimento in alto a destra sull’attacco 
dell’obiettivo.

3	 Fissare l’obiettivo ruotando in senso orario 
la levetta dell’attacco PL, sostenendo 
l’obiettivo con la mano.

	 [Nota]
Durante il montaggio, assicurarsi di non ruotare 
obiettivi con attacco PL. La rotazione dell’obiettivo 
PL potrebbe deformarne i pin di contatto elettrico.

Montaggio di un obiettivo Cooke /i

Allineare i contatti dell’obiettivo con i contatti 
elettrici dell’attacco per obiettivi PL dell’unità. 
L’unità dispone di due connettori, ciascuno dei 
quali può essere utilizzato indifferentemente. 
Specificare la posizione del connettore 
utilizzato mediante la voce Technical >Lens 
>PL-Mt Interface Position (pagina 65) del 
menu completo.

Rimozione dell’obiettivo

1	 Ruotare la levetta dell’attacco PL in senso 
antiorario sostenendo l’obiettivo da sotto.

2	 Tirare l’obiettivo in avanti.

	 [Nota]
Se non viene montato un altro obiettivo 
immediatamente, montare il coperchietto di 
protezione dell’attacco PL allineandone il recesso 
con cura, quindi bloccare il coperchietto ruotando 
la levetta dell’attacco PL in senso orario.

Regolazione della lunghezza 
focale di flangia

L’unità viene fornita con la lunghezza 
focale di flangia già registrata. Se dovesse 
essere necessario regolare ulteriormente 
la lunghezza focale di flangia, rimuovere la 
flangia dell’attacco PL e sostituire gli spessori 
con altri delle dimensioni desiderate. Lo 
spessore è regolabile da –0,1 a +0,1 mm in 
incrementi di 0,01 mm.

Spessori

Con l’unità sono forniti i seguenti spessori:
0,05 mm × 1 (circolare)
0,01 mm × 15 (1/3 di arco)
Gli spessori da 1/3 di arco devono essere 
sempre utilizzati in gruppi di 3. Aggiungere 
spessori per aumentare la lunghezza focale di 
flangia. L’unità viene fornita con la lunghezza 
focale flangia già regolata utilizzando i 
seguenti tre tipi di spessori:
0,10 mm (circolare)
0,05 mm (circolare)
0,01 mm (1/3 di arco)
Lo spessore di regolazione alla spedizione è 
indicato da un adesivo.

[Nota]
Per una migliore precisione nel controllo della lunghezza 
focale di flangia, attendere almeno 10 minuti dopo aver 
acceso l’unità prima di eseguire la regolazione.
Inoltre, è possibile ridurre al minimo eventuali errori 
durante l’utilizzo dell’unità assicurandosi che il controllo 
e le regolazioni siano effettuate a una temperatura 
ambiente il più prossima possibile a quella presente 
durante le effettive operazioni di ripresa.

Regolazione della lunghezza focale di 
flangia

1	 Svitare le sei viti Torx e rimuovere la 
flangia dell’attacco PL.

1

Flangia attacco PL

2	 Allentare le quattro viti Phillips sui due lati 
dei connettori PL (due posizioni) e 
rimuovere i connettori PL e le piastre di 
connessione PL.

3	 Collocare gli spessori sull’adattatore 
dell’attacco PL (tre posizioni).

33

33
33

22
22

Connettori PL

Piastre di 
connessione PL

Utilizzo di spessori da 1/3 di arco
Utilizzare sempre spessori identici nelle 
tre posizioni.

Montaggio di un obiettivo e regolazione della lunghezza focale di flangia
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Spessori

Utilizzo di spessori circolari
Montare con la superficie in cui sono 
presenti marcature rivolta in avanti.

Marcature

Marcature

4	 Rimontare i connettori PL (due posizioni) 
nelle loro posizioni originali e serrare le 
quattro viti Phillips a una coppia di 
0,18 N·m.

5	 Rimontare la flangia dell’attacco PL nella 
sua posizione originale e serrare le sei viti 
Torx a una coppia di 0,35 N·m utilizzando 
una chiave dinamometrica T8.

Pulizia del filtro ottico

Per poter pulire il filtro ottico è necessario 
rimuovere prima l’adattatore. Pulire la parte 
centrale dell’adattatore (in grigio nella 
figura) con un panno o altro materiale adatto 
prestando attenzione che fibre e peluzzi non 
aderiscano alle superfici. Rimuovere eventuali 
fibre aderite alle superfici con un pennello 
morbido.

Adattatore

Rimozione dell’adattatore per 
attacco PL

Prima di poter montare un obiettivo E-mount 
sull’unità è necessario rimuovere l’adattatore 
per attacco PL. Il montaggio/rimozione sono 
eseguiti con il lato posteriore dell’unità rivolto 
verso il basso.
Svitare le sei viti a testa cava esagonale 
(2,5 mm) e rimuovere l’adattatore per attacco 
PL.

Adattatore 
attacco PL

[Nota]
Quando si monta o si rimuove l’adattatore, fare 
attenzione a non toccare i contatti del connettore 
dell’unità e dell’adattatore per attacco PL.

[Informazione]
Per una maggiore stabilità, rimuovere la batteria e 
posizionare il lato posteriore dell’unità rivolto verso il 
basso.

Montaggio dell’adattatore per attacco PL

1	 Controllare che la levetta dell’innesto 
E-mount si trovi nella posizione di blocco.

Levetta 
innesto 
E-mount

2	 Collocare l’adattatore per attacco PL di 
nuovo nella sua posizione originale, 
inserire le sei viti a testa cava esagonale 
(2,5 mm) e stringerle a una coppia di 
serraggio di 0,8 ± 0,12 N·m utilizzando una 
chiave esagonale (2,5 mm).
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Montaggio di un obiettivo con 
innesto E-mount

1	 Rimozione dell’adattatore per attacco PL 
(pagina 17).

2	 Spingere verso l’alto il selettore di 
bloccaggio e ruotare la levetta 
dell’innesto E-mount in senso orario per 
rilasciare il blocco.

Levetta innesto 
E-mount

Selettore di 
bloccaggio

3	 Allineare gli indicatori di montaggio 
(bianchi) sull’unità e l’attacco 
dell’obiettivo, quindi spingere l’obiettivo 
nell’attacco.

4	 Fissare l’obiettivo ruotando la levetta 
dell’innesto E-mount in senso antiorario, 
sostenendo l’obiettivo con la mano.

 

Indicatori montaggio 
(bianchi)

[Nota]
Non tutti gli obiettivi E-mount possono essere azionati 
correttamente. Utilizzare un obiettivo raccomandato.

Per informazioni sulle ottiche disponibili, rivolgersi a un 
rappresentante di assistenza Sony.

Rimozione dell’obiettivo

1	 Spingere verso l’alto il selettore di 
bloccaggio e ruotare la levetta 
dell’innesto E-mount in senso orario per 
rilasciare il blocco.

2	 Tirare l’obiettivo in avanti.

	 [Nota]
Se non viene montato un altro obiettivo 
immediatamente, montare il coperchietto di 
protezione dell’innesto E-mount allineandone il 
recesso con cura, quindi bloccare il coperchietto 
ruotando la levetta dell’innesto E-mount in senso 
antiorario.
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Utilizzo delle schede di memoria CFexpress Type B
Utilizzare con l’unità le schede di memoria Sony CFexpress Type B* indicate in “Schede di 
memoria consigliate per la registrazione”.
Per informazioni dettagliate sull’utilizzo di supporti di memoria di altri fabbricanti, fare 
riferimento alle relative istruzioni per l’uso o consultare le informazioni del fabbricante.
*	 Indicate semplicemente come “schede CFexpress” nel presente documento.

[Note]
•• Non è possibile utilizzare schede di memoria CFexpress Type B con una capacità di 2 TB o superiore.
•• Non è possibile utilizzare schede di memoria XQD.

Supporti di memoria consigliati per la registrazione

Le condizioni operative garantite variano a seconda delle impostazioni di Rec Format e 
Recording.
Sì: funzionamento supportato
No: il funzionamento corretto non è garantito

Formato di registrazione CFexpress Type B (exFAT)

Non-VPG VPG200 VPG400

XAVC H Intra HQ 8192×4320 No No Sì

7680×4320 No No Sì

XAVC H Intra SQ 8192×4320 No No Sì

7680×4320 No No Sì

XAVC H Long 7680×4320 No Sì Sì

XAVC Intra 4096×2160 No No Sì

3840×2160 No No Sì

1920×1080 No No Sì

XAVC Long 3840×2160 No No Sì

1920×1080 No No Sì

X-OCN (LT) 8.6K 17:9 No No Sì

8.6K 16:9 No No Sì

6K 17:9 No No Sì

6K 16:9 No No Sì

5.8K 17:9 No No Sì

5.8K 16:9 No No Sì

4.3K 4:3 No No Sì

4K 17:9 No No Sì

3.8K 16:9 No No Sì

Inserimento di una scheda di 
memoria

1	 Aprire il coperchietto della sezione slot 
schede.

2	 Inserire una scheda CFexpress con 
l’etichetta rivolta a sinistra.

Etichetta

L’indicatore di accesso (pagina 4) si 
illumina di rosso, quindi diventa verde se 
la scheda è utilizzabile.

	 [Nota]
Qualora l’indicatore di accesso lampeggi 
continuamente in rosso senza diventare verde, 
provare a spegnere momentaneamente l’unità, 
quindi rimuovere e reinserire la scheda di memoria.

3	 Chiudere il coperchietto.

[Note]
•• La scheda di memoria, lo slot e i dati di immagine 

contenuti sulla scheda potrebbero subire danni se la 
scheda venisse forzata nello slot con l’orientamento 
errato.

•• Per la registrazione su schede CFexpress Type B 
contenute nei due slot A e B, è necessario che 
entrambe le schede inserite siano di tipo adatto al 
formato della registrazione.

Espulsione di una scheda di 
memoria

Aprire il coperchietto della sezione slot schede 
ed esercitare una leggera pressione sulla 
scheda di memoria per espellerla.

[Note]
•• Se l’unità viene spenta o la scheda viene rimossa 

durante l’accesso alla scheda, non è possibile 
garantire l’integrità dei dati contenuti sulla scheda. 
Tutti i dati registrati sulla scheda potrebbero essere 
danneggiati. Potrebbero verificarsi effetti anche sul 
funzionamento dell’unità stessa. Assicurarsi sempre 
che l’indicatore di accesso sia illuminato in verde o 
sia spento prima di spegnere l’unità o rimuovere la 
scheda di memoria.

•• Se si rimuove una scheda di memoria 
immediatamente dopo la registrazione, è possibile 
che sia calda. Questo tuttavia non indica un problema.

Formattazione (inizializzazione) di 
schede di memoria

Se viene inserita una scheda di memoria non 
formattata o formattata con altre specifiche, 
il monitor LCD visualizza il messaggio “Media 
Needs to be Formatted”.
Formattare la scheda come descritto di 
seguito.

1	 Selezionare Format Media (pagina 57) 
nel menu TC/Media del menu completo.

2	 Selezionare Media(A) (slot A) o Media(B) 
(slot B), quindi selezionare Full Format.
Viene visualizzato un messaggio di 
conferma.
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3	 Selezionare Execute.
Durante la formattazione è visualizzato un 
messaggio e l’indicatore di accesso si 
illumina di rosso.
Al termine della formattazione, viene 
visualizzato un messaggio per confermare 
che l’operazione è stata completata. 
Premere la manopola multifunzione per 
chiudere il messaggio.

[Note]
•• Per massimizzare le prestazioni dei supporti di 

registrazione, eseguire sempre la formattazione 
completa utilizzando l’unità.

•• La formattazione di una scheda di memoria elimina 
tutti i dati che contiene, comprese le registrazioni 
video e i file di setup.

•• A seconda della durata, potrebbero essere visualizzati 
messaggi anche durante il processo di formattazione.

Se la formattazione non riesce

Non è possibile formattare schede di memoria 
non supportate dall’unità.
Viene visualizzato un messaggio di 
avvertimento. Seguire le istruzioni e sostituire 
la scheda con una scheda di memoria 
supportata.

Utilizzo di una scheda formattata con 
questa unità nello slot di un altro 
dispositivo

Eseguire il backup di tutti i dati registrati sulla 
scheda, quindi riformattare la scheda nel 
dispositivo in cui deve essere utilizzata.

Controllo del tempo di 
registrazione rimanente

Durante la ripresa (registrazione/standby), è 
possibile monitorare la capacità rimanente 
sulle schede di memoria di ciascuno 
slot mediante gli indicatori di capacità 
rimanente degli slot A e B visualizzati nella 
schermata di ripresa e nella schermata Home 
(pagina 23).
Il tempo di registrazione rimanente è calcolato 
sulla base della capacità rimanente della 
scheda di ciascuno slot e del formato di 
registrazione corrente ed è indicato in minuti.

Tempi di sostituzione delle schede di 
memoria

•• Quando il tempo di registrazione rimanente 
totale sulle due schede di memoria scende 
al di sotto di 5 minuti, viene visualizzato 
il messaggio “Media Near Full”, la spia di 
registrazione/tally comincia a lampeggiare 
e viene emesso un segnale acustico di 
avvertimento sull’uscita cuffie.  
Sostituire con una scheda con spazio libero 
sufficiente.

•• Se si prosegue con la registrazione fino 
a esaurire completamente lo spazio 
disponibile, appare il messaggio “Media 
Full” e la registrazione si arresta.

[Nota]
Una scheda di memoria consente la registrazione di un 
massimo di 600 clip circa.

Ripristino delle schede di memoria

Qualora si verifichi un errore su una scheda di 
memoria, la scheda dovrà essere ripristinata 
prima di poter essere nuovamente utilizzata.
Se si inserisce una scheda di memoria che 
deve essere ripristinata, il monitor LCD 
visualizza un messaggio che chiede di 
confermarne il ripristino.

Ripristino di una scheda di memoria

Ruotare la manopola multifunzione 
(pagina 4) per selezionare Execute, quindi 
premere la manopola multifunzione.
Durante la formattazione lo schermo 
visualizza un messaggio e la percentuale (%) 
di avanzamento dell’operazione. L’indicatore 
di accesso è inoltre illuminato in rosso.
Al termine del ripristino viene visualizzato un 
messaggio di conferma.

Se il ripristino non riesce

•• Non è possibile ripristinare schede di 
memoria su cui sono presenti errori di 
memoria. Viene visualizzato un messaggio 
di avvertimento. Seguire le istruzioni e 
sostituire la scheda la scheda di memoria.

•• Le schede di memoria che contengono 
errori di memoria potrebbero diventare 
nuovamente utilizzabili se riformattate.

•• In alcuni casi, potranno essere ripristinati 
solo alcuni clip e non altri. I clip ripristinati 
possono essere riprodotti normalmente.

[Note]
•• Per il ripristino dei supporti, utilizzare sempre lo 

stesso apparecchio utilizzato per registrarli.
•• Questo apparecchio non consente di ripristinare 

supporti registrati con apparecchi diversi o con 
apparecchi di versione diversa (anche se dello stesso 
modello).

•• I clip di durata inferiore a 2 secondi non possono 
essere ripristinati.

•• Le schede di memoria ripristinate potrebbero non 
garantire le stesse prestazioni originali. Eseguire un 
backup di tutte i clip necessari e quindi eseguire una 
formattazione completa prima dell’uso.
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Utilizzo delle schede Utility SD
La scheda UTILITY SD è utilizzata per la 
registrazione proxy e per memorizzare e 
caricare impostazioni. Viene utilizzata anche 
per aggiornamenti futuri (aggiornamento 
software).

Schede SD supportate

Schede di memoria SDXC*
Schede di memoria SDHC*
Schede di memoria SD*
*	 Indicate collettivamente come “schede SD” in questo 

manuale.

[Nota]
Per la registrazione proxy si consiglia di utilizzare schede 
con classe di velocità 10.

Inserimento di una scheda SD

Inserire una scheda SD nello slot per schede 
Utility SD (pagina 4).
L’indicatore di accesso (pagina 4) si 
illumina di rosso e quindi si spegne quando la 
scheda è pronta all’uso.

Indicazione dello stato di accesso

Indicatore Stato dello slot

Luce rossa Accesso alla scheda SD 
(scrittura/lettura dei dati)

Rimozione di una scheda di 
memoria SD

Premere leggermente la scheda SD, quindi 
rimuoverla.

[Note]
•• Se l’unità viene spenta o la scheda viene rimossa 

durante l’accesso alla scheda, non è possibile 
garantire l’integrità dei dati contenuti sulla scheda. 
Tutti i dati registrati sulla scheda potrebbero essere 
danneggiati. Assicurarsi sempre che l’indicatore 
di accesso sia spento prima di spegnere l’unità o 
rimuovere la scheda di memoria.

•• Assicurarsi che la scheda di memoria non salti 
fuori dallo slot al momento dell’inserimento o 
dell’estrazione.

Formattazione (inizializzazione) di 
una scheda SD

Le schede SD devono essere formattate prima 
di poterle utilizzare sull’unità.
Le schede SD da utilizzare con questa unità 
devono essere formattate con la funzione 
di formattazione dell’unità stessa. Inoltre, 
è necessario formattare una scheda SD 
anche nel caso in cui venga visualizzato un 
messaggio di avvertenza al momento del suo 
inserimento.
Se viene inserita una scheda SD formattata 
con un formato non supportato, verrà 
visualizzato un messaggio che segnala che il 
file system non è compatibile.

1	 Selezionare Format Media (pagina 57) 
nel menu TC/Media del menu completo.

2	 Selezionare Utility SD, quindi selezionare il 
metodo di formattazione desiderato (Full 
Format o Quick Format).

Viene visualizzato un messaggio di 
conferma.
•• Full Format: Inizializza completamente 

il supporto di memoria, compresa 
la regione contenente i dati e le 
informazioni di gestione dei dati.

•• Quick Format: Inizializza solamente le 
informazioni di gestione dei dati del 
supporto di memoria.

3	 Selezionare Execute.
Durante la formattazione è visualizzato un 
messaggio e l’indicatore di accesso si 
illumina di rosso.
Al termine della formattazione, viene 
visualizzato un messaggio per confermare 
che l’operazione è stata completata. 
Premere la manopola multifunzione per 
chiudere il messaggio.

[Nota]
La formattazione di una scheda SD ne elimina tutti i dati, 
che non potranno più essere recuperati.

Differenza fra Quick Format e Full 
Format

Eseguire una formattazione completa (Full 
Format) quandi si nota un rallentamento della 
velocità di registrazione o lettura della scheda, 
oppure si desidera eliminare completamente 
tutti i dati. La formattazione completa richiede 
più tempo rispetto alla formattazione rapida 
perché inizializza tutti i settori della scheda di 
memoria.

Utilizzo di supporti di memoria 
formattati con questo apparecchio negli 
slot di altri dispositivi

Eseguire un backup del supporto e quindi 
formattarlo con l’altro dispositivo.
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Struttura dello schermo del monitor LCD
Lo schermo del monitor LCD presenta due modalità operative centrate intorno alla schermata Home: la modalità di monitoraggio video in cui è possibile controllare le impostazioni durante il 
monitoraggio del video e la modalità di visualizzazione delle informazioni in cui è possibile controllare e modificare informazioni e impostazioni. È possibile passare da una modalità all’altra 
premendo il pulsante HOME. La schermata di stato, la schermata del menu completo, la schermata di riproduzione e la schermata dei clip possono essere visualizzate in entrambe le modalità.
È possibile scegliere la schermata da visualizzare sul monitor LCD utilizzando i pulsanti HOME, MENU e CLIPS.

Modalità di monitoraggio video

Schermata di stato

Schermata di riproduzione
Selezione clip 
(riproduzione)

Selezione clip 
(riproduzione)

Pulsante 
CLIPS

Pulsante 
CLIPS

Schermata di stato

Schermata di controllo 
della riproduzione

Schermata menu completo

Schermata dei clip

Pulsante HOME

Schermata di 
ripresa

Schermata Home

Pulsante HOME

Pulsante MENU Pulsante HOME Pulsante MENU

Pulsante CLIPS Pulsante HOME Pulsante CLIPS

Pulsante 
MENU

Pulsante 
MENU

Pulsante HOME

Schermata menu completo

Schermata dei clip

Modalità di visualizzazione delle informazioni

[Informazioni]
•• In modalità di monitoraggio video, è possibile emettere in uscita su un monitor esterno la stessa schermata visualizzata sul monitor LCD.
•• La modalità di visualizzazione delle informazioni è concepita per l’uso sul monitor LCD quando, per l’uscita HDMI, viene utilizzato anche un monitor esterno collegato. È consigliabile collocare il monitor esterno sul lato comandi operatore 

dell’unità per il monitoraggio del video, mentre il monitor LCD può essere disposto sul lato comandi operatore oppure sul lato connettore per la configurazione delle impostazioni, in base alla composizione della squadra di ripresa. Le 
indicazioni a schermo non possono essere visualizzate in sovraimpressione sull’uscita SDI, eccetto nel caso in cui il formato di uscita video sia impostato su Monitor FHD.
–– Le funzioni visualizzate sul monitor LCD vengono gestite tramite il selettore multiplo del monitor LCD oppure la manopola multifunzione sul lato comandi operatore.
–– Le funzioni visualizzate sul monitor esterno vengono gestite tramite il selettore multiplo sul lato comandi operatore. È possibile selezionare il riquadro di riconoscimento del soggetto, spostare l’area di messa a fuoco nonché spostare la 

posizione di ingrandimento della messa a fuoco.
•• Per X-OCN, l’immagine indice non viene visualizzata nella schermata dei clip.
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Schermata di ripresa e schermata di riproduzione
Nella modalità di monitoraggio video, lo stato e le impostazioni dell’unità vengono visualizzati 
intorno all’immagine sul monitor LCD e sul monitor esterno durante la ripresa (registrazione/
standby) e la riproduzione.
Nella modalità di visualizzazione delle informazioni, lo stato dell’unità e alcune impostazioni 
possono essere visualizzate in sovraimpressione durante la ripresa e la riproduzione su 
un’immagine di monitoraggio esterna. Impostare in anticipo Info Disp nella schermata di stato 
Monitoring (pagina 30) su On.
È possibile visualizzare o nascondere queste informazioni premendo il pulsante DISPLAY. 
Anche se nascoste nella modalità di monitoraggio video, verranno sempre visualizzate in 
sovraimpressione quando si eseguono operazioni con il Direct Menu (pagina 108).
È inoltre possibile scegliere quali voci devono essere visualizzate indipendentemente dalle altre 
(pagina 58).
Gli elementi contrassegnati con un asterisco non possono essere visualizzati su un monitor 
esterno in modalità di visualizzazione delle informazioni.

Informazioni visualizzate sullo schermo durante le riprese
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1.	 Indicatore della modalità di messa a 
fuoco (pagina 100)

Significato Indicazione

Modalità Focus Hold Focus Hold

Modalità MF MF

Modalità AF AF

Modalità AF con seguimento 
in tempo reale

Riconoscimento soggetto AF (AF/ /Only/ )

Significato Indicazione

Icona rilevamento 
soggetto umano

Icona AF solo soggetto 
umano

Only

Icona AF in pausa1)

1)	 Visualizzata mentre è attiva la modalità AF ma 
la funzione AF non può continuare e si arresta 
momentaneamente. L’icona scompare quando la 
causa dell’interruzione della funzione AF viene risolta 
e la funzione AF si riavvia.

2.	 Indicatore della posizione di messa a fuoco
Visualizza la posizione di messa a fuoco 
(solo quando è montato un obiettivo 
compatibile con la funzione di visualizzazione 
dell’impostazione della messa a fuoco).

3.	 Indicatore di stato della rete 
(pagina 25)

Visualizza graficamente lo stato della 
connessione di rete.

4.	 Indicatore di upload/Indicatore file 
rimanenti (pagina 85)

5.	 Indicatore modalità di registrazione e 
stato slot A/B, intervallo di registrazione 
Interval Rec (pagina 109)

Indicazione Significato

Rec Registrazione

Stby Standby registrazione

6.	 Indicatore dello stato di Rec Control 
sull’uscita SDI o HDMI (pagina 115)

Indica lo stato di uscita del segnale REC Control.

7.	 Indicatore carica residua della batteria/
Tensione DC IN (pagina 14)

8.	 Indicatore di profondità di campo

9.	 Indicazione del nome del Look 
(pagina 94) Indicazione High Key/Low 
Key (pagina 112)

Visualizza il Look selezionato.
Visualizza “High Key” o “Low Key” quando 
sono abilitati rispettivamente High Key 
(schermata di controllo delle alte luci ad alta 
luminanza) o Low Key (schermata di controllo 
delle ombre a bassa luminanza).

10.	 Indicatore di stato della serie UWP-D 
(pagina 25)

Qualora sia collegato alla slitta MI di una 
maniglia (opzione) configurata per la 
trasmissione di audio digitale un dispositivo 
della serie UWP-D, ne visualizza l’intensità del 
segnale RF in forma grafica.

11.	 Indicatore della zona di messa a fuoco 
(pagina 97)

Visualizza la zona di messa a fuoco per la 
messa a fuoco automatica.

12.	 Indicatore assistenza visualizzazione 
gamma*

Nella modalità Custom (pagina 88), 
visualizza lo stato della funzione di assistenza 
visualizzazione gamma. La funzione di 
assistenza visualizzazione gamma può essere 
attivata o disattivata assegnando Gamma 
Display Assist a un pulsante programmabile 
(pagina 108).

13.	 Monitor segnale video (pagina 111)
Visualizza forma d’onda, vettorscopio e 
istogramma.
La linea arancione indica il valore impostato 
del livello zebra.
Nella modalità Cine EI (pagina 88), il 
monitor target, il gamut di colori del sistema 
SDI viene visualizzato sopra al display.
•• Se è selezionato LUT On, viene visualizzata 

l’indicazione “Look” indipendentemente dal 
tipo di LUT applicata.

•• Visualizza “High Key” o “Low Key” quando 
sono abilitati rispettivamente High Key o 
Low Key.

•• Se è selezionato LUT Off, viene visualizzato il 
valore di Color Gamut.

14.	 Indicatore di avviso livello video*

15.	 Visualizzazione nome clip (pagina 57)
Visualizza il nome del clip in corso di 
registrazione o che verrà registrato 
successivamente.
Il nome del clip lampeggia nei casi indicati di 
seguito.
•• Quando viene inserito un nuovo supporto di 

registrazione
•• Quando l’ultimo clip sul supporto 

di registrazione non corrisponde 
all’impostazione di Clip Name Format 
(pagina 57) >Camera ID o Reel Number 
nel menu TC/Media del menu completo..
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16.	 Indicatore della modalità di scansione 
dell’imager (pagina 88)

17.	 Indicatore della frequenza fotogrammi in 
modalità di ripresa Slow & Quick Motion 
(pagina 109)

18.	 Indicatore formato di registrazione 
(frequenza fotogrammi)/Formato di 
registrazione (Codec) (pagina 46)

Visualizza il nome del formato di registrazione 
sulle schede di memoria.

19.	 Indicatore del look di registrazione 
(pagina 94)

20.	 Indicatore di orizzontalità
Visualizza l’orizzontalità in incrementi di ±1° 
fino a un massimo di ±15°.

21.	 Indicatore di livello audio
Indica il livello audio dei canali da CH1 a CH4.

22.	 Indicatore modalità bilanciamento del 
bianco (pagina 104)

Indicazione Significato

Modalità auto

 Hold Modalità auto in pausa

W:A Modalità memoria A

W:B Modalità memoria B

W:C Modalità memoria C

W:D Modalità memoria D

W:E Modalità memoria E

W:F Modalità memoria F

W:G Modalità memoria G

W:H Modalità memoria H

23.	 Indicatore otturatore (pagina 103)

Indicazione Significato

Modalità auto

24.	 Indicatore di Base ISO/Base Sensitivity 
(pagina 102)

Nella modalità Cine EI (pagina 88) visualizza 
la sensibilità Base ISO impostata con Base 
ISO/Sensitivity nella schermata Main Status 
oppure con ISO/Gain/EI >Base ISO nel menu 
Shooting del menu completo.
Nella modalità Custom (pagina 88) 
visualizza la sensibilità di base impostata 
con Base ISO/Sensitivity nella schermata 
Main Status oppure con ISO/Gain/EI >Base 
Sensitivity nel menu Shooting del menu 
completo.

25.	 Indicatore della sincronizzazione con 
codice temporale esterno/Indicatore dati 
temporali (pagina 90)

Visualizza “EXT-LK” quando l’apparecchio 
è sincronizzato sul codice temporale di un 
dispositivo esterno.

26.	 Indicazione indice di esposizione 
(pagina 102)

Nella modalità Custom (pagina 88), 
visualizza la sensibilità ISO o il guadagno.

Indicazione Significato

Modalità auto

Modalità di regolazione 
temporanea

Modalità di controllo Bokeh 
(pagina 111)

27.	 Indicatore valore di diaframma
Visualizza il valore di diaframma (valore T-stop 
o valore F-stop) se è montato un obiettivo che 
supporta questa funzione.

Indicazione Significato

Modalità auto

[Nota]
Il valore F-stop viene visualizzato al posto del valore 
T-stop se non è possibile ottenere il valore T-stop.

28.	 Indicatore filtro ND (pagina 103)
Mostra la densità del filtro ND.

Indicazione Significato

Modalità auto

Modalità di controllo Bokeh 
(pagina 111)

29.	 Indicatore modalità AE/livello AE 
(pagina 53)

30.	 Indicatore stato supporti di memoria

Indicazione Significato

Montaggio in corso/stato di 
montaggio (scheda A)

Montaggio in corso/stato di 
montaggio (scheda B)

Montaggio con registrazione proxy 
abilitata/stato del montaggio 
(supporto proxy (scheda SD))

(lampeggiante)

Registrazione proxy abilitata ma 
non pronta (scheda non inserita, 
ecc.)

(lampeggiante)

Registrazione proxy arrestata

Se la scheda di memoria è protetta da scrittura 
viene visualizzata l’icona .

31.	 Indicatore della modalità di 
stabilizzazione dell’immagine e della 
lunghezza focale di stabilizzazione 
dell’immagine (pagina 105)

Indicazione Significato Adattatore 
attacco PL

Stabilizzazione immagine 
ON (High)

Montato

Stabilizzazione immagine 
ON (Low)

Stabilizzazione immagine 
OFF

Indicazione Significato Adattatore 
attacco PL

Stabilizzazione immagine 
ON (Active)

Non 
montato

Stabilizzazione immagine 
ON (Standard)

Stabilizzazione immagine 
OFF

Quando Image Stabilization >Stabilization 
Adjustment (pagina 44) nel menu Shooting 
del menu completo è impostata su Manual, 
la lunghezza focale della stabilizzazione 
dell’immagine viene indicata sotto all’icona 
della modalità di stabilizzazione dell’immagine.

32.	 Indicazione della posizione di zoom 
(pagina 95)

Visualizza la lunghezza focale dello zoom 
(visualizzata solo quando è montato 
un obiettivo che supporta l’indicazione 
dell’impostazione dello zoom).
Questa indicazione può essere rappresentata 
con un indicatore a barra o un indicatore 
numerico (pagina 66).
Il valore numerico 0 indica la posizione di 
grandangolo, mentre il valore 99 indica la 
posizione di teleobiettivo.
Quando è abilitata la funzione Clear Image 
Zoom, vengono visualizzate sul display anche 
le indicazioni elencate di seguito.

Indicazione Significato

Clear Image Zoom abilitato

Valore di 
ingrandimento

Quando è utilizzata la funzione 
Clear Image Zoom

33.	 Pulsante di arresto AF con seguimento in 
tempo reale (pagina 101)
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Informazioni visualizzate sullo schermo durante la riproduzione

Le seguenti informazioni vengono sovraimposte sull’immagine riprodotta.

43

7

65

15

1314

9
10

21

8

11
12

004/004

1.	 Numero del clip/Numero totale dei clip

2.	 Indicatore di stato della rete

3.	 Indicatore di upload/Indicatore file 
rimanenti

4.	 Indicatore dello stato della riproduzione

5.	 Visualizzazione nome look

6.	 Indicatore carica residua della batteria/
Tensione DC IN

7.	 Indicatore dimensioni immagine X-OCN
Visualizza la risoluzione e il rapporto 
di aspetto registrati di un clip X-OCN in 
riproduzione.

8.	 Indicatore della frequenza fotogrammi in 
modalità di ripresa Slow & Quick Motion

9.	 Formato di riproduzione
Visualizza la frequenza fotogrammi e il 
codec del clip in riproduzione. Per XAVC, 
vengono visualizzate anche le dimensioni 
dell’immagine.

10.	 Indicatore del look di registrazione

11.	 Assistenza di visualizzazione gamma*

12.	 Indicatore di livello audio
Visualizza il livello di riproduzione dell’audio.

13.	 Visualizzazione dati temporali

14.	 Visualizzazione nome clip

15.	 Indicatore capacità residua supporto
Se la scheda di memoria è protetta da scrittura 
viene visualizzata l’icona .

Indicazioni grafiche (icone)

Icone di indicazione della connessione di rete

Modalità di rete Stato della connessione Icona

Modalità punto di accesso In operazione come punto di accesso

Errore nel funzionamento come punto 
di accesso

Modalità stazione Connessione Wi-Fi
L’icona cambia in base all’intensità del 
segnale (4 livelli)

   

Wi-Fi non connesso (anche mentre 
viene stabilita la connessione)

Errore di connessione Wi-Fi

Tethering USB Tethering USB connesso

Tethering USB non connesso

Errore nel tethering USB

LAN cablata LAN cablata connessa

LAN cablata disconnessa

Errore in LAN cablata

Visualizzazione dell’icona della serie UWP-D

Stato del trasmettitore Stato della ricezione Icona

Dispositivo spento Nessuna ricezione

Stato di trasmissione normale Ricezione
 –  (livello di 

ricezione (4 livelli))

Stato del muting Ricezione (muting attivo)

Avvertimento della capacità rimanente 
della batteria

Ricezione
 (icona lampeggiante)

Muting attivo e avvertimento della 
capacità rimanente della batteria

Ricezione
 (icona lampeggiante)
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Schermata Home
Premere il pulsante HOME per visualizzare la schermata Home. La schermata Home consente di 
controllare lo stato dell’unità e configurarne le principali impostazioni.

Area di 
visualizzazione 
del nome, del 
valore di 
impostazione e 
della funzione 
della voce

Area di 
visualizzazione 
stato

[Note]
•• La schermata Home non consente di commutare fra gli stati automatico e manuale delle funzioni. Configurare 

utilizzando Direct Menu (pagina 108) oppure il menu Shooting del menu completo.
•• Nella modalità di visualizzazione delle informazioni, non è possibile utilizzare Direct Menu (pagina 108). Passare 

prima alla schermata di ripresa utilizzando il pulsante HOME e quindi eseguire la configurazione.

[Informazione]
È possibile configurare gli elementi visualizzati nella schermata Home utilizzando solo il monitor LCD assegnando i 
seguenti elementi a un pulsante programmabile (pagina 108) sul monitor LCD.
•• MENU
•• IRIS (quando si utilizzano obiettivo E-mount)

Area di visualizzazione del nome, del valore di impostazione e della 
funzione della voce

1 2 3

4 5 6

Pulsante ITEM 4 Pulsante ITEM 5 Pulsante ITEM 6

Pulsante ITEM 3Pulsante ITEM 2Pulsante ITEM 1

[Nota]
Le zone indicate con i numeri da 1 a 6 si riferiscono 
ai corrispondenti pulsanti ITEM da 1 a 6. Premere un 
pulsante ITEM per selezionare la voce corrispondente.

1.	 FPS
Visualizza e imposta la frequenza fotogrammi 
di ripresa.

2.	 Exposure Index/Base ISO
Visualizza e imposta l’indice di esposizione (EI) 
e il valore di Base ISO.

[Informazione]
Nella modalità Custom, questo visualizza e imposta ISO/
Base Sensitivity o Gain/Base Sensitivity.

3.	 Shutter
Visualizza e imposta l’otturatore elettronico.

4.	 ND Filter
Visualizza e imposta il filtro ND.

[Nota]
Nella modalità VARIABLE, il filtro ND non può essere 
configurato nella schermata Home. Eseguire la 
configurazione utilizzando la manopola e i pulsanti del 
filtro ND sul lato comandi operatore dell’unità.

5.	 Look
Visualizza e imposta il look.

[Informazione]
Nella modalità Custom, questo visualizza e imposta i file 
di scena.

6.	 WB (White Balance)
Visualizza e imposta il bilanciamento del 
bianco.
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Area di visualizzazione stato

1 3 5

8 79

42

610
11

1.	 Indicazione dati temporali
Visualizza la durata, i bit utente 
oppure il codice temporale, a seconda 
dell’impostazione di TC Display nel menu TC/
Media del menu completo (pagina 56).
Indica il tipo di dati correntemente visualizzato 
sullo schermo, come segue:

TCG: Codice temporale registrato 
EXT-LK: Aggancio sincronizzazione 
esterna

UBG: Bit utente registrati
TCR: Codice temporale di riproduzione
UBR: Bit utente di riproduzione
Clk: Orologio
Dur: Durata

2.	 Indicatore della modalità di scansione 
dell’imager

Visualizza l’impostazione Imager Scan nella 
schermata di stato Project.

3.	 Indicatore frequenza fotogrammi
Visualizza l’impostazione di Frequency nella 
schermata di stato Project.

4.	 Indicatore formato di registrazione 
(codec)/Risoluzione immagine

Visualizza il nome del formato utilizzato per 
la registrazione su una scheda CFexpress e la 
risoluzione dell’immagine.

5.	 Indicatore tensione di alimentazione/
carica residua della batteria

Visualizza la tensione di alimentazione o la 
capacità residua della batteria.

6.	 Indicatori di livello audio
Visualizzano i livelli di registrazione o 
riproduzione audio. I numeri da 1 a 4 indicano i 
canali da 1 a 4.

7.	 Visualizzazione nome clip
Visualizza “Reel: Camera ID + Reel Number” e 
“Shot: Camera Position + Shot Number”.

8.	 Indicatore capacità residua supporto
Visualizza lo stato e il tempo di registrazione 
rimanente (quando si registra nel formato di 
registrazione corrente) di ciascun supporto di 
registrazione.

9.	 Indicatore valore di diaframma
Visualizza la posizione del diaframma (valore 
T-stop o valore F-stop).

10.	 Icona di avvertenza/errore
Visualizzata quando si verifica un’avvertenza 
o un errore.
È possibile controllare il contenuto di 
avvertenze ed errori visualizzando il menu. 
Se le indicazioni a schermo sono visualizzate 
in sovraimpressione anche su un monitor 
esterno, è possibile eseguire il controllo anche 
sul monitor esterno.

11.	 Indicazione dello stato di registrazione
Visualizza i seguenti stati operativi di 
registrazione dell’unità.

Indicazione Descrizione

   Stby Standby registrazione

Rec Registrazione

Cache Cache immagine standby di 
registrazione
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Operazioni sulla schermata Home

1	 Premere il pulsante HOME.
Viene visualizzata la schermata Home.

2	 Selezionare la voce desiderata da 
impostare con i pulsanti ITEM da 1 a 6.
La seguente figura mostra un esempio nel 
caso in cui venga premuto il pulsante 
ITEM 3.

3	 Spostare il cursore sulla voce o sul valore 
di impostazione desiderato con i pulsanti 
 o  (rispettivamente pulsante ITEM 1 e 
pulsante ITEM 4).

4	 Premere il pulsante Set (pulsante ITEM 3) 
per applicare l’impostazione.

[Informazione]
È possibile utilizzare anche il selettore multiplo del 
monitor LCD o la manopola multifunzione sul lato 
comandi operatore dell’unità. Premere per visualizzare 
un cursore, quindi azionare.
È disponibile anche l’azionamento tramite touchscreen.

Elementi della schermata Home

Di seguito si indicano le impostazioni che possono essere configurate per ciascuna voce. Per 
informazioni dettagliate sugli elementi aventi le stesse impostazioni nel menu completo, fare 
riferimento alla descrizione del menu completo (pagina 33).

Voce Descrizione

FPS Specifica se la frequenza fotogrammi di ripresa è impostata sulla frequenza 
di sistema oppure può essere diversa dalla frequenza di sistema.
•• Fixed 

Se è selezionato “Fixed” sulla schermata, la frequenza fotogrammi di 
ripresa corrisponde alla frequenza di sistema. In questo caso la 
schermata visualizza l’indicazione “Fixed” e la frequenza di sistema.

•• Variable 
Se è selezionato “Variable” sulla schermata, è possibile impostare una 
frequenza fotogrammi di ripresa diversa dalla frequenza di sistema.  
Da 1 a 60 / 66 / 72 / 75 / 88 / 90 / 96 / 100 / 110 / 120 / 150 / 180 / 200 / 
240 fps

[Nota]
I valori disponibili variano a seconda di frequenza di sistema, codec e formato video 
selezionati.  

[Informazione]
Questa impostazione corrisponde a Rec Function >S&Q Motion nella schermata di 
stato Project e S&Q Motion nel menu Shooting del menu completo.

Exposure Index/Base 
ISO
(In modalità Cine EI)

Imposta il valore dell’indice di esposizione (pagina 39).
Premere Base ISO per impostare il valore di base ISO (pagina 39).

[Informazione]
Exposure Index corrisponde a ISO/Gain/EI >Exposure Index nel menu Shooting del 
menu completo. Base ISO corrisponde a ISO/Gain/EI >Base ISO nel menu Shooting del 
menu completo.

ISO/Gain / Base 
Sensitivity
(In modalità Custom)

Imposta il guadagno (pagina 39).
Premere Base Sensitivity per impostare il valore di sensibilità di base 
(pagina 39).

[Informazione]
ISO/Gain corrisponde a ISO/Gain/EI >ISO o Gain nel menu Shooting del menu 
completo. Base Sensitivity corrisponde a ISO/Gain/EI >Base Sensitivity nel menu 
Shooting del menu completo.
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Voce Descrizione

Shutter Imposta l’otturatore elettronico (pagina 40).
Premere Angle o ECS per impostare il valore dell’otturatore rispettivamente 
come angolo o frequenza.

[Informazioni]
•• Angle corrisponde a Shutter >Shutter Angle nel menu Shooting del menu completo. 

ECS corrisponde a Shutter >ECS On/Off e ECS Frequency nel menu Shooting del 
menu completo.

•• È possibile impostare la velocità dell’otturatore anziché l’angolo impostando 
Shutter >Mode su Speed nel menu Shooting del menu completo.

ND Filter Imposta la posizione del filtro ND. Disponibile solo quando il selettore ND 
STEP/VARIABLE si trova sulla posizione STEP.

Look
(In modalità Cine EI)

Imposta il look (pagina 53). Premere il pulsante Edit Look (pulsante ITEM 
4) e selezionare un look. È possibile impostare i sistemi di output a cui 
applicare un look utilizzando i pulsanti ITEM 1, 5 e 6. In base allo stato, vi 
possono essere combinazioni che non possono essere impostate oppure 
impostazioni che sono interdipendenti fra loro.

[Informazione]
Questa impostazione corrisponde a un’impostazione nella schermata di stato 
Monitoring, Base Look >Select nel menu Paint/Look del menu completo e ogni voce in 
LUT On/Off nel menu Shooting del menu completo.

Scene File
(In modalità Custom)

Abilita impostazioni di qualità di immagine preconfigurate.
Oltre alle impostazioni di qualità dell’immagine preinstallate, è possibile 
salvare e successivamente attivare le impostazioni preferite di qualità di 
immagine (pagina 53).

[Informazione]
Questa impostazione corrisponde a Scene File >Recall nel menu Paint/Look del menu 
completo.

WB (White Balance) Imposta il bilanciamento del bianco (pagina 42).
Sono disponibili otto posizioni di memoria del bianco (A/B/C/D/E/F/G/H). 
È possibile impostare il valore di ciascuna posizione utilizzando i metodi 
indicati di seguito.
•• Impostazione di valori di temperatura del colore e tinta separati
•• Impostazione automatica tramite il bilanciamento automatico del bianco
•• Selezione di valori preimpostati specifici

[Informazione]
Questa impostazione corrisponde alle voci dell’opzione White nel menu Shooting del 
menu completo.
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Schermata di stato
La schermata di stato consente di controllare 
le impostazioni e lo stato dell’unità. Le 
impostazioni delle voci contrassegnate con un 
asterisco (*) sono modificabili.
È possibile interagire con la schermata di stato 
toccando il touchscreen.

Per visualizzare la schermata di stato
•• Premere il pulsante MENU.

[Informazione]
È possibile mostrare o nascondere le varie schermate 
di stato mediante la voce Menu Page On/Off 
(pagina 65) del menu Technical.

Per passare a un’altra schermata di stato
•• Ruotare la manopola multifunzione.
•• Spostare il selettore multiplo verso l’alto o 

verso il basso.
•• Trascinare la schermata di stato verso l’alto 

o verso il basso.

[Nota]
Quando il monitor LCD si trova in modalità di 
visualizzazione delle informazioni, il comando tramite il 
selettore multiplo del lato comandi operatore dell’unità 
oppure tramite il telecomando non è disponibile.

Per chiudere la schermata di stato
•• Premere il pulsante MENU.

Per modificare un’impostazione
Mentre è visualizzata la schermata di stato, 
premere la manopola multifunzione o il 
selettore multiplo per consentire la selezione 
di una voce di impostazione contenuta in una 
pagina. Selezionare il numero della pagina 
desiderata e quindi premere per aprirla.
È possibile selezionare voci anche 
semplicemente toccandole sul touchscreen.

[Nota]
È possibile impedire la modifica delle voci della 
schermata di stato impostando su On la voce Menu 
Settings >User Menu Only (pagina 65) del menu 
Technical nel menu completo.

Schermata di stato Project

Visualizza le impostazioni di base relative al 
progetto di ripresa.

Voce visualizzata Descrizione

Frequency/Scan* Impostazioni frequenza di 
sistema e metodo di 
scansione

Codec* Impostazione codec per la 
registrazione

Rec Function* Impostazione On/Off della 
funzione di registrazione 
speciale e impostazioni 
principali

Simul Rec* Stato e impostazione On/Off 
della funzione di 
registrazione simultanea su 
2 slot

Reel* Valori di Camera ID e Reel 
Number impostati per il 
nome del clip

Imager Scan* Modalità di scansione del 
sensore immagine

Video Format* Dimensioni immagine per la 
registrazione sule schede di 
memoria

Picture Cache 
Rec*

Attivazione (On/Off) e 
impostazione delle 
dimensioni della cache 
immagine

Shot* Valore impostato di Camera 
Position e valore di Shot 
Number della registrazione 
corrente/successiva per il 
nome del clip

Shooting Mode* Impostazioni della modalità 
di ripresa

Proxy Rec* Impostazione On/Off della 
funzione di registrazione 
proxy

Genlock Stato del genlock

Schermata di stato Audio

Visualizza le impostazioni di ingresso, 
l’indicatore di livello audio e il volume di 
monitoraggio per ciascun canale.

Voce visualizzata Descrizione

CH1 Level 
Control

Stato On/Off della 
regolazione automatica

Level Meter Indicatore di livello audio

Source* Sorgente di ingresso

Reference* Livello di riferimento di 
ingresso

Wind 
Filter*

Impostazione del valore di 
riduzione del filtro antivento 
del microfono

CH2 Level 
Control

Stato On/Off della 
regolazione automatica

Level Meter Indicatore di livello audio

Source* Sorgente di ingresso

Reference* Livello di riferimento di 
ingresso

Wind 
Filter*

Impostazione del valore di 
riduzione del filtro antivento 
del microfono

CH3 Level 
Control*

Stato On/Off della 
regolazione automatica

Level 
Meter*

Indicatore di livello audio

Source* Sorgente di ingresso

Reference* Livello di riferimento di 
ingresso

Wind 
Filter*

Impostazione del valore di 
riduzione del filtro antivento 
del microfono

Voce visualizzata Descrizione

CH4 Level 
Control*

Stato On/Off della 
regolazione automatica

Level 
Meter*

Indicatore di livello audio

Source* Sorgente di ingresso

Reference* Livello di riferimento di 
ingresso

Wind 
Filter*

Impostazione del valore di 
riduzione del filtro antivento 
del microfono

Audio Input 
Level*

Impostazione del livello di 
ingresso audio (volume 
master)

HDMI Output CH* Impostazione canale audio 
di uscita HDMI

Volume* Impostazione del volume 
dell’altoparlante incorporato 
o delle cuffie

Monitor CH* Impostazione di 
monitoraggio del canale

Schermata di stato Monitoring

Visualizza le impostazioni di uscita SDI e HDMI.

Voce visualizzata Descrizione

SDI1 Signal* Dimensioni immagine di 
uscita

Info. 
Disp.*

Impostazione On/Off 
dell’emissione in uscita 
delle informazioni

Gamut/
Gamma*

Stato applicazione Monitor 
LUT/valore impostato 
gamut di colori

SDI2 Signal* Dimensioni immagine di 
uscita

Info. 
Disp.*

Impostazione On/Off 
dell’emissione in uscita 
delle informazioni

Gamut/
Gamma*

Stato applicazione Monitor 
LUT/valore impostato 
gamut di colori
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Voce visualizzata Descrizione

HDMI Signal* Dimensioni immagine di 
uscita

Info. 
Disp.*

Impostazione On/Off 
dell’emissione in uscita 
delle informazioni

Gamut/
Gamma*

Stato applicazione Monitor 
LUT/valore impostato 
gamut di colori

LCD/
Stream

Gamut/
Gamma*

Stato applicazione Monitor 
LUT/valore impostato 
gamut di colori

Base Look/LUT* Impostazione Base Look/
LUT

Gamma Display 
Assist*

Impostazione On/Off della 
funzione di assistenza alla 
visualizzazione gamma

[Informazione]
In modalità Custom, viene visualizzato Color Gamut 
invece di Gamut/Gamma.

Schermata di stato Assignable Button

Visualizza le funzioni assegnate ai pulsanti 
programmabili.

Voce visualizzata Descrizione

1 Funzione assegnata al 
pulsante ASSIGN 1

2 Funzione assegnata al 
pulsante ASSIGN 2

3 Funzione assegnata al 
pulsante ASSIGN 3

4 Funzione assegnata al 
pulsante ASSIGN 4

5 Funzione assegnata al 
pulsante ASSIGN 5

6 Funzione assegnata al 
pulsante ASSIGN 6

7 Funzione assegnata al 
pulsante ASSIGN 7

8 Funzione assegnata al 
pulsante ASSIGN 8

9 Funzione assegnata al 
pulsante ASSIGN 9

10 Funzione assegnata al 
pulsante ASSIGN 10

11 Funzione assegnata al 
pulsante ASSIGN 11

Focus Hold 
Button

Funzione assegnata al 
pulsante Focus Hold 
dell’obiettivo

Multi Function 
Dial

Funzione assegnata alla 
manopola multifunzione

Grip Dial Funzione assegnata alla 
manopola programmabile 
dell’impugnatura 1)

1)	 Impugnatura di telecomando (opzione)

Schermata Information

Visualizza informazioni sulla temperatura del 
sensore di immagine e sull’alimentazione.

Voce visualizzata Descrizione

Detected Battery Tipo di batteria

Battery Voltage / 
Charge Count

Tensione della batteria (V) / 
Numero di volte che la 
batteria è stata ricaricata

Power Source / 
Supplied Voltage

Sorgente di alimentazione / 
Tensione di alimentazione

Video Light 
Battery 
Remaining

Visualizza la capacità 
rimanente della batteria 
della luce video.

Imager 
Temperature

Temperatura del sensore di 
immagine (°C)

Battery 
Remaining / 
Capacity

Capacità rimanente (%) / 
Capacità rimanente (Ah)

Battery 
Manufacture 
Date

Data di fabbricazione della 
batteria

Schermata di stato Media

Visualizza la capacità rimanente e il tempo 
di registrazione rimanente dei supporti di 
registrazione.

Voce visualizzata Descrizione

Informazioni 
scheda A

Visualizza l’icona della 
scheda quando è inserito un 
supporto di registrazione 
nello slot A.

Indicatore 
capacità 
rimanente 
scheda A

Visualizza la capacità 
rimanente del supporto di 
registrazione inserito nello 
slot A come percentuale su 
una barra.

Voce visualizzata Descrizione

Tempo di 
registrazione 
rimanente 
scheda A

Visualizza il tempo stimato 
di registrazione rimanente 
sul supporto di registrazione 
inserito nello slot A in minuti 
nelle condizioni di 
registrazione attuali.

Format Media(A)* Seleziona il metodo di 
formattazione (Full Format) 
e formatta il supporto di 
memoria A.

Informazioni 
scheda B

Visualizza l’icona della 
scheda quando è inserito un 
supporto di registrazione 
nello slot B.

Indicatore 
capacità 
rimanente 
scheda B

Visualizza la capacità 
rimanente del supporto di 
registrazione inserito nello 
slot B come percentuale su 
una barra.

Tempo di 
registrazione 
rimanente 
scheda B

Visualizza il tempo stimato 
di registrazione rimanente 
sul supporto di registrazione 
inserito nello slot B in minuti 
nelle condizioni di 
registrazione attuali.

Format Media(B)* Seleziona il metodo di 
formattazione (Full Format) 
e formatta il supporto di 
memoria B.

Informazioni 
relative alla 
scheda Utility SD

Visualizza l’icona del 
supporto di memoria 
quando è inserita una 
scheda nello slot per schede 
Utility SD.

Protezione della 
scheda Utility SD

Visualizza l’icona del 
lucchetto quando la scheda 
inserita nello slot per schede 
Utility SD è protetta.
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Voce visualizzata Descrizione

Indicatore 
capacità 
rimanente 
scheda Utility SD

Visualizza la capacità 
rimanente della scheda 
inserita nello slot per schede 
Utility SD, espressa come 
percentuale su una barra 
grafica.

Capacità 
rimanente 
scheda Utility SD

Visualizza in minuti il tempo 
stimato di registrazione 
proxy rimanente della 
scheda inserita nello slot per 
schede Utility SD oppure la 
sua capacità rimanente in 
GB.

Format Utility SD* Seleziona il metodo di 
formattazione (Full Format o 
Quick Format) e formatta la 
scheda SD.

Schermata di stato Network

Visualizza lo stato della connessione di rete.

Voce visualizzata Descrizione

Wireless LAN Impostazioni e stato della 
connessione wireless

Wired LAN Impostazioni e stato della 
connessione della LAN 
cablata

USB Tethering Impostazioni di rete e stato 
della connessione tramite 
tethering USB

Schermata di stato File Transfer

Visualizza informazioni sul trasferimento di 
file.

Voce visualizzata Descrizione

Auto Upload Stato di attivazione o 
disattivazione della funzione 
di upload automatico del 
clip originale

Voce visualizzata Descrizione

Auto Upload 
(Proxy)

Stato di attivazione o 
disattivazione della funzione 
di upload automatico del 
clip proxy

Total Transfer 
Progress

Avanzamento complessivo 
del trasferimento dei 
processi

Default Upload 
Server

Nome del server di 
destinazione per l’upload 
automatico dei clip

Job Status 
(Remain / Total)

Numero dei processi 
rimanenti e numero totale 
dei processi

Current File 
Transfer Progress

Avanzamento del 
trasferimento del file attuale

Current 
Transferring File 
Name

Nome del file in corso di 
trasferimento

Server Address Indirizzo del server di 
destinazione del 
trasferimento dei file

Destination 
Directory

Directory di destinazione sul 
server di destinazione del 
trasferimento dei file

Utilizzo delle schermate di impostazione di tipo touchscreen

Elementi dello schermo

Voce

Simbolo indicante 
l’impostazione 
attuale

Pulsante Set 
(applica)

Cursore di selezione 
dell’impostazione 
(riquadro arancione)

Nome della voce

Opzioni selezionabili

Modalità di utilizzo

1	 Toccare una voce di impostazione.

Tocco

Vengono visualizzate le opzioni di 
selezione del valore.

2	 Trascinare o dare un colpetto con il dito 
per scorrere e selezionare il valore 
desiderato.

Scorrimento rapido

3	 Toccare il pulsante Set o il cursore di 
selezione del valore.
Il valore viene applicato e il display ritorna 
alla schermata precedente.

[Informazioni]
•• Premere il pulsante BACK per tornare al valore 

precedente.
•• È possibile utilizzare anche la manopola 

multifunzione o il selettore multiplo.
•• Se si desidera, le operazioni touchscreen possono 

essere disabilitate (pagina 64).
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Configurazione e struttura del menu completo
Premere e mantenere premuto il pulsante 
MENU per visualizzare sul monitor LCD il 
menu completo mediante il quale specificare 
le opzioni necessarie per la ripresa e la 
riproduzione. Il menu completo comprende i 
menu indicati di seguito:

Configurazione dei menu

Menu User
Contiene voci di menu configurate 
dall’utente tramite la voce Edit User Menu.

Menu Edit User
Contiene comandi per la modifica del 
menu User.

Menu Shooting
Contiene opzioni relative alla ripresa.

Menu Project
Contiene le impostazioni di base del 
progetto.

Menu Paint/Look
Contiene opzioni relative alla qualità 
dell’immagine.

Menu TC/Media
Contiene impostazioni relative ai codici 
temporali e ai supporti di registrazione.

Menu Monitoring
Contiene impostazioni relative all’uscita 
video e alla visualizzazione sul mirino.

Menu Audio
Contiene opzioni relative all’audio.

Menu Clip Operations
Configura impostazioni relative alle 
operazioni sui clip.

Menu Technical
Contiene le impostazioni relative agli 
elementi tecnici.

Menu Network
Contiene opzioni relative alle reti.

Menu Maintenance
Contiene le impostazioni del dispositivo 
stesso, ad esempio l’orologio e la lingua.

Struttura del menu completo

User 
(impostazioni di 
fabbrica)

Focus

Auto Exposure

Noise Suppression

Image Stabilization

Rec Format

Assignable Button

Multi Function Dial

All File

User File

Base Look

Clip Name Format

Format Media

De-Squeeze

Marker

LCD Monitor Setting

Peaking

Zebra

Menu Settings

Lens

APR

Edit User Menu Add Item

Customize Reset

Shooting ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

Image Stabilization

Project Base Setting

Rec Format

Cine EI Setting

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Assignable Dial

Multi Function Dial

User File

All File

Paint/Look Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

TC/Media Timecode

TC Display

User Bits

HDMI TC Out

Clip Name Format

Update Media

Format Media

Monitoring Output Format

De-Squeeze

Output Display

Display On/Off

Marker

LCD Monitor Setting

Gamma Display Assist

Peaking

Zebra

Focus Magnifier

Audio Audio Input

Audio Output

Operazioni con i 
clip

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View
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Technical Color Bars

ND Dial

Rec/Tally

LOCK Switch Settings

Touch Operation

Rec Review

Zoom

Handle Zoom

Menu Settings

Menu Page On/Off

RCP

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DC IN Alarm

Network Network Setup

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

USB Tethering

File Transfer

Network Reset

Maintenance Language

Clock Set

All Reset

Hours Meter

Version
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Utilizzo del menu completo
Premere e mantenere premuto il pulsante 
MENU per visualizzare sul monitor LCD il 
menu completo mediante il quale specificare 
impostazioni dettagliate (il menu può essere 
visualizzato anche su un monitor HDMI 
esterno in modalità di monitoraggio video).

Comandi del menu

Pulsante MENU (pagina 4)
Premere e mantenere premuto per 
visualizzare il menu completo. Premere di 
nuovo mentre è visualizzato il menu 
completo per chiudere il menu.

Selettore multiplo (pulsante direzionale 
D-Pad a 8 posizioni e pulsante di conferma) 
(pagina 5)

Utilizzare i pulsanti direzionali del D-Pad a 
8 posizioni per spostare il cursore verso 
l’alto, il basso, sinistra o destra e 
selezionare voci o impostazioni del menu.
Premere il pulsante di conferma del 
selettore multiplo per applicare la voce 
selezionata.

Manopola multifunzione (pagina 4)
Ruotare la manopola multifunzione per 
spostare il cursore verso l’alto o il basso e 
selezionare voci o impostazioni del menu.
Premere la manopola multifunzione per 
applicare la voce selezionata.

Pulsante BACK (pagina 4)
Premere per tornare al menu precedente. 
Le modifiche non confermate vengono 
annullate.

[Note]
•• Il menu completo non può essere utilizzato quando il 

camcorder si trova in modalità di ingrandimento della 
messa a fuoco (pagina 96).

•• A seconda dello stato operativo del camcorder 
quando viene visualizzato il menu, alcune voci 
potrebbero non essere selezionabili.

•• Quando il monitor LCD si trova in modalità di 
visualizzazione delle informazioni, il comando tramite 
il selettore multiplo del lato comandi operatore 
dell’unità oppure tramite il telecomando non è 
disponibile.

Impostazione delle voci dei menu

Premere i pulsanti direzionali del D-pad a 
8 posizioni oppure ruotare la manopola 
multifunzione per spostare il cursore sulla 
voce di menu da impostare, quindi premere il 
pulsante di conferma del selettore multiplo o 
la manopola multifunzione per selezionare la 
voce.
•• Nell’area di selezione delle voci del menu 

vengono visualizzate un massimo di otto 
righe. Se non possono essere visualizzate 
contemporaneamente tutte le opzioni 
disponibili per una determinata voce, 
scorrere le opzioni spostando il cursore 
verso l’alto o verso il basso.

•• Se la gamma di opzioni disponibili per una 
voce secondaria è molto ampia (ad esempio 
da –99 a + 99), l’area di selezione non viene 
visualizzata. Viene invece evidenziato il 
valore corrente per indicare che tale valore 
può essere modificato.

•• Per eseguire una funzione, selezionare 
Execute.

•• Se si seleziona una voce che richiede 
conferma prima dell’esecuzione, il menu 
verrà momentaneamente nascosto e verrà 
visualizzato un messaggio di conferma. 
Controllare il messaggio e quindi scegliere 
se eseguire o annullare la funzione.

Immissione di una stringa di 
caratteri

Quando si seleziona una voce che richiede 
l’immissione di caratteri, viene visualizzata la 
schermata di inserimento caratteri.

1

2 3

1	 Premere i pulsanti direzionali del D-pad a 
8 posizioni oppure ruotare la manopola 
multifunzione per selezionare un tipo di 
caratteri, quindi applicare l’impostazione.
ABC: caratteri alfabetici maiuscoli
abc: caratteri alfabetici minuscoli
123: caratteri numerici
!#$: caratteri speciali

2	 Selezionare il carattere desiderato nel tipo 
di caratteri specificato, quindi applicare 
l’impostazione.
Il cursore si sposta sul campo successivo.
Space: inserisce uno spazio in 

corrispondenza della posizione del 
cursore.

/: sposta la posizione del cursore.
BS: elimina il carattere alla sinistra del 

cursore (backspace).

3	 Al termine, selezionare Done ed applicare 
l’impostazione.
La stringa di caratteri viene confermata e 
la schermata di inserimento dei caratteri si 
chiude.

Blocco e sblocco del menu

È possibile bloccare il menu completo in modo 
che venga visualizzato solo il menu User.
In questo stato, non è possibile modificare le 
impostazioni mediante la schermata Home o 
le schermate di stato.

Blocco del menu

1	 Premere e mantenere premuta la 
manopola multifunzione, quindi premere 
e mantenere premuto il pulsante MENU.

2	 Selezionare Menu Settings >User Menu 
with Lock nel menu Technical.

	 [Nota]
Quando viene mantenuto premuto solo il pulsante 
MENU per visualizzare il normale menu completo, 
l’indicazione User Menu Only è visualizzata sotto 
Menu Settings nel menu Technical. Premere e 
mantenere premuta la manopola multifunzione e 
quindi premere e mantenere premuto il pulsante 
MENU per visualizzare User Menu with Lock.

3	 Impostare su On e premere il pulsante di 
conferma o la manopola multifunzione.
Lo schermo monitor LCD visualizza la 
schermata di immissione del numero di 
codice di accesso.

4	 Immettere un numero arbitrario.
Immettere un numero di 4 cifre compreso 
fra 0000 e 9999. Il valore predefinito è 
0000.
Immettere un numero e premere il 
pulsante di conferma o la manopola 
multifunzione per spostare il cursore sulla 
cifra successiva.
Dopo aver immesso tutte le cifre, spostare 
il cursore su SET.
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5	 Premere il pulsante di conferma o la 
manopola multifunzione.
Il valore immesso viene applicato.
Viene visualizzato un messaggio di 
conferma e la schermata passa alla 
visualizzazione del menu User.

Sblocco del menu

1	 Premere e mantenere premuta la 
manopola multifunzione, quindi premere 
e mantenere premuto il pulsante MENU.

2	 Selezionare Menu Settings >User Menu 
with Lock nel menu User.

	 [Nota]
Quando viene mantenuto premuto solo il pulsante 
MENU per visualizzare il normale menu completo, 
l’indicazione User Menu Only è visualizzata sotto 
Menu Settings nel menu Technical. Premere e 
mantenere premuta la manopola multifunzione e 
quindi premere e mantenere premuto il pulsante 
MENU per visualizzare User Menu with Lock.

3	 Impostare su Off e premere il pulsante di 
conferma o la manopola multifunzione.
Lo schermo monitor LCD visualizza la 
schermata di immissione del numero di 
codice di accesso.

4	 Immettere il numero PIN usato per 
bloccare il menu.
Immettere un numero e premere il 
pulsante di conferma o la manopola 
multifunzione per spostare il cursore sulla 
cifra successiva.
Dopo aver immesso tutte le cifre, spostare 
il cursore su Set.

5	 Premere il pulsante di conferma o la 
manopola multifunzione.
Il valore immesso viene applicato.
Se il numero PIN immesso corrisponde al 
numero PIN utilizzato per bloccare il 
menu, il menu viene sbloccato e viene 
visualizzato.

[Note]
•• Se il numero PIN immesso non corrisponde al numero 

PIN utilizzato per bloccare il menu, il menu non verrà 
sbloccato.

•• Si consiglia di annotare il numero PIN per evitare di 
dimenticarlo. Se si dimentica il numero PIN, contattare 
il rappresentante dell’assistenza tecnica Sony.

•• Se il menu viene bloccato senza aver registrato le voci 
del menu completo elencate nelle seguenti tabelle 
del menu User, tali funzioni non potranno essere 
assegnate a pulsanti programmabili.

•• Se tali funzioni erano già assegnate a pulsanti 
programmabili, la loro assegnazione viene disabilitata 
automaticamente al momento del blocco del menu.

Voci del menu 
completo

Selezione per 
pulsanti 
programmabili

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI> 
Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

Shooting >Auto 
Exposure >Auto ND 
Filter

Auto ND Filter

Shooting >Auto 
Exposure >Auto Iris

Auto Iris

Shooting >Iris >Bokeh 
Control

Bokeh Control

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Voci del menu 
completo

Selezione per 
pulsanti 
programmabili

Shooting >Auto 
Exposure >Mode

Spotlight

Shooting >White >Auto 
White Balance

Auto White Balance

Shooting >White >ATW ATW

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus> 
Subject Recognition AF

Subject Recognition 
AF

Monitoring >Focus 
Magnifier >Focus Mag 
Button Target

LCD Focus Magnifier

Monitoring >Focus 
Magnifier >Focus Mag 
Button Target

Output Focus 
Magnifier

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >LUT On/Off 
>SDI/HDMI, Shooting 
>LUT On/Off >SDI

LUT On/Off

Shooting >LUT On/Off 
>LCD/Proxy/Stream, 
Shooting >LUT On/Off 
>LCD/HDMI/Px/
Stream

LUT On/Off

Monitoring >Display 
On/Off >Image 
Stabilization

Image Stabilization

Project >Rec Format 
>Imager Scan Mode

Crop Select

Project >Picture Cache 
Rec >Setting

Picture Cache Rec

Technical >Rec Review 
>Setting

Rec Review

Clip Operations >Set 
Clip Flag >Add OK

Clip Flag OK

Clip Operations >Set 
Clip Flag >Add NG

Clip Flag NG

Voci del menu 
completo

Selezione per 
pulsanti 
programmabili

Clip Operations >Set 
Clip Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

TC/Media >TC Display 
>Display Select

DURATION/TC/U-
BIT

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >LCD 
Monitor Setting >Color 
Mode

LCD Monitor Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Audio >Audio Output 
>Volume

Volume

Technical >Touch 
Operation >Setting

Touch Operation

Technical >Handle 
Zoom >Setting

Handle Zoom

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)
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Menu User
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu (impostazioni 
predefinite di fabbrica).

User

Voce di menu Descrizione

Focus Voce di menu Shooting >Focus

Auto Exposure Voce di menu Shooting >Auto Exposure

Noise Suppression Voce di menu Shooting >Noise Suppression

Image Stabilization Voce di menu Shooting >Image Stabilization

Rec Format Voce di menu Project >Rec Format

Assignable Button Voce di menu Project >Assignable Button

Multi Function Dial Voce di menu Project >Multi Function Dial

All File Voce di menu Project >All File

User File Voce di menu Project >User File

Base Look Voce di menu Paint/Look >Base Look

Clip Name Format Voce di menu TC/Media >Clip Name Format

Format Media Voce di menu TC/Media >Format Media

De-Squeeze Voce di menu Monitoring >De-Squeeze

Marker Voce di menu Monitoring >Marker

LCD Monitor Setting Voce di menu Monitoring >LCD Monitor Setting

Peaking Voce di menu Monitoring >Peaking

Zebra Voce di menu Monitoring >Zebra

Menu Settings Voce di menu Technical >Menu Settings

Lens Voce di menu Technical >Lens

APR Voce di menu Technical >APR

[Nota]
Il menu Edit User consente di aggiungere o rimuovere voci del menu User. Possono essere configurate fino a 20 voci.
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Menu Edit User
Selezionando Edit User Menu nel menu User, viene visualizzato il menu Edit User al livello più 
alto.

Edit User

Voce di menu Impostazione della voce secondaria Descrizione

Add Item
Aggiunge una voce al 
menu User

Aggiunge una voce al menu User.

Customize Reset
Ripristina le voci del 
menu User

Ripristina l’impostazione predefinita 
delle voci del menu User.

Voce di menu 
selezionata durante la 
modifica

Delete Rimuove dal menu User la voce di 
menu registrata.

Move Cambia l’ordine delle voci registrate 
del menu User.

Edit Sub Item Modifica (aggiunge o elimina) le voci 
secondarie registrate nel menu User.
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Menu Shooting
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Shooting >ISO/Gain/EI
Consente di specificare le impostazioni relative al guadagno.

Voce di menu Impostazione della voce secondaria Descrizione

Mode ISO / dB Seleziona la modalità di impostazione del 
guadagno.

ISO/Gain Imposta il guadagno.
Abilitato solo in modalità Custom.

Quando Mode è impostato su ISO

Base Look >Select S-Cinetone / Standard / 
Still / ITU709 / 709tone

Impostazioni diverse da 
quelle indicate a sinistra

Base Sensitivity Low High Low High

ISO/Gain ISO 320 ISO 1250 ISO 800 ISO 3200

ISO 400 ISO 1600 ISO 1000 ISO 4000

ISO 500 ISO 2000 ISO 1250 ISO 5000

ISO 640 ISO 2500 ISO 1600 ISO 6400

ISO 800 ISO 3200 ISO 2000 ISO 8000

ISO 1000 ISO 4000 ISO 2500 ISO 10000

ISO 1250 ISO 5000 ISO 3200 ISO 12800

ISO 1600 ISO 6400 ISO 4000 ISO 16000

ISO 2000 ISO 8000 ISO 5000 ISO 20000

ISO 2500 ISO 10000 ISO 6400 ISO 25600

Quando Mode è impostato su dB 
Da –3dB a 0dB a 18dB (in incrementi di 1dB)

Shooting >ISO/Gain/EI
Consente di specificare le impostazioni relative al guadagno.

Voce di menu Impostazione della voce secondaria Descrizione

Exposure 
Index

Quando Base ISO è impostato su ISO 800
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Quando Base ISO è impostato su ISO 3200
800EI / 4.0E
1000EI / 4.3E
1250EI / 4.7E
1600EI / 5.0E
2000EI / 5.3E
2500EI / 5.7E
3200EI / 6.0E
4000EI / 6.3E
5000EI / 6.7E
6400EI / 7.0E
8000EI / 7.3E
10000EI / 7.7E
12800EI / 8.0E

Imposta il valore dell’indice di 
esposizione.
Disponibile solo in modalità Cine EI.

Shockless 
Gain

On / Off Attiva o disattiva la funzione di guadagno 
fluido.

Base 
Sensitivity

High / Low Imposta la sensibilità di base per la 
modalità Custom.

Base ISO ISO 3200 / ISO 800 Imposta la sensibilità ISO di base per la 
modalità Cine EI.
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Shooting >ND Filter
Imposta la modalità di visualizzazione utilizzata per esprimere il livello di trasmittanza della luce 
del filtro ND.

Voce di menu Impostazione della voce secondaria Descrizione

Display Mode Optical Density / Transmittance Imposta la modalità di visualizzazione 
utilizzata per esprimere il livello di 
trasmittanza della luce del filtro ND. La 
visualizzazione e la regolazione vengono 
eseguiti utilizzando la modalità di 
visualizzazione selezionata.
Optical Density: 

Visualizza e regola la quantità di luce 
trasmessa attraverso il filtro ND in 
termini di densità ottica (notazione 
logaritmica).

Transmittance: 
Visualizza e regola la quantità di luce 
trasmessa attraverso il filtro ND in 
termini di trasmittanza (indicazione 
frazionale).

Shooting >Shutter
Consente di specificare le impostazioni relative al funzionamento dell’otturatore elettronico.

Voce di menu Impostazione della voce secondaria Descrizione

Mode Speed / Angle Seleziona la modalità dell’otturatore 
elettronico.
Seleziona la modalità di impostazione 
della velocità dell’otturatore in secondi 
(Speed) o in gradi (Angle).

Shutter 
Speed  
On/Off

On / Off Specifica se il tempo di esposizione, 
quando è selezionata la modalità Speed, 
deve seguire il valore di Shutter Speed o 
deve essere impostato sulla massima 
esposizione.

Shooting >Shutter
Consente di specificare le impostazioni relative al funzionamento dell’otturatore elettronico.

Voce di menu Impostazione della voce secondaria Descrizione

Shutter 
Speed

Da 64F a 1/8000
Le impostazioni disponibili variano a 
seconda della frequenza di sistema del 
formato di registrazione selezionato.
59.94P: 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1.2F(1/50) / 1/60 / 1/100 / 
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Imposta la velocità dell’otturatore 
quando è selezionata la modalità Speed.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 360.0° / 300.0° / 270.0° / 240.0° / 
216.0° / 210.0° / 180.0° / 172.8° / 150.0° / 
144.0° / 120.0° / 90.0° / 86.4° / 72.0° / 
45.0° / 30.0° / 22.5° / 11.25° / 5.6°

Imposta l’angolo dell’otturatore quando 
è selezionata la modalità Angle.

ECS On/Off On / Off Attiva o disattiva la funzione ECS 
(Extended Clear Scan).
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Shooting >Shutter
Consente di specificare le impostazioni relative al funzionamento dell’otturatore elettronico.

Voce di menu Impostazione della voce secondaria Descrizione

ECS 
Frequency

Da 23.99 a 8000
Le impostazioni disponibili variano a 
seconda della frequenza di sistema del 
formato di registrazione selezionato.
Di seguito si indicano i valori predefiniti.
59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Imposta la frequenza ECS quando è 
selezionata la modalità ECS.

Shooting >Iris
Configura le impostazioni della funzione di controllo del bokeh.

Voce di menu Impostazione della voce secondaria Descrizione

Bokeh 
Control

On / Off Attiva o disattiva la funzione di controllo 
del bokeh.

Shooting >Auto Exposure
Consente di specificare le impostazioni della correzione automatica dell’esposizione.

Voce di menu Impostazione della voce secondaria Descrizione

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 / 
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / 
–3.0

Imposta i livelli di luminosità per il valore 
di esposizione rilevato automaticamente.

Mode Backlight / Standard / Spotlight Specifica la modalità operativa della 
regolazione dell’esposizione automatica.
Backlight: 

Modalità controluce (modalità che 
consente di schiarire le ombre dei 
soggetti ripresi in controluce)

Standard: 
Modalità standard

Spotlight: 
Modalità riflettore (limita il clipping 
dei bianchi quando il soggetto è 
illuminato da riflettori)

Speed Da –99 a +99 (±0) Imposta la velocità di regolazione della 
regolazione dell’esposizione automatica.

Shooting >Auto Exposure
Consente di specificare le impostazioni della correzione automatica dell’esposizione.

Voce di menu Impostazione della voce secondaria Descrizione

Auto ND Filter On / Off Attiva o disattiva la funzione di 
regolazione automatica del livello di 
trasmittanza del filtro ND.

AGC On / Off Attiva o disattiva la funzione AGC 
(controllo del guadagno automatico).

AGC Limit Imposta il guadagno massimo della funzione AGC.

Quando Mode è impostato su ISO

Base Look >Select S-Cinetone / Standard / 
Still / ITU709 / 709tone

Impostazioni diverse da 
quelle indicate a sinistra

Base Sensitivity Low High Low High

AGC Limit ISO 400 ISO 1600 ISO 1000 ISO 4000

ISO 500 ISO 2000 ISO 1250 ISO 5000

ISO 640 ISO 2500 ISO 1600 ISO 6400

ISO 800 ISO 3200 ISO 2000 ISO 8000

ISO 1000 ISO 4000 ISO 2500 ISO 10000

ISO 1250 ISO 5000 ISO 3200 ISO 12800

ISO 1600 ISO 6400 ISO 4000 ISO 16000

ISO 2000 ISO 8000 ISO 5000 ISO 20000

ISO 2500 ISO 10000 ISO 6400 ISO 25600

Quando Mode è impostato su dB 
3dB, 6dB, 9dB, 12dB, 15dB, 18dB

AGC Point F2.8 / F4 / F5.6 Imposta il valore di apertura (F-stop) del 
diaframma a cui ha inizio il 
funzionamento della funzione AGC 
quando la funzione AGC è On.

Auto Shutter On / Off Attiva o disattiva la funzione di otturatore 
automatico.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Imposta la velocità massima della 
funzione di otturatore automatico.

A.SHT Point F5.6 / F8 / F11 / F16 Imposta il valore di apertura (F-stop) del 
diaframma a cui ha inizio il 
funzionamento della funzione di 
otturatore automatico.

Auto Iris On / Off Attiva o disattiva la funzione di 
diaframma automatico.
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Shooting >Auto Exposure
Consente di specificare le impostazioni della correzione automatica dell’esposizione.

Voce di menu Impostazione della voce secondaria Descrizione

Clip High 
light

On / Off Attiva o disattiva la funzione che ignora 
le zone più luminose per dare una 
risposta più piatta alle luminanze elevate.

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Imposta il campo di misurazione della 
luce per la regolazione automatica della 
luce secondo la luminosità del soggetto. 
(Non disponibile quando l’esposizione 
viene regolata manualmente)

Detect 
Window 
Indication

On / Off Attiva o disattiva l’indicazione il campo di 
misurazione della luce.

Custom 
Width

Da 40 a 999 (500) Imposta la larghezza del campo di 
misurazione della luce.

Custom 
Height

Da 70 a 999 (500) Imposta l’altezza del campo di 
misurazione della luce.

Custom H 
Position

Da –479 a +479 (±0) Imposta la posizione orizzontale del 
campo di misurazione della luce.

Custom V 
Position

Da –464 a +464 (±0) Imposta la posizione verticale del campo 
di misurazione della luce.

Shooting >White
Specifica le impostazioni del bilanciamento del bianco.

Voce di menu Impostazione della voce secondaria Descrizione

White Select A / B / C / D / E / F / G / H Seleziona la posizione della memoria del 
bianco.

Auto White 
Balance

Execute / Cancel Esegue il bilanciamento automatico del 
bianco per la posizione di memoria del 
bianco selezionata (eseguire con 
Execute).

ATW On / Off Attiva o disattiva la funzione ATW.

[Nota]
Quando si passa a una posizione di memoria 
del bianco, la funzione ATW viene impostata 
su Off.

Shooting >White
Specifica le impostazioni del bilanciamento del bianco.

Voce di menu Impostazione della voce secondaria Descrizione

Color Temp Da 2000K a 15000K (3200K) Imposta la temperatura di colore di 
bilanciamento del bianco da salvare nella 
posizione di memoria del bianco 
selezionata.

[Nota]
Poiché Color Temp è soggetto a clipping a 
2000K e 15000K mentre è attiva la funzione 
R/B Gain, potrebbe non essere visualizzato il 
valore di Color Temp corretto corrispondente al 
valore di R/B Gain.

Tint Da –99 a +99 (±0) Imposta il valore del tono di colore (Tint) 
del bilanciamento del bianco da salvare 
nella posizione di memoria del bianco 
selezionata.

[Nota]
Poiché Tint è soggetto a clipping a ±99 mentre 
è attiva la funzione R/B Gain, potrebbe non 
essere visualizzato il valore di Tint corretto 
corrispondente al valore di R/B Gain.

R Gain Da –99.0 a +99.0 (±0.0) Imposta il valore del guadagno R del 
bilanciamento del bianco da salvare nella 
posizione di memoria del bianco 
selezionata.

B Gain Da –99.0 a +99.0 (±0.0) Imposta il valore del guadagno B del 
bilanciamento del bianco da salvare nella 
posizione di memoria del bianco 
selezionata.

Preset White 
Select

In modalità di ripresa Custom 
3200K ±00 
4300K ±00 
5600K ±00 
6300K ±00

In modalità di ripresa Cine EI 
3200K ±00 
4300K ±00 
5500K ±00

Imposta la temperatura di colore di 
bilanciamento del bianco da salvare nella 
posizione di memoria del bianco 
selezionata utilizzando un valore 
preimpostato specificato. Il valore del 
tono di colore (Tint) è impostato su ±0.
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Shooting >White Setting
Regola le impostazioni del bilanciamento del bianco.

Voce di menu Impostazione della voce secondaria Descrizione

Shockless 
White

Off / 1 / 2 / 3 Imposta la velocità di risposta del 
bilanciamento del bianco quando si 
cambia la modalità di bilanciamento del 
bianco.
Off: Commutazione istantanea.
Da 1 a 3: Il passaggio avviene più 

lentamente (velocità minore con 
numero più alto).

ATW Speed 1 / 2 / 3 / 4 / 5 Imposta la velocità di risposta in modalità 
ATW.
1: Più alta velocità di risposta

Shooting >Focus
Consente di specificare le impostazioni relative alla messa a fuoco.

Voce di menu Impostazione della voce secondaria Descrizione

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Specifica la velocità dell’azionamento del 
sistema di messa a fuoco quando il 
soggetto cambia durante la messa a 
fuoco automatica.

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Imposta la sensibilità al cambiamento del 
soggetto durante la messa a fuoco 
automatica.

Focus Area Wide / Zone / Flexible Spot Specifica la zona di messa a fuoco per le 
funzioni di messa a fuoco automatica e 
Push Auto Focus (AF) (pagina 97).
Wide: 

Cerca il soggetto su un ampio angolo 
dell’immagine durante la messa a 
fuoco.

Zone: 
Cerca automaticamente una punto di 
messa a fuoco all’interno della zona 
specificata.

Flexible Spot: 
Mette a fuoco una posizione 
specificata dell’immagine.

Shooting >Focus
Consente di specificare le impostazioni relative alla messa a fuoco.

Voce di menu Impostazione della voce secondaria Descrizione

Subject 
Recognition 
AF

Human Only AF / Human Priority AF / Off Imposta la modalità operativa della 
funzione di riconoscimento del soggetto 
AF.
Human Only AF: 

La telecamera rileva i soggetti 
(persone) ed esegue la messa a 
fuoco sugli occhi, il viso e il corpo di 
tali persone. Se non vengono rilevate 
persone, viene interrotta la messa a 
fuoco automatica.

Human Priority AF: 
La telecamera rileva i soggetti 
(persone) ed esegue la messa a 
fuoco sugli occhi, il viso e il corpo di 
tali persone. Se non vengono rilevate 
persone, viene attivata la messa a 
fuoco automatica.

Touch 
Function in 
MF

Tracking AF / Spot Focus Specifica l’azione eseguita toccando il 
touchscreen durante la messa a fuoco 
manuale.

AF Assist On / Off Quando è impostato su On, consente di 
ignorare momentaneamente la funzione 
di messa a fuoco automatica ed eseguire 
la messa a fuoco manualmente.

Shooting >S&Q Motion
Consente di specificare le impostazioni relative alla modalità Slow & Quick Motion (pagina 109).

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la modalità Slow & 
Quick Motion.
Quando è impostato su On, le seguenti 
funzioni sono disabilitate:
•• Diaframma automatico
•• Otturatore automatico

Frame Rate Da 1 a 60 / 66 / 72 / 75 / 88 / 90 / 96 / 
100 / 110 / 120 / 150 / 180 / 200 / 240 fps

Imposta la frequenza fotogrammi per le 
riprese in modalità Slow & Quick Motion.

[Nota]
I valori disponibili variano a seconda di 
frequenza di sistema, codec e formato video 
selezionati.
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Shooting >LUT On/Off
Consente di specificare le impostazioni relative alla LUT.

Voce di menu Impostazione della voce secondaria Descrizione

SDI/HDMI LUT On / LUT Off Seleziona se applicare la LUT monitor al 
video in uscita su SDI e HDMI.

[Nota]
Configurabile quando Rec Format >Codec 
(pagina 46) è impostato sul formato X-OCN 
nel menu Project.

SDI LUT On / LUT Off Seleziona se applicare la LUT monitor al 
video in uscita su SDI.

[Nota]
Configurabile quando Rec Format >Codec 
(pagina 46) non è impostato sul formato 
X-OCN nel menu Project.

LCD/
Proxy/Stream

LUT On / LUT Off Seleziona se applicare la LUT monitor al 
video in uscita LCD, Proxy e Stream.

[Nota]
Configurabile quando Rec Format >Codec 
(pagina 46) è impostato sul formato X-OCN 
nel menu Project.

LCD/
HDMI/Px/
Stream

LUT On / LUT Off Seleziona se applicare la LUT monitor al 
video in uscita LCD, HDMI, Proxy e 
Stream.

[Nota]
Configurabile quando Rec Format >Codec 
(pagina 46) non è impostato sul formato 
X-OCN nel menu Project.

Shooting >Noise Suppression
Consente di specificare le impostazioni relative alla soppressione del rumore.

[Informazione]
Le impostazioni di Setting(Custom) e Level(Custom) sono riflesse nell’impostazione Target Display 
(pagina 73).

Voce di menu Impostazione della voce secondaria Descrizione

Setting 
(Custom)

On / Off Attiva o disattiva la soppressione del 
rumore in modalità Custom.

Level 
(Custom)

Low / Mid / High Imposta il livello di soppressione del 
rumore in modalità Custom.

Setting 
(Cine EI)

On / Off Attiva o disattiva la soppressione del 
rumore in modalità Cine EI.

Level 
(Cine EI)

Low / Mid / High Imposta il livello di soppressione del 
rumore in modalità Cine EI.

Shooting >Flicker Reduce
Consente di specificare le impostazioni relative alla correzione dello sfarfallio.

Voce di menu Impostazione della voce secondaria Descrizione

Mode Auto / On / Off Imposta la modalità di correzione dello 
sfarfallio.

Frequency 50Hz / 60Hz Consente di specificare la frequenza della 
sorgente di alimentazione del dispositivo 
di illuminazione che causa lo sfarfallio.

Shooting >Image Stabilization
Consente di specificare le impostazioni relative alla stabilizzazione dell’immagine (pagina 105).

Voce di menu Impostazione della voce secondaria Descrizione

PL 
Stabilization

High / Low / Off Imposta la funzione di stabilizzazione 
dell’immagine.

[Nota]
Configurabile solo quando è montato un 
adattatore per attacchi PL.

SteadyShot Active / Standard / Off Imposta la funzione di stabilizzazione 
dell’immagine.

[Note]
•• Configurabile solo quando non è montato 

un adattatore per attacchi PL.
•• Se è montato un obiettivo dotato di selettore 

di comando della funzione di stabilizzazione 
dell’immagine e tale selettore si trova sulla 
posizione OFF, l’impostazione dell’obiettivo 
ha la precedenza e questa impostazione non 
può essere modificata sull’unità.

Stabilization 
Adjustment

Auto / Manual Imposta la funzione di stabilizzazione 
dell’immagine appropriata per l’obiettivo 
montato.
Auto: 

La stabilizzazione dell’immagine 
viene eseguita automaticamente in 
base alle informazioni fornite 
dall’obiettivo.

Manual: 
La stabilizzazione dell’immagine 
viene realizzata in base alla 
lunghezza focale impostata in Focal 
Length (da 8 mm a 1000 mm).
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Shooting >Image Stabilization
Consente di specificare le impostazioni relative alla stabilizzazione dell’immagine (pagina 105).

Voce di menu Impostazione della voce secondaria Descrizione

Focal Length 8mm / 9mm / 10mm / 11mm / 12mm / 
13mm / 14mm / 15mm / 16mm / 17mm / 
18mm / 19mm / 20mm / 21mm / 24mm / 
25mm / 28mm / 30mm / 32mm / 35mm / 
40mm / 45mm / 50mm / 55mm / 60mm / 
70mm / 75mm / 80mm / 85mm / 90mm / 
100mm / 105mm / 120mm / 135mm / 
150mm / 180mm / 200mm / 210mm / 
250mm / 300mm / 350mm / 400mm / 
450mm / 500mm / 600mm / 800mm / 
1000mm

Imposta il valore di lunghezza focale 
utilizzato dalla funzione di stabilizzazione 
dell’immagine nella telecamera quando 
la funzione di regolazione della 
stabilizzazione dell’immagine è 
impostata su Manual.

[Note]
•• La stabilizzazione dell’immagine non potrà 

funzionare correttamente nel caso in cui 
non sia possibile ottenere dall’obiettivo 
la lunghezza focale ed altre informazioni 
necessarie. Impostare Stabilization 
Adjustment su Manual e configurare Focal 
Length su un valore adatto all’obiettivo 
montato. Il valore di lunghezza focale 
configurato viene visualizzato sotto all’icona 
della stabilizzazione dell’immagine.

•• Qualora sia stata montata un’ottica di 
conversione sull’obiettivo SEL16F28 
(opzione), impostare Stabilization 
Adjustment su Manual e configurare Focal 
Length.
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Menu Project
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Project >Base Setting
Consente di specificare le impostazioni di base.

Voce di menu Impostazione della voce secondaria Descrizione

Shooting 
Mode

Custom / Cine EI Imposta la modalità di ripresa 
(pagina 88).

Target 
Display

SDR(BT.709) / HDR(HLG) Imposta il gamut di colori della 
registrazione o uscita in modalità 
Custom.

Project >Rec Format
Consente di specificare le impostazioni relative al formato di registrazione.

Voce di menu Impostazione della voce secondaria Descrizione

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 Seleziona la frequenza di sistema.

Imager Scan 
Mode

FF 8.6K 17:9 / FF 8.6K 16:9 /  
FFc 6K 17:9 / FFc 6K 16:9 /  
FFc 3.8K 16:9 / S35 5.8K 17:9 /  
S35 5.8K 16:9 / S35 4.3K 4:3 /  
S35c 4K 17:9 / S35 1.9K 16:9

Seleziona le dimensioni dell’imager.

[Informazioni]
•• Non è possibile selezionare S35 1.9K 16:9 

quando la frequenza di sistema è impostata 
su 24.

•• Quando è selezionato S35 1.9K 16:9, Codec 
viene impostato su XAVC-I o XAVC-L.

•• Quando si desidera registrare in 8K, 
impostare la frequenza di sistema su un 
valore di 29.97 o inferiore.

•• Quando è selezionato S35 4.3K 4:3 oppure 
quando la frequenza di sistema è impostata 
su 24 ed è selezionato FF 8.6K 16:9, FFc 6K 
16:9, FFc 3.8K 16:9 o S35 5.8K 16:9, Codec 
viene impostato su X-OCN.

Codec X-OCN(LT) / XAVC H-I HQ / XAVC H-I SQ / 
XAVC H-L / XAVC-I / XAVC-L

Imposta la modalità di registrazione e 
riproduzione dei clip.

[Informazioni]
•• Se si desidera registrare in formato 8K, 

selezionare X-OCN oppure XAVC H.
•• X-OCN può essere selezionato solo in 

modalità Cine EI.

Project >Rec Format
Consente di specificare le impostazioni relative al formato di registrazione.

Voce di menu Impostazione della voce secondaria Descrizione

Video Format Le opzioni di impostazione disponibili 
variano a seconda delle impostazioni di 
Frequency e Codec.

Imposta il bit rate e le dimensioni 
dell’immagine.

[Informazione]
Le dimensioni di immagine di X-OCN sono 
determinate dalla modalità di Imager Scan. 
XAVC H supporta solo 8K.

Frequency Codec Opzioni 
selezionabili

59.94 X-OCN(LT) –

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P

50 X-OCN(LT) –

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P
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Project >Rec Format
Consente di specificare le impostazioni relative al formato di registrazione.

Voce di menu Impostazione della voce secondaria Descrizione

Formato 
video

29.97 X-OCN(LT) –

XAVC H-I HQ 8192×4320P

7680×4320P

XAVC H-I SQ 8192×4320P

7680×4320P

XAVC H-L 7680×4320P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P

25 X-OCN(LT) –

XAVC H-I HQ 8192×4320P

7680×4320P

XAVC H-I SQ 8192×4320P

7680×4320P

XAVC H-L 7680×4320P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P

23.98 X-OCN(LT) –

XAVC H-I HQ 8192×4320P

7680×4320P

XAVC H-I SQ 8192×4320P

7680×4320P

XAVC H-L 7680×4320P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P

Project >Rec Format
Consente di specificare le impostazioni relative al formato di registrazione.

Voce di menu Impostazione della voce secondaria Descrizione

Video Format 24 X-OCN(LT) –

XAVC H-I HQ 8192×4320P

XAVC H-I SQ 8192×4320P

XAVC-I 4096×2160P

Project >Cine EI Setting
Specifica le impostazioni della modalità Cine EI.

Voce di menu Impostazione della voce secondaria Descrizione

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Imposta il gamut di colori della modalità 
Cine EI.

Embed LUT 
File

On / Off Attiva o disattiva la registrazione dei 
metadati del file 3D LUT (file CUBE).

Project >Simul Rec
Configura le impostazioni della modalità di registrazione simultanea (pagina 111).

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di 
registrazione simultanea e specifica il 
supporto di destinazione della 
registrazione.

Project >Proxy Rec
Configura le impostazioni della modalità di registrazione proxy.

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la modalità di 
registrazione proxy.

Audio 
Channel

CH1/CH2 / CH3/CH4 Seleziona il canale audio da registrare sui 
dati proxy.
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Project >Interval Rec
Configura le impostazioni della modalità di registrazione a intervalli (pagina 109).

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la modalità di 
registrazione a intervalli. (Attivando 
questa modalità, si disattivano tutte le 
altre modalità speciali).

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

Imposta l’intervallo fra registrazioni nella 
modalità di registrazione Interval Rec 
(Interval Rec impostata su On).

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
I valori disponibili variano a seconda della 
frequenza fotogrammi del formato video 
selezionato.
59.94P/50P: 

2frames / 6frames / 12frames
29.97P/25P/24P/23.98P: 

1frame / 3frames / 6frames / 9frames

Imposta il numero di fotogrammi per 
ciascuna ripresa nella modalità di 
registrazione Interval Rec (Interval Rec 
impostata su On).

Pre-Lighting Off / 2 s / 5 s / 10 s Specifica con che anticipo in secondi si 
deve accendere la luce video prima 
dell’avvio della registrazione in modalità 
Interval Rec.

[Informazione]
Disponibile solo se viene utilizzata la luce video 
HVL-LBPC (opzionale).

Project >Picture Cache Rec
Configura le impostazioni della modalità di registrazione cache immagine (pagina 110).

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la modalità di 
registrazione cache immagine.

Cache Size Short / Medium / Long / Max Specifica il tempo di accumulo delle 
immagini nella memoria cache immagine 
(il tempo di registrazione della cache 
immagine).

Cache Rec 
Time

Indica il tempo di accumulo delle 
immagini nella memoria cache immagine 
(il tempo di registrazione della cache 
immagine).

Project >SDI/HDMI Rec Control
Consente di specificare le impostazioni relative alla registrazione SDI/HDMI.

Voce di menu Impostazione della voce secondaria Descrizione

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Configura l’avvio e l’arresto della 
registrazione su un dispositivo esterno 
tramite i segnali di uscita SDI/HDMI.
Off: 

Comando a distanza disabilitato.
SDI/HDMI Remote I/F:  

Comando di avvio e arresto 
registrazione di un dispositivo 
esterno collegato, quando non è 
inserito nessun supporto di memoria 
nell’unità. Non sincronizzato con 
precisione di fotogramma con i 
supporti di memoria dell’unità.

Parallel Rec: 
Comando di avvio e arresto 
registrazione di un dispositivo 
esterno collegato, quando è presente 
un supporto di memoria sull’unità. 
Sincronizzato con precisione di 
fotogramma con i supporti di 
memoria dell’unità.

[Note]
•• Per il comando tramite il segnale di uscita 

HDMI, impostare HDMI TC Out >Setting 
(pagina 56) nel menu TC/Media del menu 
completo su On.

•• 	Non è possibile selezionare Parallel 
Rec quando il formato di uscita video è 
impostato su Monitor FHD.
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Project >Assignable Button
Assegna le funzioni desiderate ai pulsanti programmabili.

Voce di menu Impostazione della voce secondaria Descrizione

Da <1> a <11>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / Push 
AGC / ND Filter Position / Auto ND Filter / 
Push Auto ND / Iris / Auto Iris / Push Auto 
Iris / Bokeh Control / Auto Shutter / Auto 
Exposure Level / Backlight / Spotlight / 
Auto White Balance / ATW / ATW Hold / 
AF Speed/Sens. / Focus Setting / Subject 
Recognition AF / Push AF/Push MF / Focus 
Hold / LCD Focus Magnifier / Output Focus 
Magnifier / S&Q Motion / LUT On/Off / 
LUT On/Off / High/Low Key / Image 
Stabilization / Crop Select / Rec / Picture 
Cache Rec / Rec Review / Clip Flag OK / 
Clip Flag NG / Clip Flag Keep / Color Bars / 
CALL / DURATION/TC/U-BIT / Display / 
Lens Info / Video Signal Monitor / Marker / 
LCD Monitor Adjust / LCD Monitor Mode / 
Gamma Display Assist / Peaking / Zebra / 
Volume / Clips / Touch Operation / Handle 
Zoom / Auto Upload (Proxy) / Direct 
Menu / User Menu / Menu

Assegna funzioni ai pulsanti 
programmabili.
Base ISO/Sensitivity: 

Commuta la sensibilità di base del 
sensore immagine.

AGC: 
Attiva o disattiva la funzione AGC.

Push AGC: 
Attiva la funzione AGC mentre si 
tiene premuto il pulsante.

ND Filter Position: 
Consente di scegliere il filtro ND.

Auto ND Filter: 
Attiva o disattiva la funzione di filtro 
ND automatico.

Push Auto ND: 
Attiva la funzione di filtro ND 
automatico mentre si tiene premuto 
il pulsante.

Iris: 
Seleziona l’impostazione della 
posizione del diaframma. 
In modalità di monitoraggio video, 
tenere premuto per selezionare 
l’impostazione automatica o manuale.

Auto Iris: 
Attiva o disattiva la funzione di 
diaframma automatico.

Push Auto Iris: 
Abilita la funzione di diaframma 
automatico mentre si tiene premuto 
il pulsante.

Bokeh Control: 
Attiva o disattiva la funzione di 
controllo del bokeh.

Auto Shutter: 
Attiva o disattiva la funzione di 
otturatore automatico.

Auto Exposure Level: 
Apre o chiude il Direct Menu relativo 
al livello di esposizione automatica.

Backlight: 
Alterna fra Backlight e Standard.

Project >Assignable Button
Assegna le funzioni desiderate ai pulsanti programmabili.

Voce di menu Impostazione della voce secondaria Descrizione

Da <1> a <11>, 
Focus Hold 
Button

Spotlight: 
Alterna fra Spotlight e Standard.

Auto White Balance: 
Esegue il bilanciamento automatico 
del bianco.

ATW: 
Attiva o disattiva la funzione ATW.

ATW Hold: 
Sospende la funzione ATW.

AF Speed/Sens.: 
Selezione della velocità di transizione 
AF e della sensibilità al cambiamento 
del soggetto AF.

Focus Setting: 
Configura l’area di messa a fuoco.

Subject Recognition AF: 
Commuta l’impostazione di 
riconoscimento del soggetto AF.

Push AF/Push MF: 
In modalità messa a fuoco MF, attiva 
la modalità AF mentre il pulsante 
viene mantenuto premuto. 
In modalità messa a fuoco AF, attiva 
la modalità MF mentre il pulsante 
viene mantenuto premuto.

Focus Hold: 
In modalità messa a fuoco AF, fissa la 
messa a fuoco mentre il pulsante 
viene mantenuto premuto.

LCD Focus Magnifier:
Output Focus Magnifier: 

Consente di scegliere il rapporto di 
ingrandimento della messa a fuoco 
per il monitor LCD o l’uscita esterna.

[Informazione]
È possibile selezionare LCD Focus 
Magnifier quando Focus Magnifier >Focus 
Mag Button Target (pagina 60) nel 
menu Monitoring del menu completo 
è impostato su LCD Monitor. È possibile 
selezionare Output Focus Magnifier 
quando è impostato su Output.
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Project >Assignable Button
Assegna le funzioni desiderate ai pulsanti programmabili.

Voce di menu Impostazione della voce secondaria Descrizione

Da <1> a <11>, 
Focus Hold 
Button

S&Q Motion: 
Attiva o disattiva la modalità Slow & 
Quick Motion. 
Se mantenuto premuto, imposta la 
frequenza fotogrammi di ripresa.

LUT On/Off: 
Consente di scegliere fra LUT  
On/Off >SDI e SDI/HDMI nel 
menu Shooting.

LUT On/Off: 
Consente di scegliere fra LUT  
On/Off >LCD/HDMI/Px/Stream e 
LCD/Proxy/Stream nel menu 
Shooting.

High/Low Key: 
Consente di selezionare High Key 
(schermata di controllo delle alte luci 
ad alta luminanza), Low Key 
(schermata di controllo delle ombre a 
bassa luminanza) oppure Off 
(schermata normale).

Image Stabilization: 
Consente di selezionare la modalità 
operativa della funzione di 
stabilizzazione dell’immagine.

Crop Select: 
Imposta la modalità di scansione 
dell’imager.

Rec: 
Avvia o arresta la registrazione.

Picture Cache Rec: 
Attiva o disattiva la funzione di 
registrazione cache immagine.

Rec Review: 
Attiva o disattiva la funzione Rec 
Review.

Clip Flag OK: 
Esegue la funzione Add OK. 
Premere due volte per eseguire 
Delete Clip Flag.

Clip Flag NG: 
Esegue la funzione Add NG. 
Premere due volte per eseguire 
Delete Clip Flag.

Clip Flag Keep: 
Esegue la funzione Add Keep. 
Premere due volte per eseguire 
Delete Clip Flag.

Project >Assignable Button
Assegna le funzioni desiderate ai pulsanti programmabili.

Voce di menu Impostazione della voce secondaria Descrizione

Da <1> a <11>, 
Focus Hold 
Button

Color Bars: 
Attiva o disattiva la visualizzazione 
della barra colori.

CALL: 
Mentre il pulsante rimane premuto, 
viene inviato un segnale di chiamata 
al pannello di comando a distanza 
connesso all’unità.

DURATION/TC/U-BIT: 
Alterna fra Time Code, Users Bit e 
Duration.

Display: 
Attiva o disattiva la visualizzazione 
degli indicatori a schermo.

Lens Info: 
Specifica la modalità dell’indicatore 
della profondità di campo.

Video Signal Monitor: 
Attiva una modalità di monitor del 
segnale video (ad esempio il monitor 
della forma d’onda).

Marker: 
Attiva o disattiva la funzione Marker.

LCD Monitor Adjust: 
Visualizza le barre di livello per la 
regolazione della luminosità del 
monitor LCD.

LCD Monitor Mode: 
Consente di scegliere se visualizzare 
l’immagine sul monitor LCD a colori o 
in bianco e nero.

Gamma Display Assist: 
Commuta la funzione di assistenza 
per la visualizzazione gamma.

Peaking: 
Attiva o disattiva la funzione Peaking.

Zebra: 
Attiva o disattiva la funzione Zebra.

Volume: 
Regola il livello di uscita dell’audio di 
monitoraggio su jack cuffie e 
altoparlante incorporato.
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Project >Assignable Button
Assegna le funzioni desiderate ai pulsanti programmabili.

Voce di menu Impostazione della voce secondaria Descrizione

Da <1> a <11>, 
Focus Hold 
Button

Clips: 
Apre o chiude la schermata dei clip.

Touch Operation: 
Attiva o disattiva la funzionalità del 
touchscreen.

Handle Zoom: 
Specifica la modalità di 
funzionamento dello zoom della 
maniglia.

Auto Upload (Proxy): 
Attiva o disattiva il trasferimento 
automatico dei clip proxy.

Direct Menu: 
Visualizza o chiude il Direct Menu.

User Menu: 
Visualizza o chiude il menu User.

Menu: 
Visualizza o chiude il menu completo.

Project >Assignable Dial
Assegna le funzioni desiderate alla manopola programmabile e ne imposta la direzione di 
rotazione.

Voce di menu Impostazione della voce secondaria Descrizione

Grip/Remote 
Dial

Off / ISO/Gain/EI / ND Filter / IRIS /  
Auto Exposure Level / Audio Input Level / 
Multi Function Dial

Assegna funzioni alla manopola 
programmabile dell’impugnatura di 
telecomando (opzione) o del 
telecomando RM-30BP.
ISO/Gain/EI: 

Regola il guadagno o l’EI.
ND Filter: 

Regola il filtro ND.
IRIS: 

Regola il diaframma.
Auto Exposure Level: 

Regola il livello di esposizione 
automatica.

Audio Input Level: 
Regola il livello di registrazione audio.

Multi Function Dial: 
Agisce come manopola 
multifunzione.

Project >Assignable Dial
Assegna le funzioni desiderate alla manopola programmabile e ne imposta la direzione di 
rotazione.

Voce di menu Impostazione della voce secondaria Descrizione

Grip Dial 
Direction

Normal / Opposite Imposta la direzione di rotazione della 
manopola programmabile 
dell’impugnatura di telecomando 
(opzione) o del telecomando RM-30BP.
Normal: Ruota nella direzione normale.
Opposite: Ruota in senso inverso.

Project >Multi Function Dial
Assegna funzioni alla manopola multifunzione.

Voce di menu Impostazione della voce secondaria Descrizione

Default 
Function

Off / ISO/Gain/EI / IRIS / Auto Exposure 
Level / Audio Input Level 

Assegna la funzione di default alla 
manopola multifunzione.
IRIS: 

Regola il diaframma.
ISO/Gain/EI: 

Regola il guadagno o l’EI.
Auto Exposure Level: 

Regola il livello di esposizione 
automatica.

Audio Input Level: 
Regola il livello di registrazione audio.

Project >User File
Specifica impostazioni relative alla gestione dei file utente.

Voce di menu Impostazione della voce secondaria Descrizione

Load from 
UTILITY SD

Execute / Cancel Carica le impostazioni del file utente 
contenuto su una scheda SD.
Execute: Esegue la funzione.

Save to 
UTILITY SD

Execute / Cancel Salva le impostazioni del file utente su 
una scheda SD.
Execute: Esegue la funzione.

File ID Visualizza una schermata che mostra e 
consente di modificare l’ID dei file utente.

Load 
Customize 
Data

On / Off Specifica se caricare le informazioni 
personalizzate del menu User quando 
viene eseguito Load from UTILITY SD.

Load White 
Data

On / Off Specifica se caricare le informazioni 
relative al bilanciamento del bianco 
quando viene eseguito Load from 
UTILITY SD.
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Project >All File
Esegue impostazioni relative ai file ALL (all-settings).

Voce di menu Impostazione della voce secondaria Descrizione

Load from 
UTILITY SD

Execute / Cancel Carica un file ALL da una scheda SD.
Execute: Esegue la funzione.

Load from 
Cloud(Private)

Execute / Cancel Carica dal servizio cloud C3 Portal 
(privato) un file ALL precedentemente 
caricato su di esso.
Execute: Esegue la funzione.

Load from 
Cloud(Share)

Execute / Cancel Carica dal servizio cloud C3 Portal 
(condiviso) un file ALL precedentemente 
caricato su di esso.
Execute: Esegue la funzione.

Save to 
UTILITY SD

Execute / Cancel Salva le impostazioni di un file ALL su 
una scheda SD.
Execute: Esegue la funzione.

Save to 
Cloud(Private)

Execute / Cancel Salva le impostazioni di un file ALL sul 
servizio cloud C3 Portal (privato).
Execute: Esegue la funzione.

Save to 
Cloud(Share)

Execute / Cancel Salva le impostazioni di un file ALL sul 
servizio cloud C3 Portal (condiviso).
Execute: Esegue la funzione.

File ID Assegna un nome al file.

Load Network 
Data

On / Off Specifica se caricare o meno le 
impostazioni del menu Network quando 
vengono eseguiti Load from UTILITY SD, 
Load from Cloud(Private) oppure Load 
from Cloud(Share).
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Menu Paint/Look
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Paint/Look >Scene File
Consente di specificare le impostazioni relative ai file di scena.

Voce di menu Impostazione della voce secondaria Descrizione

Recall Carica un file di scena memorizzato nella 
memoria interna e ne applica le 
impostazioni come impostazioni attive 
per la qualità dell’immagine.

Store Salva in un file di scena nella memoria 
interna lo stato corrente delle 
impostazioni relative alla qualità 
dell’immagine.

Delete Elimina un file di scena memorizzato 
nella memoria interna.

Preset Recall Quando Shooting Mode è impostato su 
Custom e Target Display è impostato su 
SDR(BT.709)

S-Cinetone / Standard / Still / ITU709 / 
709tone

Quando Shooting Mode è impostato su 
Custom e Target Display è impostato su 
HDR(HLG)

HLG Live / HLG Natural

Applica valori preconfigurati delle 
impostazioni di qualità dell’immagine 
(non riscrivibili) alle impostazioni di 
qualità dell’immagine correnti.

Paint/Look >Base Look
Configura impostazioni relative al look di base.

Voce di menu Impostazione della voce secondaria Descrizione

Select Quando Shooting Mode è impostato su 
Custom e Target Display è impostato su 
SDR(BT.709)

S-Cinetone / Standard / Still / ITU709 / 
709tone / da User1 a User16

Quando Shooting Mode è impostata su 
Custom e Target Display è impostato su 
HDR(HLG):

HLG Live / HLG Natural / da User1 a 
User16

Quando Shooting Mode è impostato su 
Cine EI

709(800%) / S-Log3 / s709 / Warm / 
Cool / Vintage / Teal and Orange / 
ACESproxy / ACEScct / ACES 1.0 
Output-Rec.709 / da User1 a User16

Seleziona un look di base.

[Nota]
Quando Cine EI Setting >Color Gamut 
(pagina 47) nel menu Project del menu 
completo è impostato su S-Gamut3/SLog3, 
possono essere selezionati i look di base 
indicati di seguito.
•• ACESproxy
•• ACEScct
•• ACES 1.0 Output-Rec.709

Paint/Look >Base Look
Configura impostazioni relative al look di base.

Voce di menu Impostazione della voce secondaria Descrizione

Delete Elimina il look di base selezionato.

Delete All Elimina tutti i look di base.

Import from 
Utility SD

Execute / Cancel Carica un file di look di base da una 
scheda SD.
Execute: Esegue la funzione.

Import from 
Cloud(Private)

Execute / Cancel Importa dal servizio cloud C3 Portal 
(privato) un file di look di base caricato su 
di esso.
Execute: Esegue la funzione.

Import from 
Cloud(Share)

Execute / Cancel Importa dal servizio cloud C3 Portal 
(condiviso) un file di look di base caricato 
su di esso.
Execute: Esegue la funzione.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Imposta il gamut di ingresso del look di 
base selezionato.

Output BT.709 / HLG Imposta il gamut di colore di uscita del 
look di base selezionato.

AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV / 
5/3EV / 2EV

Imposta il valore di riferimento per 
l’esposizione del look di base 
selezionato.

Paint/Look >Reset Paint Settings
Resetta le impostazioni del menu Paint/Look, con l’esclusione del look di base.

Voce di menu Impostazione della voce secondaria Descrizione

Reset without 
Base Look

Execute / Cancel Resetta le impostazioni del menu Paint/
Look, con l’esclusione del look di base.
Execute: Esegue la funzione.

Paint/Look >Black
Consente di specificare le impostazioni relative al nero.

Voce di menu Impostazione della voce secondaria Descrizione

Master Black Da –99.0 a +99.0 (±0.0) Imposta il livello del nero master.

R Black Da –99.0 a +99.0 (±0.0) Imposta il livello R del nero.

B Black Da –99.0 a +99.0 (±0.0) Imposta il livello B del nero.
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Paint/Look >Knee
Consente di specificare le impostazioni relative alla correzione del knee.

Voce di menu Impostazione della voce secondaria Descrizione

Setting Quando Target Display è impostato su 
SDR(BT.709)

On / Off
Quando Target Display è impostato su 
HDR(HLG)

On / Off

Attiva o disattiva la funzione di 
correzione del knee.

[Informazione]
Abilitato solo se Base Look >Select è impostato 
su Standard, ITU709, 709tone, HLG Live o HLG 
Natural.

Auto Knee Quando Target Display è impostato su 
SDR(BT.709):

On / Off
Quando Target Display è impostato su 
HDR(HLG)

On / Off

Attiva o disattiva la funzione di 
correzione del knee automatica.

[Informazione]
Abilitato solo se l’impostazione della 
correzione del knee è configurata su On e Base 
Look >Select è impostato su Standard, ITU709 
o 709tone. 

Point Da 75% a 109% (90%) Imposta il punto knee.

Slope Da –99 a +99 (±0) Imposta la pendenza del knee.

Paint/Look >Detail
Specifica le impostazioni di regolazione del dettaglio.

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di 
regolazione del dettaglio.

Level Da –7 a +7 (±0) Imposta il livello del dettaglio.

H/V Ratio Da –2 a +2 (±0) Imposta il bilanciamento tra il dettaglio 
verticale (V) e orizzontale (H).

B/W Balance Type1 / Type2 / Type3 / Type4 / Type5 Imposta il bilanciamento tra il dettaglio 
del nero (B) per le zone a bassa 
luminanza e il dettaglio del bianco (W) 
per le zone ad alta luminanza.

Limit Da 0 a 7 Imposta il livello limite del dettaglio.

Crispening Da 0 a 7 Imposta il livello di miglioramento della 
nitidezza.

High Light 
Detail

Da 0 a 4 Imposta il livello di dettaglio per le zone 
ad alta luminanza.

Paint/Look >Matrix
Consente di specificare le impostazioni relative alla correzione della matrice.

Voce di menu Impostazione della voce secondaria Descrizione

User Matrix On / Off Attiva o disattiva la funzione di matrice 
dell’utente.

Paint/Look >Matrix
Consente di specificare le impostazioni relative alla correzione della matrice.

Voce di menu Impostazione della voce secondaria Descrizione

User Matrix 
Level

Da –99 a +99 (±0) Regola la saturazione del colore 
dell’intera immagine.

User Matrix 
Phase

Da –99 a +99 (±0) Regola il tono di colore (la fase) 
dell’intera immagine.

User Matrix 
R-G

Da –99 a +99 (±0) Imposta una matrice R-G definita 
dall’utente.

User Matrix 
R-B

Da –99 a +99 (±0) Imposta una matrice R-B definita 
dall’utente.

User Matrix 
G-R

Da –99 a +99 (±0) Imposta una matrice G-R definita 
dall’utente.

User Matrix 
G-B

Da –99 a +99 (±0) Imposta una matrice G-B definita 
dall’utente.

User Matrix 
B-R

Da –99 a +99 (±0) Imposta una matrice B-R definita 
dall’utente.

User Matrix 
B-G

Da –99 a +99 (±0) Imposta una matrice B-G definita 
dall’utente.
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Paint/Look >Multi Matrix
Consente di specificare le impostazioni relative alla correzione multimatrice.

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la correzione 
multimatrice.

Area 
Indication

On / Off Attiva o disattiva la funzione di 
visualizzazione che identifica l’area di 
target corrispondente all’asse del colore 
target su cui effettuare la regolazione 
mentre è attiva la modalità Multi Matrix.
On: 

Visualizza in bianco e nero le aree 
che non corrispondono all’area di 
colore specificata da Axis.

Off: 
Visualizzazione normale.

[Informazioni]
•• Questa impostazione viene attivata o 

disattivata (On/Off) premendo il pulsante 
DISPLAY (pagina 5) mentre è visualizzata 
la schermata di impostazione della 
correzione multimatrice. Quando Area 
Indication Control è impostato su Menu & 
RCP, è inoltre possibile attivare o disattivare 
(On/Off) dal pannello di comando a 
distanza.

•• Questa impostazione rimane fissata su Off 
durante la registrazione e mentre è attivata 
la funzione di registrazione della cache 
immagine.

•• Questa impostazione viene 
automaticamente impostata su Off quando 
si passa dall’impostazione Multi Matrix a un 
altro menu.

[Note]
•• Mentre è attiva la funzione di visualizzazione 

che identifica l’area di target, il video 
visualizzato viene emesso in uscita anche 
come video di registrazione e video in uscita.

•• Mentre è attiva la funzione di registrazione 
cache immagine, l’impostazione di Area 
Indication non può essere modificata.

Paint/Look >Multi Matrix
Consente di specificare le impostazioni relative alla correzione multimatrice.

Voce di menu Impostazione della voce secondaria Descrizione

Area 
Indication 
Control

Menu Only / Menu & RCP Imposta la destinazione per 
l’impostazione Area Indication >On/Off.
Menu Only: 

Area Indication >On/Off è 
configurabile solo dall’unità.

Menu & RCP: 
Area Indication >On/Off è 
configurabile dall’unità e dal pannello 
di comando a distanza.

Reset Execute / Cancel Ripristina sui valori predefiniti le 
impostazioni di tonalità (hue) e 
saturazione del colore di ciascun asse di 
colore.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Seleziona l’asse di colore su cui eseguire 
la regolazione (asse target).

Hue Da –99 a +99 (±0) Imposta la tonalità (hue) dell’asse di 
colore target su cui eseguire la 
regolazione selezionato in Axis.

Saturation Da –99 a +99 (±0) Imposta la saturazione dell’asse di colore 
target su cui eseguire la regolazione 
selezionato in Axis.
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Menu TC/Media
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

TC/Media >Timecode
Consente di specificare le impostazioni relative al codice temporale.

Voce di menu Impostazione della voce secondaria Descrizione

Mode Preset / Regen / Clock Imposta la modalità di avanzamento del 
codice temporale.
Preset: 

Si avvia da un valore preimpostato.
Regen: 

Prosegue dal codice temporale della 
fine del clip precedente.

Clock: 
Utilizza l’orologio interno come 
codice temporale.

Run Rec Run / Free Run Rec Run: Avanza solo durante la 
registrazione.

Free Run: Avanzamento costante, sia che 
l’unità stia registrando o meno.

Setting Imposta il codice temporale su un valore 
arbitrario.
SET: Imposta il valore.

Reset Execute / Cancel Azzera il codice temporale (00:00:00:00).
Execute: Esegue la funzione.

TC Format DF / NDF Imposta il formato del codice temporale.
DF: Drop frame
NDF: Non drop frame

TC/Media >TC Display
Consente di specificare le impostazioni di visualizzazione dei dati temporali.

Voce di menu Impostazione della voce secondaria Descrizione

Display Select Timecode / Users Bit / Duration Consente di scegliere quali dati temporali 
devono essere visualizzati.

TC/Media >Users Bit
Consente di specificare le impostazioni relative ai bit utente.

Voce di menu Impostazione della voce secondaria Descrizione

Mode Fix / Time Imposta la modalità del bit utente.
Fix: Utilizza per i bit utente un valore fisso 

arbitrario.
Time: Utilizza ora, minuto e secondo 

attuali nei bit utente.

TC/Media >Users Bit
Consente di specificare le impostazioni relative ai bit utente.

Voce di menu Impostazione della voce secondaria Descrizione

Setting Imposta i bit utente su un valore 
arbitrario.

TC/Media >HDMI TC Out
Consente di specificare le impostazioni relative all’uscita del codice temporale quando si utilizza 
HDMI.

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Consente di selezionare se emettere il 
codice temporale ad altri dispositivi per 
altri scopi, tramite HDMI.

TC/Media >Genlock
Consente di specificare le impostazioni relative al genlock.

Voce di menu Impostazione della voce secondaria Descrizione

Reference 
Lock Type

Internal / External(HD) / External(HD) 
Shift / External(SD) / External(SD) Shift

Visualizza lo stato operativo del genlock.
Internal: 

Indica che il video viene emesso in 
sincronia con l’orologio interno, senza 
l’utilizzo di genlock.

External(HD): 
Indica che il genlock è sincronizzato 
con un segnale di riferimento HD.

External(HD) Shift: 
Indica che il genlock è sincronizzato 
con un segnale di riferimento HD con 
la fase sfasata del valore di Sync Shift 
Value.

External(SD): 
Indica che il genlock è sincronizzato 
con un segnale di riferimento SD.

External(SD) Shift: 
Indica che il genlock è sincronizzato 
con un segnale di riferimento SD con 
la fase sfasata del valore di Sync Shift 
Value.
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TC/Media >Genlock
Consente di specificare le impostazioni relative al genlock.

Voce di menu Impostazione della voce secondaria Descrizione

Sync Shift Il numero di passi fino al limite superiore 
dell’intervallo di regolazione varia a 
seconda della frequenza di sistema del 
formato di registrazione selezionato.
59.94:

Da 0 a 72071 (+16683.102μs)
50:

Da 0 a 86399 (+19999.769μs)
29.97:

Da 0 a 144143 (+33366.435μs)
25:

Da 0 a 172799 (+39999.769μs)
24:

Da 0 a 179999 (+41666.435μs)
23.98:

Da 0 a 180179 (+41708.102μs)

Regola la fase del segnale di ingresso del 
genlock in incrementi discreti 
corrispondenti al valore del passo 
(pagina 116).

Sync Shift 
Value

+xxxxx.xxx μs Visualizza il tempo di sfasamento 
configurato utilizzando Sync Shift.

TC/Media >Clip Name Format
Configura impostazioni relative al nome di clip e cartelle.

Voce di menu Impostazione della voce secondaria Descrizione

Camera ID Da A a Z Imposta l’ID della telecamera per la 
generazione del nome dei clip.

Reel Number 001 a 999 Imposta la parte numerica del Reel 
Number utilizzato per la generazione di 
nomi dei clip.

Camera 
Position

C / L / R Imposta la stringa di caratteri della prima 
porzione dello Shot Number utilizzato 
per la generazione del nome dei clip.

XAVC Root 
Folder Name

XDROOT / Cam ID + Reel# Imposta il nome dell’etichetta di volume 
e il nome della cartella principale del 
supporto di registrazione.

TC/Media >Update Media
Aggiorna il file di gestione delle schede di memoria.

Voce di menu Impostazione della voce secondaria Descrizione

Media(A) Execute / Cancel Aggiorna il file di gestione della scheda 
di memoria nello slot A.
Execute: Esegue la funzione.

TC/Media >Update Media
Aggiorna il file di gestione delle schede di memoria.

Voce di menu Impostazione della voce secondaria Descrizione

Media(B) Execute / Cancel Aggiorna il file di gestione della scheda 
di memoria nello slot B.
Execute: Esegue la funzione.

TC/Media >Format Media
Inizializza le schede di memoria.

Voce di menu Impostazione della voce secondaria Descrizione

Media(A) Full Format / Cancel Formatta la scheda di memoria nello slot 
A.

Media(B) Full Format / Cancel Formatta la scheda di memoria nello slot 
B.

Utility SD Full Format / Quick Format / Cancel Formatta la scheda SD.
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Menu Monitoring
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Monitoring >Output Format
Consente di specificare le impostazioni relative al formato di uscita.

Voce di menu Impostazione della voce secondaria Descrizione

SDI1 Per informazioni dettagliate su queste 
impostazioni, vedere “Formati di uscita e 
limitazioni” (pagina 122).

Imposta la risoluzione delle uscite SDI e 
HDMI.SDI2

HDMI

REF HD Sync Visualizza il formato di uscita del segnale 
di sync. (Solo HD Sync)

Monitoring >De-Squeeze
Consente di specificare impostazioni relative al De-Squeeze.

Voce di menu Impostazione della voce secondaria Descrizione

Ratio Off(1.0×) / 1.3× / 1.5× / 1.8× / 2.0× Seleziona il rapporto di decompressione 
(De-Squeeze) dell’immagine visualizzata 
per il sistema di output specificato 
durante le riprese con ottiche 
anamorfiche.

SDI (Monitor 
FHD)

On / Off Specifica se decomprimere la 
visualizzazione dell’immagine di uscita 
SDI quando il formato è impostato su 
Monitor FHD.

HDMI (FHD 
Output)

On / Off Specifica se decomprimere o meno la 
visualizzazione dell’immagine di uscita 
HDMI per le dimensioni di immagine di 
uscita FHD.

LCD Monitor On / Off Specifica se decomprimere o meno la 
visualizzazione dell’immagine di uscita 
sul monitor LCD.

Monitoring >Output Display
Configura le impostazioni di uscita visualizzazione schermata.

Voce di menu Impostazione della voce secondaria Descrizione

SDI On / Off Specifica se incorporare o meno menu, 
stato e indicazioni a schermo nel segnale 
di uscita SDI.

HDMI On / Off Configura se menu, stato e 
visualizzazione della schermata sono 
incorporati nel segnale di uscita HDMI.

Monitoring >Display On/Off
Consente di specificare le impostazioni di visualizzazione delle indicazioni.

Voce di menu Impostazione della voce secondaria Descrizione

Focus Mode On / Off Seleziona gli elementi da visualizzare sul 
monitor LCD.Focus 

Position
On / Off

Network 
Status

On / Off

File Transfer 
Status

On / Off

Rec/Play 
Status

Always On / On / Off

SDI/HDMI 
Rec Control

On / Off

Tally On / Off

Battery 
Remain

On / Off

Zoom 
Position

On / Off

Image 
Stabilization

On / Off

Media Status On / Off

Lens Info On / Off

Look Name On / Off

UWP RF Level On / Off

Focus Area 
Indicator

On / Off

Subject 
Recognition 
Frame

On / Off

Clip Name On / Off

Video Level 
Warning

On / Off

Timecode On / Off

Gamma 
Display Assist

On / Off
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Monitoring >Display On/Off
Consente di specificare le impostazioni di visualizzazione delle indicazioni.

Voce di menu Impostazione della voce secondaria Descrizione

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Imager Scan 
Mode

On / Off

Frame Rate On / Off

Rec Format On / Off

Rec Look On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Base ISO/
Sensitivity

On / Off

Shutter On / Off

White 
Balance

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Consente di specificare le impostazioni relative alla visualizzazione degli indicatori.

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la visualizzazione di 
tutti gli indicatori.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Seleziona il colore del segnale 
dell’indicatore.

Center 
Marker

1 / 2 / 3 / 4 / Off Seleziona l’indicatore del centro 
immagine.

Monitoring >Marker
Consente di specificare le impostazioni relative alla visualizzazione degli indicatori.

Voce di menu Impostazione della voce secondaria Descrizione

Safety Zone On / Off Attiva o disattiva la visualizzazione 
dell’indicatore della zona di sicurezza.

Safety Area 80% / 90% / 92.5% / 95% Seleziona le dimensioni dell’indicatore 
della zona di sicurezza (come percentuale 
delle dimensioni totali dello schermo).

Aspect 
Marker

Line / Mask / Off Seleziona il tipo di indicatore di aspetto.

Aspect Mask Da 0 a 15 (12) Imposta il livello del segnale video 
all’esterno dell’indicatore.

Aspect Safety 
Zone

On / Off Attiva o disattiva la visualizzazione della 
zona di sicurezza di aspetto.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Seleziona le dimensioni dell’indicatore 
della zona di sicurezza di aspetto come 
percentuale delle dimensioni totali dello 
schermo.

Aspect Select 1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 / 
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / Custom

Imposta la modalità di visualizzazione 
dell’indicatore di aspetto.

Custom 
Aspect Ratio

Consente di immettere un valore arbitrario 
(01.00:01.00)

Imposta il rapporto di aspetto su un 
valore arbitrario.

[Nota]
Questa impostazione è disponibile solo 
quando Aspect Select è impostato su Custom.

Guide Frame On / Off Attiva o disattiva la visualizzazione del 
riquadro di guida.

100% Marker On / Off Attiva o disattiva la visualizzazione 
dell’indicatore 100%.

User Box On / Off Attiva o disattiva la visualizzazione del 
riquadro utente.

User Box 
Width

Da 3 a 479 (240) Specifica la larghezza del riquadro utente 
(distanza dal centro ai bordi destro e 
sinistro).

User Box 
Height

Da 3 a 269 (135) Specifica l’altezza del riquadro utente 
(distanza dal centro ai bordi superiore e 
inferiore).

User Box H 
Position

Da –476 a +476 (0) Specifica la posizione orizzontale del 
centro del riquadro utente.

User Box V 
Position

Da –266 a +266 (0) Specifica la posizione verticale del centro 
del riquadro utente.
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Monitoring >LCD Monitor Setting
Consente di specificare le impostazioni relative al mirino.

Voce di menu Impostazione della voce secondaria Descrizione

Brightness Da 1 a 15 (8) Regola la luminosità dell’immagine del 
mirino.

Color Mode Color / B&W Seleziona la modalità di visualizzazione 
del mirino in modalità di registrazione o 
E-E.

Monitoring >Gamma Display Assist
Configura le impostazioni di assistenza visualizzazione gamma.

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di 
assistenza alla visualizzazione gamma in 
modalità Cine EI quando Base Look è 
impostato su S-Log3 (valore predefinito: 
Off) o in modalità Custom quando Target 
Display è impostato su HDR(HLG) (valore 
predefinito: On).

Monitoring >Peaking
Consente di specificare le impostazioni relative al peaking.

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione Peaking.

Peaking Level High / Mid / Low Imposta il livello di segnale del peaking 
del colore.

Color B&W / Red / Yellow / Blue Seleziona il colore del segnale di peaking 
colore.

Monitoring >Zebra
Consente di specificare le impostazioni del motivo zebra.

Voce di menu Impostazione della voce secondaria Descrizione

Setting Off / Zebra1 / Zebra2 Seleziona il tipo di motivo zebra (Off, 
Zebra 1, Zebra 2).

Zebra1 Level Da 0% a 109% (70%) Imposta il livello di visualizzazione del 
motivo Zebra 1.

Zebra1 
Aperture 
Level

Da 2% a 20% (10%) Imposta il livello di apertura del motivo 
Zebra 1.

Zebra2 Level Da 0% a 109% (100%) Imposta il livello di visualizzazione del 
motivo Zebra 2.

Monitoring >Focus Magnifier
Specifica le impostazioni relative all’ingrandimento della messa a fuoco.

Voce di menu Impostazione della voce secondaria Descrizione

Focus Mag 
Button Target

LCD Monitor / Output Specifica dove realizzare l’ingrandimento 
della messa a fuoco mediante un 
pulsante programmabile.



61 3. Utilizzo della telecamera

Menu Audio
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).
Fare riferimento a “Diagrammi a blocchi” (pagina 141).

Audio >Audio Input
Consente di specificare le impostazioni relative all’ingresso audio.

Voce di menu Impostazione della voce secondaria Descrizione

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 Seleziona la sorgente di ingresso per la 
registrazione sul canale 1.

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Seleziona la sorgente di ingresso per la 
registrazione sul canale 2.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 Seleziona la sorgente di ingresso per la 
registrazione sul canale 3.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

Seleziona la sorgente di ingresso per la 
registrazione sul canale 4.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Imposta il livello di riferimento di 
registrazione dell’ingresso microfono XLR 
su INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Imposta il livello di riferimento di 
registrazione dell’ingresso microfono XLR 
su INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Seleziona il livello di riferimento di 
ingresso quando il selettore INPUT1/
INPUT2 è impostato su LINE.

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Seleziona il livello di registrazione del 
segnale di tono di riferimento a 1 kHz.

CH1 Wind 
Filter

On / Off Abilita o disabilita il filtro di riduzione del 
rumore del vento per la registrazione del 
canale 1.

CH2 Wind 
Filter

On / Off Abilita o disabilita il filtro di riduzione del 
rumore del vento per la registrazione del 
canale 2.

CH3 Wind 
Filter

On / Off Abilita o disabilita il filtro di riduzione del 
rumore del vento per la registrazione del 
canale 3.

CH4 Wind 
Filter

On / Off Abilita o disabilita il filtro di riduzione del 
rumore del vento per la registrazione del 
canale 4.

Audio >Audio Input
Consente di specificare le impostazioni relative all’ingresso audio.

Voce di menu Impostazione della voce secondaria Descrizione

CH3 Level 
Control

Auto / Manual Seleziona la regolazione del livello di 
ingresso audio automatica o manuale 
per la registrazione sul canale 3.

[Nota]
Se CH3 Input Select e CH4 Input Select sono 
entrambi impostati su Internal MIC, CH4 viene 
impostato su automatico o manuale in accordo 
con questa impostazione.

CH4 Level 
Control

Auto / Manual Seleziona la regolazione del livello di 
ingresso audio automatica o manuale 
per la registrazione sul canale 4.

[Nota]
Se CH3 Input Select e CH4 Input Select sono 
entrambi impostati su Internal MIC, CH4 viene 
impostato su automatico o manuale in accordo 
l’impostazione di CH3 Level Control.

CH3 Input 
Level

Da 0 a 99 (49) Imposta il livello di ingresso per la 
registrazione sul canale 3.

CH4 Input 
Level

Da 0 a 99 (49) Imposta il livello di ingresso per la 
registrazione sul canale 4.

Audio Input 
Level

Da 0 a 99 Imposta il livello di ingresso audio.
Utilizzabile come volume master secondo 
le impostazioni delle opzioni CH Level da 
1 a 4.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Seleziona la caratteristica di limitazione 
per i segnali di ingresso di livello elevato 
quando il livello di ingresso audio viene 
regolato manualmente.

CH1&2 AGC 
Mode

Mono / Stereo Imposta la modalità di regolazione livello 
automatica per la registrazione sui canali 
1 e 2. Quando è selezionato Stereo, la 
regolazione AGC agisce 
contemporaneamente sui due canali.

CH3&4 AGC 
Mode

Mono / Stereo Imposta la modalità di regolazione livello 
automatica per la registrazione sui canali 
3 e 4. Quando è selezionato Stereo, la 
regolazione AGC agisce 
contemporaneamente sui due canali.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Seleziona la caratteristica AGC.
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Audio >Audio Input
Consente di specificare le impostazioni relative all’ingresso audio.

Voce di menu Impostazione della voce secondaria Descrizione

1kHz Tone on 
Color Bars

On / Off Attiva o disattiva l’emissione del segnale 
di tono di riferimento a 1 kHz durante la 
visualizzazione delle barre colore.

[Nota]
Se impostato su On, viene impostato il 
segnale di tono di riferimento a 1 kHz per la 
registrazione sui canali 3 e 4, anche se CH3 
Input Select e CH4 Input Select sono impostati 
su Off.

CH1 Level Ingresso senza adattatore XLR
Audio Input Level / Side / Level+Side

Ingresso con adattatore XLR (pagina 107)
Audio Input Level / Through

Imposta la combinazione delle 
regolazioni del livello di ingresso audio 
abilitate per la registrazione del canale 1.

[Nota]
“Side” indica la manopola AUDIO LEVEL (CH1) 
sul lato dell’unità. Se è selezionato Level+Side, 
il livello di registrazione audio è determinato 
dalla combinazione di Audio Input Level e la 
posizione della manopola (pagina 141).

CH2 Level Ingresso senza adattatore XLR
Audio Input Level / Side / Level+Side

Ingresso con adattatore XLR (pagina 107)
Audio Input Level / Through

Imposta la combinazione delle 
regolazioni del livello di ingresso audio 
abilitate per la registrazione del canale 2.

[Nota]
“Side” indica la manopola AUDIO LEVEL (CH2) 
sul lato dell’unità. Se è selezionato Level+Side, 
il livello di registrazione audio è determinato 
dalla combinazione di Audio Input Level e la 
posizione della manopola (pagina 141).

CH3 Level Ingresso senza adattatore XLR
Audio Input Level / CH3 Input Level / 
Level+CH3 Input Level

Ingresso con adattatore XLR (pagina 107)
Audio Input Level / Through

Imposta la combinazione delle 
regolazioni del livello di ingresso audio 
abilitate per la registrazione del canale 3.

CH4 Level Ingresso senza adattatore XLR
Audio Input Level / CH4 Input Level / 
Level+CH4 Input Level

Ingresso con adattatore XLR (pagina 107)
Audio Input Level / Through

Imposta la combinazione delle 
regolazioni del livello di ingresso audio 
abilitate per la registrazione del canale 4.

Audio >Audio Output
Consente di specificare le impostazioni relative all’uscita audio.

Voce di menu Impostazione della voce secondaria Descrizione

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

Seleziona l’uscita del canale audio sul 
jack cuffie e l’altoparlante incorporato.

[Nota]
Se l’audio è impostato per l’uscita simultanea 
su più di un canale, il livello di uscita di ciascun 
canale viene ridotto per evitare il clipping.

Volume Da 0 a 50 Regola il livello di uscita dell’audio di 
monitoraggio su jack cuffie e altoparlante 
incorporato.

Headphone 
Out

Mono / Stereo Specifica se l’uscita del jack cuffie deve 
essere mono o stereo.

Alarm Level Da 0 a 7 (4) Regola il volume dell’allarme.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Imposta la combinazione dei canali audio 
sull’uscita HDMI.

SDI Out CH 
(Monitor FHD)

CH1/CH2 / CH3/CH4 Imposta la combinazione di canali audio 
sull’uscita SDI quando il formato di uscita 
SDI è impostato su Monitor FHD.
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Menu Clip Operations
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Operazioni con i clip

Voce di menu Impostazione della voce secondaria Descrizione

Display Clip 
Properties

Visualizza la schermata delle proprietà 
dei clip.

Clip Operations >Set Clip Flag
Consente di specificare le impostazioni relative ai flag dei clip.

Voce di menu Impostazione della voce secondaria Descrizione

Add OK Aggiunge un flag OK.

Add NG Aggiunge un flag NG.

Add KEEP Aggiunge un flag Keep.

Delete Clip 
Flag

Elimina tutti i flag.

Clip Operations >Lock/Unlock Clip
Consente di specificare le impostazioni relative alla protezione dei clip.

Voce di menu Impostazione della voce secondaria Descrizione

Select Clip Seleziona e blocca/sblocca un clip.

Lock All Clips Blocca tutti i clip.

Unlock All 
Clips

Sblocca tutti i clip.

Clip Operations >Transfer Clip
Trasferisce clip.

[Nota]
Non è possibile configurare Transfer Clip se non è stata configurata una password mediante Network Setup nel 
menu Network.

Voce di menu Impostazione della voce secondaria Descrizione

Select Clip Trasferisce i clip selezionati.

All Clips Trasferisce tutti i clip.

[Nota]
È possibile trasferire fino a 200 clip.

Clip Operations >Transfer Clip (Proxy)
Trasferisce clip proxy.

[Nota]
Non è possibile configurare Transfer Clip (Proxy) se non è stata configurata una password mediante Network 
Setup nel menu Network.

Voce di menu Impostazione della voce secondaria Descrizione

Select Clip Trasferisce i clip proxy corrispondenti ai 
clip selezionati.

All Clips Trasferisce i clip proxy corrispondenti a 
tutti i clip.

[Nota]
È possibile trasferire fino a 200 clip.

Clip Operations >Filter Clips
Consente di specificare le impostazioni relative ai clip da visualizzare.

Voce di menu Impostazione della voce secondaria Descrizione

OK Visualizza solo i clip che contengono un 
flag OK.

NG Visualizza solo i clip che contengono un 
flag NG.

KEEP Visualizza solo i clip che contengono un 
flag Keep.

None Visualizza solo i clip che non contengono 
nessun flag.

All Visualizza tutti i clip, indipendentemente 
dalla presenza o meno di flag.

Clip Operations >Customize View
Consente di scegliere la modalità di visualizzazione della schermata dei clip.

Voce di menu Impostazione della voce secondaria Descrizione

Clips Caption Clip Name / Date Time / Time Code / 
Duration / Sequential Number

Seleziona le informazioni visualizzate 
sotto l’immagine del clip.
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Menu Technical
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Technical >Color Bars
Consente di specificare le impostazioni della barra colori.

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la barra colori.

[Informazione]
Non può essere impostato su On quando la 
modalità di scansione dell’imager è impostata 
su S35 4.3K 4:3.

Type ARIB / 100% / 75% / SMPTE Seleziona il tipo di barra colori.

Technical >ND Dial
Consente di specificare le impostazioni relative al funzionamento della manopola ND VARIABLE.

Voce di menu Impostazione della voce secondaria Descrizione

CLEAR with 
Dial

On / Off Specifica se abilitare o meno l’attivazione 
del filtro ND (CLEAR  On) tramite la 
manopola ND VARIABLE.

Technical >Rec/Tally
Configura impostazioni per la spia di registrazione/tally.

Voce di menu Impostazione della voce secondaria Descrizione

Rec/Tally 
Lamp

On / Off Accende o spegne la spia di 
registrazione/tally.

Tally Control REMOTE / External / Internal Seleziona la destinazione per ricevere le 
informazioni di comando Tally/Call.
REMOTE: 

Comando Tally da un dispositivo 
connesso al connettore REMOTE 
(pagina 6).

External: 
Comando Tally/Calll da un dispositivo 
esterno.

Internal: 
Comando basato sulle impostazioni e 
sullo stato della telecamera.

Rec Start/
Stop Beep

Da 0 a 50 Regola il volume del segnale acustico 
emesso all’avvio e all’arresto della 
registrazione.

Technical >LOCK Switch Settings
Consente di specificare le impostazioni relative al selettore LOCK.

Voce di menu Impostazione della voce secondaria Descrizione

with Rec 
Button

On / Off Consente di scegliere se bloccare anche il 
funzionamento del pulsante REC (avvio/
arresto registrazione).

with Hand 
Grip Remote

On / Off Consente di scegliere se bloccare il 
funzionamento dell’impugnatura di 
telecomando.

with LCD 
Monitor

On / Off Consente di scegliere se bloccare il 
funzionamento dei pulsanti del monitor 
LCD.

Technical >Touch Operation
Configura impostazioni relative al funzionamento del touchscreen.

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzionalità del 
touchscreen.

Technical >Rec Review
Consente di specificare impostazioni relative alla revisione della registrazione.

Voce di menu Impostazione della voce secondaria Descrizione

Setting 3 s / 10 s / Clip Seleziona la durata della riproduzione dei 
clip appena registrati per la loro 
revisione.

Technical >Zoom
Consente di specificare impostazioni relative allo zoom.

Voce di menu Impostazione della voce secondaria Descrizione

Zoom Type Optical Zoom Only / On(Clear Image 
Zoom)

Imposta il tipo di zoom.
Optical Zoom Only: 

Lo zoom ottico viene regolato 
azionando l’obiettivo.

On(Clear Image Zoom): 
Zoom elettronico con scarso o 
nessun deterioramento della qualità 
dell’immagine.



3. Utilizzo della telecamera: Menu Technical65

Technical >Handle Zoom
Consente di specificare le impostazioni relative al comando dello zoom tramite una maniglia 
(opzione) dotata di slitta MI.

Voce di menu Impostazione della voce secondaria Descrizione

Setting Off / Low / High / Variable Imposta la velocità dello zoom della 
maniglia.

High Da 1 a 8 (8) Imposta la velocità dello zoom della 
maniglia quando è selezionata la velocità 
High.

Low Da 1 a 8 (3) Imposta la velocità dello zoom della 
maniglia quando è selezionata la velocità 
Low.

[Nota]
Valori molto bassi di velocità dello zoom 
potrebbero influire negativamente 
sull’uniformità dell’azione di zoom.

Technical >Menu Settings
Consente di specificare impostazioni relative alle voci del menu.

Voce di menu Impostazione della voce secondaria Descrizione

User Menu 
Only

On / Off Specifica se visualizzare solo il menu User 
(On) o l’elenco dei menu (Off) quando 
viene visualizzato il menu.

User Menu 
with Lock

On / Off Specifica se bloccare o meno la 
visualizzazione del menu, mostrando 
solo il menu User.

[Nota]
Nella visualizzazione normale del menu, questa 
voce non è visualizzata. Per informazioni 
dettagliate sulla visualizzazione dei menu, 
vedere pagina 35.

Technical >Menu Page On/Off
Configura impostazioni relative alla visualizzazione della schermata di stato.

Voce di menu Impostazione della voce secondaria Descrizione

Project On / Off Attiva o disattiva la visualizzazione della 
schermata di stato Project.

Audio On / Off Attiva o disattiva la visualizzazione della 
schermata di stato Audio.

Monitoring On / Off Attiva o disattiva la visualizzazione della 
schermata di stato Monitoring.

Assignable 
Button

On / Off Attiva o disattiva la visualizzazione della 
schermata di stato Assignable Button.

Technical >Menu Page On/Off
Configura impostazioni relative alla visualizzazione della schermata di stato.

Voce di menu Impostazione della voce secondaria Descrizione

Information On / Off Attiva o disattiva la visualizzazione della 
schermata Information.

Media On / Off Attiva o disattiva la visualizzazione della 
schermata di stato Media.

Network On / Off Attiva o disattiva la visualizzazione della 
schermata di stato Network.

File Transfer On / Off Attiva o disattiva la visualizzazione della 
schermata di stato File Transfer.

Technical >RCP
Effettua impostazioni relative ai pannelli di comando a distanza.

Voce di menu Impostazione della voce secondaria Descrizione

CNS Mode Off / Bridge Specifica se consentire o meno la 
connessione in modalità Bridge con un 
pannello di comando a distanza.

Technical >Fan Control
Consente di specificare le impostazioni di comando della ventola.

Voce di menu Impostazione della voce secondaria Descrizione

Setting Auto / Minimum / Off in Rec Imposta la modalità di controllo della 
ventola dell’unità.

[Nota]
Anche se è selezionata l’opzione Off in Rec, la 
ventola si attiva ugualmente se la temperatura 
interna dell’unità supera un determinato valore.

Technical >Lens
Consente di specificare le impostazioni relative agli obiettivi.

Voce di menu Impostazione della voce secondaria Descrizione

PL-Mt 
Interface 
Position

Top / Side / Off Imposta la posizione dell’interfaccia 
dell’obiettivo con attacco PL.

PL-Mt 
Voltage

10 V  24 V / 24V Seleziona il metodo di fornitura di 
alimentazione a obiettivi con attacco PL.

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Imposta la direzione della ghiera dello 
zoom.

[Nota]
Abilitato solo quando si utilizza un obiettivo 
con innesto E-mount che consente la scelta 
della direzione di azionamento della ghiera 
dello zoom.
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Technical >Lens
Consente di specificare le impostazioni relative agli obiettivi.

Voce di menu Impostazione della voce secondaria Descrizione

Shading 
Compensation

Auto / Auto(Low) / Off Consente di impostare la compensazione 
automatica per l’illuminazione periferica 
quando è montato un obiettivo 
compatibile.

[Note]
•• A seconda dell’obiettivo, potrebbe non 

essere possibile eseguire la compensazione 
dell’illuminazione periferica anche se 
l’opzione Shading Compensation è abilitata.

•• A seconda dell’obiettivo, potrebbero 
non esserci differenze fra i livelli di 
compensazione ottenuti con Auto e con 
Auto(Low).

Chroma 
Aberration 
Comp.

Auto / Off Consente di impostare la compensazione 
automatica dell’aberrazione cromatica 
quando è montato un obiettivo 
compatibile.

Distortion 
Comp.

Auto / Off Imposta la compensazione automatica 
della distorsione.

[Nota]
Quando Image Stabilization >SteadyShot 
(pagina 44) è impostato su Active nel menu 
Shooting, Distortion Comp. viene impostato 
su Auto.

Breathing 
Compensation

Auto / Off Imposta la compensazione dell’effetto 
breathing dell’obiettivo.

Distance 
Display

Meter / Feet Specifica le unità di misura visualizzate 
per informazioni sull’obiettivo e sulla 
posizione di messa a fuoco.

Zoom 
Position 
Display

Focal Length / Number / Bar Specifica il formato di visualizzazione 
della posizione dello zoom.

[Nota]
Nella modalità di visualizzazione delle 
informazioni, la visualizzazione Number è 
selezionata anche se Zoom Position Display è 
impostato su Bar.

Technical >Video Light Set
Specifica il metodo di illuminazione della luce video. Disponibile solo se viene utilizzata la luce 
video HVL-LBPC (opzionale).

Voce di menu Impostazione della voce secondaria Descrizione

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Imposta il metodo di controllo 
dell’illuminazione per la luce video 
montata sulla slitta Multi-interface.
Power Link: 

Accende e spegne la luce video in 
sincronia con l’accensione o 
spegnimento dell’unità.

Rec Link: 
Accende e spegne la luce video in 
sincronia con l’avvio e l’arresto della 
registrazione.

Rec Link + Stby: 
Accende e mette in standby la luce 
video in sincronia con l’avvio e 
l’arresto della registrazione.

Technical >APR
Esegue la funzione APR.

Voce di menu Impostazione della voce secondaria Descrizione

APR Execute / Cancel Esegue la funzione APR di ricostruzione 
automatica pixel per la regolazione 
automatica del sensore di immagine.
Execute: Esegue la funzione.

[Nota]
Per garantire un’adeguata schermatura dalla 
luce, montare il coperchietto e quindi coprire 
l’intera area con un panno nero.

Technical >Camera Battery Alarm
Consente di specificare le impostazioni relative all’allarme per bassa tensione batteria.

Voce di menu Impostazione della voce secondaria Descrizione

Near End:Info 
Battery

Da 5% a 100% (incrementi del 5%) Imposta il valore di soglia al quale 
l’indicatore della capacità rimanente 
della batteria comincia a lampeggiare se 
è utilizzata una batteria Sony Info.

End:Info 
Battery

Da 0% a 5% Imposta il valore di soglia per la 
visualizzazione dell’avvertenza “Battery 
End” quando si utilizza una batteria Sony 
Info.
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Technical >Camera Battery Alarm
Consente di specificare le impostazioni relative all’allarme per bassa tensione batteria.

Voce di menu Impostazione della voce secondaria Descrizione

Near 
End:Sony 
Battery

Da 11.5V a 17.0V (in incrementi di 0.1V) Imposta il valore di soglia al quale 
l’indicatore della capacità rimanente 
della batteria comincia a lampeggiare se 
è utilizzata una batteria Sony di tipo non 
Info.

End:Sony 
Battery

Da 11.0V a 12.5V (in incrementi di 0.1V) Imposta il valore di soglia per la 
visualizzazione dell’avvertenza “Battery 
End” quando si utilizza una batteria Sony 
di tipo non Info.

Near 
End:Other 
Battery

Da 11.5V a 17.0V (11.8V) (in incrementi di 
0.1V)

Imposta il valore di soglia al quale 
l’indicatore della capacità rimanente 
della batteria comincia a lampeggiare se 
è utilizzata una batteria non Sony.

End:Other 
Battery

Da 11.0V a 14.0V (in incrementi di 0.1V) Imposta il valore di soglia per la 
visualizzazione dell’avvertenza “Battery 
End” quando si utilizza una batteria non 
Sony.

Detected 
Battery

Sony Info Battery / Sony Battery / Other 
Battery / DC IN

Visualizza i risultati del rilevamento 
automatico del tipo di batteria.

Technical >Camera DC IN Alarm
Consente di specificare le impostazioni relative all’allarme della tensione di ingresso.

Voce di menu Impostazione della voce secondaria Descrizione

DC Low 
Voltage1

Da 11.5V a 17.0V (in incrementi di 0.1V) Imposta la tensione alla quale 
visualizzare l’allarme di bassa tensione su 
ingresso DC IN.

DC Low 
Voltage2

Da 11.0V a 14.0V (in incrementi di 0.1V) Imposta la tensione alla quale 
visualizzare l’allarme di tensione su 
ingresso DC IN insufficiente.
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Menu Network
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Network >Network Setup
Esegue impostazioni relative alla rete.

Voce di menu Impostazione della voce secondaria Descrizione

Setup for 
Mobile App

Avvia lo strumento di assistenza alla 
configurazione di rete.

User Name Specifica il nome utente per 
l’autenticazione di accesso.

Input 
Password

Specifica la password per l’autenticazione 
di accesso.

[Nota]
Per maggior sicurezza, si consiglia di impostare 
una password di lunghezza sufficiente e che 
non possa essere indovinata facilmente da 
altri, quindi conservarla in maniera sicura.

Generate 
Password

Execute / Cancel Genera automaticamente una password 
per l’autenticazione di accesso.
Execute: Esegue la funzione.

Show 
Authentication

Visualizza il nome utente e la password 
per l’autenticazione di accesso sotto 
forma di testo e di codice QR.

LAN Type 
Select

WLAN (AP Mode) / WLAN (ST Mode) / 
Wired LAN / Off

Imposta il metodo di connessione alla 
LAN.

Network >Wireless LAN
Consente di specificare le impostazioni relative alle connessioni su LAN wireless.

Voce di menu Impostazione della voce secondaria Descrizione

WPS Execute / Cancel Stabilisce una connessione tramite WPS 
(Wi-Fi Protected Setup).
Execute: Esegue la funzione.

[Nota]
La connessione tramite WPS non può essere 
configurata con un dispositivo su cui non è 
attiva una funzione di sicurezza.

MAC Address Visualizza l’indirizzo MAC dell’interfaccia 
LAN wireless dell’unità.

Network >AP Mode Settings
Consente di specificare le impostazioni relative alle connessioni in modalità punto di accesso.

Voce di menu Impostazione della voce secondaria Descrizione

Channel Auto(5GHz) / Auto / CH1 / CH2 / CH3 / 
CH4 / CH5 / CH6 / CH7 / CH8 / CH9 /  
CH10 / CH11

Imposta il canale della LAN wireless. 
L’opzione Auto(5GHz) è disponibile solo 
sul modello WW279317.

Camera SSID 
& Password

Visualizza SSID e password dell’unità.

Regenerate 
Password

Execute / Cancel Crea una nuova password.
Execute: Esegue la funzione.

IP Address Visualizza l’indirizzo IP dell’unità in 
modalità punto di accesso.

Subnet Mask Visualizza la subnet mask dell’unità in 
modalità punto di accesso.

Network >ST Mode Settings
Consente di specificare impostazioni relative alle connessioni in modalità stazione.

Voce di menu Impostazione della voce secondaria Descrizione

Camera 
Remote 
Control

Enable / Disable Specifica se abilitare o meno il comando 
a distanza da un dispositivo di comando 
connesso all’unità tramite LAN wireless in 
modalità Station.

Connected 
Network

Visualizza la rete LAN wireless collegata 
(punto di accesso).

SSID Visualizza il SSID del punto di accesso a 
cui connettersi.

Security Visualizza il tipo di protezione della 
connessione al punto di accesso.

Password Visualizza la password della connessione 
al punto di accesso.
Quando Security è impostata su WPA2 o 

WPA3: *******
Quando Security è impostata su None: 

(vuoto)

DHCP Indica se DHCP è attivo o no.

IP Address Visualizza l’indirizzo IP dell’unità.

Subnet Mask Visualizza la subnet mask dell’unità.

Gateway Visualizza il gateway predefinito 
dell’unità.

DNS Auto Indica se l’acquisizione del DNS è attiva o 
no.
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Network >ST Mode Settings
Consente di specificare impostazioni relative alle connessioni in modalità stazione.

Voce di menu Impostazione della voce secondaria Descrizione

Connected 
Network

Primary DNS Server Visualizza il server DNS primario dell’unità.

Secondary DNS Server Visualizza il server DNS secondario 
dell’unità.

Scan 
Networks

Rileva e visualizza un elenco delle reti 
LAN wireless (punto di accesso).
Seleziona nell’elenco la destinazione del 
collegamento.

SSID Visualizza il SSID del punto di accesso a 
cui connettersi.

Security Visualizza il tipo di protezione della 
connessione al punto di accesso.

Password Immettere la password per la 
connessione al punto di accesso.

[Nota]
Per WPA2 è possibile immettere da 8 a 63 
caratteri. Per WPA3 è possibile immettere da 
8 a 128 caratteri. Di seguito sono riportati i 
caratteri validi consentiti:
Caratteri alfabetici (maiuscole e minuscole), 
caratteri numerici, simboli (- . @ _ ( ) ! “ # $ % & ‘ 
* + , / : ; < = > ? [ \ ] ^ ` { | } ~)

DHCP 
On / Off

Attiva o disattiva DHCP.

IP Address Consente di immettere l’indirizzo IP 
dell’unità quando DHCP è impostato su 
Off.

Subnet Mask Consente di immettere la subnet mask 
dell’unità quando DHCP è impostato su 
Off.

Gateway Consente di immettere il default gateway 
dell’unità quando DHCP è impostato su 
Off.

DNS Auto 
On / Off

Attiva o disattiva la funzione di 
acquisizione automatica del DNS.

Primary DNS Server Consente di immettere il server DNS 
primario dell’unità quando DNS Auto è 
impostato su Off.

Secondary DNS Server Consente di immettere il server DNS 
secondario dell’unità quando DNS Auto è 
impostato su Off.

Network >ST Mode Settings
Consente di specificare impostazioni relative alle connessioni in modalità stazione.

Voce di menu Impostazione della voce secondaria Descrizione

Manual 
Register

Registra le impostazioni per la 
connessione manuale a un punto di 
accesso.

SSID Consente di immettere il SSID del punto 
di accesso a cui connettersi.

[Nota]
Possono essere immessi da 1 a 32 caratteri. 
Di seguito sono riportati i caratteri validi 
consentiti:
Caratteri alfabetici (maiuscole e minuscole), 
caratteri numerici, simboli (- . @ _ ( ) ! “ # $ % & ‘ 
* + , / : ; < = > ? [ \ ] ^ ` { | } ~)

Security 
None / WPA2 / WPA3

Consente di scegliere il tipo di protezione 
della connessione al punto di accesso.

[Note]
•• L’unità supporta connessioni a punti di 

accesso che offrono protocolli di sicurezza 
WPA3-SAE o WPA2-PSK (AES), oppure 
senza alcuna impostazione di sicurezza. 
Per garantire una connessione LAN wireless 
sicura, si consiglia vivamente di connettersi a 
punti di accesso protetti con impostazione di 
sicurezza WPA3 o WPA2.

•• Per impostazione predefinita, è selezionato il 
metodo di sicurezza WPA2.

•• La connessione a punti di accesso senza 
nessuna impostazione di sicurezza potrebbe 
permettere hacking, accesso da parte di terzi 
malintenzionati o attacchi a vulnerabilità 
eventualmente presenti. A meno che non sia 
assolutamente inevitabile, la connessione 
senza alcuna impostazione di sicurezza non 
è mai consigliata.

•• La configurazione della sicurezza su una LAN 
wireless è molto importante. Sony non potrà 
essere ritenuta responsabile per eventuali 
danni derivanti dalla mancata adozione 
di misure di sicurezza o nel caso in cui si 
verifichi un problema di sicurezza a causa 
di circostanze inevitabili nell’uso della LAN 
wireless.
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Network >ST Mode Settings
Consente di specificare impostazioni relative alle connessioni in modalità stazione.

Voce di menu Impostazione della voce secondaria Descrizione

Manual 
Register

Password Immettere la password per la 
connessione al punto di accesso.

[Nota]
Per WPA2 è possibile immettere da 8 a 63 
caratteri. Per WPA3 è possibile immettere da 
8 a 128 caratteri. Di seguito sono riportati i 
caratteri validi consentiti:
Caratteri alfabetici (maiuscole e minuscole), 
caratteri numerici, simboli (- . @ _ ( ) ! “ # $ % & ‘ 
* + , / : ; < = > ? [ \ ] ^ ` { | } ~)

DHCP 
On / Off

Attiva o disattiva DHCP.

IP Address Consente di immettere l’indirizzo IP 
dell’unità quando DHCP è impostato su 
Off.

Subnet Mask Consente di immettere la subnet mask 
dell’unità quando DHCP è impostato su 
Off.

Gateway Consente di immettere il default gateway 
dell’unità quando DHCP è impostato su 
Off.

DNS Auto 
On / Off

Attiva o disattiva la funzione di 
acquisizione automatica del DNS.

Primary DNS Server Consente di immettere il server DNS 
primario quando DNS Auto è impostato 
su Off.

Secondary DNS Server Consente di immettere il server DNS 
secondario quando DNS Auto è 
impostato su Off.

Network >Wired LAN
Consente di specificare le impostazioni relative alle connessioni su LAN cablata.

Voce di menu Impostazione della voce secondaria Descrizione

Camera 
Remote 
Control

Enable / Disable Specifica se abilitare o meno il comando 
a distanza da un dispositivo di comando 
connesso dell’unità tramite LAN cablata.

Detail 
Settings

Configura le proprietà della connessione 
LAN cablata.

DHCP 
On / Off

Attiva o disattiva DHCP.

Network >Wired LAN
Consente di specificare le impostazioni relative alle connessioni su LAN cablata.

Voce di menu Impostazione della voce secondaria Descrizione

Detail 
Settings

IP Address Consente di immettere l’indirizzo IP 
dell’unità quando DHCP è impostato su 
Off.

Subnet Mask Consente di immettere la subnet mask 
dell’unità quando DHCP è impostato su 
Off.

Gateway Consente di immettere il default gateway 
dell’unità quando DHCP è impostato su 
Off.

DNS Auto 
On / Off

Attiva o disattiva la funzione di 
acquisizione automatica del DNS.

Primary DNS Server Consente di immettere il server DNS 
primario quando DNS Auto è impostato 
su Off.

Secondary DNS Server Consente di immettere il server DNS 
secondario quando DNS Auto è 
impostato su Off.

MAC Address Visualizza l’indirizzo MAC dell’interfaccia 
LAN cablata dell’unità.

Network >USB Tethering
Consente di specificare impostazioni relative al tethering USB.

Voce di menu Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la connessione tramite 
smartphone.

Camera 
Remote 
Control

Enable / Disable Imposta l’autorizzazione per il comando 
a distanza tramite tethering USB 
mediante un’app per smartphone, ad 
esempio Monitor & Control oppure 
Creators’ App for enterprise.

Device Name Visualizza il nome di dispositivo dello 
smartphone.

IP Address Visualizza l’indirizzo IP dell’unità.

Subnet Mask Visualizza la subnet mask dell’unità.
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Network >File Transfer
Consente di specificare impostazioni relative al trasferimento di file.

Voce di menu Impostazione della voce secondaria Descrizione

Auto Upload On / Off Attiva o disattiva l’upload automatico dei 
clip originali.

[Nota]
Quando Simul Rec >Setting (pagina 47) 
nel menu Project è impostato su On, l’upload 
automatico dei clip registrati sulla scheda dello 
slot B non viene eseguito.

Auto Upload 
(Proxy)

On / Off On:
Attiva l’upload automatico dei clip 
proxy.

Off:
Disattiva l’upload automatico dei clip 
proxy.

Default 
Upload 
Server

Seleziona il server per l’upload dei file. Il 
server selezionato qui diventa la 
destinazione per l’upload automatico dei 
clip originali e dei clip proxy, nonché la 
destinazione per l’upload dei file dalla 
schermata dei clip.
Mostra il nome di visualizzazione 
configurato in Server Settings da 1 a 3.

Clear 
Completed 
Jobs

Execute / Cancel Rimuove dall’elenco i trasferimenti 
completati.
Execute: Esegue la funzione.

Clear All Jobs Execute / Cancel Rimuove tutti i trasferimenti dall’elenco.
Execute: Esegue la funzione.

View Job List Visualizza l’elenco dei file da trasferire.

Server 
Settings1

Display Name Imposta il nome di visualizzazione 
mostrato nel menu di configurazione 
della destinazione di trasferimento.

Service 
FTP

Visualizza il tipo di server.

Host Name Imposta il nome host del server di 
destinazione del trasferimento.

Port (da 1 a 65535 (21)) Imposta il numero della porta del server 
di destinazione del trasferimento.

User Name Imposta il nome utente per 
l’autenticazione della connessione con il 
server di destinazione del trasferimento.

Network >File Transfer
Consente di specificare impostazioni relative al trasferimento di file.

Voce di menu Impostazione della voce secondaria Descrizione

Server 
Settings1

Password Imposta la password per l’autenticazione 
della connessione con il server di 
destinazione del trasferimento.

Passive Mode 
On / Off (Active Mode)

Attiva o disattiva la modalità PASV.

Destination Directory Immettere il nome della directory di 
destinazione del trasferimento.

Using Secure Protocol 
On / Off

Specifica se utilizzare (On) o non 
utilizzare (Off) la modalità di 
trasferimento Secure FTP (FTPS Explicit 
Mode: FTPES).

Root Certificate 
Load / Clear / None

Carica un certificato radice per il 
trasferimento in modalità Secure FTP ed 
annulla le impostazioni.

Root Certificate Status 
Loaded / No Certificate

Visualizza lo stato del caricamento del 
certificato radice per il trasferimento in 
modalità Secure FTP.

Reset 
Execute / Cancel

Ripristina sui valori predefiniti le 
impostazioni di Server Settings.
Execute: Esegue la funzione.

Server 
Settings2

Come Server Settings1.

Server 
Settings3

Come Server Settings1.

Network >Network Reset
Ripristina le impostazioni di rete.

Voce di menu Impostazione della voce secondaria Descrizione

Reset Execute / Cancel Ripristina le impostazioni di rete.
Execute: Esegue la funzione.
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Menu Maintenance
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Maintenance >Language
Imposta la lingua di visualizzazione.

Voce di menu Impostazione della voce secondaria Descrizione

Select Imposta la lingua di visualizzazione.
SET: Imposta la lingua.

Maintenance >Clock Set
Consente di specificare le impostazioni relative all’orologio interno.

Voce di menu Impostazione della voce secondaria Descrizione

Time Zone Da UTC –12:00 a UTC +14:00 Imposta la differenza rispetto all’ora UTC 
in passi di 30 minuti.

Date Mode YYMMDD / MMDDYY / DDMMYY Seleziona il formato di visualizzazione 
della data.
YYMMDD: Anno, mese, giorno
MMDDYY: Mese, giorno, anno
DDMMYY: Giorno, mese, anno

12h/24h 12h / 24h Seleziona il formato di visualizzazione 
dell’ora.
12h: Orologio a 12 ore
24h: Orologio a 24 ore

Date Imposta la data corrente.
SET: Imposta il valore.

Time Imposta l’ora corrente.
SET: Imposta il valore.

Maintenance >All Reset
Ripristina i valori predefiniti di fabbrica di tutte le impostazioni.

Voce di menu Impostazione della voce secondaria Descrizione

Reset Execute / Cancel Ripristina i valori predefiniti di fabbrica di 
tutte le impostazioni.
Execute: Esegue la funzione.

[Nota]
Il file 3D LUT file importato tramite Base 
Look >Import from Utility SD, Import 
from Cloud(Private), oppure Import from 
Cloud(Share) (pagina 53) nel menu Paint/
Look non può essere eliminato. Per eliminare 
tutti i file 3D LUT importati, selezionare Base 
Look >Delete All (pagina 53) nel menu Paint/
Look.

Maintenance >All Reset
Ripristina i valori predefiniti di fabbrica di tutte le impostazioni.

Voce di menu Impostazione della voce secondaria Descrizione

Reset without 
Network

Execute / Cancel Ripristina le impostazioni predefinite di 
fabbrica dei menu, eccetto le 
impostazioni del menu Network.

Reset to 
Factory 
Defaults

Execute / Cancel Elimina tutte le impostazioni e i file e li 
ripristina allo stato predefinito di 
fabbrica.

Maintenance >Hours Meter
Visualizza il tempo cumulativo di funzionamento.

Voce di menu Impostazione della voce secondaria Descrizione

Hours(System) Visualizza le ore d’uso totali (non può 
essere azzerato).

Hours(Reset) Visualizza le ore d’uso totali (può essere 
azzerato).

Reset Execute / Cancel Azzera l’indicazione Hours(Reset) a 0.
Execute: Esegue la funzione.

Maintenance >Version
Visualizza informazioni sulla versione.

Voce di menu Impostazione della voce secondaria Descrizione

Version 
Number

Vx.xx Visualizza la versione del software 
dell’unità.

Version Up Execute / Cancel
Se è disponibile un aggiornamento, viene 
visualizzato “”.

Aggiorna l’unità.*

Execute: Esegue la funzione.
*	 Questa funzione aggiorna il software 

dell’unità.

Lens Version 
Number

Vxx Visualizza la versione del software 
dell’obiettivo E-mount.
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Impostazioni di qualità dell’immagine salvate per ciascuna modalità di ripresa
In questa sezione si indica in che modo viene salvato lo stato corrente di alcune delle voci di configurazione relative alla qualità dell’immagine nelle modalità di ripresa elencate di seguito. Gli 
elementi comuni vengono salvati in tutte le modalità di ripresa. Al cambiamento della modalità di ripresa, le impostazioni corrispondenti alle voci salvate separatamente vengono applicate anche 
alla nuova modalità di ripresa.
•• Modalità Cine EI
•• Modalità personalizzata SDR(BT.709)
•• Modalità personalizzata HDR(HLG)

Di seguito si indicano quali voci di configurazione relative alla qualità dell’immagine sono salvate.
: Salvata (impostazioni comuni che si applicano a più modalità di ripresa).
–: Disabilitata nella modalità di ripresa corrispondente.

Voce di configurazione Modalità di ripresa

Modalità Cine EI Modalità Custom

SDR(BT.709) HDR(HLG)

Menu Shooting ISO/Gain/EI ISO/Gain – 1)

Exposure Index  –

Base Sensitivity – 
Base ISO  –

White 
White Setting 
LUT On/Off  –

Noise Suppression Setting(Custom) –  

Level(Custom) –  
Setting(Cine EI)  –

Level(Cine EI)  –

Menu Paint/Look Base Look Select   
Input2) 
Output2) 
AE Level Offset2) 

Black –  
Knee Auto Knee –  

Tutte le altre voci –  
Detail –  
Matrix –  
Multi Matrix –  

1)	 Per le due modalità Custom SDR(BT.709) e HDR(HLG) vengono salvati valori di sensibilità ISO separati.
2)	Le impostazioni vengono salvate per ciascun Base Look e non dipendono dalla modalità di ripresa.
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Salvataggio e caricamento dei dati di configurazione

Dati di configurazione

Le impostazioni del menu completo possono 
essere salvate su una scheda SD. Il file ALL 
può anche essere salvato su un servizio cloud. 
Questo consente di richiamare rapidamente 
un set di impostazioni precedentemente 
ottimizzato per la situazione attuale.
I dati di configurazione sono salvati nelle 
categorie indicate di seguito.

File utente
I file utente consentono di salvare le 
impostazioni e i dati del menu User 
personalizzabile.
È possibile salvare fino a 64 file su ciascuna 
scheda SD.
Caricando questo file nella memoria dell’unità, 
è possibile personalizzare la configurazione 
del menu User.

File All (file ALL)
I file ALL salvano i dati di configurazione di 
tutti i menu. È possibile salvare fino a 64 file su 
ciascuna scheda SD. È possibile salvare su C3 
Portal (servizio cloud) fino a 120 file, di cui 60 
privati e 60 condivisi.

[Nota]
Per informazioni dettagliate sui contenuti salvati in un 
file ALL, fare riferimento a “Impostazioni salvate in file” 
(pagina 133).

Salvataggio di file utente o file ALL

Salvataggio su una scheda SD

1	 Inserire una scheda SD nello slot per 
schede Utility SD (pagina 4).

2	 Per un file utente, selezionare User File 
>Save to UTILITY SD (pagina 51) 
>Execute nel menu Project del menu 
completo.
Per un file ALL, selezionare All File >Save 
to UTILITY SD (pagina 52) >Execute nel 
menu Project del menu completo.
Viene visualizzata la schermata di 
destinazione per il salvataggio del file.

3	 Selezionare una riga con l’indicazione “No 
File” nella schermata della destinazione 
del salvataggio.
Se la riga selezionata contiene già un File 
ID, il file selezionato viene sovrascritto.
L’identificativo File ID assegnato al 
momento del salvataggio può essere 
modificato tramite il menu. Per 
informazioni dettagliate sulla 
configurazione, fare riferimento a 
“Modifica del File ID” (pagina 75).

4	 Selezionare Execute nella schermata di 
conferma.

Salvataggio di un file ALL su un servizio 
cloud

1	 Collegarsi all’unità dall’app per 
smartphone “Creators’ App for enterprise” 
(pagina 87).

2	 Selezionare All File >Save to Cloud(Private) 
oppure Save to Cloud(Share) 
(pagina 52) >Execute nel menu Project 
del menu completo.
Viene visualizzata la schermata di 
destinazione per il salvataggio del file.

3	 Selezionare una riga con l’indicazione “No 
File” nella schermata della destinazione 
del salvataggio.
Se la riga selezionata contiene già un File 
ID, il file selezionato viene sovrascritto.
L’identificativo File ID assegnato al 
momento del salvataggio può essere 
modificato tramite il menu. Per 
informazioni dettagliate sulla 
configurazione, fare riferimento a 
“Modifica del File ID” (pagina 75).

4	 Selezionare Execute nella schermata di 
conferma.

Caricamento di file utente o file ALL

[Nota]
Per garantire la coerenza tra le impostazioni quando 
viene caricato un file utente, le impostazioni che non 
sono correlate al file utente possono subire modifiche 
automatiche.

Caricamento da una scheda SD

1	 Inserire la scheda SD su cui è salvato il file 
nello slot per schede Utility SD 
(pagina 4).

2	 Per un file utente, selezionare User File 
>Load from UTILITY SD (pagina 51) 
>Execute nel menu Project del menu 
completo.
Per un file ALL, selezionare All File >Load 
from UTILITY SD (pagina 52) >Execute 
nel menu Project del menu completo.
Viene visualizzato un elenco dei file.

3	 Selezionare un file da caricare.
Viene visualizzata una schermata di 
conferma.

4	 Selezionare Execute.

[Note]
•• Al termine del caricamento dei dati di configurazione 

l’unità si riavvia automaticamente.
•• Quando All File >Load Network Data nel menu Project 

del menu completo è impostato su Off, saranno 
caricate tutte le impostazioni contenute nel file ALL, 
eccetto le impostazioni del menu Network.

Caricamento di un file ALL da un servizio 
cloud

1	 Collegarsi all’unità dall’app per 
smartphone “Creators’ App for enterprise” 
(pagina 87).

2	 Selezionare All File >Load from 
Cloud(Private) oppure Load from 
Cloud(Share) (pagina 52) >Execute nel 
menu Project del menu completo.
Viene visualizzato un elenco dei file.

3	 Selezionare un file da caricare.
Viene visualizzata una schermata di 
conferma.

4	 Selezionare Execute.

[Note]
•• Al termine del caricamento dei dati di configurazione 

l’unità si riavvia automaticamente.
•• Quando All File >Load Network Data nel menu Project 

del menu completo è impostato su Off, saranno 
caricate tutte le impostazioni contenute nel file ALL, 
eccetto le impostazioni del menu Network.
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Modifica del File ID

1	 Per un file utente, selezionare User File 
>File ID (pagina 51) nel menu Project 
del menu completo.
Per un file ALL, selezionare All File >File ID 
(pagina 52) nel menu Project del menu 
completo.
Viene visualizzata una schermata per la 
modifica del File ID.

2	 Utilizzare il selettore multiplo 
(pagina 9) o la manopola 
multifunzione (pagina 4) per 
selezionare il carattere desiderato, quindi 
premere il pulsante di conferma del 
selettore multiplo o la manopola 
multifunzione.

3	 Ripetere il passo 2 tutte le volte 
necessarie.

4	 Al termine dell’immissione dei caratteri, 
selezionare Done.
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Operazioni con i clip
Premendo il pulsante CLIPS (pagina 4), i clip registrati sulla scheda di memoria vengono visualizzati sulla schermata dei clip.
La schermata dei clip consente di selezionare un clip e avviarne la riproduzione. Nella schermata dei clip è possibile eseguire operazioni di gestione dei clip e controllarne le proprietà tramite il menu 
Clip Operations del menu completo. In modalità di visualizzazione delle informazioni, è possibile gestire la riproduzione sul monitor LCD (schermata di controllo della riproduzione).
Premere di nuovo il pulsante CLIPS per chiudere la schermata dei clip e tornare all’immagine della telecamera.

[Note]
•• La schermata dei clip mostra solo i clip registrati nel formato di registrazione correntemente selezionato. Se un clip registrato che avrebbe dovuto essere presente non è visualizzato, controllare il formato di registrazione. Prestare 

attenzione a questo fatto prima di procedere con la formattazione (inizializzazione) dei supporti di memoria.
•• Si osservi che se si apre un’impostazione relativa alla password nel menu completo mentre è aperta la schermata dei clip, la pagina del menu verrà visualizzata su un monitor esterno.

Schermata dei clip

Nella parte inferiore dello schermo vengono visualizzate le informazioni relative al clip su cui è posizionato il cursore.

4 6

7

53

1

2

Indicatore della scheda  
di memoria corrente-
mente selezionata
(se la scheda è protetta, 
viene visualizzata l’icona 
del lucchetto).

Cursore 
(giallo)

Numero del clip/Numero dei 
clip

1.	 Miniatura (immagine indice)
Visualizza l’immagine indice del clip. Quando 
si registra un clip, il primo fotogramma viene 
impostato automaticamente come immagine 
indice.
Sotto la miniatura vengono visualizzate 
informazioni sul clip e sul fotogramma. 
È possibile scegliere quali informazioni 
visualizzare utilizzando la voce Customize 
View (pagina 63) >Clips Caption nel menu 

Clip Operations del menu completo. Visualizza 
anche lo stato dei clip mediante icone.

Icona Significato

(non 
riproducibile)

Non è possibile riprodurre il 
clip.

[Nota]
Nel formato X-OCN(LT), viene visualizzata la stringa 
“X-OCN” invece dell’immagine dell’indice delle 
miniature.

2.	 Nome del clip
Visualizza il nome del clip selezionato.

3.	 Formato di registrazione video
Visualizza il formato del file del clip 
selezionato.

4.	 Informazioni sulla registrazione speciale
Se il clip è stato registrato con una modalità di 
registrazione speciale, ne indica la modalità.

Se il clip è registrato in modalità Slow & 
Quick Motion, ne viene indicata la frequenza 
fotogrammi sulla destra.

5.	 Data di creazione

6.	 Durata del clip

7.	 Codice temporale
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Schermata di controllo della riproduzione

Quando il monitor LCD si trova in modalità di visualizzazione delle informazioni, è possibile 
selezionare un clip nella schermata dei clip per visualizzare la schermata di controllo della 
riproduzione. L’area di visualizzazione delle funzioni può essere utilizzata anche toccando lo 
schermo touchscreen.

Area di visualizzazione delle funzioni

1 2 3

4 5 6

Pulsante ITEM 4 Pulsante ITEM 5 Pulsante ITEM 6

Pulsante ITEM 3Pulsante ITEM 2Pulsante ITEM 1

[Nota]
Le zone indicate con i numeri da 1 a 6 si riferiscono 
ai corrispondenti pulsanti ITEM da 1 a 6. Premere un 
pulsante ITEM per selezionare la voce corrispondente.

1.	 Pulsante F Rev
Esegue la riproduzione ad alta velocità in 
direzione indietro.
Premere ripetutamente il pulsante per 
scegliere una delle tre velocità disponibili.

2.	 Pulsante Play/Pause
Riproduce o mette in pausa la riproduzione di 
un clip.

3.	 Pulsante F Fwd
Esegue la riproduzione ad alta velocità in 
direzione avanti.
Premere ripetutamente il pulsante per 
scegliere una delle tre velocità disponibili.

4.	 Pulsante Prev
Salta all’inizio del clip precedente.

5.	 Pulsante Stop/Clips
Arresta la riproduzione e torna alla schermata 
dei clip.

6.	 Pulsante Next
Salta all’inizio del clip successivo.

Area di visualizzazione stato

1 2 3

7 6 58910

412
11

13

1.	 Indicazione dati temporali
Visualizza il codice temporale della posizione 
in corso di riproduzione.

2.	 Indicatore frequenza fotogrammi
Visualizza la frequenza fotogrammi del clip in 
riproduzione.

3.	 Indicatore tensione di alimentazione/
carica residua della batteria

Visualizza la tensione di alimentazione o la 
capacità residua della batteria.

4.	  Indicatori di livello audio
Visualizza il livello di riproduzione dell’audio.

5.	 Indicatore modalità di registrazione 
speciale

Visualizza le informazioni sulla modalità di 
registrazione speciale del clip in riproduzione.	

6.	 Indicatore risoluzione dell’immagine
Visualizza la risoluzione dell’immagine.

7.	 Visualizzazione nome codec
Visualizza il nome del codec.

8.	 Indicatore delle dimensioni dell’immagine
Visualizza le dimensioni dell’immagine.

9.	 Indicatore del numero del clip e del 
numero totale dei clip

Visualizza numero del clip in riproduzione 
corrente/Numero totale di clip riproducibili.

10.	 Visualizzazione nome clip
Visualizza il nome del clip.

11.	 Indicatore supporto
Mostra il supporto riprodotto.
Se la scheda di memoria è protetta da 
scrittura, sulla destra viene visualizzata l’icona 

 (protezione).

12.	 Icona di avvertenza/errore
Visualizzata quando si verifica un’avvertenza 
o un errore.
È possibile controllare il contenuto di 
avvertenze ed errori visualizzando il menu. 
Se le indicazioni a schermo sono visualizzate 
in sovraimpressione anche su un monitor 
esterno, è possibile eseguirne il controllo 
anche sul monitor esterno.

13.	 Indicazione dello stato della riproduzione
Visualizza lo stato operativo della 
riproduzione.
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Utilizzo del menu Clip Operations

Per visualizzare il menu Clip Operations 
(pagina 63), mantenere premuto il pulsante 
MENU e selezionare Clip Operations.
Utilizzare il selettore multiplo (pagina 5) 
o la manopola multifunzione (pagina 4) 
per selezionare la funzione desiderata, quindi 
premere il pulsante di conferma del selettore 
multiplo o la manopola multifunzione.
Premere il pulsante BACK (pagina 4) per 
tornare alla schermata precedente.

[Nota]
A seconda dello stato operativo del camcorder quando 
viene visualizzato il menu, alcune voci potrebbero non 
essere selezionabili.

Displaying clip properties

Selezionare Display Clip Properties 
(pagina 63) nel menu Clip Operations per 
visualizzare la schermata delle proprietà dei 
clip.
Premere il pulsante sinistro o destro del 
selettore multiplo per passare rispettivamente 
al clip precedente o successivo.

Aggiunta di flag ai clip

È possibile aggiungere flag (ovvero 
contrassegni OK, NG o KP) ai clip per poterne 
in seguito filtrare la visualizzazione in base ad 
essi.
Selezionare il clip a cui aggiungere il flag, 
quindi selezionare il tipo di flag desiderato 
mediante Set Clip Flag (pagina 63) nel 
menu Clip Operations del menu completo.

Impostazione Flag di clip aggiunto

Add OK OK

Add NG NG

Add KEEP KP

Visualizzazione della schermata dei clip 
filtrata

Selezionare Filter Clips (pagina 63) nel 
menu Clip Operations del menu completo, 
quindi selezionare il tipo di flag desiderato per 
visualizzare solo i clip che lo contengono.
Per visualizzare tutti i clip, selezionare All.

[Informazione]
È possibile passare da un filtro all’altro in sequenza 
anche premendo il pulsante DISPLAY.

Modifica delle informazioni nella 
schermata dei clip

È possibile scegliere quali informazioni sui clip 
o sui fotogrammi sono visualizzate sotto la 
miniatura.
Selezionare Customize View >Clips Caption 
nel menu Clip Operations del menu completo, 
quindi selezionare le informazioni da 
visualizzare.
Clip Name: 

Visualizza il nome del clip.
Date Time: 

Visualizza la data e l’ora di creazione e 
dell’ultima modifica del clip.

Time Code: 
Visualizza il codice temporale.

Duration: 
Visualizza la durata del clip.

Sequential Number: 
Visualizza un numero sequenziale su ogni 
miniatura.
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Riproduzione
È possibile riprodurre i clip registrati mentre 
l’unità si trova in modalità standby (Stby) di 
registrazione.

1	 Inserire la scheda di memoria da 
riprodurre.

2	 Premere il pulsante CLIPS (pagina 4).
Il monitor LCD visualizzerà la schermata 
dei clip disponibili sul supporto di 
riproduzione attivo.

3	 Utilizzare il selettore multiplo 
(pagina 5) o la manopola 
multifunzione (pagina 4) per spostare 
il cursore sul clip da riprodurre.

4	 Premere il pulsante di conferma del 
selettore multiplo o la manopola 
multifunzione.
La riproduzione si avvia dall’inizio del clip 
selezionato.

[Nota]
L’unità non esegue la riproduzione continua.

Operazioni di riproduzione

È possibile comandare la riproduzione con i 
seguenti pulsanti:
Premere il pulsante di conferma del selettore 

multiplo o la manopola multifunzione: La 
riproduzione entra in pausa. Premere una 
seconda volta per tornare alla riproduzione 
normale.

Premere i pulsanti freccia sinistra o freccia 
destra del selettore multiplo: Salta all’inizio 
del clip o al clip precedente o successivo.

Premere e mantenere premuto il pulsante 
freccia sinistra o il pulsante freccia 
destra del selettore multiplo: Ritorno 
e avanzamento veloce. Torna alla 
riproduzione normale quando si rilascia il 
pulsante.

Pulsante BACK: Arresta la riproduzione e torna 
alla modalità standby di registrazione. 
Viene visualizzata la schermata di ripresa o 
la schermata Home.

Controllo mediante i pulsanti della 
schermata di controllo della riproduzione
Quando il monitor LCD si trova nella modalità 
di visualizzazione delle informazioni, 
è possibile controllare la riproduzione 
utilizzando i pulsanti della schermata di 
controllo della riproduzione.
Pulsante Play/Pause: Mette in pausa la 
riproduzione. Per riprendere la riproduzione, 
premere di nuovo questo pulsante.
Pulsante Prev/Next: Salta all’inizio del clip o al 
clip precedente o successivo.
Pulsanti F Fwd e F Rev: Avanzamento 

veloce o ritorno veloce. Per tornare alla 
riproduzione normale, premere il pulsante 
Play/Pause.

Pulsante Stop/Clips: Arresta la riproduzione e 
torna alla schermata dei clip.

[Informazione]
È possibile selezionare voci anche semplicemente 
toccandole sul touchscreen.

Monitoraggio dell’audio

Nella modalità di riproduzione normale è 
possibile monitorare l’audio registrato tramite 
l’altoparlante incorporato (pagina 4) 
oppure collegando cuffie alla telecamera.
Quando si collegano cuffie al connettore cuffie 
(pagina 4), l’altoparlante incorporato viene 
disabilitato.
È possibile selezionare il canale da monitorare 
e regolarne il volume utilizzando le voci Audio 
Output >Monitor CH e Volume (pagina 62) 
del menu Audio del menu completo.

Ricerca di clip (cueing)

Per avviare la riproduzione dall’inizio di un 
clip, premere il pulsante Prev sulla schermata 
di riproduzione.

Per saltare clip ed avviare l’operazione da un 
altro clip, premere ripetutamente i pulsanti 
Prev e Next.

Passaggio da una scheda di memoria 
all’altra

Quando sono inserite due schede di 
memoria, premere il pulsante SLOT SELECT 
(pagina 4) per passare da una scheda 
all’altra nella schermata dei clip.

[Nota]
Non è possibile passare da una scheda di memoria 
all’altra durante la riproduzione. Non è possibile eseguire 
la riproduzione continua delle schede contenute negli 
slot A e B.
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Connessione ad altri dispositivi tramite LAN
Utilizzando la funzione LAN di cui è dotata, 
l’unità è in grado di connettersi a smartphone, 
tablet e altri dispositivi di comando tramite 
una connessione LAN.
Collegando l’unità a un dispositivo tramite una 
rete LAN, è possibile utilizzare l’applicazione 
“Monitor & Control” per eseguire le operazioni 
descritte di seguito.
•• Comando a distanza 

È possibile comandare a distanza l’unità 
mediante uno smartphone o un tablet 
connesso ad essa tramite LAN.

•• Trasferimento di file 
Utilizzando una LAN, è possibile trasferire a 
un server clip proxy (bassa risoluzione) e/o 
clip originali (alta risoluzione) registrati sulla 
scheda di memoria dell’unità.

•• Monitoraggio video 
Utilizzando l’applicazione “Monitor & 
Control” su un dispositivo, è possibile 
monitorare l’immagine della telecamera o 
riprodurre video contenuto sull’unità.

	 [Note]
•• L’unità non consente di utilizzare 

contemporaneamente la LAN wireless e la LAN 
cablata.

•• L’unità non è un dispositivo di rete (ad esempio, 
un router o uno switch). Si consiglia vivamente 
di collegare l’unità a una rete di cui sia possibile 
configurare e gestire le impostazioni in modo 
appropriato per proteggersi da attacchi provenienti 
dalla rete stessa, ad esempio attacchi DoS (attacchi 
Denial of Service).

•• Per il collegamento dell’unità a una rete, servirsi di 
un router opportunamente configurato e gestito, 
oppure utilizzare una porta LAN dotata di analoghe 
funzionalità. Se il collegamento avviene senza tali 
protezioni (ad esempio nel caso di Wi-Fi aperti a 
tutti), potrebbero verificarsi problemi di sicurezza. 
Se configurati correttamente, i router forniscono 
una protezione sufficiente contro gli attacchi DoS 
o la perdita di funzionalità dei dispositivi nella 
rete. Se si nota qualcosa di insolito, scollegare 
immediatamente la telecamera dalla rete.

Applicazione “Monitor & Control”

È possibile utilizzare questa applicazione 
per azionare l’unità in remoto e configurare 
impostazioni dell’unità durante il 
monitoraggio del video dell’unità sullo 
schermo del dispositivo.

Per informazioni dettagliate sull’applicazione “Monitor & 
Control” rivolgersi al proprio rappresentante commerciale 
o di assistenza tecnica Sony.

Impostazione del nome utente e 
della password

Per poter utilizzare le funzionalità di rete è 
necessario impostare il nome utente e la 
password dell’unità.

1	 Impostare Network Setup >User Name 
(pagina 68) nel menu Network del 
menu completo.

2	 Impostare Network Setup >Input 
Password (pagina 68) nel menu 
Network del menu completo.

	 [Informazioni]
•• È possibile anche generare una password 

automaticamente. Eseguire Generate Password 
invece di Input Password.

•• Il nome utente e la password possono essere 
visualizzati come testo e codice QR utilizzando 
Show Authentication.

	 [Nota]
Assicurarsi che il codice QR e la password non 
possano essere visti da altre persone. In particolare, 
quando il formato di uscita video è impostato su 
Monitor FHD o durante l’uscita HDMI, è importante 
ricordare che la pagina del menu verrà visualizzata 
su un monitor esterno qualora il codice QR e le 
impostazioni della password nel menu completo 
vengano visualizzate mentre è aperta la schermata 
dell’elenco dei clip.

Connessione tramite la modalità 
Punto di accesso LAN wireless

L’unità funziona come punto di accesso e si 
connette a un dispositivo di comando tramite 
LAN wireless.

Smartphone/Tablet

Connessione a un dispositivo WPS 
compatibile

È possibile utilizzare la funzione di 
collegamento WPS con i dispositivi che la 
supportano.

1	 Selezionare Network Setup >LAN Type 
Select >WLAN (AP Mode) nel menu 
Network del menu completo.

2	 Selezionare Wireless LAN >WPS >Execute 
nel menu Network del menu completo.

3	 Aprire le impostazioni di rete o Wi-Fi del 
dispositivo ed attivare Wi-Fi.

4	 Per eseguire il collegamento, selezionare 
il SSID dell’unità nell’elenco dei SSID in 
Wi-Fi Network sul dispositivo, quindi 
selezionare WPS Push Button in Option.

	 [Note]
•• Il metodo di funzionamento dipende dal 

dispositivo.
•• Per informazioni su SSID e password dell’unità, 

vedere AP Mode Settings >Camera SSID & 
Password (pagina 68) nel menu Network del 
menu completo.

5	 Eseguire la connessione mediante 
l’applicazione Monitor & Control.

	 [Informazione]
È possibile verificare le informazioni necessarie per 
la connessione all’unità mediante Network Setup 
>Show Authentication (pagina 68) nel menu 
Network del menu completo.
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Connessione mediante immissione di 
SSID e password su un dispositivo

È possibile connettere l’unità a un dispositivo 
immettendo sul dispositivo SSID e password 
dell’unità.

1	 Selezionare Network Setup >LAN Type 
Select >WLAN (AP Mode) nel menu 
Network del menu completo.

2	 Aprire le impostazioni di rete o Wi-Fi del 
dispositivo ed attivare Wi-Fi.

3	 Per eseguire il collegamento, selezionare 
il SSID dell’unità nell’elenco dei SSID in 
Wi-Fi Network sul dispositivo, quindi 
immettere la password.
Per informazioni su SSID e password 
dell’untà, vedere AP Mode Settings 
>Camera SSID & Password (pagina 68) 
nel menu Network.

	 [Nota]
Il metodo di funzionamento dipende dal 
dispositivo.

4	 Eseguire la connessione mediante 
l’applicazione Monitor & Control.

	 [Informazione]
È possibile verificare le informazioni necessarie per 
la connessione all’unità mediante Network Setup 
>Show Authentication (pagina 68) nel menu 
Network del menu completo.

Connessione tramite la modalità 
Wireless LAN Station

L’unità si connette a un punto di accesso 
esistente nella LAN wireless come client. Il 
dispositivo di comando si connette tramite il 
punto di accesso.
La cronologia mostra gli ultimi 10 punti di 
accesso a cui ci si è collegati.
La cronologia viene salvata nel file ALL, ma 
le password di accesso non vengono salvate. 
È sempre necessario immettere la password 
la prima volta che si esegue la connessione 
dopo aver caricato un file ALL.

Smartphone/
Tablet

Punto di accesso

Computer

Connessione a un punto di accesso 
mediante WPS

Se il punto di accesso è compatibile con la 
funzione WPS, è possibile connettersi al punto 
di accesso con impostazioni semplificate.

1	 Accendere il punto di accesso.

2	 Accendere l’unità.

3	 Selezionare Network Setup >LAN Type 
Select >WLAN (ST Mode) nel menu 
Network del menu completo.

4	 Selezionare ST Mode Settings >Camera 
Remote Control (pagina 68) >Enable 
nel menu Network del menu completo.

5	 Selezionare Wireless LAN >WPS >Execute 
nel menu Network del menu completo.

6	 Premere il pulsante WPS del punto di 
accesso.
Per informazioni dettagliate sull’uso del 
pulsante WPS, consultare le istruzioni per 
l’uso del punto di accesso.
Una volta realizzata correttamente la 
connessione, l’icona di indicazione dello 
stato della rete visualizzata sul monitor 
LCD indicherà un livello di intensità del 
segnale di almeno 1.

	 [Nota]
Se la connessione non riesce, ripetere la procedura 
dal punto 1.

7	 Connettere il dispositivo al punto di 
accesso.
Per informazioni dettagliate sulla 
connessione, consultare le istruzioni per 
l’uso del dispositivo.

8	 Avviare l’applicazione Monitor & Control 
su un dispositivo e selezionare l’unità.

	 [Informazione]
È possibile verificare le informazioni necessarie per 
la connessione all’unità mediante Network Setup 
>Show Authentication (pagina 68) nel menu 
Network del menu completo.

Connessione tramite la funzione di 
rilevamento automatico del punto di 
accesso

1	 Eseguire i passi da 1 a 3 descritti in 
“Connessione a un punto di accesso 
mediante WPS” (pagina 81).

2	 Selezionare ST Mode Settings >Scan 
Networks (pagina 69) >Execute nel 
menu Network del menu completo.
L’unità avvia la ricerca di destinazioni di 
connessione.
Le possibili destinazioni trovate vengono 
visualizzate in un elenco.

3	 Selezionare la destinazione desiderata 
nell’elenco.
Appare la schermata dei dettagli della 
rete (punto di accesso). La connessione 
selezionata è visualizzata in SSID.

4	 Selezionare Password e immettere la 
password del punto di accesso per la 
connessione nella schermata di 
immissione della password.
La selezione di un SSID nella cronologia 
delle connessioni ne configura 
automaticamente le impostazioni, 
compresa la password.
Impostare la password per tornare alla 
schermata dei dettagli di rete (punto di 
accesso).
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5	 Configurare le impostazioni di 
connessione indicate di seguito.
•• DHCP 

Configurare l’impostazione DHCP.  
Quando è impostato su On, 
l’indirizzo IP viene assegnato all’unità 
automaticamente.  
Per assegnare manualmente l’indirizzo 
IP all’unità, impostare su Off.

•• IP Address 
Immettere l’indirizzo IP dell’unità.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.

•• Subnet Mask 
Immettere la subnet mask dell’unità.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.

•• Gateway 
Immettere il gateway del punto di 
accesso.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.

•• DNS Auto 
Specifica se acquisire l’indirizzo DNS 
automaticamente o meno.  
Quando impostato su On, l’indirizzo 
del server DNS viene acquisito 
automaticamente. Questa impostazione 
è disponibile solo quando DHCP è 
impostato su On.

•• Primary DNS Server 
Immettere l’indirizzo del server DNS 
primario del punto di accesso.  
Questa impostazione è disponibile solo 
quando DNS Auto è impostato su Off.

•• Secondary DNS Server 
Immettere l’indirizzo del server DNS 
secondario del punto di accesso.  
Questa impostazione è disponibile solo 
quando DNS Auto è impostato su Off.

6	 Al termine, selezionare Connect per 
connettersi al punto di accesso.

7	 Connettere il dispositivo al punto di 
accesso.
Per informazioni dettagliate sulla 
connessione, consultare le istruzioni per 
l’uso del dispositivo.

8	 Avviare l’applicazione Monitor & Control 
su un dispositivo e selezionare l’unità.

	 [Informazione]
È possibile verificare le informazioni necessarie per 
la connessione all’unità mediante Network Setup 
>Show Authentication (pagina 68) nel menu 
Network del menu completo.

Connessione manuale tramite 
l’immissione di informazioni del punto 
di accesso

1	 Eseguire i passi da 1 a 3 descritti in 
“Connessione a un punto di accesso 
mediante WPS” (pagina 81).

2	 Selezionare ST Mode Settings >Manual 
Register (pagina 69) nel menu Network 
del menu completo.
Appare la schermata dei dettagli della 
rete (punto di accesso).

3	 Configurare le impostazioni di 
connessione indicate di seguito.
•• SSID 

Immettere il SSID del punto di accesso 
della connessione.

•• Security 
Selezionare il metodo di crittografia.

[Note]
•• L’unità supporta connessioni a punti di 

accesso che offrono protocolli di sicurezza 
WPA3-SAE o WPA2-PSK (AES), oppure 
senza alcuna impostazione di sicurezza. 
Per garantire una connessione LAN wireless 
sicura, si consiglia vivamente di connettersi a 
punti di accesso protetti con impostazione di 
sicurezza WPA3 o WPA2.

•• Per impostazione predefinita, è selezionato il 
metodo di sicurezza WPA2.

•• La connessione a punti di accesso senza 
nessuna impostazione di sicurezza potrebbe 
permettere hacking, accesso da parte di terzi 
malintenzionati o attacchi a vulnerabilità 
eventualmente presenti. A meno che non sia 
assolutamente inevitabile, la connessione 
senza alcuna impostazione di sicurezza non è 
mai consigliata.

•• La configurazione della sicurezza su una LAN 
wireless è molto importante. Sony non potrà 
essere ritenuta responsabile per eventuali 
danni derivanti dalla mancata adozione 
di misure di sicurezza o nel caso in cui si 
verifichi un problema di sicurezza a causa 
di circostanze inevitabili nell’uso della LAN 

wireless.

•• Password 
Immettere la password del punto di 
accesso.

•• DHCP 
Configurare l’impostazione DHCP.  
Quando è impostato su On, 
l’indirizzo IP viene assegnato all’unità 
automaticamente.  
Per assegnare manualmente l’indirizzo 
IP all’unità, impostare su Off.

•• IP Address 
Immettere l’indirizzo IP dell’unità.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.

•• Subnet Mask 
Immettere la subnet mask dell’unità.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.

•• Gateway 
Immettere l’indirizzo del gateway.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.

•• DNS Auto 
Specifica se acquisire l’indirizzo DNS 
automaticamente o meno.  
Quando impostato su On, l’indirizzo 
del server DNS viene acquisito 
automaticamente. Questa impostazione 
è disponibile solo quando DHCP è 
impostato su On.

•• Primary DNS Server 
Immettere l’indirizzo del server DNS 
primario.  
Questa impostazione è disponibile solo 
quando DNS Auto è impostato su Off.

•• Secondary DNS Server 
Immettere l’indirizzo del server DNS 
secondario.  
Questa impostazione è disponibile solo 
quando DNS Auto è impostato su Off.

4	 Al termine, selezionare Connect per 
connettersi al punto di accesso.

5	 Connettere il dispositivo al punto di 
accesso.
Per informazioni dettagliate sulla 
connessione, consultare le istruzioni per 
l’uso del dispositivo.

6	 Avviare l’applicazione Monitor & Control 
su un dispositivo e selezionare l’unità.

	 [Informazione]
È possibile verificare le informazioni necessarie per 
la connessione all’unità mediante Network Setup 
>Show Authentication (pagina 68) nel menu 
Network del menu completo.
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Connessione a Internet
È possibile collegare l’unità a Internet tramite 
tethering USB, una LAN cablata o una LAN 
wireless.
Il nome utente e la password dell’unità devono 
essere stati impostati in anticipo (pagina 80).

Collegamento tramite tethering 
USB

È possibile collegare l’unità a uno smartphone 
tramite un cavo USB e quindi connettersi a 
Internet tramite lo smartphone.

Configurazione della comunicazione 
tramite smartphone

Abilitare la funzione di tethering sullo 
smartphone.
Per ulteriori informazioni, consultare le 
istruzioni per l’uso dello smartphone.

Collegamento di uno smartphone 
all’unità

Collegare un cavo USB al connettore USB-C 
(pagina 5) dell’unità, quindi collegare lo 
smartphone.

[Note]
•• Collegare o scollegare lo smartphone solo mentre 

l’unità è spenta.
•• La funzione di tethering USB non può essere utilizzata 

se lo smartphone è connesso tramite un hub USB.
•• Per il tethering, utilizzare solo smartphone di cui si 

ha fiducia. La connessione a dispositivi di origine 
sconosciuta non è consigliata per motivi di sicurezza.

Connessione a una rete

1	 Accendere l’unità.

2	 Impostare su On la voce USB Tethering 
>Setting (pagina 70) nel menu Network 
del menu completo.

Abilitazione del comando tramite uno 
smartphone

È possibile comandare a distanza l’unità 
mediante l’applicazione Monitor & Control su 
uno smartphone connesso con un cavo USB.

1	 Impostare su Enable la voce USB Tethering 
>Camera Remote Control (pagina 70) 
nel menu Network del menu completo.

2	 Avviare l’applicazione Monitor & Control 
su uno smartphone e selezionare l’unità.

	 [Informazione]
È possibile verificare le informazioni necessarie 
per la connessione all’unità dall’applicazione 
Monitor & Control mediante Network Setup >Show 
Authentication (pagina 68) nel menu Network 
del menu completo.

Connessione tramite la modalità 
Station LAN wireless (modalità 
Wi-Fi Station)

È possibile connettere l’unità a Internet nella 
modalità Wi-Fi Station tramite un router Wi-Fi 
opzionale o tramite tethering Wi-Fi su uno 
smartphone.
Eseguire il collegamento al router Wi-Fi o al 
dispositivo come descritto in “Connessione 
tramite la modalità Wireless LAN Station” 
(pagina 81).

Smartphone/
Tablet

Router Wi-Fi

Computer

Internet

Smartphone/
Tablet

Internet

Connessione con cavo LAN

È possibile connettersi a Internet collegando il 
connettore di rete dell’unità a un router Wi-Fi 
(opzione) utilizzando un cavo LAN.

Smartphone/
Tablet

Computer

Router Wi-Fi

Internet
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Connessioni cavo LAN e impostazioni 
LAN cablata

1	 Collegare il connettore di rete dell’unità al 
router Wi-Fi utilizzando un cavo LAN.

2	 Accendere l’unità.

3	 Impostare Network Setup >LAN Type 
Select su Wired LAN nel menu Network 
del menu completo.

4	 Configurare le impostazioni di 
connessione mediante la voce Wired LAN 
>Detail Settings (pagina 70) del menu 
Network.
•• DHCP 

Configurare l’impostazione DHCP.  
Quando è impostato su On, 
l’indirizzo IP viene assegnato all’unità 
automaticamente.  
Per assegnare manualmente l’indirizzo 
IP all’unità, impostare su Off.

•• IP Address 
Immettere l’indirizzo IP dell’unità.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.

•• Subnet Mask 
Immettere la subnet mask dell’unità.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.

•• Gateway 
Immettere l’indirizzo del gateway.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.

•• DNS Auto 
Specifica se acquisire l’indirizzo DNS 
automaticamente o meno.  
Quando impostato su On, l’indirizzo 
del server DNS viene acquisito 
automaticamente. Questa impostazione 
è disponibile solo quando DHCP è 
impostato su On.

•• Primary DNS Server 
Immettere l’indirizzo del server DNS 
primario.  
Questa impostazione è disponibile solo 
quando DNS Auto è impostato su Off.

•• Secondary DNS Server 
Immettere l’indirizzo del server DNS 
secondario.  
Questa impostazione è disponibile solo 
quando DNS Auto è impostato su Off.

5	 Al termine, selezionare Set per applicare 
le impostazioni.

[Nota]
Selezionare sempre Set dopo aver modificato le 
impostazioni di connessione. Le impostazioni non sono 
applicate fino a quando non viene selezionato Set.

Abilitazione del comando tramite uno 
smartphone mediante LAN cablata

Per azionare l’unità a distanza utilizzando 
l’applicazione Monitor & Control su uno 
smartphone tramite Wi-Fi utilizzando un 
router Wi-Fi connesso mediante una LAN 
cablata, impostare su Enable la voce Wired 
LAN >Camera Remote Control (pagina 70) 
nel menu Network del menu completo.
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Upload di file
È possibile eseguire l’upload di clip proxy e 
clip originali registrati sull’unità su un server 
Internet o un server sulla rete locale tramite 
uno smartphone o un punto di accesso.

Operazioni di preparazione

Connessione a una rete

Collegare l’unità a Internet o alla rete locale 
come descritto in “Connessione a Internet” 
(pagina 83) o “Connessione ad altri 
dispositivi tramite LAN” (pagina 80).

Registrazione di una destinazione di 
trasferimento file

Registrare anticipatamente il server per il 
caricamento.

1	 Selezionare File Transfer >Server Settings1 
(oppure Server Settings2, Server Settings3) 
nel menu Network del menu completo.
Appare la schermata di configurazione 
della destinazione di trasferimento.

2	 Impostare le varie opzioni nella schermata 
di configurazione della destinazione di 
trasferimento.
Display Name
Immettere il nome del server da 
visualizzare nell’elenco delle destinazioni 
di trasferimento.
Service
Visualizza il tipo di server.
“FTP”: server FTP
Host Name
Immettere l’indirizzo del server.
Port
Immettere il numero di porta del server a 
cui connettersi.

User Name
Immettere il nome utente.
Password
Immettere la password.
Passive Mode
Attivare o disattivare la modalità Passive.
Destination Directory
Immettere il nome della directory sul 
server di destinazione.

	 [Note]
•• I clip originali sono caricati nella cartella “Main” 

della directory specificata come destinazione 
dell’upload.

•• Durante la modifica, “” indica caratteri che 
non possono essere cambiati. Non è possibile 
garantire il funzionamento corretto se si 
modificano nomi di directory che contengono 
tali caratteri.  
Se è necessario eseguire una modifica, eliminare 
tutti i caratteri ed immettere nuovamente il 
valore desiderato.

•• Se vengono immessi in Destination Directory 
caratteri non validi per il server di destinazione, 
i file saranno trasferiti alla directory Home 
dell’utente. I caratteri validi e non validi variano a 
seconda del server.

Using Secure Protocol
Specifica se utilizzare o meno il protocollo 
di upload Secure FTP.
Root Certificate
Caricamento o annullamento di un 
certificato.
•• Load 

Selezionare Set al passo 3 per importare 
un certificato CA.
*	 Il certificato da caricare deve essere in formato 

PEM, deve essere contenuto nella directory 
radice della scheda SD contenuta nello slot 
per schede Utility SD e deve avere il nome 
“certification.pem”.

[Informazione]
La verifica della convalida del certificato viene 
eseguita con il metodo OCSP. La struttura del 
certificato è riportata di seguito.  
-----BEGIN CERTIFICATE----- 
(Certificato radice da utilizzare) 
-----END CERTIFICATE-----

•• Clear 
Selezionare Set al passo 3 per annullare 
un certificato CA.

•• None 
Non carica né annulla nessun certificato.

	 [Note]
•• Impostare l’orologio dell’unità sull’ora corretta 

prima di importare un certificato CA.
•• Durante la registrazione in modalità X XAVC-I 

4096×2160P/3840×2160P, XAVC H-I HQ/SQ o 
X-OCN, non è possibile selezionare Load.

•• In condizioni di bassa tensione, non è possibile 
selezionare Load o Clear per un certificato CA.

Root Certificate Status
Visualizza lo stato di caricamento del 
certificato.
Reset
Ripristina sui valori predefiniti le 
impostazioni di Server Settings.

3	 Al termine, selezionare Set per applicare 
le impostazioni.
Selezionare sempre Set dopo aver 
modificato le impostazioni. Le 
impostazioni non sono applicate fino a 
quando non viene selezionato Set.

Selezione e upload di clip

I clip proxy e i clip originali contenuti su 
schede di memoria possono essere caricati su 
un server.

Upload dalla schermata dei clip di clip 
proxy contenuti su una scheda di 
memoria

1	 Collegare l’unità al dispositivo tramite una 
connessione LAN (pagina 80).

2	 Selezionare Transfer Clip (Proxy) >Select 
Clip nel menu Clip Operations del menu 
completo.
Il display passa dal menu completo alla 
schermata dei clip.
Il trasferimento dei clip può essere 
effettuato sia dalla schermata dei clip che 
dalla schermata filtrata dei clip.

3	 Selezionare il clip da trasferire, quindi 
premere il pulsante MENU.
Viene visualizzata una schermata di 
conferma del trasferimento.

4	 Selezionare Execute.
Il gruppo di file corrispondente ai clip 
proxy selezionati viene registrato come 
operazione di trasferimento e l’upload ha 
inizio.
Non appena l’operazione di trasferimento 
viene registrata, appare la schermata dei 
risultati del trasferimento.

5	 Selezionare OK.
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Trasferimento di tutti i clip
Per eseguire il trasferimento dei gruppi di file 
corrispondenti a tutti i clip proxy, selezionare 
All Clips invece di Select Clip al passo 2.

[Nota]
Possono essere registrati fino a 200 trasferimenti.

Upload dalla schermata dei clip di clip 
originali contenuti su una scheda di 
memoria

[Nota]
I clip originali sono caricati nella cartella “Main” della 
directory specificata come destinazione dell’upload.

1	 Collegare l’unità al dispositivo tramite una 
connessione LAN (pagina 80).

2	 Selezionare Transfer Clip >Select Clip nel 
menu Clip Operations del menu completo.
Il display passa dal menu completo alla 
schermata dei clip.
Il trasferimento dei clip può essere 
effettuato sia dalla schermata dei clip che 
dalla schermata filtrata dei clip.

3	 Selezionare il clip da trasferire, quindi 
premere il pulsante MENU.
Viene visualizzata una schermata di 
conferma del trasferimento.

4	 Selezionare Execute.
Il gruppo di file corrispondente ai clip 
selezionati viene registrato come 
operazione di trasferimento e l’upload ha 
inizio.
Non appena l’operazione di trasferimento 
viene registrata, appare la schermata dei 
risultati del trasferimento.

5	 Selezionare OK.

Trasferimento di tutti i clip
Per eseguire il trasferimento di tutti i file, 
selezionare All Clips invece di Select Clip al 
passo 2.

[Nota]
Possono essere registrati fino a 200 trasferimenti.

Controllo del trasferimento del file

È possibile controllare lo stato del 
trasferimento dei file selezionando File 
Transfer >View Job List (pagina 71) nel 
menu Network del menu completo.
È possibile controllare lo stato del 
trasferimento dei file anche nella schermata 
dell’applicazione Monitor & Control.

[Informazione]
Se File Transfer >Auto Upload (pagina 71) oppure 
Auto Upload (Proxy) (pagina 71) nel menu Network 
del menu completo è impostato su On ed è presente 
una connessione di rete, i clip originali e i clip proxy 
vengono automaticamente caricati sul server specificato 
in Default Upload Server (pagina 71) al termine della 
registrazione. Se è stato configurato l’upload automatico 
sia di clip originali che di clip proxy, avrà la precedenza 
l’upload automatico dei clip proxy.

[Note]
•• Possono essere registrati fino a 200 trasferimenti.
•• L’elenco dei trasferimenti permane anche dopo 

lo spegnimento dell’unità, tuttavia potrebbero 
andare persi fino a 10 minuti di informazioni 
sull’avanzamento dell’operazione qualora venga 
rimosso il pacco batteria oppure venga interrotta 
l’alimentazione dell’unità senza aver prima spostato il 
selettore di alimentazione su STANDBY.

•• I trasferimenti aggiunti dopo l’entrata in stato di bassa 
tensione batteria non sono salvati nell’elenco delle 
operazioni.

•• Qualora si verificasse un errore durante il 
trasferimento di un file, il trasferimento di un clip con 
lo stesso nome di un clip trasferito potrebbe non 
venire ripreso, in base alle impostazioni e allo stato 
del server di destinazione del trasferimento. In tal 
caso, controllare le impostazioni e lo stato del server 
di destinazione del trasferimento.

Upload automatico dei clip

Upload automatico di clip originali

Al termine della registrazione, è possibile 
eseguire l’upload dei clip originali su un server 
specificato. Per abilitare questa funzione, 
impostare su On la voce File Transfer >Auto 
Upload (pagina 71) nel menu Network del 
menu completo.

Upload automatico di clip proxy

Al termine della registrazione, è possibile 
eseguire l’upload dei clip proxy su un server 
specificato. Per abilitare questa funzione, 
impostare su On la voce File Transfer >Auto 
Upload (Proxy) (pagina 71) nel menu 
Network del menu completo.

Upload tramite Secure FTP

Per proteggere con crittografia l’upload di 
file, è possibile utilizzare il protocollo FTPS 
in modalità Explicit (FTPES) per realizzare la 
connessione con il file server di destinazione.

Configurazione del trasferimento in 
modalità Secure FTP

Per utilizzare il protocollo Secure FTP, 
configurare su ON l’opzione Using Secure 
Protocol nelle impostazioni del file server 
di destinazione ed importare il relativo 
certificato.
Per informazioni dettagliate sulla 
configurazione, fare riferimento a 
“Registrazione di una destinazione di 
trasferimento file” (pagina 85).
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Utilizzo di Creators' App for enterprise
Collegando l’unità con l’applicazione per 
smartphone “Creators' App for enterprise” è 
semplicissimo trasferire file sul servizio cloud 
C3 Portal.
Innanzitutto, ottenere un account C3 Portal e 
installare Creators' App for enterprise su uno 
smartphone.
Per informazioni dettagliate su come ottenere 
un account del servizio cloud C3 Portal, 
rivolgersi all’amministratore della propria 
organizzazione.

[Note]
•• Questo servizio può non essere disponibile in tutte le 

regioni geografiche.
•• Per informazioni dettagliate sull’utilizzo di Creators' 

App for enterprise, fare riferimento alla relativa Guida.

Upload di file su C3 Portal

1	 Selezionare Network Setup >Setup for 
Mobile App (pagina 68) nel menu 
Network del menu completo.
Viene visualizzata una schermata di 
conferma per gli elementi che verranno 
aggiornati automaticamente.
Le seguenti impostazioni del menu 
Network sono selezionate 
automaticamente.
•• USB Tethering >Setting: On
•• USB Tethering >Camera Remote Control: 

Enable
•• Network Setup >Input Password: 

(Generata automaticamente se non 
specificata)

2	 Controllare le impostazioni e selezionare 
OK.
La procedura di configurazione si avvia. 
Mentre è in corso la configurazione, viene 
visualizzato il messaggio “Now changing”.
Al completamento della configurazione, 

viene visualizzata sul mirino la seguente 
schermata.

Vengono visualizzate le seguenti 
informazioni per l’autenticazione 
dell’accesso.
Nome utente, password, impronta 
digitale, nome del modello della 
telecamera, numero di serie

	 [Informazione]
Questa schermata non viene emessa sull’uscita 
video.

	 [Nota]
Evitare che la password possa essere vista e 
che il codice QR possa essere copiato da altri. In 
particolare, quando il formato di uscita video è 
impostato su Monitor FHD o durante l’uscita HDMI, 
è importante ricordare che la pagina del menu 
verrà visualizzata su un monitor esterno qualora 
il codice QR e le impostazioni della password nel 
menu completo vengano visualizzate mentre è 
aperta la schermata dell’elenco dei clip.

3	 Avviare Creators' App for enterprise sullo 
smartphone e accedere al servizio cloud.

4	 Collegare lo smartphone al connettore 
USB-C dell’unità tramite un cavetto USB.

5	 Abilitare il tethering USB sullo schermo 
dello smartphone.
Per informazioni dettagliate sulla 
configurazione, fare riferimento a 
“Collegamento tramite tethering USB” 
(pagina 83).
Le operazioni richieste potranno variare a 
seconda dello smartphone. Fare 
riferimento al manuale per l’uso dello 

smartphone.

6	 Eseguire la scansione del codice QR 
visualizzato sul mirino seguendo le 
istruzioni visualizzate nella schermata di 
Creators' App for enterprise.
Le informazioni di configurazione del 
trasferimento file vengono inviate dallo 
smartphone all’unità e viene visualizzato 
il messaggio riportato di seguito.

7	 Selezionare OK.
Ha inizio il caricamento delle informazioni 
di configurazione.
Al termine del caricamento della 
configurazione, viene visualizzato il 
messaggio “Network File loaded.”.

[Note]
•• Creators' App for enterprise sovrascrive le 

impostazioni di File Transfer (pagina 71) nel menu 
Network dell’unità.

•• Il certificato radice non può essere impostato 
automaticamente. Deve essere configurato 
manualmente.

Upload di clip originali

Impostare File Transfer >Auto Upload 
(pagina 71) nel menu Network su On per 
abilitare l’upload dei clip originali su C3 Portal.
Al termine di ciascuna registrazione, il file 
viene caricato sull’ubicazione associata 
all’account C3 Portal.

Upload di clip proxy

Impostare File Transfer >Auto Upload (Proxy) 
(pagina 71) nel menu Network su On per 
abilitare l’upload dei clip proxy su C3 Portal.
Al termine di ciascuna registrazione, il file 
viene caricato sull’ubicazione associata 

all’account C3 Portal.

Upload di clip selezionati

Vedere “Selezione e upload di clip” 
(pagina 85).

[Informazioni]
•• I file inviati dall’unità vengono memorizzati nella 

cache di Creators' App for enterprise e quindi trasferiti 
a C3 Portal. L’indicazione dello stato del trasferimento 
di file sull’unità indica lo stato del trasferimento a 
Creators' App for enterprise.

•• Al termine del trasferimento dei file dall’unità a 
Creators' App for enterprise sullo smartphone, è 
possibile spegnere l’unità. Si osservi tuttavia che il 
trasferimento dei file dallo smartphone potrebbe 
essere ancora in corso. Tenere sotto controllo la carica 
rimanente della batteria dello smartphone.

Altre funzioni che utilizzano C3 
Portal

Gestione dei file 3D LUT

È possibile importare sull’unità i file 3D 
LUT memorizzati su C3 Portal. Vedere 
“Importazione da un servizio cloud” 
(pagina 93).

Gestione dei file ALL

I file ALL creati sull’unità possono essere 
salvati su C3 Portal. Analogamente, è possibile 
caricare sull’unità file ALL memorizzati su 
C3 Portal. Vedere “Salvataggio di un file 
ALL su un servizio cloud” (pagina 74) e 
“Caricamento di un file ALL da un servizio 
cloud” (pagina 74).
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Configurazione delle operazioni di base
Prima di iniziare le riprese, è necessario 
configurare il funzionamento di base dell’unità 
secondo l’applicazione specifica nella 
schermata di stato Project.

Modalità di ripresa

Sono disponibili due modalità di ripresa: 
la modalità “Cine EI”, in cui l’unità viene 
utilizzata in maniera analoga a una macchina 
cinematografica a pellicola, sviluppando poi 
le immagini in sede di post produzione, e la 
modalità “Custom”, che consente la creazione 
dell’immagine in sito con la massima 
flessibilità.
Impostare la modalità di ripresa con Shooting 
Mode (pagina 30) nella schermata di stato 
Project.

[Informazione]
La modalità di ripresa può essere impostata anche con 
Base Setting >Shooting Mode (pagina 46) nel menu 
Project del menu completo.

Cine EI

Quando la modalità di ripresa è impostata 
su Cine EI, selezionare il gamut di colori di 
base per il segnale di registrazione e per il 
segnale di uscita. Il gamut di colori selezionato 
qui è il gamut di colori del video registrato 
e dell’uscita video quando Monitor LUT è 
impostata su Off.
È possibile impostare il gamut di colori 
desiderato mediante Cine EI Setting >Color 
Gamut (pagina 47) nel menu Project del 
menu completo.
•• S-Gamut3.Cine/SLog3: Gamut di colore 

per il cinema digitale di facile regolazione 
(DCI-P3).

•• S-Gamut3/SLog3: Gamut di colori Sony 
molto ampio che copre lo gamut di colori 
ITU-R BT.2020.

Per informazioni dettagliate, vedere 
pagina 92.

[Note]
•• La modalità di ripresa Cine EI presenta le seguenti 

limitazioni:
•• Funzioni che non possono essere regolate 

automaticamente
–– Bilanciamento del bianco
–– Guadagno
–– Shutter

•• Funzioni che non possono essere configurate
–– Sensibilità ISO/guadagno (impostata sulla 

sensibilità ISO di base (fissa))
–– Impostazioni menu Paint/Look (eccetto Base 

Look)
–– File di scena (disabilitato)

•• Le funzioni indicate di seguito sono disponibili solo 
nella modalità di ripresa Cine EI (pagina 92).

•• Exposure Index
•• Monitor LUT

•• Durante la registrazione in Cine EI, si consiglia di 
mantenere costante l’impostazione di Exposure Index. 
Qualora si modifichi l’impostazione di Exposure Index, 
la correzione della luminosità potrebbe risultare 
molto difficile in sede di post produzione, rendendo 
probabilmente impossibile la riproduzione dello stato 
esistente al momento della ripresa originale delle 
immagini.

Custom

Nella modalità di ripresa Custom è possibile 
selezionare lo standard video utilizzato.
Lo standard video può essere impostato con 
Base Setting >Target Display (pagina 46) nel 
menu Project del menu completo.
•• SDR(BT.709): Ripresa con lo standard di 

broadcast HD
•• HDR(HLG): Ripresa con lo standard di 

broadcast 4K di prossima generazione
Per informazioni dettagliate, vedere 
pagina 94.

Frequenza di sistema

Impostare la frequenza di sistema con 
Frequency/Scan (pagina 30) nella 
schermata di stato Project. Dopo la selezione, 
l’unità potrebbe riavviarsi automaticamente, a 
seconda del valore selezionato.

[Informazione]
La frequenza di sistema può essere impostata anche con 
Rec Format >Frequency (pagina 46) nel menu Project 
del menu completo.

[Nota]
Non è possibile cambiare la frequenza di sistema 
durante la registrazione o la riproduzione.

Modalità di scansione imager

Le dimensioni di immagine effettive e la 
risoluzione del sensore immagini possono 
essere impostate secondo le proprie esigenze.
Impostare la modalità di scansione con Imager 
Scan (pagina 30) nella schermata di stato 
Project.
•• FF 8.6K 16:9, FF 8.6K 17:9, FFc 6K 16:9, FFc 

6K 17:9, FFc 3.8K 16:9: Utilizzare con il pieno 
formato.

•• S35 5.8K 16:9, S35 5.8K 17:9, S35 4.3K 4:3, 
S35c 4K 17:9, S35 1.9K 16:9: Utilizzare con il 
formato Super 35mm.

[Informazione]
La modalità di scansione può essere impostata anche 
con Rec Format >Imager Scan Mode (pagina 46) nel 
menu Project del menu completo.

[Nota]
Non è possibile cambiare la modalità di scansione 
dell’imager durante la registrazione o la riproduzione.
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Dimensioni immagine effettive

L’unità consente la ripresa nelle dimensioni immagine effettive indicate di seguito. (Unità di 
misura: mm)

FF 8.6K 16:9
(35.9x20.2)

FF 8.6K 17:9
(35.9x18.9)

FFc 6K 16:9
(33.6x18.9) 

FFc 6K 17:9
(33.6x17.7) 

S35 1.9K 16:9
S35 5.8K 16:9

(24.0x13.5)

S35 5.8K 17:9
(24.0x12.6)

S35c 4K 17:9
(17.0x9.0)

S35 4.3K 4:3
(23.6x17.7)

FFc 3.8K 16:9
(32.0x18.0)

Codec

Impostare il codec con Codec (pagina 30) 
nella schermata di stato Project. Dopo 
la selezione, l’unità potrebbe riavviarsi 
automaticamente, a seconda del valore 
selezionato.

[Informazione]
Il codec può essere impostato anche con Rec Format 
>Codec (pagina 46) nel menu Project del menu 
completo.

[Note]
•• Non è possibile cambiare il codec durante la 

registrazione o la riproduzione.
•• 	L’unità si riavvia durante il passaggio da o a X-OCN o 

XAVC.
•• 	Nel formato X-OCN, sono presenti limitazioni al 

segnale di uscita video. Per informazioni dettagliate, 
vedere pagina 122.

•• È necessario impostare la modalità di ripresa su Cine 
EI prima di poter passare a X-OCN.

Formato video

È possibile scegliere il formato video per le 
registrazioni. Impostare il formato video con 
Video Format (pagina 30) nella schermata 
di stato Project.

[Informazione]
Il formato video può essere impostato anche con Rec 
Format >Video Format (pagina 46) nel menu Project 
del menu completo.

[Note]
•• 	Non configurabile nel formato X-OCN.
•• Non è possibile cambiare il formato video durante la 

registrazione o la riproduzione.
•• In base alle impostazioni del formato video, 

potrebbero essere presenti limitazioni relative al 
segnale fornito dai connettori SDI OUT e HDMI OUT.
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Operazioni di base
Di seguito si descrive la procedura per 
eseguire una semplice ripresa di base.

1	 Montare i dispositivi necessari e 
controllare che l’alimentazione sia 
presente.

2	 Inserire almeno una scheda di memoria.

	 [Nota]
Prima di avviare la ripresa, eseguire un backup dei 
clip, quindi eseguire una formattazione completa 
del supporto di registrazione utilizzando Format 
Media (pagina 57) nel menu TC/Media del menu 
completo.

3	 Accendere l’unità.
La spia di alimentazione si illumina e 
l’immagine proveniente dalla telecamera 
appare sul monitor LCD.

4	 Premere il pulsante REC (avvio/arresto 
registrazione) (pagina 4).
La spia REC si illumina e si avvia la 
registrazione.

5	 Per arrestare la registrazione, premere di 
nuovo il pulsante REC (avvio/arresto 
registrazione).
La registrazione si arresta e l’unità passa 
alla modalità STBY (standby di 
registrazione).

[Nota]
Se si preme il pulsante REC (avvio/arresto registrazione) 
nei primi secondi immediatamente dopo l’accensione 
dell’unità, la spia REC si illumina per indicare che 
l’unità si trova in stato di registrazione. Ciononostante, 
a seconda del formato di registrazione selezionato, 
potrebbero essere necessari alcuni secondi prima 
dell’avvio effettivo della registrazione sul supporto di 
memoria.

Passaggio da una scheda di 
memoria all’altra

Quando sono inserite due schede di memoria, 
premere il pulsante SLOT SELECT (pagina 4) 
per passare da una scheda all’altra.
La registrazione passa automaticamente 
alla seconda scheda di memoria appena 
immediatamente prima dell’esaurimento 
completo dello spazio sulla prima scheda 
(registrazione relay). È possibile eseguire 
registrazioni continuate ininterrottamente 
sostituendo ogni volta la scheda di memoria 
piena con una nuova.

[Nota]
Non è possibile passare da una scheda all’altra durante 
la riproduzione. Non è inoltre possibile la riproduzione 
continuata di un clip che si estende su entrambe le 
schede di memoria dei due slot A e B.

Clip (dati registrati)
Quando si arresta la registrazione, il video, 
l’audio e i dati accessori dall’inizio alla fine 
della registrazione vengono salvati come un 
unico “clip” sulla scheda di memoria.

Nome dei clip
Il nome dei clip registrati dall’unità viene 
assegnato automaticamente utilizzando il 
formato impostato tramite la voce Clip Name 
Format (pagina 57) nel menu TC/Media del 
menu completo.

Durata massima dei clip
Fino a 6 ore per clip.
La durata massima di una registrazione 
continua è identica alla durata massima di 
un clip. Se il tempo di registrazione del clip 
supera la lunghezza massima consentita, viene 
creato automaticamente un nuovo clip e la 
registrazione continua. Il nuovo clip apparirà 
come un clip separato sulla schermata dei clip.

Nella funzione di registrazione continua 
(relay), vengono registrati più clip in 
successione l’uno dopo l’altro. In questa 
modalità, la registrazione si arresta 
automaticamente dopo circa 24 ore.

[Note]
•• Non espellere una scheda di memoria mentre 

è in corso la registrazione su di essa. Durante la 
registrazione, sostituire schede di memoria solo negli 
slot il cui indicatore di accesso non è illuminato.

•• Quando la capacità rimanente sulla scheda di 
memoria su cui viene eseguita la registrazione 
diventa inferiore a un minuto ed è presente una 
scheda di memoria registrabile nell’altro slot, viene 
visualizzato il messaggio “Will Switch Slots Soon”. Il 
messaggio scompare dopo il passaggio all’altro slot.

•• La registrazione relay può non essere possibile se 
la registrazione viene avviata quando la capacità 
rimanente della scheda di memoria è inferiore a un 
minuto. Per consentire il funzionamento corretto 
della registrazione relay, controllare che la capacità 
rimanente sulla scheda di memoria sia superiore a un 
minuto prima di iniziare la registrazione.

•• I video creati con la funzione di registrazione relay 
dell’unità non possono essere riprodotti senza 
interruzioni sull’unità.

•• Per unire insieme video creati con la funzione di 
registrazione relay dell’unità, utilizzare il software 
“Catalyst Browse”.

Monitoraggio audio

L’audio registrato può essere monitorato 
tramite le cuffie.
Collegando delle cuffie al relativo jack 
(pagina 4) è possibile monitorare 
l’audio durante la registrazione. L’audio 
di riproduzione (pagina 79) può essere 
monitorato sia tramite l’altoparlante 
incorporato (pagina 4) che le cuffie.
Il volume dell’audio di monitoraggio può essere 
regolato mediante Volume (pagina 30) nella 
schermata di stato Audio o mediante Audio 
Output >Volume (pagina 62) nel menu Audio 
del menu completo.

Il canale da monitorare può essere selezionato 
mediante Monitor CH (pagina 30) nella 
schermata di stato Audio o mediante Audio 
Output >Monitor CH (pagina 62) nel menu 
Audio del menu completo.

Specifica dei dati temporali

Impostazione del codice temporale

Impostare il codice temporale da registrare 
con la voce Timecode (pagina 56) del menu 
TC/Media del menu completo.

Impostazione dei bit utente

È possibile aggiungere all’immagine 
registrata un numero esadecimale a 8 cifre 
come bit utente. Il bit utente può essere 
anche impostato sull’ora corrente. Eseguire 
l’impostazione con Users Bit (pagina 56) nel 
menu TC/Media.

Visualizzazione dei dati temporali

Specificare il codice temporale da visualizzare 
mediante l’opzione TC Display (pagina 56) 
>Display Select del menu TC/Media.
Premendo un pulsante programmabile 
(pagina 108) a cui è assegnata la funzione 
DURATION/TC/U-BIT, è possibile visualizzare 
in sequenza il codice temporale, i bit utente e 
la durata.
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Commutazione entrata/uscita del codice 
temporale

Il selettore TC/REF IN/OUT (pagina 6) 
consente di scegliere se il codice temporale 
deve essere ricevuto in entrata o emesso in 
uscita.
Per informazioni dettagliate, vedere 
pagina 116.

Rivedere una registrazione  
(Rec Review)

È molto semplice rivedere sullo schermo 
l’ultimo clip registrato (revisione della 
registrazione).

[Nota]
La funzione Rec Review non è supportata se il formato 
video è stato modificato dopo la registrazione del clip.

Metodo di revisione della registrazione

Assegnare in anticipo la funzione Rec Review 
a uno dei pulsanti programmabili.
Mentre la registrazione è arrestata, premere 
il pulsante programmabile (pagina 108) a 
cui è assegnata la funzione Rec Review. La 
riproduzione dell’ultimo clip registrato si avvia.
Il clip viene riprodotto fino alla fine e l’unità 
esce dalla funzione Rec Review tornando alla 
modalità di STBY (standby).

Per arrestare Rec Review

Premere il pulsante programmabile a cui è 
assegnata la funzione Rec Review oppure 
premere il pulsante BACK.

Impostazioni della revisione della 
registrazione

È possibile impostare la posizione di avvio 
della riproduzione su una delle seguenti 
opzioni tramite la voce Rec Review 
(pagina 64) del menu Technical.
•• Ultimi 3 secondi del clip
•• Ultimi 10 secondi del clip
•• Inizio del clip

[Informazione]
Per rivedere un determinato clip dopo averne registrato 
diversi, premere il pulsante CLIPS per visualizzare la 
schermata dei clip, quindi selezionare il clip desiderato 
per avviarne la riproduzione.
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Ripresa con regolazione del look in post-produzione
Utilizzando l’unità in modalità Cine EI e 
registrando con una gradazione uniforme 
dell’intero campo dalle ombre alle alte luci, 
sarà possibile effettuare regolazioni fini 
in sede di post produzione, ad esempio, 
ripristinando la gradazione delle alte luci e 
delle ombre solo localmente.
In questo caso, tuttavia, se visualizzate su un 
monitor convenzionale, le immagini registrate 
avranno un contrasto generale piuttosto 
basso, rendendo più difficoltoso il controllo 
della messa a fuoco e dell’esposizione.
È possibile applicare una LUT al monitor 
utilizzato con l’unità per facilitare varie 
regolazioni durante le riprese. È possibile 
applicare una LUT anche al video di 
riproduzione per verificare il risultato finito.
Le LUT sono applicate dai sistemi indicati di 
seguito. Potrà essere applicata una sola LUT 
alla volta.
•• Durante la registrazione X-OCN:

–– Uscita SDI oppure uscita HDMI (solo una 
uscita)

–– Monitor LCD, proxy, streaming
•• Modalità diverse dalla registrazione X-OCN:

–– Uscita SDI
–– Uscita HDMI, monitor LCD, proxy e 
streaming

[Note]
•• Se il formato di uscita video SDI 1 ha una risoluzione 

di 4096×2160 o 3840×2160, non è possibile applicare 
una LUT al video di uscita SDI.

•• Se il formato di uscita video HDMI ha una risoluzione 
di 3840×2160, non è possibile applicare una LUT al 

video di uscita HDMI.

Applicazione di una LUT 
all’immagine del monitor LCD

1	 Premere il pulsante MENU per visualizzare 
la schermata di stato Monitoring.

2	 Selezionare la colonna Gamut/Gamma 
nella riga LCD/Stream.

3	 Selezionare On o Off.

[Note]
•• L’impostazione LUT On/Off del monitor LCD viene 

applicata anche al file proxy e al video in streaming 
durante la registrazione X-OCN. Per i formati diversi 
dalla registrazione X-OCN, viene applicata anche 
all’uscita HDMI, ai file proxy e al video in streaming.

•• Mentre è attiva la funzione di ingrandimento della 
messa a fuoco è disponibile anche la funzione di 
assistenza alla visualizzazione gamma.

[Informazioni]
•• È possibile anche eseguire l’impostazione della 

LUT mediante LUT On/Off (pagina 44) nel menu 
Shooting del menu completo.

•• SDI e HDMI possono essere impostati in maniera 
analoga al monitor LCD.

Modifica di una LUT

1	 Premere il pulsante MENU per visualizzare 
la schermata di stato Monitoring.

2	 Selezionare il campo Base Look/LUT.

3	 Selezionare la LUT da applicare nell’elenco 
dei look di base.

[Informazioni]
•• L’unità dispone delle seguenti LUT preimpostate: 

s709, 709(800%), S-Log3, Warm, Cool, Vintage, Teal 
and Orange, ACESproxy, ACEScct e ACES 1.0 Output-
Rec.709.

•• È possibile anche importare ed applicare un 
file 3D LUT. Per informazioni dettagliate, vedere 
“Importazione del look di base desiderato” 
(pagina 92) e “Eliminazione di un look di base” 
(pagina 93).

•• Il look di base può essere impostato anche mediante 
Base Look >Select (pagina 53) nel menu Paint/Look 
del menu completo.

Importazione del look di base 
desiderato

È possibile importare da una scheda di 
memoria o da un servizio cloud un file 3D LUT 
creato con un computer o un altro dispositivo 
e utilizzarlo come look di base. Possono essere 
importati fino a 16 file.
•• Formato file: file CUBE (*.cube) per una 3D 

LUT a 17 grid o 33 grid creato utilizzando 
Catalyst Browse o RAW Viewer

•• Gamma/gamut di colori di ingresso: 
S-Gamut3.Cine/S-Log3 o S-Gamut3/S-Log3

•• Le dimensioni prevista dei file CUBE 
importati è di circa 1 MB per i file a 33 grid. 
Non è possibile importare file CUBE di 
dimensioni superiori.  
A seconda delle sue dimensioni, potrebbe 
non essere possibile salvare il file CUBE 
originale nella memoria non volatile 
dell’unità anche se tale file può essere 
importato. In questo caso, i metadati del file 
3D LUT non possono essere registrati anche 
se l’opzione Cine EI Setting >Embed LUT File 
(pagina 47) del menu Project nel menu 
completo è impostata su On.  

Nell’elenco dei look di base, i look che 
presentano questo problema sono 
identificati con l’icona  visualizzata di 
fronte al nome del look stesso.

Importazione da una scheda di memoria

È possibile importare un file 3D LUT da una 
scheda di memoria.

1	 Sul computer o altro dispositivo, salvare il 
file 3D LUT nella cartella specificata del 
supporto di registrazione.

Supporto di 
registrazione

Percorso cartella

Scheda SD /PRIVATE/SONY/PRO/LUT/

2	 Inserire la scheda di memoria su cui sono 
salvati i file 3D LUT nello slot per schede 
Utility SD.

3	 Selezionare Base Look >Import from Utility 
SD (pagina 53) nel menu Paint/Look 
del menu completo.

4	 Selezionare la destinazione di 
importazione.

5	 Selezionare il file 3D LUT da importare.
Seguire le istruzioni indicate a schermo. 
L’unità può gestire il file 3D LUT come look 
di base.

6	 Selezionare il file 3D LUT importato con la 
voce Base Look >Select (pagina 53) nel 
menu Paint/Look del menu completo.

7	 Configurare Base Look >Input e Output 
(pagina 53) nel menu Paint/Look del 
menu completo per riflettere gli attributi 
del file 3D LUT importato.
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Importazione da un servizio cloud

È possibile importare un file 3D LUT da un 
servizio cloud.

1	 Collegarsi all’unità dall’app per 
smartphone “Creators’ App for enterprise” 
(pagina 87).

2	 Selezionare Base Look >Import from 
Cloud(Private) oppure Import from 
Cloud(Share) (pagina 53) nel menu 
Paint/Look del menu completo.

3	 Selezionare la destinazione di 
importazione.

4	 Selezionare il file 3D LUT da importare.
Seguire le istruzioni indicate a schermo. 
L’unità può gestire il file 3D LUT come look 
di base.

5	 Selezionare il file 3D LUT importato con la 
voce Base Look >Select (pagina 53) nel 
menu Paint/Look del menu completo.

6	 Configurare Base Look >Input e Output 
(pagina 53) nel menu Paint/Look del 
menu completo per riflettere gli attributi 
del file 3D LUT importato.

Gestione della sottoesposizione

Qualora si rilevi una tendenza alla 
sottoesposizione quando è selezionata 
l’esposizione automatica durante l’uso di un 
look di base importato, correggere secondo 
le esigenze Base Look >AE Level Offset 
(pagina 53) nel menu Paint/Look.

[Note]
•• La sola importazione di un file 3D LUT non ha alcun 

effetto sull’immagine. Caricare il file 3D LUT importato 
mediante Base Look >Select (pagina 53) nel menu 
Paint/Look del menu completo.

•• Se Input non è impostato correttamente, non sarà 
possibile ottenere il look desiderato.

•• Le impostazioni delle voci di menu Input, Output 
e AE Level Offset sono applicate al menu di base 
selezionato con Select. Se è stato importato più 
di un file 3D LUT, è necessario selezionare Select 
e configurare Input, Output e AE Level Offset 
individualmente per ciascuno di tali file 3D LUT.

•• Le impostazioni configurate di Input, Output e 
AE Level Offset sono salvate individualmente per 
ciascuno dei file 3D LUT.

•• Le opzioni di selezione del look di base e della LUT 
per i file 3D LUT importati sono comuni alle modalità 
Custom e Cine EI, ma la conversione di gamma e 
gamut di colori non viene eseguita in base a tali 
modalità.

•• L’esecuzione di All Reset >Reset nel menu 
Maintenance del menu completo non elimina i file 
3D LUT.

Eliminazione di un look di base

È possibile eliminare un file 3D LUT 
precedentemente importato utilizzando Base 
Look >Delete (pagina 53) nel menu Paint/
Look del menu completo.
È possibile eliminare tutti file 3D LUT 
precedentemente importati utilizzando Base 
Look >Delete All (pagina 53) nel menu 
Paint/Look del menu completo.

[Note]
•• Prima dell’eliminazione, controllare che il look di base 

non sia utilizzato in nessun file di scena. Se viene 
eliminato un look di base utilizzato in file di scena, 
il look dei file di scena che lo utilizzano non sarà 
corretto.

•• I look di base eliminati non sono più utilizzabili nella 
modalità Custom (pagina 92).

•• La selezione di All Reset >Reset (pagina 72) nel 
menu Maintenance del menu completo non elimina i 
file 3D LUT importati.

Registrazione di un file 3D LUT 
come metadati

Il camcorder consente di registrare un file 
3D LUT (file CUBE) che viene applicato 
all’immagine di monitoraggio durante la 
ripresa come metadati per il clip.
Per abilitare questa funzione, impostare Cine 
EI Setting >Embed LUT File (pagina 47) nel 
menu Project del menu completo su On.
Il file 3D LUT (file CUBE) selezionato all’avvio 
della registrazione viene registrato come 
metadati.
Tuttavia, la registrazione come metadati non è 
possibile nelle seguenti circostanze:
•• Quando non è possibile salvare il file 

3D LUT (file CUBE) sulla telecamera, ad 
esempio perché le dimensioni del file 3D 
LUT importato superano i 1,25 MB (davanti 
al nome del file appare l’indicazione “!” 
quando viene selezionato Base Look)

•• Quando il file 3D LUT selezionato può 
essere salvato, ma i dati di LUT da utilizzare 
vengono modificati immediatamente prima 
dell’avvio della registrazione.

[Note]
•• È possibile registrare un solo elemento di metadati 

per ciascun clip.
•• Durante la registrazione X-OCN, la registrazione di un 

file 3D LUT come metadati non è supportata.
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Ripresa con il Look desiderato
Impostando l’unità nella modalità Custom, è 
possibile regolare i valori di nero, matrice ed 
altri parametri per creare “look” personalizzati 
basati sul look di base.

Look di 
base

Look Nero

:

Matrice

Salvando diverse combinazioni di 
impostazioni in file di scena diventa quindi 
possibile selezionare rapidamente look diversi 
secondo le proprie esigenze.
L’unità dispone di sei look preconfigurati.

Selezione di un look

1	 Mentre è visualizzata la schermata di 
ripresa, premere la manopola 
multifunzione.

2	 Selezionare l’icona  (file di scena).
Il numero nell’icona indica il numero del 
file.

3	 Premere la manopola multifunzione.

4	 Selezionare il look desiderato nel menu e 
quindi premere la manopola 
multifunzione.

[Informazioni]
•• Nelle impostazioni predefinite sono preconfigurati i 

seguenti preset:

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

File di scena 1 S-Cinetone HLG Live

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

File di scena 2 Standard HLG Natural

File di scena 3 Still (Non 

registrato)

File di scena 4 ITU709 (Non 

registrato)

File di scena 5 709tone (Non 

registrato)

File di scena da 6 a 16 (Non 

registrato)

(Non 

registrato)

•• È possibile selezionare un look utilizzando la voce 
Scene File >Recall (pagina 53) nel menu Paint/
Look del menu completo. Utilizzare Scene File >Preset 
Recall per richiamare un look preconfigurato.

Personalizzazione di un look

Se si desidera eseguire riprese utilizzando un 
look diverso da quelli preimpostati, è possibile 
creare un look personalizzato partendo da un 
look di base, modificando secondo le proprie 
esigenze i valori di Black, Knee, Detail, Matrix 
e Multi Matrix nel menu Paint/Look del menu 
completo. Per informazioni dettagliate sulle 
varie voci di impostazione, fare riferimento a 
pagina 53.
Collegare l’unità a un televisore o a un 
monitor e regolare la qualità dell’immagine 
osservandola sullo schermo.

[Nota]
Quando si importa e si applica all’immagine un file 
3D LUT, non sarà possibile ottenere il look desiderato 
e definito in tale file se sono state modificate le 
impostazioni di Matrix e altre impostazioni diverse 
da quelle del look di base nel menu Paint/Look. È 
possibile resettare tutte le impostazioni personalizzate 
mediante Reset Paint Settings >Reset without Base Look 
(pagina 53) nel menu Paint/Look del menu completo.

Salvataggio di un look

Il look corrente può essere salvato come file 
di scena nella memoria interna del camcorder 
utilizzando la voce Scene File >Store 
(pagina 53) nel menu Paint/Look del menu 
completo.
È possibile eseguire rapidamente il 
salvataggio tramite le funzionalità del Direct 
Menu nella schermata di ripresa.

[Note]
•• Se viene selezionato un altro look senza aver prima 

salvato il look corrente, il look corrente andrà perso.
•• L’esecuzione di All Reset >Reset (pagina 72) nel 

menu Maintenance del menu completo non elimina i 
file di scena.

[Informazione]
I file di scena preconfigurati possono essere sovrascritti.
Per ripristinare un file di scena preconfigurato, caricare il 
look da ripristinare mediante la voce Scene File >Preset 
Recall (pagina 53) nel menu Paint/Look del menu 
completo, quindi salvare il file di scena con Scene File 
>Store.

Eliminazione di un look salvato

È possibile eliminare file di scena salvati nella 
memoria interna del camcorder utilizzando 
la voce Scene File >Delete (pagina 53) nel 
menu Paint/Look del menu completo.

[Informazione]
I file di scena eliminati, non sono più visualizzati nel 
Direct Menu.
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Azionamento dello zoom
Il camcorder consente di regolare lo zoom in 
base alle condizioni di ripresa.

Se è montato un obiettivo zoom, è possibile 
azionarne lo zoom utilizzando la levetta dello 
zoom dell’impugnatura di telecomando o di 
una maniglia (opzione) dotata di slitta MI. La 
velocità di zoom varia in base alla pressione 
applicata alla levetta.
L’unità è dotata di una funzione di zoom che 
utilizza una metodologia di elaborazione 
del segnale denominata Clear Image Zoom. 
Quando Clear Image Zoom è attivato, diventa 
possibile eseguire zoom anche con obiettivi 
a focale fissa. Questa funzione consente di 
estendere il campo di zoom oltre al campo 
ottico fisicamente disponibile su obiettivi con 
zoom motorizzato.
Il rapporto massimo di zoom offerto da Clear 
Image Zoom varia a seconda della risoluzione 
di registrazione.
•• Con risoluzione di registrazione QFHD/4K: 

1,5×
•• Con risoluzione di registrazione HD: 2×

[Note]
•• Clear Image Zoom può essere utilizzato solo quando 

la modalità di scansione imager (pagina 88) è 
impostata su S35 5.8K 17:9, S35 5.8K 16:9 o S35 1.9K 
16:9.

•• Se è montato un obiettivo con attacco PL, la funzione 
Clear Image Zoom non è supportata dai comandi 
dell’obiettivo.

•• La funzione Clear Image Zoom non è supportata nelle 
registrazioni X-OCN.

Selezione del tipo di zoom

Selezionare il tipo di zoom mediante Zoom 
>Zoom Type (pagina 64) nel menu Technical 
del menu completo.
I tipi di zoom disponibili varieranno in base al 
tipo di obiettivo montato sul camcorder.

Obiettivo 
montato

Impostazione Zoom Type

Optical Zoom 
Only

On(Clear Image 
Zoom)

Obiettivo 
a lunghez-
za focale 
fissa o con 
zoom 
manuale

L’azionamento 
dello zoom 
tramite la levetta 
non è 
disponibile.

Clear Image 
Zoom è 
supportato.

Obiettivo 
con zoom 
motoriz-
zato

Solo zoom ottico Sono disponibili 
sia zoom ottico 
che Clear Image 
Zoom.

[Note]
•• Quando S&Q Motion >Setting (pagina 43) nel 

menu Shooting del menu completo è impostato su 
On, Clear Image Zoom non può essere utilizzato.

•• Se viene azionato il selettore SERVO/MANUAL 
dell’obiettivo, l’ingrandimento di Clear Image Zoom 
viene reimpostato su 1×.

Impostazione dello zoom della 
maniglia

Configurare l’impostazione della levetta dello 
zoom di una maniglia (opzione) dotata di 
una slitta MI utilizzando la voce Handle Zoom 
(pagina 65) nel menu Technical del menu 
completo.

Impostazione della direzione della 
ghiera dello zoom

Su alcuni obiettivi con innesto E-mount, è 
possibile invertire la direzione di rotazione 
della ghiera dello zoom.
La direzione di rotazione può essere 
selezionata mediante Lens >Zoom Ring 
Direction (pagina 65) nel menu Technical 
del menu completo.
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Regolazione della messa a fuoco
La messa a fuoco può essere regolata 
automaticamente o manualmente, in base alle 
condizioni di ripresa.

[Note]
•• Se è montato un obiettivo con attacco PL, non è 

possibile eseguire la messa a fuoco tramite i comandi 
dell’unità o dell’impugnatura di telecomando.

•• Quando il monitor LCD è in modalità di 
visualizzazione delle informazioni, non è possibile 
agire sulla schermata visualizzata su un monitor 
esterno utilizzando il selettore multiplo del monitor 
LCD.

Regolazione manuale della messa 
a fuoco (Manual Focus)

Per regolare manualmente la messa a fuoco, 
spostare il selettore FOCUS (pagina 4) su 
“MF”.
Questo consente di regolare la messa a fuoco 
manualmente secondo le condizioni di ripresa.
La messa a fuoco manuale è utile per le 
seguenti tipologie di soggetti:
•• Soggetti sull’altro lato di una finestra 

coperta di goccioline d’acqua
•• Soggetti con un basso contrasto rispetto 

allo sfondo
•• Soggetti più lontani in presenza di soggetti 

vicini

[Informazioni]
•• È possibile mantenere una messa a fuoco più stabile 

attendendo almeno 10 minuti dopo l’accensione 
dell’unità prima di regolare la messa a fuoco stessa.  
Inoltre, in caso di cambiamenti significativi della 
temperatura ambiente, è consigliabile regolare 
ulteriormente la messa a fuoco per mantenere 
condizioni di ripresa ottimali.

•• Nei seguenti casi, è possibile utilizzare la funzione 
di messa a fuoco automatica anche se viene 
principalmente utilizzata la messa a fuoco manuale.
–– Quando la sensibilità al cambiamento del soggetto 

AF è impostata su 1(Locked)
–– Quando il selettore FOCUS si trova sulla posizione 

“AF”

–– Ruotando la ghiera della messa a fuoco (AF Assist, 
pagina 99)

Messa a fuoco toccando lo schermo 
(Spot Focus)

Nella modalità di messa a fuoco manuale, è 
possibile specificare la posizione di messa a 
fuoco desiderata semplicemente toccando lo 
schermo touchscreen in tale punto.
Per utilizzare la funzione di messa a fuoco 
spot, impostare Focus >Touch Function in MF 
(pagina 43) nel menu Shooting su Spot 
Focus.
Toccando sullo schermo la posizione in cui 
si desidera effettuare la messa a fuoco, lo 
schermo visualizza un indicatore di messa a 
fuoco spot.

[Informazioni]
•• Mentre è attiva, è possibile disattivare 

momentaneamente la modalità di messa a fuoco 
spot e attivare invece la messa a fuoco automatica 
premendo un pulsante programmabile (pagina 108) 
a cui è stata assegnata la funzione Push AF/Push MF. 
La messa a fuoco ritorna alla modalità manuale non 
appena si rilascia il pulsante.

•• La funzione Spot Focus non è attiva se l’obiettivo è 
impostato per la messa a fuoco manuale.

•• Non è possibile specificare una posizione di 
messa a fuoco spot mentre è attiva la funzione di 
ingrandimento della messa a fuoco oppure quando 
Touch Operation (pagina 64) nel menu Technical è 
impostato su Off.

Utilizzo della funzione di messa a fuoco 
automatica temporanea (Push Auto 
Focus (AF))

Mentre è attiva la modalità di messa 
a fuoco manuale, è possibile attivare 
momentaneamente la messa a fuoco 
automatica premendo un pulsante 
programmabile (pagina 108) a cui è stata 
assegnata la funzione Push AF/Push MF, che 
rimane attiva fino a quando il pulsante rimane 
premuto.
La messa a fuoco avviene nell’area di messa 
a fuoco impostata tramite Focus >Focus Area 
(pagina 43) nel menu Shooting del menu 
completo.
La messa a fuoco ritorna alla modalità 
manuale non appena si rilascia il pulsante.
Questa funzione è utile quando si desidera 
spostare lentamente la messa a fuoco da un 
soggetto a un altro durante la messa a fuoco 
automatica.

[Nota]
La funzione Push Auto Focus non è attiva se l’obiettivo è 
impostato per la messa a fuoco manuale.

Messa a fuoco con vista ingrandita 
(Focus Magnifier)

È possibile selezionare la zona in cui eseguire 
l’ingrandimento della messa a fuoco mediante 
Focus Magnifier (pagina 60) nel menu 
Monitoring del menu completo. Il nome 
della funzione assegnata a un pulsante 
programmabile per l’ingrandimento della 
messa a fuoco cambierà in base a questa 
impostazione.
È possibile commutare l’ingrandimento della 
messa a fuoco sul monitor LCD premendo 
un pulsante programmabile (pagina 108) a 
cui è stata assegnata la funzione LCD Focus 
Magnifier. Ad ogni pressione del pulsante, 

l’ingrandimento al centro dello schermo 
cambia come indicato di seguito.

Impostazione 
del codec

Dimensioni 
immagine 
registrata

Ingrandimento

X-OCN 8K 3×, 6×

Valori diversi 
da 8K

Formati diversi 
da X-OCN

8K 4×

Valori diversi 
da 8K

3×, 6×

Questa funzione è utile per controllare la 
messa a fuoco.
Dopo aver raggiunto l’ingrandimento 
massimo, premendo nuovamente il pulsante 
si ritorna alla vista originale.
Durante l’ingrandimento della messa a 
fuoco, è possibile spostare la zona ingrandita 
utilizzando il selettore multiplo (pagina 5). 
Premere il selettore multiplo per tornare al 
centro dell’immagine.
È possibile commutare il valore di 
ingrandimento della messa a fuoco dell’uscita 
SDI e dell’uscita HDMI, come mostrato 
di seguito, anche premendo un pulsante 
programmabile (pagina 108) a cui è stata 
assegnata la funzione Output Focus Magnifier.

Imposta-
zione del 
codec

Dimensioni 
immagine 
registrata

Ingrandimento

SDI 
(FHD)

HDMI(FHD)/ 
Monitor FHD

X-OCN – 2×, 4× 2×, 4×

Formati 
diversi da 
X-OCN

8K – 4×

Valori diversi 
da 8K

– 2×, 4×

[Note]
•• L’immagine non viene ingrandita sulle uscite SDI 

(tranne nel caso in cui il formato di uscita video sia 
impostato su Monitor FHD), né sulle uscite SDI/HDMI 
non FHD.

•• Non è possibile applicare una LUT all’immagine in 
uscita se viene utilizzato l’ingrandimento della messa 
a fuoco sull’immagine di uscita HDMI, eccetto che 
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durante la registrazione X-OCN.
•• Allo spegnimento dell’unità, la posizione di 

ingrandimento ritorna al centro dello schermo.
•• 	All’immagine del monitor LCD potrà essere 

applicata una LUT se sull’immagine viene utilizzato 
l’ingrandimento della messa a fuoco quando è 
selezionato LUT Off durante la registrazione X-OCN.

•• Se viene utilizzato l’ingrandimento della messa 
a fuoco sull’immagine di uscita HDMI durante la 
registrazione X-OCN il video emesso sarà in formato 
Log.

Regolazione automatica della 
messa a fuoco (Auto Focus)

L’unità utilizza un sistema di messa a fuoco 
tramite rilevamento di fase per la messa a 
fuoco automatica ad alta velocità e tramite 
contrasto per la messa a fuoco di precisione.
La combinazione di questi due metodi di 
messa a fuoco automatica consente di ottenere 
contemporaneamente rapidità e precisione.
Per regolare automaticamente la messa a 
fuoco, spostare su “AF” il selettore FOCUS 
dell’unità (pagina 4). Se l’obiettivo è 
dotato di un selettore di messa a fuoco, 
spostarlo nella posizione “AF/MF” o “AF”. Se 
il selettore si trova nelle posizioni “Full MF” 
o “MF” non è possibile eseguire la messa a 
fuoco dall’unità .

[Informazione]
Quando Focus >AF Assist (pagina 43) nel menu 
Shooting del menu completo è impostato su On, rimane 
possibile eseguire la regolazione della messa a fuoco 
tramite la ghiera dell’obiettivo anche durante la messa a 
fuoco automatica.

[Note]
•• È necessario che sia montato un obiettivo che 

supporta la funzione di messa a fuoco automatica.
•• In base alle condizioni di ripresa potrebbe non essere 

possibile ottenere la massima precisione.
•• Non è possibile regolare automaticamente la messa a 

fuoco su obiettivi con attacco PL.

•• La messa a fuoco automatica non è utilizzabile 
quando De-Squeeze >Ratio (pagina 58) nel menu 
Monitoring del menu completo è stato impostato su 
un valore diverso da Off(1.0×).

Impostazione della zona di messa a 
fuoco automatica e della sua posizione 
(Focus Area)

È possibile impostare la zona di rilevamento 
per la messa a fuoco automatica mediante 
la voce Focus >Focus Area (pagina 43) nel 
menu Shooting del menu completo.

Flexible Spot:
Mette a fuoco una posizione specificata 
dell’immagine.
Quando è selezionata questa opzione, 
specificare la posizione utilizzando il selettore 
multiplo (pagina 5).
Per tornare alla posizione centrale, premere e 
mantenere premuto il selettore multiplo.

Zone:
Cerca automaticamente una posizione 
di messa a fuoco all’interno della zona 
specificata.
Quando è selezionata questa opzione, 
specificare la posizione utilizzando il selettore 
multiplo (pagina 5).
Per tornare alla posizione centrale, premere e 
mantenere premuto il selettore multiplo.

Wide:
Cerca il soggetto su un ampio angolo 
dell’immagine durante la messa a fuoco. Non 
viene visualizzato nessun riquadro.

[Informazione]
È possibile scegliere se visualizzare o meno il riquadro 
dell’area di messa a fuoco mediante l’opzione Display 
On/Off >Focus Area Indicator (pagina 58) nel menu 
Monitoring del menu completo.

[Nota]
Il riquadro dell’area di messa a fuoco è sempre visibile 
quando si utilizza il pulsante DISPLAY.

Modifica rapida della zona di messa a 
fuoco (Focus Setting)

È possibile modificare rapidamente la 
posizione e le dimensioni della zona di 
messa a fuoco automatica durante le riprese 
assegnando Focus Setting a un pulsante 
programmabile (pagina 108).
L’operazione varia a seconda 
dell’impostazione della zona di messa a fuoco.

Quando Focus >Focus Area (pagina 43) nel 
menu Shooting del menu completo è 
impostata su Flexible Spot o Zone
Per spostare l’area di messa a fuoco, 

premere il pulsante programmabile a cui è 
stata assegnata la funzione Focus Setting 
e regolarne le dimensioni con il selettore 
multiplo (pagina 5).
Per riportare l’area di messa a fuoco sulla sua 
posizione centrale durante la regolazione della 
posizione, premere il selettore multiplo.
Per modificare le dimensioni della zona di 
messa a fuoco, premere e mantenere premuto 
il pulsante programmabile a cui è stata 
assegnata la funzione Focus Setting.
Dopo averne impostato le dimensioni, 
spostare l’area di messa a fuoco sulla 
posizione desiderata premendo il selettore 
multiplo.
Al termine, premere il pulsante programmabile 
a cui è stata assegnata la funzione Focus 
Setting per tornare alla schermata iniziale.

Quando Focus >Focus Area (pagina 43) nel 
menu Shooting del menu completo è 
impostata su Wide
È possibile modificare solamente le 
dimensioni della zona di messa a fuoco 
premendo e mantenendo premuto il pulsante 
programmabile a cui è stata assegnata la 
funzione Focus Setting. Prima di poterne 
spostare la posizione, è necessario impostare 
il tipo su Flexible Spot o Zone.

[Informazione]
Quando è possibile spostare la posizione dell’area 
di messa a fuoco, il relativo riquadro è visualizzato in 
arancione.

Spostamento del riquadro dell’area di 
messa a fuoco tramite touchscreen (area 
di messa a fuoco Touch)

Per spostare la posizione dell’area di messa 
a fuoco, premere il pulsante programmabile 
(pagina 108) a cui è assegnato Focus Setting 
per visualizzarne il riquadro in arancione, 
quindi spostarla con il touchscreen.
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Toccare lo schermo per spostare l’area di 
messa a fuoco, centrandola sul punto che 
è stato toccato. Trascinare l’area di messa a 
fuoco con il dito per spostarla nella posizione 
desiderata sullo schermo (pagina 10).

[Informazione]
È possibile abilitare e disabilitare l’uso del touchscreen 
per la messa a fuoco sulla schermata di ripresa 
utilizzando un pulsante programmabile a cui è 
assegnato Focus Setting.

Toccare un punto qualsiasi dello schermo

L’area di messa a fuoco si sposta 
centrandosi sulla posizione toccata.

Trascinare l’area di messa a fuoco con il 
dito per spostarla nella posizione 
desiderata sullo schermo.

[Note]
•• 	Se si tocca una posizione o si trascina l’area di messa 

a fuoco su una posizione al di fuori del campo 
disponibile impostato, l’area di messa a fuoco viene 
impostata sul bordo superiore, inferiore, sinistro o 
destro di tale campo.

•• 	Questa funzione non è disponibile nei casi descritti di 
seguito.
–– Quando Touch Operation (pagina 64) nel menu 

Technical del menu completo è impostata su Off
–– Quando l’area di messa a fuoco non è visualizzata 

oppure è visualizzata in grigio

Regolazione dell’azione di messa a 
fuoco automatica (Velocità di transizione 
AF, Sensibilità al cambiamento del 
soggetto AF)

Velocità di transizione AF
La voce Focus >AF Transition Speed 
(pagina 43) del menu Shooting del menu 
completo consente di impostare la velocità 
di azionamento del sistema di messa a 
fuoco automatica in caso di movimento del 
soggetto.
Se impostata su una velocità più bassa, 
quando il soggetto messo a fuoco si sposta, 
la messa a fuoco segue il soggetto in maniera 
più graduale, consentendo la ripresa di 
immagini di grande impatto.
Se impostata su una velocità più alta, la messa 
a fuoco seleziona il soggetto più rapidamente. 
Questa impostazione è ideale per la ripresa 
di documentari che richiedono una rapida 
messa a fuoco in quanto il soggetto viene 
immediatamente messo a fuoco non appena 
entra nel campo di ripresa.

Durante il cambiamento:
1(SLow): Il cambiamento della 
messa a fuoco avviene 
lentamente
.
.
.
7(Fast): Il cambiamento della 
messa a fuoco avviene 
rapidamente

È a fuoco il soggetto più lontano

È a fuoco il soggetto più vicino
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Sensibilità al cambiamento del soggetto AF
È possibile impostare la sensibilità al 
cambiamento del soggetto mediante la voce 
Focus >AF Subj. Shift Sens. (pagina 43) nel 
menu Shooting del menu completo.
Se impostata su una sensibilità più bassa, la 
messa a fuoco non cambia immediatamente 
anche se un altro soggetto si dovesse spostare 
di fronte al soggetto originariamente messo a 
fuoco. Se impostata su una sensibilità più alta, 
la messa a fuoco cambia immediatamente per 
dare la precedenza al soggetto che si sposta 
di fronte.

[Informazione]
Se AF Speed/Sens. è assegnata a un pulsante 
programmabile, le barre di livello per la regolazione dei 
valori vengono visualizzate nel seguente ordine ad ogni 
pressione del pulsante, consentendo di modificare le 
impostazioni di velocità di transizione AF e di sensibilità 
al cambiamento del soggetto AF:
Velocità di transizione AF  Sensibilità al cambiamento 
del soggetto AF  Nessuna indicazione …

AF Subj. Shift Sens.: 1(Locked On) AF Subj. Shift Sens.: 5(Responsive)

La messa a fuoco del nuovo soggetto 
avviene lentamente

La messa a fuoco del nuovo soggetto 
avviene rapidamente

Selezione manuale del soggetto della 
messa a fuoco (AF Assist)

Quando Focus >AF Assist (pagina 43) 
nel menu Shooting del menu completo è 
impostato su On, rimane possibile mettere a 
fuoco un soggetto ruotando manualmente la 
ghiera dell’obiettivo anche durante la messa a 
fuoco automatica.
Dopo aver completato la messa a fuoco 
del soggetto con la ghiera dell’obiettivo, 
la funzione di messa a fuoco automatica 
continua a mantenere a fuoco il soggetto 
messo a fuoco manualmente (messa a fuoco 
automatica assistita).
Lo spostamento della messa a fuoco su un 
soggetto diverso dopo l’azionamento della 
ghiera di messa a fuoco sarà leggermente più 
difficile, indipendentemente dall’impostazione 
di Focus >AF Subj. Shift Sens. (pagina 43) 
nel menu Shooting del menu completo.
La messa a fuoco automatica assistita (AF 
Assist) viene annullata nei seguenti casi:
•• Quando il soggetto messo a fuoco con la 

ghiera di messa a fuoco dell’obiettivo non è 
più visibile.

•• Quando si passa alla messa a fuoco 
manuale.

•• Quando viene avviata la funzione di messa a 
fuoco automatica con seguimento in tempo 
reale

[Informazioni]
•• È possibile annullare rapidamente la messa a fuoco 

automatica assistita anche premendo un pulsante 
programmabile (pagina 108) a cui sono assegnate le 
funzioni Push AF o Push MF.

•• La funzione di messa a fuoco automatica con 
seguimento in tempo reale si arresta quando viene 
utilizzata la ghiera di messa a messa a fuoco.

•• In modalità Human Only AF, la messa a fuoco 
automatica mette a fuoco il viso più vicino alla 
posizione di messa a fuoco definita dalla ghiera di 
messa a fuoco.
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Messa a fuoco manuale temporanea 
(Push Manual Focus)

Mentre è attiva la modalità di messa a 
fuoco automatica, è possibile attivare 
momentaneamente la messa a fuoco manuale 
premendo un pulsante programmabile 
(pagina 108) a cui è stata assegnata la 
funzione Push AF/Push MF, che rimane attiva 
fino a quando il pulsante rimane premuto.
La messa a fuoco ritorna alla modalità 
automatica non appena si rilascia il pulsante.
Questo consente di interrompere 
momentaneamente la messa a fuoco 
automatica ed eseguire la messa a fuoco 
manuale quando un elemento che non è il 
soggetto della ripresa attraversa il campo 
di visuale della ripresa davanti al soggetto 
desiderato.

Seguimento mediante la funzione 
di rilevamento soggetto umano 
(Subject Recognition AF)

L’unità è in grado identificare, come soggetto 
da seguire, gli esseri umani e quindi metterne 
a fuoco automaticamente il viso, gli occhi e il 
corpo all’interno dell’area di messa a fuoco.
Questa funzione è disponibile solo quando 
la messa a fuoco è in modalità AF o durante 
Push Auto Focus.
Quando viene rilevata una persona, viene 
visualizzato un riquadro di riconoscimento 
del soggetto di colore grigio. Quando viene 
identificato un soggetto per la messa a fuoco 
automatica, il riquadro diventa di colore 
bianco e la funzione di seguimento si avvia.
Se viene riconosciuta una caratteristica di 
identificazione più precisa (ad esempio gli 
occhi), a tale elemento viene assegnata 
automaticamente una maggiore priorità, 
visualizzando un riquadro di riconoscimento.
Se vengono rilevate più persone, il soggetto 
principale è determinato automaticamente.

[Informazione]
Quando l’area di messa a fuoco è impostata su 
Zone o Flexible Spot, verranno visualizzati riquadri 
di riconoscimento intorno agli elementi riconosciuti 
del soggetto (viso, occhi, testa, corpo) non appena la 
persona entra nel campo dell’area di messa a fuoco.

Impostare l’azione della funzione di AF con 
rilevamento del soggetto tramite Focus 
>Subject Recognition AF (pagina 43) nel 
menu Shooting.

Human Only AF:
La telecamera rileva i soggetti (persone), 
seguendo ed eseguendo la messa a fuoco 
sugli occhi, il viso, la testa e il corpo di tali 
persone. Finché non viene rilevato nessun 
viso, occhi, testa o corpo, la funzione AF viene 
temporaneamente sospesa e sullo schermo 

appare l’icona  che indica la pausa della 
messa a fuoco automatica (pagina 23). 
Questa modalità è efficace quando si desidera 
seguire e mantenere automaticamente a 
fuoco solo il viso, gli occhi, la testa e il corpo 
dei soggetti.

Human Priority AF:
La telecamera rileva il viso, gli occhi, la testa e 
il corpo dei soggetti (persone) e dà priorità al 
seguimento e alla messa a fuoco di tali parti 
del corpo. Se non viene rilevato nessun viso, 
occhi, testa o corpo, la messa a fuoco avviene 
in modalità AF (impostazione predefinita).

Off:
La funzione di AF con rilevamento del 
soggetto è disabilitata.

[Note]
•• Mentre è attiva la funzione di Push Auto Focus, viene 

sempre attivata Human Priority AF, anche mentre è 
selezionata Human Only AF.

•• Quando il selettore FOCUS si trova in posizione MF, 
la funzione di AF con rilevamento del soggetto è 
disabilitata (eccetto durante Push Auto Focus).

•• Se si spegne l’unità mentre è selezionato Human Only 
AF, verrà ripristinata automaticamente la modalità 
Human Priority AF alla successiva riaccensione.

Nascodere i riquadri di rilevamento del 
soggetto

È possibile scegliere se visualizzare o meno 
i riquadri di rilevamento del soggetto con la 
voce Display On/Off >Subject Recognition 
Frame (pagina 58) nel menu Monitoring del 
menu completo.

Selezione della modalità AF con 
rilevamento del soggetto tramite un 
pulsante programmabile

Assegnare Subject Recognition AF a un 
pulsante programmabile (pagina 108). 
Premendo ripetutamente tale pulsante, 

diventa possibile passare in sequenza da una 
modalità AF con rilevamento del soggetto 
all’altra, passando da Human Priority AF, a 
Human Only AF, a Off, ecc.

Impostazione con Direct Menu

La modalità operativa AF con rilevamento del 
soggetto può essere selezionata anche con 
Direct Menu (pagina 108).

Seguimento di un soggetto 
specificato (Realtime Tracking AF)

L’unità consente di mantenere la messa a 
fuoco su un determinato soggetto toccandolo 
sullo schermo oppure selezionandone il 
riquadro di rilevamento corrispondente.
Il seguimento si avvia non appena viene 
selezionato il soggetto desiderato e lo 
schermo visualizza un riquadro di seguimento 
bianco.

[Informazioni]
•• Il seguimento ha luogo sull’intera area dell’immagine, 

indipendentemente dall’impostazione dell’area di 
messa a fuoco.

•• Quando Focus >Touch Function in MF (pagina 43) 
nel menu Shooting è impostato su Tracking AF, la 
messa a fuoco automatica con seguimento in tempo 
reale è supportata anche quando la messa a fuoco si 
trova in modalità MF.

In base alla modalità operativa della funzione 
di AF con rilevamento del soggetto, avranno 
luogo, per quanto riguarda il soggetto del 
seguimento, le azioni indicate di seguito.
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Human Only AF / Human Priority AF:
Messa a fuoco e seguimento del soggetto 
specificato.
Se il soggetto da seguire è una persona e se il 
camcorder ne rileva il viso, gli occhi, la testa o 
il corpo, la messa a fuoco avviene su tale parte 
del corpo.

Off:
Messa a fuoco e seguimento del soggetto 
specificato.
Il rilevamento del viso, degli occhi, della testa 
o del corpo non ha luogo, anche se il soggetto 
del seguimento è una persona.

[Nota]
La funzione Realtime Tracking AF non è attiva se 
l’obiettivo è impostato per la messa a fuoco manuale.

Avvio della messa a fuoco automatica 
con seguimento in tempo reale

Il seguimento si avvia non appena viene 
specificato un determinato soggetto da 
seguire.

Specifica toccando lo schermo
Con il camcorder in uno degli stati indicati di 
seguito, toccare il soggetto da seguire:
•• Quando la messa a fuoco è in modalità 

MF oppure durante la messa a fuoco 
manuale Push e Focus >Touch Function 
in MF (pagina 43) nel menu Shooting è 
impostato su Tracking AF

•• Quando la messa a fuoco è in modalità 
AF oppure durante la messa a fuoco 
automatica Push (AF)

[Nota]
Non è possibile specificare un soggetto toccandolo sullo 
schermo se Touch Operation (pagina 64) nel menu 
Technical è impostato su Off.

Specifica tramite la selezione del riquadro di 
rilevamento del soggetto
Utilizzando il selettore multiplo (pagina 5), 
spostare il cursore di selezione del soggetto 
(sottolineatura arancione) sul soggetto da 
seguire, quindi premere il selettore multiplo.

Altri riquadri di 
rilevamento del 
soggetto (grigi)

Riquadro di 
seguimento

Cursore di selezione del soggetto 
(arancione)

[Informazioni]
•• In modalità di messa a fuoco automatica con 

seguimento in tempo reale è possibile cambiare il 
soggetto da seguire.

•• Premendo un pulsante programmabile (pagina 108) 
a cui è assegnata la funzione LCD Focus Magnifier 
durante la messa a fuoco automatica con seguimento 
in tempo reale, la messa a fuoco viene ingrandita 
mantenendo lo stato del seguimento. Durante 
l’ingrandimento della messa a fuoco, tuttavia, non è 
possibile specificare il soggetto da seguire.

[Nota]
Durante la messa a fuoco manuale non è possibile 
avviare il seguimento tramite la selezione del riquadro di 
rilevamento del soggetto.

Arresto della messa a fuoco automatica 
con seguimento in tempo reale

Arresto toccando lo schermo
Toccare il pulsante  (arresto messa a 
fuoco automatica con seguimento in tempo 
reale) in alto a sinistra sul touchscreen.

[Informazione]
La messa a fuoco automatica con seguimento in tempo 
reale si arresterà nei casi descritti di seguito:

–– Quando vengono azionati il selettore FOCUS o il 
selettore AUTO/MAN dell’obiettivo.

–– Quando viene selezionata una modalità di messa a 
fuoco diversa.

–– Quando viene eseguita l’assistenza alla messa a 
fuoco automatica.

–– Quando viene modificata l’impostazione dell’area 
di messa a fuoco oppure l’azione di messa a fuoco 
automatica con rilevamento del soggetto.

–– Quando viene premuto un pulsante 
programmabile a cui è assegnata la funzione Push 
AF/Push MF.

–– Quando il soggetto da seguire non è presente nella 
schermata della ripresa o se il soggetto rimane 
fuori fuoco per diversi secondi.

Note per le riprese

•• La messa a fuoco sul soggetto può risultare 
difficoltosa nei casi descritti di seguito:

•• In condizioni di scarsa illuminazione o 
di controluce

•• Quando il soggetto si trova in ombra
•• Quando il soggetto è molto fuori fuoco

Nei casi descritti di seguito, la messa a fuoco 
sugli occhi può risultare difficoltosa, anche 
se la telecamera riconosce gli occhi:

•• Quando gli occhi sono chiusi
•• Quando gli occhi sono coperti da capelli 

ecc.
•• Quando la persona indossa occhiali da 

vista o da sole
Esistono anche altre situazioni in cui la 
messa a fuoco sul soggetto potrebbe non 
risultare possibile.

•• Quando la telecamera non è in grado di 
mettere a fuoco la parte a cui si desidera 
assegnare la priorità, ad esempio gli occhi 
del soggetto, la telecamera potrebbe 
mettere a fuoco automaticamente altre parti 
riconosciute, ad esempio la testa o il corpo 
del soggetto.

•• Anche quando viene visualizzata una 
cornice bianca di riconoscimento del 
soggetto attorno al viso del soggetto, 
ecc., la telecamera potrebbe mettere 
automaticamente a fuoco un’alta parte a cui 
si desidera dare la priorità, ad esempio gli 
occhi del soggetto.

•• Il soggetto potrebbe non essere 
riconosciuto quando solo una parte si trova 
all’interno dell’angolo di visuale.
–– Se sono visibili soltanto le mani e piedi di 
una persona o le zampe di un animale

–– Se una parte del soggetto è nascosta e 
non è visibile, ecc.

•• In alcuni casi, la telecamera potrebbe 
riconoscere erroneamente come soggetto 
altri oggetti indesiderati.
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Regolazione della luminosità
È possibile regolare la luminosità variando 
opportunamente i valori di diaframma, 
guadagno, velocità dell’otturatore, nonché 
regolando il livello di luce mediante i filtri ND. 
È anche possibile effettuare tali regolazioni 
automaticamente.
Il livello ottimale di regolazione automatica 
della luminosità può essere impostato 
mediante l’opzione Auto Exposure >Level 
(pagina 41) del menu Shooting del menu 
completo. La funzione Auto Exposure Level 
può essere assegnata anche a un pulsante o 
una manopola programmabile (pagina 108).

[Nota]
Il guadagno non è regolabile in modalità Cine EI. 
La sensibilità di base è fissa. Inoltre, non è possibile 
regolare automaticamente la luminosità mediante 
la velocità dell’otturatore. È supportata invece la 
regolazione automatica della luminosità tramite 
diaframma e filtro ND.

Selezione della sensibilità di base 
(Base Sensitivity)

L’unità dispone di due tipologie di sensibilità 
di base.
Nella modalità Cine EI, è possibile 
impostare il valore ISO di base su ISO 3200 
o ISO 800 mediante ISO/Gain/EI >Base ISO 
(pagina 39) nel menu Shooting del menu 
completo.
Si consiglia di selezionare ISO 800 in 
condizioni di illuminazione normali e ISO 3200 
in condizioni di scarsa illuminazione.
Nella modalità Custom, è possibile impostare 
la sensibilità di base su High o Low mediante 
ISO/Gain/EI >Base Sensitivity (pagina 39) 
nel menu Shooting del menu completo.
Si consiglia di selezionare Low in condizioni di 
illuminazione normali e High in condizioni di 
scarsa illuminazione.

[Informazione]
Le funzioni Base ISO e Base Sensitivity possono 
essere assegnate anche a un pulsante programmabile 
(pagina 108).

Regolazione del diaframma

È possibile regolare la luminosità regolando il 
diaframma.

[Nota]
Se è montato un obiettivo con attacco PL, non è 
possibile eseguire la regolazione del diaframma tramite 
i comandi dell’unità o di un telecomando che non sia 
un pannello di comando a distanza. La regolazione del 
diaframma tramite un pannello di comando a distanza è 
supportata solo in modalità manuale.

Regolazione automatica del diaframma

Questa funzione regola la luminosità in base 
al soggetto. È necessario che sia montato 
un obiettivo che supporta la funzione di 
regolazione automatica del diaframma.

1	 Se è montato un obiettivo con selettore 
Auto Iris, impostarlo su AUTO.

2	 Visualizzare il Direct Menu Auto Iris 
(pagina 108) e selezionare Auto.

	 [Nota]
Se è montato un obiettivo con attacco PL, Auto Iris 
è impostato su Off.

	 [Informazione]
La funzione Auto Iris può essere assegnata anche a 
un pulsante programmabile (pagina 108).

Regolazione manuale del diaframma

1	 Visualizzare il Direct Menu Auto Iris 
(pagina 108) e selezionare Manual.

2	 Visualizzare il Direct Menu Auto Iris 
(pagina 108) per visualizzare il valore del 
diaframma su uno sfondo bianco.

3	 Ruotare la manopola multifunzione per 
regolare il valore.

	 [Informazioni]
•• Se si desidera, è possibile utilizzare la 

manopola multifunzione come manopola IRIS 
di regolazione del diaframma (pagina 108) 
assegnando ad essa la funzione IRIS.

•• È possibile anche assegnare la funzione IRIS 
alla manopola programmabile del telecomando 
(pagina 108).

•• Con gli obiettivi dotati di ghiera di regolazione 
del diaframma è possibile utilizzare tale ghiera 
per eseguire le regolazioni manualmente.

Regolazione automatica temporanea

Premendo il pulsante programmabile 
(pagina 108) a cui è assegnata la funzione 
Push Auto Iris, il camcorder esegue la 
regolazione automatica del diaframma mentre 
il pulsante rimane premuto.
Il diaframma ritorna all’impostazione 
precedente non appena si rilascia il pulsante.

[Note]
•• Se il selettore Auto Iris dell’obiettivo si trova in 

posizione MANUAL, le funzioni Auto Iris e Push Auto 
Iris dell’unità non hanno effetto. Non hanno effetto 
nemmeno le regolazioni manuali del diaframma 
eseguite sull’unità.

•• La funzione Push Auto Iris non può essere eseguita se 
Iris >Bokeh Control (pagina 41) nel menu Shooting 
è impostato su On.

Regolazione automatica dell’indice 
di esposizione (Exposure Index)

Nella modalità Cine EI, si presuppone il video 
in uscita con Monitor LUT impostata su 
Off sia registrato come segnale principale. 
Modificando la luminosità dell’immagine 
con Monitor LUT impostata su On in modo 
che corrisponda a un valore EI, è possibile 
controllare il risultato della regolazione della 

sensibilità in post produzione durante le 
riprese.
Il valore di EI può essere regolato anche 
mediante ISO/Gain/EI >Exposure Index 
(pagina 39) nel menu Shooting del menu 
completo.

[Nota]
Durante la registrazione in Cine EI, si consiglia di 
mantenere costante l’impostazione di Exposure Index. 
Qualora si modifichi l’impostazione di Exposure Index, 
la correzione della luminosità potrebbe risultare 
molto difficile in sede di post produzione, rendendo 
probabilmente impossibile la riproduzione dello stato 
esistente al momento della ripresa originale delle 
immagini.

Regolazione del guadagno

In modalità Custom è possibile regolare la 
luminosità regolando il guadagno.

Regolazione automatica del guadagno

Visualizzare il Direct Menu AGC (pagina 108) 
e selezionare Auto.

[Informazioni]
•• È possibile eseguire la stessa regolazione impostando 

Auto Exposure >AGC (pagina 41) nel menu 
Shooting su On.

•• La funzione AGC può essere assegnata anche a un 
pulsante programmabile (pagina 108).

Regolazione manuale del guadagno

La regolazione del guadagno è utile per 
regolare l’esposizione mentre si utilizza 
un valore di diaframma fisso oppure se si 
desidera evitare l’aumento del guadagno 
generato dalla funzione AGC.

1	 Visualizzare il Direct Menu AGC 
(pagina 108) e selezionare Manual.
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2	 Visualizzare il Direct Menu Gain Value 
(pagina 108) e impostare il guadagno.

[Informazioni]
•• Il valore di guadagno preimpostato può essere 

modificato anche mediante ISO/Gain/EI >ISO/
Gain (pagina 39) nel menu Shooting del menu 
completo.

•• È possibile anche assegnare la funzione Push AGC 
a un pulsante programmabile per attivare AGC 
momentaneamente mantenendo premuto tale 
pulsante.

[Nota]
La funzione Push AGC non può essere eseguita se Iris 
>Bokeh Control (pagina 41) nel menu Shooting del 
menu completo è impostato su On.

Regolazione dell’otturatore

È possibile regolare la luminosità regolando 
l’otturatore.

Regolazione automatica dell’otturatore

Visualizzare il Direct Menu Auto Shutter 
(pagina 108), quindi selezionare Auto 
per regolare automaticamente la velocità 
o l’angolo dell’otturatore in risposta alla 
luminosità dell’immagine.

[Informazione]
È possibile eseguire la stessa regolazione su On la voce 
Auto Exposure >Auto Shutter (pagina 41) del menu 
Shooting nel menu completo.

Regolazione manuale dell’otturatore

1	 Visualizzare il Direct Menu Shutter Speed 
Value o Shutter Angle Value 
(pagina 108) per visualizzare il valore 
dell’otturatore su uno sfondo bianco.

2	 Ruotare la manopola multifunzione per 
regolare il valore dell’otturatore.

[Informazioni]
•• Per regolare il tempo di esposizione in modo che 

corrisponda all’intervallo fotogrammi, selezionare Off 
al passo 1.

•• È anche possibile impostare l’angolazione e regolare 
la frequenza (pagina 40).

Regolazione del livello di luce 
(filtro ND)

In condizioni di illuminazione troppo intensa, 
è possibile ottenere la luminosità corretta 
utilizzando un filtro ND.
L’unità dispone di due modalità di filtro ND. 
Per passare da una modalità all’altra, utilizzare 
il selettore ND STEP/VARIABLE.

LOCK

MFAF

ND STEP ND VARIABLE

FULL MENU

ND ON

1 2

3

CLEAR

DISP

MENU

BACK

REC

B

C

A

Regolazione in modalità Step

Spostare il selettore ND STEP/VARIABLE (A) 
sulla posizione STEP, quindi impostare il filtro 
su uno dei valori indicati di seguito utilizzando 
i pulsanti ND FILTER POSITION su/giù (B).
È possibile specificare la modalità utilizzata 
per esprimere la trasmittanza della luce 

attraverso il filtro ND mediante la voce ND 
Filter >Display Mode (pagina 40) del menu 
Shooting nel menu completo.  
•• 	Se impostata su Optical Density: 

Clear (nessun filtro ND), 0.6, 0.9, 1.2, 1.5, 1.8 
oppure 2.1.

•• Se impostata su Transmittance: 
Clear (nessun filtro ND), 1/4, 1/8, 1/16, 1/32, 
1/64 oppure 1/128.

Regolazione in modalità variabile

Spostare il selettore ND STEP/VARIABLE 
(A) sulla posizione VARIABLE. Scegliere 
l’impostazione CLEAR oppure On utilizzando i 
pulsanti ND FILTER POSITION su/giù (B).

Regolazione automatica del livello di luce
Attivando la funzione Auto ND Filter 
viene abilitata la regolazione automatica 
dell’esposizione mediante il filtro ND.

1	 Premere il pulsante [+] dei pulsanti ND 
FILTER POSITION su/giù (B) per attivare il 
filtro ND.

2	 Visualizzare il Direct Menu Auto ND Filter 
(pagina 108) e selezionare Auto.

Regolazione manuale del livello di luce

1	 Premere il pulsante [+] dei pulsanti ND 
FILTER POSITION su/giù (B) per attivare il 
filtro ND.

2	 Visualizzare il Direct Menu Auto ND Filter 
(pagina 108) e selezionare Manual.

3	 Utilizzare la manopola ND VARIABLE (C) 
per regolare la trasmittanza del filtro.

[Informazione]
La funzione ND Filter può essere assegnata anche a una 
manopola programmabile (pagina 108).

Regolazione automatica temporanea
È possibile anche assegnare Push Auto ND a 
un pulsante programmabile (pagina 108) 
per attivare momentaneamente la funzione 
di filtro ND automatico mantenendo premuto 
tale pulsante. Al rilascio del pulsante, la 
funzione Auto ND Filter viene nuovamente 
disattivata.
Premere il pulsante [+] dei pulsanti ND FILTER 
POSITION su/giù (B) per attivare il filtro ND.

[Note]
•• La modifica dell’impostazione Display Mode potrebbe 

modificare anche la densità attuale del filtro ND.
•• Qualora, durante le riprese, venga modificato il valore 

del filtro ND passando per la posizione CLEAR, verrà 
visualizzato il riquadro del filtro ND, sull’immagine 
potrebbe apparire un riflesso della luce viola del 
sensore di rilevamento e, nell’audio, potrebbe essere 
registrato anche il rumore di azionamento del filtro. 
La luce del sensore e i rumori di azionamento non 
verranno riflessi nel video una volta completata la 
commutazione.

•• 	La funzione Push Auto ND non può essere eseguita se 
Iris > Bokeh Control (pagina 41) nel menu Shooting 
è impostato su On.

[Informazioni]
•• È possibile impostare il filtro su CLEAR ruotando 

verso il basso la manopola ND VARIABLE (C) dalla 
posizione ND 0.6. Ruotando verso l’alto la manopola 
dalla posizione CLEAR si imposta ND 0.6. È possibile 
disabilitare questa azione mediante ND Dial >CLEAR 
with Dial (pagina 64) nel menu Technical del menu 
completo.

•• È possibile anche assegnare ND Filter Position a un 
pulsante programmabile (pagina 108) e premere 
tale pulsante invece di usare i pulsanti ND FILTER 
POSITION su/giù per modificare l’impostazione.  
Modalità Step: Clear  0.6  0.9  …  Clear … 
Modalità Variable: Clear  On  Clear …

•• È possibile anche assegnare Auto ND Filter a un 
pulsante programmabile (pagina 108) per attivare e 
disattivare la funzione Auto ND Filter premendo tale 
pulsante.

•• Nella ripresa di soggetti fortemente illuminati, la 
chiusura eccessiva del diaframma può dar luogo a 
sfocature per diffrazione. Questo è un fenomeno 
tipico nelle videocamere. È possibile eliminare questo 
fenomeno ed ottenere risultati migliori utilizzando il 
filtro ND.
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Come ottenere colori naturali (bilanciamento del bianco)
È possibile selezionare la modalità di 
regolazione più adatta per le condizioni di 
ripresa.

Modalità ATW (bilanciamento 
automatico del bianco)

Questa funzione regola automaticamente il 
bilanciamento del bianco a un livello ottimale.
Il valore di bilanciamento del bianco viene 
automaticamente regolato quando cambia la 
temperatura di colore della sorgente luminosa.
Visualizzare il Direct Menu del bilanciamento 
del bianco (pagina 108) e impostare ATW su 
On.
È possibile selezionare la velocità di 
regolazione (cinque livelli) con l’opzione White 
Setting >ATW Speed (pagina 43) del menu 
Shooting del menu completo.

[Informazioni]
•• 	È possibile impostare White >ATW (pagina 42) su 

On anche nel menu Shooting del menu completo 
oppure utilizzando un pulsante programmabile 
(pagina 108) a cui è assegnata la funzione ATW.

•• È possibile “congelare” il valore di bilanciamento 
del bianco corrente assegnando la funzione 
ATW Hold a un pulsante programmabile 
(pagina 108) e premendo tale pulsante per 
sospendere temporaneamente la modalità ATW.

[Note]
•• La funzione ATW non è utilizzabile in modalità Cine EI.
•• A seconda delle condizioni di illuminazione e del 

soggetto, la funzione ATW può non essere in grado di 
ottimizzare sempre il colore.  
Esempi:
–– Quando il soggetto è dominato da un unico colore, 

ad esempio cielo, mare, prati o fiori.
–– Quando il soggetto è illuminato da una sorgente 

luminosa con temperatura di colore estremamente 
alta o estremamente bassa.

	 Se non è possibile ottenere l’effetto opportuno 
perché la velocità di regolazione automatica ATW è 
insufficiente o per altri motivi, eseguire la funzione di 
bilanciamento automatico del bianco.

Regolazione manuale del 
bilanciamento del bianco

Quando ATW è impostato su On: 
Selezionare l’icona  in Direct Menu 
(pagina 108) e selezionare una delle 
opzioni da W:A a W:H.

Quando ATW è impostato su Off: 
Selezionare una delle opzioni da W:A a 
W:H in Direct Menu.

•• W:A: Posizione di memoria A
•• W:B: Posizione di memoria B
•• W:C: Posizione di memoria C
•• W:D: Posizione di memoria D
•• W:E: Posizione di memoria E
•• W:F: Posizione di memoria F
•• W:G: Posizione di memoria G
•• W:H: Posizione di memoria H

Selezionare la posizione di memoria da 
A a H desiderata nella schermata Home 
(pagina 26).

[Informazione]
È possibile impostare la memoria anche utilizzando 
White >White Select (pagina 42) nel menu Shooting 
del menu completo.

È possibile impostare le varie posizioni di 
memoria utilizzando i metodi indicati di 
seguito.
•• Modificando il valore di preset predefinito
•• Modificando la temperatura e il tono di 

colore (tint)
•• Eseguendo il bilanciamento automatico del 

bianco

Modifica del valore di preset predefinito

Quando si seleziona una delle opzioni da W:A 
a W:H in Direct Menu (pagina 108), viene 
visualizzato quanto segue.
Cine EI:
5500K±00
4300K±00

3200K±00
Custom:
6300K±00
5600K±00
4300K±00
3200K±00
La selezione di un valore aggiorna 
l’impostazione per la posizione di memoria 
corrente.

Selezione della temperatura di colore

1	 Visualizzare il Direct Menu di Color Temp. 
o Tint (pagina 108) per visualizzarne il 
valore su uno sfondo bianco.

2	 Ruotare la manopola multifunzione per 
regolare il valore.

[Informazione]
È possibile impostare la temperatura di colore anche 
sulla schermata Home (pagina 26) oppure utilizzando 
White >Color Temp, Tint, R-Gain e B-Gain (pagina 42) 
nel menu Shooting del menu completo.

Esecuzione del bilanciamento 
automatico del bianco

Il bilanciamento del bianco da salvare nella 
posizione di memoria da A a H è configurato 
automaticamente.

1	 Selezionare una posizione di memoria da 
A a H.

2	 Collocare un foglio o un altro oggetto 
bianco in una posizione con la stessa 
sorgente di luce e le stesse condizioni di 
illuminazione del soggetto, quindi 
zoomare sul foglio fino a riempire lo 
schermo di bianco.

3	 Regolare la luminosità.
Regolare il diaframma servendosi della 
procedura descritta in “Regolazione 
manuale del diaframma” (pagina 102).

4	 Selezionare una delle opzioni da W:A a 
W:H in Direct Menu, quindi selezionare 
AWB.
•• Il risultato della regolazione automatica 

del bilanciamento del bianco viene 
salvato nella posizione di memoria (da 
A a H) selezionata nel passo 1.

•• Se il bilanciamento automatico del 
bianco viene eseguito in modalità 
ATW, il risultato viene ereditato e la 
modalità ATW riprende al termine 
della regolazione automatica. Ciò 
è utile quando si desidera regolare 
il bilanciamento del bianco molto 
rapidamente, indipendentemente 
dall’impostazione di ATW Speed.

[Informazione]
È possibile eseguire il bilanciamento automatico del 
bianco anche dalla schermata Home (pagina 26), 
utilizzando White >Auto White Balance (pagina 42) 
nel menu Shooting del menu completo oppure 
utilizzando un pulsante programmabile (pagina 108) a 
cui è assegnata la funzione Auto White Balance.

[Nota]
Se la regolazione non può essere eseguita 
correttamente, viene visualizzato un messaggio di errore 
sullo schermo per circa tre secondi. Se il messaggio 
di errore persiste anche dopo ripetuti tentativi di 
impostazione del bilanciamento del bianco, rivolgersi al 
servizio di assistenza tecnica Sony.
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Utilizzo della stabilizzazione dell’immagine
È possibile abilitare la funzione di 
stabilizzazione dell’immagine per sopprimere 
i tremolii causati da leggeri movimenti della 
mano durante le riprese.
La stabilizzazione dell’immagine può essere 
eseguita automaticamente o manualmente, a 
seconda dell’obiettivo montato.

[Nota]
La stabilizzazione dell’immagine non è utilizzabile 
quando De-Squeeze >Ratio (pagina 58) nel menu 
Monitoring è stato impostato su un valore diverso da 
Off(1.0×).

Abilitazione della stabilizzazione 
dell’immagine

Le voci da configurare variano a seconda che 
sia montato un adattatore per attacco PL 
oppure no.

Quando è montato un adattatore per 
attacchi PL

Impostare Image Stabilization >PL Stabilization 
(pagina 44) su High o Low nel menu 
Shooting del menu completo.
•• Low: Esegue la stabilizzazione 

dell’immagine durante la ripresa di video in 
condizioni relativamente stabili.

•• High: esegue una stabilizzazione 
dell’immagine più intensa in confronto a 
Low.

Per eseguire riprese senza utilizzare la 
funzione di stabilizzazione dell’immagine, 
impostare PL Stabilization su Off. In tal caso si 
consiglia l’utilizzo di un cavalletto.

Quando non è montato un adattatore 
per attacchi PL

Impostare Image Stabilization >SteadyShot 
(pagina 44) su Active o Standard nel menu 
Shooting del menu completo.
•• Standard: Esegue la stabilizzazione 

dell’immagine durante la ripresa di video in 
condizioni relativamente stabili.

•• Active: esegue una stabilizzazione 
dell’immagine più intensa in confronto a 
Standard.

Per eseguire riprese senza utilizzare la 
funzione di stabilizzazione dell’immagine, 
impostare SteadyShot su Off. In tal caso si 
consiglia l’utilizzo di un cavalletto.

[Nota]
Non è possibile impostare Active (o High) nei seguenti 
casi:
•• Quando Rec Format >Codec (pagina 46) è 

impostato su X-OCN nel menu Project
•• Quando S&Q Motion >Setting (pagina 43) è 

impostato su On nel menu Shooting
•• Quando Rec Format >Imager Scan Mode 

(pagina 46) nel menu Project del menu completo è 
impostato su FF 8.6K 17:9 / FF 8.6K 16:9 / S35c 4K 17:9

Impostazione automatica della 
lunghezza focale

La lunghezza focale per la stabilizzazione 
dell’immagine viene impostata 
automaticamente in base alle informazioni 
fornite dall’obiettivo.
Per impostare automaticamente la lunghezza 
focale per la stabilizzazione dell’immagine, 
impostare Image Stabilization >Stabilization 
Adjustment (pagina 44) nel menu Shooting 
del menu completo su Auto.

Impostazione manuale della 
lunghezza focale

La lunghezza focale per la stabilizzazione 
dell’immagine può essere impostata anche 
manualmente.
Per impostare manualmente la lunghezza 
focale per la stabilizzazione dell’immagine, 
impostare Image Stabilization >Stabilization 
Adjustment (pagina 44) nel menu Shooting 
del menu completo su Manual e impostare la 
lunghezza focale.
Impostare la lunghezza focale utilizzando 
Image Stabilization >Focal Length 
(pagina 45) nel menu Shooting del 
menu completo. È possibile impostare una 
lunghezza focale compresa tra 8 mm e 
1000 mm.
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Impostazione dell’audio da registrare
È possibile specificare l’audio da registrare 
scegliendo opportunamente i connettori di 
ingresso e utilizzando i selettori e le manopole 
dell’unità.

Connettori e selettori di ingresso audio 
esterno

Connettore INPUT 1 (pagina 5)
Connettore INPUT 2 (pagina 5)
Slitta Multi-interface (quando è montata una 
maniglia opzionale dotata di slitta MI)
Selettore INPUT 1 (LINE/MIC/MIC+48V) 
(pagina 5)
Selettore INPUT 2 (LINE/MIC/MIC+48V) 
(pagina 5)

Selettori per l’impostazione del livello 
audio

Selettore CH1 (AUTO/MAN) (pagina 4)
Selettore CH2 (AUTO/MAN) (pagina 4)
Manopola AUDIO LEVEL (CH1) (pagina 4)
Manopola AUDIO LEVEL (CH2) (pagina 4)

Schermata di stato Audio

Selezione del dispositivo di 
ingresso audio

1	 Impostare l’ingresso audio con CH1/CH2/
CH3/CH4 >Source (pagina 30) nella 
schermata di stato Audio oppure con le 
opzioni da Audio Input >CH1 Input Select a 
Audio Input >CH4 Input Select 
(pagina 61) nel menu Audio del menu 
completo.

	 [Note]
•• L’audio non viene registrato nelle modalità 

Interval Rec e Slow & Quick Motion.
•• L’unità è dotata di un microfono incorporato 

da narrazione per la registrazione dell’audio 
ambientale. Può essere utilizzato per 
la sincronizzazione dei tempi con altre 
apparecchiature. In tal caso, specificare Internal 
MIC.

•• Quando CH1 Input Select e CH2 Input Select 
sono impostati su Internal MIC, il livello di 
registrazione audio dei due canali CH1 e CH2 può 
essere regolato con la manopola AUDIO LEVEL 
(CH1) (pagina 4). Quando CH3 Input Select e 
CH4 Input Select sono impostati su Internal MIC, 
il livello di registrazione audio dei due canali CH3 
e CH4 può essere regolato con la voce CH3 Input 
Level (pagina 61).

2	 Selezionare la sorgente di ingresso audio.
Configurare i selettori INPUT 1 e INPUT 2 
(LINE/MIC/MIC+48V) in base ai dispositivi 
collegati rispettivamente ai connettori 
INPUT 1 e INPUT 2.

Dispositivo collegato Posizione 
selettore

Sorgente audio esterna (ad 
es. mixer)

LINE

Microfono dinamico, 
microfono a batteria

MIC

Microfono con 
alimentazione phantom 
+48 V

MIC+48V

•• Se si seleziona MIC+48V, assicurarsi che 
il microfono connesso sia compatibile 
con una sorgente a +48V per evitare 
di danneggiarlo. Controllare questa 
impostazione prima di procedere con il 
collegamento.

•• Se è necessario limitare l’eventuale 
rumore sui connettori ai quali non è 
connesso nessun dispositivo, impostare 
su LINE i selettori INPUT1/INPUT2 (LINE/
MIC/MIC+48V) corrispondenti.

Regolazione automatica del livello 
di registrazione audio

Spostare su AUTO i selettori CH1/CH2 (AUTO/
MAN) dei canali da regolare automaticamente.
Per CH3/CH4, impostare su Auto 
(pagina 61) il controllo di livello audio 
nella schermata di stato Audio (pagina 30) 
oppure le voci Audio Input >CH3 Level Control 
e CH4 Level Control del menu Audio nel menu 
completo.

Regolazione manuale del livello di 
registrazione audio

La seguente procedura consente di regolare il 
livello di registrazione audio per i canali CH1/
CH2.

1	 Spostare su MAN i selettori CH1/CH2 
(AUTO/MAN) dei canali da regolare 
manualmente.

2	 Durante la ripresa o lo standby, ruotare le 
manopole AUDIO LEVEL (CH1)/(CH2) per 
regolare il livello audio del canale 
corrispondente.
•• Per CH3/CH4, impostare su Manual il 

controllo di livello audio mediante CH3/
CH4 (pagina 30) nella schermata di 
stato Audio oppure mediante la voce 
Audio Input >CH3 Level Control o CH4 
Level Control nel menu Audio del menu 
completo, quindi regolare il livello di 
registrazione audio utilizzando CH3 
Input Level o CH4 Input Level.

•• È possibile regolare i livelli dei canali 
da CH1 a CH4 collettivamente in 
gruppo. Il livello di registrazione può 
essere regolato con la manopola 
programmabile (pagina 108) 
assegnata alla funzione Audio Input 
Level, nella schermata di stato Audio, 
oppure mediante Audio Input >Audio 
Input Level nel menu Audio del menu 
completo.

[Informazione]
La schermata di stato Audio consente di controllare 
facilmente il livello di ingresso audio (pagina 30).

[Note]
•• Con determinate combinazioni di impostazioni 

del menu Audio, l’impostazione Audio Input Level 
potrebbe essere disabilitata. Per informazioni 
dettagliate, vedere il diagramma a pagina 141.

•• L’unità supporta combinazioni di varie impostazioni. 
Per informazioni dettagliate, vedere il diagramma a 
pagina 141.
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Aggiunta di connettori di ingresso 
audio

È possibile collegare contemporaneamente 
all’unità fino a quattro canali di dispositivi 
audio XLR montando una maniglia (opzione) 
dotata di slitta MI e un adattatore XLR modello 
XLR-K3M (opzione).
Montare l’adattatore XLR sulla slitta Multi-
interface di una maniglia (opzione) dotata 
di slitta MI e quindi, nella schermata di stato 
Audio (pagina 30), impostare CH3 >Source 
su Shoe CH1 e CH4 >Source su Shoe CH2. In 
alternativa, impostare Audio Input >CH3 Input 
Select su Shoe CH1 e CH4 Input Select su Shoe 
CH2 nel menu Audio del menu completo.
Le funzioni del dell’unità che si 
sovrappongono verranno disabilitate per i 
canali per i quali è selezionato come ingresso 
l’adattatore XLR. Eseguire le regolazioni 
necessarie servendosi dei pulsanti e delle 
manopole dell’adattatore XLR.

[Note]
•• L’unità supporta l’interfaccia audio digitale 2ch 

dell’adattatore XLR-K3M.
•• Se Audio Input >CH3 Level e CH4 Level nel menu 

Audio sono impostati su Audio Input Level, il valore 
di Audio Input Level dell’unità verrà moltiplicato per il 
valore di livello impostato sull’adattatore XLR.  
Audio Input Level viene abilitato anche quando il 
selettore dell’adattatore XLR è impostato su AUTO.  
Se è specificato “Through”, l’audio verrà registrato al 
livello impostato con l’adattatore XLR (pagina 142).
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Funzioni utili

Utilizzo del Direct Menu

Quando sul monitor LCD è visualizzata la 
schermata di ripresa, è possibile controllare 
lo stato dell’unità e selezionare e modificare 
direttamente le impostazioni visualizzate sullo 
schermo.
Possono essere configurate le impostazioni 
elencate di seguito.
•• Auto Focus Mode
•• Steady Shot
•• Auto Exposure Mode
•• Auto Exposure Level
•• ND Filter Position
•• Auto ND Filter
•• ND Filter Value
•• Auto Iris
•• Iris Value
•• AGC
•• Gain Value
•• ISO Value
•• EI Gain
•• Base ISO/Sensitivity
•• ECS
•• Auto Shutter
•• Shutter Speed Value
•• Shutter Angle Value
•• ATW
•• Auto White Balance
•• Color Temp.
•• Tint
•• Preset White Select
•• Scene File
•• S&Q Motion Frame Rate

1	 Premere la manopola multifunzione o un 
pulsante programmabile a cui è 
assegnata la funzione Direct Menu.
Le voci sullo schermo che possono essere 
configurate tramite Direct Menu sono 
selezionabili mediante un cursore di 
colore arancione.

2	 Ruotare la manopola multifunzione per 
spostare il cursore sulla voce di menu da 
impostare, quindi premere la manopola 
multifunzione.
Appare un menu, oppure la voce viene 
visualizzata su uno sfondo bianco.

3	 Ruotare la manopola multifunzione per 
selezionare l’impostazione desiderata 
quindi premere la manopola multifunzione.
Il menu o lo sfondo bianco scompaiono e 
il nuovo valore appare visualizzato con un 
cursore arancione.
Per uscire da Direct Menu, premere 
nuovamente il pulsante programmabile a 
cui è assegnata la funzione oppure 
attendere 3 secondi senza eseguire 
nessuna operazione.

	 [Informazioni]
•• È possibile configurare direttamente le 

impostazioni anche mantenendo premuto per 
alcuni istanti il relativo pulsante funzione.

•• Quando le voci sono visualizzate su uno sfondo 
bianco, la manopola multifunzione può essere 
utilizzata come una manopola programmabile.

•• La selezione può essere eseguita anche 
mediante il selettore multiplo (pagina 5).

Pulsanti e manopole 
programmabili

L’unità è dotata dei pulsanti programmabili 
ASSIGN da 1 a 3 e ASSIGN da 7 a 11 
(pagina 5, 5, 6, 9) a cui è 
possibile assegnare varie funzioni.
È possibile assegnare funzioni anche 
alla manopola multifunzione dell’unità 
(pagina 4) e alla manopola programmabile 
dell’impugnatura di telecomando (opzione). 
Il pulsanti programmabili ASSIGN da 4 a 6 
si trovano sull’impugnatura di telecomando 
(opzione) o sul telecomando RM-30BP.

Modifica della funzione assegnata al 
pulsante

Utilizzare Assignable Button (pagina 49) nel 
menu Project del menu completo.
Le funzioni assegnate sono visualizzate 
nella schermata di stato Assignable Button 
(pagina 31).

Funzioni predefinite assegnate ai vari pulsanti 
programmabili al momento dell’acquisto
Pulsante 1	 Off
Pulsante 2	 Off
Pulsante 3	 Off
Pulsante 4	 LCD Focus Magnifier
Pulsante 5	 Direct Menu
Pulsante 6	 Off
Pulsante 7	 Off
Pulsante 8	 Off
Pulsante 9	 Off
Pulsante 10	 Off
Pulsante 11	 Off
Pulsante Focus Hold	 Focus Hold

Funzioni assegnabili ai pulsanti
•• Off
•• Base ISO/Sensitivity
•• AGC
•• Push AGC
•• ND Filter Position
•• Auto ND Filter
•• Push Auto ND
•• Iris (pulsante funzione)
•• Auto Iris
•• Push Auto Iris
•• Bokeh Control
•• Auto Shutter
•• Auto Exposure Level
•• Backlight
•• Spotlight
•• Auto White Balance
•• ATW
•• ATW Hold
•• AF Speed/Sens.

•• Focus Setting
•• Subject Recognition AF
•• Push AF/Push MF
•• Focus Hold
•• LCD Focus Magnifier
•• Output Focus Magnifier
•• S&Q Motion
•• LUT On/Off
•• LUT On/Off
•• High/Low Key
•• Image Stabilization
•• Crop Select
•• Rec
•• Picture Cache Rec
•• Rec Review
•• Clip Flag OK
•• Clip Flag NG
•• Clip Flag Keep
•• Color Bars
•• CALL
•• DURATION/TC/U-BIT
•• Display
•• Lens Info
•• Video Signal Monitor
•• Marker
•• LCD Monitor Adjust
•• LCD Monitor Mode
•• Gamma Display Assist
•• Peaking
•• Zebra
•• Volume
•• Clips
•• Touch Operation
•• Handle Zoom
•• Auto Upload (Proxy)
•• Direct Menu
•• User Menu
•• Menu
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Modifica della funzione assegnata alla 
manopola

  multifunzione dell’unità e alla manopola 
programmabile dell’impugnatura di 
telecomando (opzione) possono essere 
cambiate secondo le proprie esigenze.

Per la manopola multifunzione, utilizzare 
la voce Multi Function Dial (pagina 51) 
>Default Function del menu Project.
La funzione Iris è assegnata per impostazione 
predefinita.

Funzioni assegnabili alla manopola 
multifunzione
•• Off
•• ISO/Gain/EI
•• IRIS
•• Auto Exposure Level
•• Audio Input Level

[Nota]
L’impostazione è disabilitata mentre è visualizzato il 
menu.

Impostare la manopola programmabile 
mediante la voce Assignable Dial (pagina 51) 
del menu Project nel menu completo.
Per impostazione predefinita è assegnata la 
funzione IRIS.

[Informazione]
La manopola programmabile del telecomando RM-30BP 
(opzionale) segue l’impostazione di Grip/Remote Dial.

Funzioni assegnabili alla manopola 
programmabile
•• Off
•• ISO/Gain/EI
•• ND Filter
•• IRIS
•• Auto Exposure Level
•• Audio Input Level
•• Multi Function Dial

Le funzioni assegnate sono visualizzate 
nella schermata di stato Assignable Button 
(pagina 31).

Slow & Quick Motion

Quando Rec Format >Imager Scan Mode 
(pagina 46) nel menu Project del menu 
completo è impostato su uno dei valori 
seguenti, è possibile specificare valori diversi 
per la frequenza fotogrammi di ripresa e la 
frequenza fotogrammi di riproduzione.

Modalità di scansione 
imager

Frequenza fotogrammi

FF 8.6K 17:9 1–30

FF 8.6K 16:9

FFc 6K 17:9 1–60

FFc 6K 16:9

FFc 3.8K 16:9 1–60, 66, 72, 75, 88, 90, 
96, 100, 110, 120

S35 5.8K 17:9 1–60

S35 5.8K 16:9

S35 4.3K 4:3 1–60

S35c 4K 17:9 1–60, 66, 72, 75, 88, 90, 
96, 100, 110, 120

S35 1.9K 16:9 1–60, 66, 72, 75, 88, 90, 
96, 100, 110, 120, 150, 
180, 200, 240

È possibile attivare e disattivare la modalità 
Slow & Quick Motion premendo un pulsante 
programmabile (pagina 108) a cui è stata 
assegnata la funzione S&Q Motion.
Premere e mantenere premuto il pulsante per 
impostare la frequenza fotogrammi di ripresa.

[Informazione]
È possibile impostare la modalità anche utilizzando Rec 
Function nella schermata di stato Project e S&Q Motion 
nel menu Shooting del menu completo.

[Note]
•• La funzione Slow & Quick Motion non può essere 

impostata durante la registrazione, la riproduzione o 
mentre è visualizzata la schermata dei clip.

•• La modalità Slow & Quick Motion non consente la 
registrazione di audio.

•• Nella modalità Slow & Quick Motion, le funzioni di 
diaframma automatico e otturatore automatico sono 
disabilitate.

•• Alcuni obiettivi potrebbero presentare un limite 
superiore per il valore di frequenza fotogrammi, 
in base anche alla combinazione con il formato di 
registrazione.

•• Nella modalità Slow & Quick Motion, la funzione 
di messa a fuoco automatica presenta le seguenti 
limitazioni:
–– Limitazioni dovute a modello di obiettivo, 

frequenza di sistema e frequenza fotogrammi di 
ripresa

Obiettivo 
Sony

Frequenza di 
sistema

Disponibilità 
AF

SEL16F28 59.94/29.97/ 
23.98

Supportati 30, 
60, 120 fps

50.00/25.00 Supportati 25, 
50, 100 fps

24.00 Non 
supportata

Registrazione di video a intervalli 
(Interval Rec)

L’unità è dotata della funzione Interval Rec 
che consente di catturare video in time-lapse 
nella sua memoria interna. Questa funzione è 
efficace per riprendere soggetti che cambiano 
molto lentamente.
Quando si avvia la registrazione in questa 
modalità, l’unità registra automaticamente un 
numero specificato di fotogrammi a intervalli 
di tempo specificati.

Intervallo di ripresa (Interval Time)

Numero di fotogrammi in ciascuna ripresa
(Number of Frames)

Quando è attiva la modalità Interval Rec, la 
luce video HVL-LBPC (opzionale) si accende 
automaticamente prima dell’avvio della 
registrazione per consentire la ripresa di 
immagini in stabili condizioni di illuminazione 
e di temperatura di colore (funzione di 
preilluminazione Pre-Lighting).

[Note]
•• È possibile utilizzare una sola funzione di 

registrazione speciale (ad esempio Interval Rec) alla 
volta.

•• Se durante l’utilizzo di Interval Rec viene attivata 
un’altra modalità di registrazione speciale, il 
camcorder esce dalla modalità Interval Rec.

•• Il camcorder esce automaticamente dalla modalità 
Interval Rec se vengono modificate le impostazioni di 
sistema, ad esempio il formato video.

•• Le impostazioni della modalità Interval Rec non 
possono essere modificate durante la registrazione, 
la riproduzione o mentre è visualizzata la schermata 
dei clip.
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Impostazione di Interval Rec

Selezionare Rec Function >Interval Rec nella 
schermata di stato Project e configurare le 
impostazioni di Number of Frames e Interval 
Time.
Se si utilizza la luce video HVL-LBPC 
(opzionale), l’opzione Interval Rec >Pre-
Lighting del menu Project consente di 
specificare secondo le proprie esigenze con 
che anticipo dovrà accendersi la luce video 
prima dell’avvio della registrazione.

[Informazione]
È possibile impostare la modalità anche mediante 
Interval Rec (pagina 48) nel menu Project del menu 
completo.

[Note]
•• L’utilizzo di una luce HVL-LBPC richiede che sia 

montata una maniglia (opzione) dotata di slitta MI.
•• Se si desidera accendere la luce video prima 

dell’avvio della registrazione, spostare il selettore 
della luce video su AUTO. La luce video si accenderà e 
spegnerà automaticamente secondo l’impostazione 
dell’opzione Video Light Set (pagina 66) nel menu 
Technical.

•• Spostando su ON il selettore della luce video, la luce 
rimane sempre accesa (non si accende e spegne 
automaticamente).

•• La luce video non si spegne se è configurata per 
spegnersi per un tempo pari o inferiore a 5 secondi.

Allo spegnimento, l’unità esce dalla modalità 
Interval Rec, ma i valori impostati in Number 
of Frames, Interval Time e Pre-Lighting sono 
mantenuti. Non è necessario impostarli 
nuovamente la volta successiva che si utilizza 
la funzione Interval Rec.

Ripresa in modalità Interval Rec

Premere il pulsante REC (avvio/arresto 
registrazione) per avviare la registrazione. Il 
monitor LCD visualizza, alternativamente, le 
indicazioni “Int /Rec” e “Int /Stby”.
Se si utilizza la funzione di preilluminazione, 
la luce video si illumina prima dell’avvio della 
registrazione.

Arresto della ripresa

Arrestare la registrazione.
Al termine della ripresa, i dati video 
memorizzati fino a quel momento nella 
memoria vengono salvati sul supporto di 
registrazione.

Uscire dalla modalità Interval Rec

Eseguire una delle operazioni indicate di 
seguito.
•• Spegnere l’unità.
•• Nella modalità standby di registrazione, 

impostare Rec Function su un valore diverso 
da Interval Rec nella schermata di stato 
Project.

L’unità esce automaticamente dalla modalità 
Interval Rec anche quando viene riavviata.

Limitazioni durante la registrazione

•• Non viene registrato audio.
•• Non è possibile rivedere la registrazione 

(Rec Review).

Se l’unità viene spenta durante la 
registrazione

•• Se il selettore di alimentazione dell’unità 
viene spostato sulla posizione Off, 
l’unità accede per alcuni secondi al 
supporto di registrazione per salvare le 
immagini contenute in memoria fino 
al quel momento, quindi si spegne 
automaticamente.

•• Se l’alimentazione si interrompe perché è 
stata rimossa la batteria, è stato scollegato 
il cavo di alimentazione CC oppure è stata 
interrotta l’alimentazione all’adattatore CA, 
tutti i dati video ed audio registrati fino a 
quel momento andranno persi (max. 10 
secondi). Prestare attenzione durante la 
sostituzione la batteria.

Registrazione di immagini 
preregistrate nella cache (Picture 
Cache Rec)

Mantenendo una memoria cache interna 
di una durata specificata durante le riprese, 
la funzione Picture Cache Rec consente di 
catturare video “retroattivamente” all’avvio 
della registrazione.
Impostare Picture Cache Rec su On nella 
schermata di stato Project e quindi impostare 
le dimensioni della cache.

Impostazione 
Cache Size

Tempo cache 
(approssimativo)

Short 5 secondi

Medium 10 secondi

Long 20 secondi

Max Valore massimo per 
ciascun formato di 
registrazione

[Informazioni]
•• A seconda della frequenza fotogrammi di ripresa 

e del formato di registrazione, il tempo di cache 
potrebbe essere più breve. Controllare l’indicazione 
in basso a destra nella schermata di configurazione 
delle dimensioni della cache.

•• È possibile impostare la modalità anche mediante 
Picture Cache Rec (pagina 48) nel menu Project del 
menu completo.

•• È possibile attivare e disattivare la funzione 
Picture Cache Rec anche utilizzando un pulsante 
programmabile (pagina 108).

[Note]
•• Picture Cache Rec non può essere utilizzata 

contemporaneamente a Interval Rec, registrazione 
simultanea su 2 slot o registrazione proxy. Quando 
viene attivata la funzione Picture Cache Rec, queste 
altre funzioni di registrazione vengono disattivate 
automaticamente.

•• Non è possibile selezionare la modalità Picture Cache 
Rec durante la registrazione o Rec Review.

•• Mentre Picture Cache Rec è impostata su On, il 
codice temporale viene sempre registrato in modalità 
Free Run anche se impostato su Regen o Rec Run 
(pagina 56).

•• L’impostazione Output Format potrebbe non essere 
configurabile nella modalità Picture Cache Rec. In tal 
caso, impostare provvisoriamente Picture Cache Rec 
su Off e modificare le impostazioni desiderate.

Avvio di Picture Cache Rec

Quando Picture Cache Rec è impostata su On, 
l’indicazione “Cache” appare sul monitor 
LCD.
Quando viene premuto il pulsante REC (avvio/
arresto registrazione), la registrazione si avvia 
e il video viene registrato sulle schede di 
memoria, a partire dal video contenuto nella 
memoria cache.

Uscita dalla modalità Picture Cache Rec

Impostare Picture Cache Rec su Off nella 
schermata di stato Project, oppure premere il 
pulsante programmabile a cui è assegnata la 
funzione Picture Cache Rec.

[Note]
•• Se si cambia il formato di registrazione o il Look di 

base, il video già esistente nella memoria cache 
viene eliminato e la memoria cache inizia a registrare 
nuovo video. Di conseguenza, non è possibile 
registrare le immagini presenti nella cache prima del 
cambiamento del formato anche se la registrazione 
viene avviata immediatamente dopo il cambiamento 
del formato.

•• Se Picture Cache Rec viene impostata su On o Off 
immediatamente dopo l’inserimento di una scheda 
di memoria, è possibile che i dati della cache non 
vengano registrati sulla scheda.

•• Il video viene memorizzato nella memoria cache 
a partire dal momento in cui la funzione di 
Picture Cache Rec viene impostata su On. Prima 
dell’impostazione su On della funzione il video non 
viene memorizzato.

•• La cache non memorizza video durante l’accesso 
a una scheda di memoria, ad esempio durante 
riproduzione, Rec Review o visualizzazione della 
schermata dei clip. Durante tale periodo non è 
possibile registrare immagini nella cache.
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Registrazione simultanea sulle 
schede di memoria A e B (Simul 
Rec su 2 slot)

È possibile registrare simultaneamente sia 
sulla scheda di memoria A che sulla scheda 
di memoria B impostando su On la voce 
Simul Rec (pagina 30) nella schermata 
di stato Project, oppure Simul Rec >Setting 
(pagina 47) nel menu Project del menu 
completo.

Monitor segnale video

La voce Display On/Off >Video Signal Monitor 
(pagina 59) del menu Monitoring consente 
di specificare se visualizzare il segnale video 
sullo schermo del monitor LCD come forma 
d’onda, vettorscopio o istogramma.
La linea arancione indica il valore impostato 
del livello zebra.
La funzione Video Signal Monitor può 
essere assegnata anche a un pulsante 
programmabile (pagina 108).

Indicazione dei valori desiderati sul 
monitor

Nella modalità Cine EI, l’angolo superiore 
destro del monitor del segnale video visualizza 
informazioni relative alle impostazioni del 
gamut di colori (pagina 88) o della LUT 
monitor (pagina 44) per indicare i valori 
ottimali desiderati.

Look

Funzione Gamma Display Assist

Nella modalità Custom (pagina 88), quando 
Target Display è impostato su HDR(HLG), è 
possibile impostare Gamma Display Assist* 
nella schermata di stato Monitoring su On per 
visualizzare sul mirino una versione assistita 
dell’immagine, concepita per facilitare la 
ripresa in HDR.
*	 È possibile impostare la funzione anche mediante 

Gamma Display Assist >Setting (pagina 60) nel 
menu Monitoring del menu completo.

Compensazione dell’effetto 
breathing

È possibile specificare se realizzare o meno 
la compensazione dell’effetto breathing sugli 
obiettivi E-mount mediante la voce Lens 
>Breathing Compensation (pagina 66) nel 
menu Technical del menu completo.
Questa funzione corregge il fenomeno per il 
quale si verificano cambiamenti nell’angolo 
di visuale al cambiamento della posizione di 
messa a fuoco.
Quando la compensazione dell’effetto 
breathing è attiva, una porzione dell’immagine 
viene ritagliata elettronicamente per 
mantenere un angolo di visuale costante e 
compensare così questo fenomeno.

[Note]
•• Quando la compensazione dell’effetto breathing è 

attiva potrebbero aver luogo piccoli cambiamenti 
nell’angolo di visuale e nella qualità dell’immagine.

•• In base all’obiettivo, la funzione di compensazione 
dell’effetto breathing potrebbe non essere in grado di 
correggere i cambiamenti all’angolo di visuale.

•• La compensazione dell’effetto breathing non è 
possibile se l’obiettivo montato non supporta tale 
funzionalità.

•• Questa funzione è fissata su Off nei casi indicati di 
seguito.
–– Quando Lens >Distortion Comp. nel menu Technical 

è impostata su Off.
–– Quando S&Q Motion >Setting nel menu Shooting è 

impostato su On
–– Quando Rec Format >Imager Scan Mode 

(pagina 46) nel menu Project non è impostato 
su S35 5.8K 17:9/S35 5.8K 16:9/S35 1.9K 16:9

–– Quando Rec Format >Codec (pagina 46) nel 
menu Project è impostato su X-OCN(LT)

Regolazione del Bokeh (funzione 
di controllo Bokeh)

È possibile regolare facilmente il livello di 
bokeh collegando al valore di diaframma il 
filtro ND e il guadagno.

Attivazione e disattivazione della 
funzione di controllo del bokeh

Questa funzione può essere abilitata solo se è 
attiva la regolazione manuale dell’esposizione. 
Impostare il filtro ND sulla modalità variabile, 
quindi impostare diaframma, guadagno, 
otturatore e filtro ND sulla regolazione 
manuale.
È possibile attivare e disattivare la funzione di 
controllo del bokeh tramite la voce Iris >Bokeh 
Control (pagina 41) nel menu Shooting del 
menu completo.
Quando la funzione di controllo del bokeh è 
impostata su On, l’icona  viene visualizzata 
sugli indicatori del filtro ND e del guadagno. 

[Informazione]
Assegnando la funzione Bokeh Control a un pulsante 
programmabile (pagina 108) è possibile attivare o 
disattivare tale funzione di controllo semplicemente 
premendo il pulsante a cui è stata assegnata.

Regolazione del livello di bokeh

1	 Impostare la funzione di controllo del 
bokeh su On.

2	 Aprire completamente il diaframma.

3	 Impostare il filtro ND su 1/128.

4	 Impostare il guadagno su 0 dB e utilizzare 
l’illuminazione per regolare l’esposizione.
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5	 Regolazione della messa a fuoco.

6	 Regolare il diaframma.
Questo cambia il livello del bokeh.

[Informazioni]
•• Quando la funzione di controllo del bokeh è 

impostata su On, il filtro ND e il guadagno operano 
insieme per compensare le variazioni di esposizione 
dovute alla regolazione del diaframma, consentendo 
di modificare il livello di bokeh.

•• Il controllo del bokeh viene prima collegata al filtro ND 
in risposta al cambiamento del valore di diaframma. 
Quando non è più possibile agire sul filtro ND, viene 
collegato il guadagno.

•• In modalità MF, si consiglia di aprire prima il 
diaframma e quindi regolare la messa a fuoco.

•• Se si utilizza il filtro ND automatico invece della 
funzione di controllo del bokeh, il filtro ND segue il 
cambiamento di luminosità del soggetto.

Visualizzazione durante il 
funzionamento in collegamento di 
guadagno

Quando la funzione di controllo del bokeh è 
impostata su On, il cambiamento del valore di 
diaframma potrebbe causare il cambiamento 
del guadagno.
Quando è attivo il collegamento con il 
guadagno, viene visualizzato un messaggio 
nella parte superiore dello schermo e l’icona 

 sull’indicatore di guadagno lampeggia. 

[Note]
•• Questa funzione è abilitata solo con obiettivi E-mount 

in grado di comunicare con l’unità.
•• L’effetto massimo di questa funzione può essere 

ottenuto utilizzando la ghiera del diaframma su un 
obiettivo Sony E-mount.

•• L’aspetto potrà variare a seconda della velocità 
operativa, dell’obiettivo, delle impostazioni di ripresa 
e del soggetto. Potrà variare anche la luminosità. 
Si consiglia vivamente di eseguire un test con il 
camcorder prima delle riprese effettive.

•• La luminosità potrà variare anche con il cambiamento 
della direzione del funzionamento del diaframma, ad 
esempio quando si apre il diaframma dopo averlo 
chiuso o quando si chiude il diaframma dopo averlo 
aperto. In questo caso, è consigliabile effettuare una 
regolazione leggermente superiore al necessario, 
tornare un po’ indietro, controllare la luminosità e 
quindi iniziare la ripresa.  
Ad esempio, se si desidera aprire il diaframma 
all’apertura F8 e sfocare lo sfondo, chiudere prima 
l’apertura superando F8, tornare quindi a F8, 
controllare la luminosità e iniziare la ripresa.

•• Eseguire le operazioni di controllo del bokeh 
lentamente. Se è necessario eseguire un cambiamento 
rapido, cercare di eseguire la regolazione 
gradualmente controllando sempre, allo stesso tempo, 
i cambiamenti apportati all’immagine.

•• Non è possibile garantire la qualità dell’immagine 
durante il controllo del bokeh in tutte le condizioni di 
ripresa.

•• La funzione di controllo del bokeh viene disattivata 
(impostata su Off) nei casi indicati di seguito.
–– Se l’unità viene spenta
–– Se viene impostato su Auto il diaframma, il 

guadagno, l’otturatore oppure il filtro ND
–– Quando viene selezionata una modalità di ripresa 

diversa.
–– Quando il filtro ND viene impostato su Clear o su 

una modalità Step.
–– Quando viene rimosso l’obiettivo
–– Quando l’unità si riavvia, ad esempio, dopo aver 

cambiato la frequenza.

Impostazione della 
visualizzazione in De-Squeeze

Utilizzando un obiettivo anamorfico per le 
riprese, è possibile ottenere immagini in 
formato Cinemascope.
Impostando la visualizzazione decompressa 
(De-Squeeze) sui valori specifici dell’obiettivo 
anamorfico utilizzato, le immagini emesse 
sull’uscita SDI, sull’uscita HDMI e sul monitor 
LCD avranno un rapporto di aspetto corretto, 
come se il soggetto venisse visualizzato 
direttamente.

È possibile impostare la visualizzazione 
decompressa mediante De-Squeeze 
(pagina 58) nel menu Monitoring del menu 
completo.

[Nota]
Quando il rapporto di decompressione è impostato su 
1.8× o 2.0×, il monitor della forma d’onda (VSM) rileva 
anche le parti laterali sinistra e destra non visualizzate.

Controllo delle alte luci ad alta 
luminanza e delle ombre a bassa 
luminanza

È possibile controllare la presenza di alte luci 
ad alta luminanza e ombre a bassa luminanza 
sull’immagine dell’uscita video o del monitor 
LCD.
Abilitando l’opzione High Key, le eventuali 
differenze nelle aree ad alta luminanza 
diventano più facili da vedere, facilitando il 
rilevamento di alte luci “sparate” nelle zone ad 
alta luminanza.
Abilitando l’opzione Low Key, le eventuali 
differenze nelle aree a bassa luminanza 
diventano più facili da vedere, facilitando il 
rilevamento di ombre “chiuse” nelle zone a 
bassa luminanza.
È possibile scegliere la visualizzazione High 
Key, Low Key oppure Off (visualizzazione 
normale) premendo il pulsante 
programmabile assegnato ad High/Low Key.

[Note]
•• Se il formato di uscita SDI è impostato su un valore 

diverso da Monitor FHD, High/Low Key non può 
essere abilitato quando l’uscita SDI è impostata su 
LUT On.

•• Appare nell’immagine quando LUT On/Off 
(pagina 44) è impostata su LUT On nel menu 
Shooting del menu completo.

•• Se viene eseguita un’operazione quale la modifica 
dell’impostazione del look di base nella schermata 
dei menu o nella schermata Home, la visualizzazione 
High/Low Key viene impostata su Off.
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Registrazione proxy
L’unità consente di registrare un clip proxy 
su una scheda SD contemporaneamente alla 
registrazione sulla scheda CFexpress.

Per informazioni dettagliate sulle schede di memoria 
supportate, sulla formattazione delle schede di memoria 
e sul controllo della capacità rimanente, fare riferimento 
a “Controllo del tempo di registrazione rimanente” 
(pagina 20).

Configurazione prima della ripresa

1	 Impostare su On la voce Proxy Rec 
(pagina 30) nella schermata di stato 
Project oppure la voce Proxy Rec >Setting 
(pagina 47) nel menu Project del menu 
completo.

2	 Inserire la scheda SD nello slot per schede 
Utility SD (pagina 4) con l’etichetta 
rivolta verso l’alto.

[Nota]
La modalità Proxy Rec non può essere impostata su 
On contemporaneamente a Picture Cache Rec, S&Q 
Motion o Interval Rec. Quando Proxy Rec è impostata 
su On, queste altre modalità di registrazione vengono 
automaticamente impostate su Off.

Registrazione di proxy

Premere il pulsante REC (avvio/arresto 
registrazione) per avviare la registrazione 
dopo aver completato le impostazioni 
necessarie per la ripresa.

[Note]
•• Se l’unità viene spenta o la scheda viene rimossa 

durante l’accesso alla scheda, non è possibile 
garantire l’integrità dei dati contenuti sulla scheda. 
Tutti i dati registrati sulla scheda di memoria 
potrebbero essere eliminati. Assicurarsi sempre 
che l’indicatore di accesso alla scheda di memoria 
sia spento prima di spegnere l’unità o rimuovere la 
scheda di memoria stessa.

•• Assicurarsi che la scheda di memoria non salti 
fuori dallo slot al momento dell’inserimento o 
dell’estrazione.

Per uscire, arrestare la registrazione.

Impostazione del canale audio per 
la registrazione proxy

Selezionare Proxy Rec >Audio Channel 
(pagina 47) nel menu Project del menu 
completo e impostare il canale audio per la 
registrazione dei dati proxy.

Informazioni sul file registrato

L’estensione del nome del file è “.mp4”.
Anche il timecode viene registrato 
simultaneamente.

Destinazione di salvataggio del 
file registrato

Il file registrato viene salvato nella directory 
indicata di seguito.

Supporto di 
registrazione

Percorso cartella

Scheda SD /PRIVATE/PXROOT/Clip

Informazioni sul nome dei file

Il nome del file consiste del nome del clip 
registrato sulla scheda di memoria più il 
suffisso “S03”.
Per informazioni dettagliate sul nome dei 
clip, fare riferimento a Clip Name Format 
(pagina 57) nel menu TC/Media del menu 
completo.

[Nota]
Quando viene interrotto il collegamento tra un clip 
originale e un clip proxy, verrà creato un clip proxy 
avente, come nome del clip, il codice temporale all’inizio 
della registrazione.
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Collegamento di un pannello di comando a distanza
Collegando all’unità un pannello di comando 
a distanza RCP-1530/3100/3500/3501 o un 
dispositivo di telecomando analogo tramite 
un cavo LAN diventa possibile controllare e 
comandare alcune funzioni dell’unità tramite 
tale dispositivo.

Collegamento di un pannello di 
comando a distanza

1	 Configurare le impostazioni della rete LAN 
cablata come descritto in “Connessione 
con cavo LAN” (pagina 83).

2	 Impostare su Enable la voce Wired LAN 
>Camera Remote Control (pagina 70) 
nel menu Network del menu completo.

3	 Impostare RCP >CNS Mode (pagina 65) 
nel menu Technical del menu completo su 
Bridge.

4	 Impostare il pannello di comando a 
distanza sulla modalità BRIDGE.

5	 Impostare l’indirizzo IP dell’unità sul 
pannello di comando a distanza.
Per informazioni dettagliate sulla 
connessione, consultare le istruzioni per 
l’uso del pannello di comando a distanza 
specifico.

6	 Connettersi a un pannello di comando a 
distanza collegando il connettore di rete 
dell’unità a un switching hub con 
funzione PoE utilizzando un cavo LAN.

Pannello di comando 
a distanza

Switching hub con 
funzione PoE

7	 Accendere l’unità.
L’unità entra in modalità di comando a 
distanza, consentendo il comando delle 
sue operazioni di ripresa dal pannello di 
comando a distanza.

[Note]
•• La connessione tramite LAN wireless non è possibile.
•• La connessione tramite Internet non è possibile.
•• Non è possibile utilizzare contemporaneamente altre 

funzioni di rete.

Rilascio modalità di comando a 
distanza

1	 Impostare RCP >CNS Mode nel menu 
Technical del menu completo su Off.

2	 Impostare su Disable la voce Wired LAN 
>Camera Remote Control nel menu 
Network del menu completo.

3	 Spegnere l’unità per scollegare il pannello 
di comando a distanza.

[Nota]
Per connettere un dispositivo di comando, ad esempio 
uno smartphone o un tablet, all’unità utilizzando una 
connessione LAN, fare riferimento a “Connessione ad 
altri dispositivi tramite LAN” (pagina 80).

6. Collegamento di dispositivi esterni
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Connessione di monitor e dispositivi di registrazione esterni
Per visualizzare le immagini di registrazione 
e riproduzione su un monitor esterno, 
selezionare il segnale di uscita dell’unità e 
utilizzare il cavo appropriato per il monitor 
esterno da collegare.
È possibile anche collegare dispositivi di 
registrazione, ad esempio un VTR, e registrare 
il segnale in uscita dall’unità.
È possibile visualizzare le varie informazioni di 
stato e il menu su un monitor HDMI esterno. 
Impostare Info. Disp. (pagina 30) nella 
schermata di stato Monitoring oppure Output 
Display (pagina 58) nel menu Monitoring 
del menu completo su On in base al segnale 
da emettere in uscita sul monitor. Quando 
il formato di uscita video è impostato su 
Monitor FHD, è anche possibile visualizzare le 
varie informazioni su un monitor SDI anziché 
su un monitor HDMI.

[Nota]
Osservare sempre le seguenti precauzioni per il 
collegamento all’unità di monitor o dispositivi di 
registrazione esterni. In caso contrario, si potrebbero 
generare flussi di corrente eccessivi nei circuiti interni 
dell’unità che potrebbero danneggiarne i componenti 
elettronici.
1.	 Informazioni sui cavi per corrente continua 

Per il collegamento di monitor esterni e dispositivi di 
registrazione, utilizzare cavi per corrente continua (CC) 
con linea di massa GND a bassa impedenza.

2.	 Controllo della differenza di potenziale 
Prima dell’uso, assicurarsi che non vi sia nessuna 
differenza di potenziale tra tutti i dispositivi collegati 
e l’unità.
(1)	 Scollegare dall’unità tutti i dispositivi collegati, 

quali monitor esterni e dispositivi di registrazione.  
Verificare che non siano collegati né il cavo 
coassiale da 75 Ω, né il cavo HDMI, né altri cavi.

(2)	 Collegare i cavi CC di tutti i dispositivi collegati 
e dell’unità, quindi accendere l’alimentazione di 
ciascun dispositivo collegato e dell’unità.

(3)	 Utilizzando un tester o un altro dispositivo adatto, 
controllare che non vi sia nessuna differenza 
di potenziale tra l’unità e ciascun dispositivo 
collegato.

Qualora sia presente una differenza di potenziale, è 
possibile che l’impedenza di linea GND di uno dei cavi 
CC sia eccessivamente elevata. Sostituire tale cavo 
con uno avente una bassa impedenza di linea GND 
per eliminare la differenza di potenziale.

3.	 Sequenza di connessione e accensione 
Collegare ciascun cavo e attivare l’alimentazione 
nell’ordine indicato di seguito.
(1)	 Spegnere l’unità, il monitor esterno, i dispositivi di 

registrazione e tutti gli altri dispositivi.
(2)	 Collegare i cavi CC di tutti i dispositivi.
(3)	 Collegare il cavo coassiale da 75 Ω, il cavo HDMI e 

gli altri cavi.
(4)	 Accendere tutti i dispositivi collegati e quindi 

l’unità.
Per informazioni dettagliate, rivolgersi a un 
rappresentante di assistenza Sony.

Connettori SDI OUT 1/2 (tipo BNC)

Il connettore SDI OUT 1 può emettere in uscita 
segnali SDI fino a 12G.
Il connettore SDI OUT 2 può emettere in uscita 
segnali SDI fino a 3G.
Impostare il formato di uscita mediante il 
menu Monitoring (pagina 58).
Per il collegamento, utilizzare un cavo 
coassiale da 75 Ω disponibile in commercio.

[Note]
•• 	Durante la registrazione X-OCN, l’uscita SDI non è 

disponibile se è abilitata l’uscita HDMI.
•• 	Assicurarsi che la connessione di terra fra l’unità e il 

dispositivo esterno sia efficacemente connessa a terra 
prima di accendere l’alimentazione. (Si consiglia di 
accendere l’unità e il dispositivo esterno solo dopo 
aver collegato il cavo coassiale da 75 Ω).  
Se è necessario collegare il dispositivo esterno 
all’unità mentre questa è già accesa, collegare il cavo 
coassiale da 75 Ω all’unità solo dopo averlo prima 
collegato al dispositivo esterno.

•• Quando il formato di uscita video è impostato su 
Monitor FHD, alcuni metadati non vengono emessi in 
tempo reale.

Avvio simultaneo della registrazione 
sull’unità e sul dispositivo esterno

Con l’uscita segnale SDI abilitata, impostare 
SDI/HDMI Rec Control (pagina 48) >Setting 
nel menu Project del menu completo su SDI/
HDMI Remote I/F o Parallel Rec per abilitare 

l’emissione di un segnale di trigger REC diretto 
al dispositivo esterno connesso al connettore 
SDI OUT. Questo sincronizzerà la registrazione 
sul dispositivo esterno con l’unità.

[Note]
•• Se il dispositivo esterno connesso non è compatibile 

con il segnale di trigger REC, il dispositivo non può 
essere comandato.

•• Se non è inserito un supporto, viene solamente 
emesso il segnale di trigger REC.

•• Non è possibile selezionare Parallel Rec quando il 
formato di uscita video è impostato su Monitor FHD o 
durante la registrazione X-OCN.

Connettore HDMI OUT (tipo A)

Impostare il formato di uscita mediante il 
menu Monitoring (pagina 58) del menu 
completo.

Avvio simultaneo della registrazione 
sull’unità e sul dispositivo esterno

Con l’uscita segnale HDMI abilitata, impostare 
HDMI TC Out >Setting (pagina 56) nel menu 
TC/Media del menu completo su On, quindi 
impostare SDI/HDMI Rec Control >Setting 
(pagina 48) nel menu Project su SDI/
HDMI Remote I/F o Parallel Rec per abilitare 
l’emissione in uscita di un segnale di trigger 
REC diretto al dispositivo esterno connesso al 
connettore HDMI OUT. Questo sincronizzerà 
la registrazione sul dispositivo esterno con 
l’unità.

[Note]
•• Se il dispositivo esterno connesso non è compatibile 

con il segnale di trigger REC, il dispositivo non può 
essere comandato.

•• Se impostato su SDI/HDMI Remote I/F, viene emesso 
solo il segnale di trigger REC nel caso in cui non sia 
inserito nessun supporto di registrazione.

•• Non è possibile selezionare Parallel Rec durante la 
registrazione X-OCN.
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Per le riprese con più unità, le unità utilizzate 
possono essere sincronizzate insieme su un 
codice temporale o un segnale di riferimento 
specifico tramite il loro connettore REF IN/REF 
OUT.

Sincronizzazione della fase dei 
segnali video (genlock)

Per abilitare il genlock, spostare il selettore 
TC/REF IN/OUT (pagina 6) dell’unità 
sulla posizione IN e fornire un segnale di 
riferimento sul connettore REF IN/REF OUT 
(pagina 7).
I segnali di riferimento utilizzabili variano 
a seconda della frequenza di sistema del 
formato di registrazione selezionato.

Frequenza di 
sistema del 
formato di 
registrazione

Segnali di riferimento in 
ingresso consentiti

59.94P 1920×1080 59.94i 
720×486 59.94i

50P 1920×1080 50i 
720×576 50i

29.97P 1920×1080 59.94i 
720×486 59.94i

25P 1920×1080 50i 
720×576 50i

24P 1920×1080 48i (24PsF)
1920×1080 24P

23.98P 1920×1080 47.95i (23.98PsF)
1920×1080 23.98P

[Note]
•• Se il segnale di riferimento non è stabile, sarà 

impossibile ottenere la sincronizzazione genlock.
•• Il subcarrier non è sincronizzato.

Regolazione della fase di 
sincronizzazione del genlock (timing)

La fase di sincronizzazione del genlock e 
la fase di uscita del segnale video possono 
essere regolate in relazione alla fase del 
segnale di ingresso genlock in incrementi di 
valore discreto fino a un massimo di circa 1 
fotogramma.

1	 Selezionare Genlock >Sync Shift 
(pagina 57) nel menu TC/Media del 
menu completo.

Appare la schermata di regolazione della 
fase del genlock.

2	 Utilizzando i pulsanti direzionali del D-pad 
a 8 posizioni oppure ruotando la 
manopola multifunzione, spostare il 
cursore per selezionare le cifre del valore 
discreto di passo da modificare.

3	 Premere i pulsanti direzionali del D-pad a 
8 posizioni oppure ruotare la manopola 
multifunzione per immettere il valore 
discreto di passo desiderato.
Il valore di passo immesso viene 
convertito in un valore di tempo e 
visualizzato in New Value.
Premendo i pulsanti direzionali del D-pad 
a 8 posizioni oppure la manopola 
multifunzione, il valore visualizzato in New 
Value appare in Current e si riflette sulla 
fase di sincronizzazione del genlock e 
sulla fase del segnale di uscita video.

Se il valore del passo immesso eccede il 
massimo consentito, New Value 
visualizzerà l’avviso “Over”.
Selezionando Apply per applicare il valore, 
il valore visualizzato in New Value appare 
in Current e si riflette sulla fase di 
sincronizzazione del genlock e sulla fase 
del segnale di uscita video.
Selezionare Reset se si desidera 
ripristinare il valore predefinito.

Se il valore del passo supera il massimo 
consentito (il campo New Value visualizza 
l’avviso “Over”), verrà riflesso il valore 
massimo consentito.

4	 Selezionare Set per applicare il valore.

Il valore del passo viene applicato e il 
display torna alla schermata del menu.
Premendo Cancel si ripristina il valore di 
passo precedente e il display torna alla 
schermata del menu.

[Note]
•• Quando il valore di passo viene riflesso sulla fase di 

sincronizzazione genlock, il monitor LCD, l’uscita SDI 
e l’uscita HDMI visualizzeranno momentaneamente 
una schermata nera oppure il messaggio “No Sync”. 
Attendere la stabilizzazione del segnale di uscita e 
controllare il risultato della regolazione della fase.

•• Il valore di passo configurato viene mantenuto anche 
dopo aver spento l’unità. Quando viene immesso 
un segnale genlock, il valore si riflette sulla fase di 
sincronizzazione genlock.

•• Il valore di passo configurato viene reimpostato 
quando si modifica il valore di Frequency del formato 
di registrazione o il valore di Imager Scan Mode. Se 
necessario, configurare nuovamente l’impostazione.

•• Quando il valore di passo è impostato su 0, la fase del 
segnale di ingresso genlock e la fase del segnale di 
uscita video sono identiche.

•• Se il formato di uscita video è impostato su Monitor 
FHD, la fase del segnale di ingresso genlock potrebbe 
non corrispondere alla fase del segnale di uscita 
video.

•• Se il formato di uscita video è impostato su Monitor 
FHD, al riavvio dell’unità dopo lo spegnimento, la 
fase del segnale video di uscita potrebbe risultare 
diversa da quella configurata. In tal caso, regolare 
nuovamente la fase.

•• Se il formato di uscita video è impostato su Monitor 
FHD, la modifica del valore di passo di un solo passo 
potrebbe non aver effetto sulla fase del segnale di 
uscita video. In questo caso, aumentare il valore del 
passo.

Sincronizzazione esterna
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Sincronizzazione del codice 
temporale con altri dispositivi

Impostare l’unità che fornisce il codice 
temporale su una modalità in cui il codice 
temporale continui ad avanzare (es. Free Run 
o Clock).

1	 Impostare l’opzione Timecode 
(pagina 56) del menu TC/Media come 
indicato di seguito.
Mode: Preset
Run: Free Run

2	 Premere il pulsante programmabile 
(pagina 108) a cui è assegnata la 
funzione DURATION/TC/U-BIT per 
visualizzare il codice temporale sullo 
schermo.

3	 Controllare che il selettore TC/REF IN/OUT 
(pagina 6) si trovi sulla posizione IN, 
quindi fornire un segnale di riferimento 
HD o SD al connettore REF IN/REF OUT e 
un codice temporale di riferimento al 
connettore TC IN/TC OUT.

Il generatore del codice temporale dell’unità 
si sincronizza con il codice temporale 
di riferimento e sullo schermo appare 
l’indicazione “EXT-LK”.
Una volta trascorsi dieci secondi circa 
dall’acquisizione della sincronizzazione, 
lo stato di sincronizzazione esterno viene 
mantenuto anche se la sorgente di riferimento 
esterna del codice temporale viene scollegata.

[Note]
•• Controllare che il codice temporale di riferimento e 

il segnale video di riferimento siano in un rapporto 
di fase conforme agli standard SMPTE per i codici 
temporali.

•• Durante il funzionamento in modalità di 
sincronizzazione esterna, il codice temporale 
acquisisce istantaneamente la sincronizzazione 
con il codice temporale esterno e nella sezione di 
visualizzazione dei dati viene visualizzato il valore 
del codice temporale esterno. Tuttavia, non avviare 
immediatamente la registrazione. Prima di avviare la 
registrazione è necessario attendere alcuni secondi la 
stabilizzazione del generatore del codice temporale.

•• Se la frequenza del codice temporale di riferimento 
è diversa dalla frequenza fotogrammi dell’unità, 
non sarà possibile ottenere la sincronizzazione e 
l’unità non potrà funzionare correttamente. In questo 
caso, il codice temporale non potrà sincronizzarsi 
correttamente con il codice temporale esterno.

•• Se la sorgente del codice temporale esterno viene 
disconnessa, il codice temporale potrà variare di un 
fotogramma all’ora rispetto al codice temporale di 
riferimento.

Per rilasciare la sincronizzazione esterna

Cambiare l’impostazione di Timecode nel 
menu TC/Media.
La sincronizzazione esterna viene annullata 
anche quando si cambia frequenza di sistema 
o quando si avvia la registrazione in una 
modalità di registrazione speciale (Slow & 
Quick Motion o Interval Rec).

Sincronizzazione del codice 
temporale di un altro dispositivo 
con il codice temporale dell’unità

Impostare il codice temporale dell’unità su 
una modalità in cui continui ad aggiornarsi (es. 
Free Run o Clock).

1	 Impostare il codice temporale dell’unità 
con la voce Timecode (pagina 56) del 
menu TC/Media del menu completo.

2	 Controllare che il selettore TC/REF IN/OUT 
(pagina 6) si trovi nella posizione OUT, 
quindi collegare il connettore TC IN/TC 
OUT e il connettore REF IN/REF OUT ai 
connettori di ingresso rispettivamente del 
codice temporale e del segnale di 
riferimento del dispositivo che si desidera 
sincronizzare.
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Gestione ed editing di clip con un computer

Connessione con cavo USB

Utilizzo di un lettore di schede (opzione)

Collegare un lettore di schede CFexpress 
Type B o SD a un computer mediante un 
cavo USB ed inserire una scheda di memoria 
nello slot del lettore di schede. La scheda di 
memoria viene riconosciuta come un’unità 
di estensione del computer. Sui computer 
supportati, è possibile importare clip ad 
alta velocità utilizzando la modalità di 
memorizzazione di massa dell’unità.

Utilizzo della modalità di 
memorizzazione di massa

[Nota]
La modalità di memorizzazione di massa non può 
essere utilizzata quando USB Tethering >Setting nel 
menu Network del menu completo è impostato su On. 
Impostare su Off.

Collegare l’unità mediante un cavo USB, quindi 
inserire una scheda di memoria nello slot A 
o nello slot B. La scheda di memoria viene 
riconosciuta come un’unità di estensione del 
computer.

1	 Servendosi di un cavo USB, collegare al 
computer il connettore USB-C 
(pagina 5).

2	 Accendere l’unità.
Sul monitor LCD viene visualizzato un 
messaggio che richiede se abilitare la 
connessione USB.

	 [Note]
•• 	Non eseguire le seguenti operazioni se 

l’indicatore di accesso è illuminato in rosso.
–– Spegnere l’apparecchio o scollegare il cavo di 

alimentazione.
–– Rimuovere una scheda di memoria
–– Scollegare il cavo USB

•• Il messaggio di conferma della connessione 
USB non viene visualizzato se è già visualizzato 
un altro messaggio di conferma o un indicatore 
di avanzamento, ad esempio durante la 
formattazione o il recupero di una scheda di 
memoria.  
Il messaggio di conferma verrà visualizzato al 
termine della formattazione o del recupero. Il 
messaggio di conferma USB non è visualizzato 
neanche quando è visualizzata la schermata 
delle proprietà del clip. Il messaggio verrà 
visualizzato al termine dell’operazione o quando 
si ritorna alla schermata dei clip.

3	 Ruotare la manopola multifunzione e 
selezionare Execute.

4	 Su Windows, controllare che la scheda sia 
aggiunta come disco rimovibile nella 
finestra “My Computer”.
Su Mac, controllare che sia stata creata sul 
Desktop una cartella con il nome “NO 
NAME” o “Untitled” (modificabile).

[Note]
•• Non eseguire le seguenti operazioni se l’indicatore di 

accesso è illuminato in rosso.
–– Spegnere l’apparecchio o scollegare il cavo di 

alimentazione
–– Rimuovere una scheda di memoria
–– Scollegare il cavo USB

•• Il funzionamento non è garantito con tutti i computer.

Utilizzo di un sistema di editing 
non lineare

In un sistema di editing non lineare, è 
necessario utilizzare un software di editing 
(opzione) che supporti i formati registrati 
dall’unità.
Utilizzare un software applicativo dedicato 
per salvare in anticipo sul disco rigido del 
computer i clip di cui eseguire l’editing.
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Precauzioni per l’uso
Leggere questa sezione insieme alle 
informazioni contenute nel documento 
“Prima di usare l’apparecchio” fornito con 
l’apparecchio stesso.

Utilizzo e conservazione

Non sottoporre l’unità a urti eccessivi

Il meccanismo interno potrebbe risultarne 
danneggiato e la struttura dell’apparecchio 
deformata.

Non coprire l’unità durante il 
funzionamento

La copertura del dispositivo con un panno, 
ad esempio, potrebbe provocare un calore 
interno eccessivo.

Dopo l’uso

Spegnere l’unità.

Prima di riporre l’unità per periodi 
prolungati

Rimuovere il pacco batteria.

Non lasciare l’unità con l’obiettivo rivolto 
in direzione del sole

La luce solare diretta condotta dalle ottiche 
può mettersi a fuoco all’interno dell’unità e 
causare incendi.

Spedizione

•• Rimuovere le schede di memoria prima di 
trasportare l’unità.

•• In caso di spedizione o trasporto mediante 
camion, nave, aereo o altro mezzo, imballare 
sempre l’unità nel suo imballo di spedizione.

Manutenzione dell’unità

Se sporca, pulire l’unità con un panno morbido 
e asciutto. In casi estremi, usare un panno 
inumidito con alcune gocce di detergente 
neutro, quindi asciugare.
Per evitare di scolorire o danneggiare la finitura 
superficiale dell’unità, non utilizzare mai 
solventi organici, ad esempio alcool o diluenti.
Per evitare di danneggiare i componenti ottici, 
non utilizzare aria compressa per la pulizia, 
come ad esempio bombolette antipolvere.

In caso di problemi di funzionamento

In caso di problemi, rivolgersi al proprio 
rivenditore Sony.

Ventola

La ventola è una parte di consumo e necessita 
di una sostituzione periodica.
Se l’apparecchio viene utilizzato a temperatura 
ambiente, il ciclo normale di sostituzione 
è di circa 5 anni. Tuttavia, ciò ha un valore 
puramente indicativo e non implica alcuna 
garanzia sulla durata di vita prevista di questo 
componente. Per ulteriori informazioni sulla 
sostituzione dei componenti, rivolgersi al 
proprio rivenditore.

Condensatore elettrolitico

La vita utile prevista del condensatore 
elettrolitico è di circa 5 anni a temperature 
normali e in condizioni di utilizzo normale  
(8 ore al giorno per 25 giorni al mese).
Se le condizioni di utilizzo eccedono i valori 
normali sopra indicati, la vita prevista si ridurrà 
proporzionalmente.

Nota sul terminale di contatto 
della batteria

Il terminale della batteria dell’apparecchio (il 
connettore per pacchi batteria e adattatori CA) 
è un prodotto di consumo.
Se i piedini del terminale sono piegati e 
deformati a causa di urti o vibrazioni, o se 
vengono corrosi a causa di un uso prolungato 
all’aria aperta, l’alimentazione potrebbe non 
essere fornita correttamente.
Si consiglia di eseguire dei controlli periodici 
per assicurare il funzionamento corretto 
dell’apparecchio e prolungarne la vita utile. Per 
ulteriori informazioni sui controlli, contattare il 
servizio tecnico o un rappresentante Sony.

Ambienti d’uso e conservazione

Conservare in un luogo ventilato e a 
temperatura costante.
Evitare di usare o conservare l’apparecchio negli 
ambienti indicati di seguito.
•• In presenza di temperature eccessivamente 

alte o basse (temperatura di funzionamento 
permessa compresa fra 0 °C e 40 °C)  
Ricordare che in estate, in climi caldi, la 

temperatura all’interno di un’auto con i 
finestrini chiusi può facilmente superare i 
50 °C.

•• In luoghi umidi o polverosi
•• In luoghi in cui l’unità potrebbe essere 

esposta a pioggia
•• In luoghi sottoposti a forti vibrazioni
•• In prossimità di forti campi magnetici
•• In prossimità di impianti di trasmissione 

radio o TV che producono forti campi 
elettromagnetici.

•• In esposizione alla luce solare diretta o in 
prossimità di fonti di riscaldamento per 
periodi prolungati

Prevenzione delle interferenze 
elettromagnetiche causate da dispositivi 
di comunicazione portatili

L’uso di telefoni portatili e di altri dispositivi 
di comunicazione in prossimità di questa 
unità potrebbe causare malfunzionamenti ed 
interferenze con i segnali audio e video.
Si consiglia di spegnere eventuali dispositivi 
di comunicazione portatili nelle vicinanze di 
questa unità.

Nota sui raggi laser

I raggi laser possono danneggiare il sensore 
immagine CMOS. Qualora vengano riprese 
scene in cui sono presenti raggi laser, evitare 
che tali raggi colpiscano l’obiettivo dell’unità. 
I particolare, i fasci laser ad alta potenza 
generati da dispositivi medicali o di altro tipo 
possono causare danni anche se riflessi o 
diffusi.
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Informazioni sugli schermi

•• Non lasciare gli schermi esposti alla luce 
solare diretta in quanto la luce solare diretta 
potrebbe causare danni.

•• Non esercitare eccessiva pressione 
premendo o passando le dita sugli schermi, 
né lasciare oggetti appoggiati su di essi 
in quanto la pressione potrebbe causarne 
il malfunzionamento, come ad esempio 
irregolarità dell’immagine, ecc.

•• Gli schermi potrebbero riscaldarsi durante 
l’uso. Non si tratta di un guasto.

Pannelli LCD

Il pannello LCD di cui è dotato l’apparecchio è 
prodotto con tecnologia ad alta precisione che 
consente di ottenere una percentuale di pixel 
funzionanti minima di ben 99,99%. È quindi 
possibile che una piccolissima percentuale 
dei pixel possa rimanere “bloccata”, sempre 
disattivata (nera), sempre attivata (rossa, verde 
o blu) oppure lampeggiante. È inoltre possibile 
che, dopo un lungo periodo d’uso, alcuni pixel 
si “blocchino” spontaneamente a causa delle 
caratteristiche fisiche del display a cristalli 
liquidi.
Tali fenomeni non sono il risultato di guasti e
non hanno alcun effetto sui dati registrati.

Condensazione

Qualora l’unità venga spostata rapidamente 
da un ambiente freddo a uno caldo, oppure se 
la temperatura ambiente dovesse aumentare 
improvvisamente, è possibile che si formi 
umidità sulle superfici esterne dell’unità e/o al 
suo interno. Questo fenomeno è denominato 
condensazione. In tal caso, spegnere l’unità ed 
attendere la scomparsa della condensazione 
prima di riavviarla. L’utilizzo dell’unità mentre 
è presente condensazione può causare danni 
all’unità stessa.

Fenomeni intrinsechi al sensore 
immagini CMOS della telecamera

[Nota]
Di seguito si descrivono alcuni fenomeni che potrebbero 
apparire nelle immagini. Tali fenomeni sono intrinsechi 
dei sensori di immagine. Non possono esser considerati 
malfunzionamenti.

Macchiette bianche

I sensori di immagine sono prodotti con 
tecnologie di elevatissima precisione. 
Ciononostante possono presentarsi sullo 
schermo in alcuni rari casi piccole macchiette 
bianche, causate da raggi cosmici ecc.
Questo fenomeno è intrinseco al principio di 
funzionamento dei sensori immagine e non 
indica la presenza di guasti.
Le macchiette bianche tendono ad apparire 
principalmente nei seguenti casi:
•• in caso di elevate temperature ambiente
•• se è stato aumentato il guadagno 

(sensibilità)

Sfarfallio

Nelle riprese effettuate con illuminazione 
prodotta da lampade fluorescenti o LED o 
ai vapori di sodio o di mercurio, lo schermo 
potrebbe presentare fenomeni di sfarfallio e i 
colori potrebbero apparire alterati.

Nota relative allo schermo

Le seguenti operazioni possono causare 
distorsioni alle immagini sullo schermo del 
mirino e sulle uscite:

–– Modifica del formato video
–– Modifica della velocità fotogrammi FPS
–– Applicazione del genlock

Frammentazione dei file

Se non è possibile registrare o riprodurre 
correttamente le immagini, provare a 
formattare il supporto di registrazione. 
Se vengono eseguite operazioni di 
registrazione o riproduzione ripetutamente 
su uno stesso supporto di memoria per 
un periodo prolungato, è possibile che si 
verifichi la frammentazione dei file contenuti 
nel supporto, impedendo una corretta 
registrazione e memorizzazione. In tal 
caso, eseguire il backup dei clip contenuti 
sul supporto quindi formattare il supporto 
utilizzando Format Media (pagina 57) nel 
menu TC/Media del menu completo.

Non collocare questo prodotto 
nelle vicinanze di dispositivi 
medicali 

Questo prodotto (accessori inclusi) contiene 
magneti che potrebbero interferire con 
pacemaker, valvole shunt programmabili per 
il trattamento dell’idrocefalo o altri dispositivi 
medicali. Non collocare questo prodotto 
nelle vicinanze di persone che fanno uso di 
tali dispositivi medicali. Consultare il proprio 
medico prima di usare questo prodotto se si fa 
uso di dispositivi medicali.

Precauzioni per la sicurezza

•• Dal punto di vista della sicurezza, si consiglia 
vivamente di mantenere sempre aggiornata 
l’unità all’ultima versione del software. Per 
informazioni dettagliate sulle precauzioni 
per la sicurezza, visitare il seguente sito 
Web. 
https://helpguide.sony.net/pro/network_
security_c/v1/h_zz/index.html

•• SONY NON SARÀ RESPONSABILE PER DANNI 
DI QUALSIASI TIPO RISULTANTI DALLA 
MANCATA IMPLEMENTAZIONE DI ADEGUATE 
MISURE DI SICUREZZA SUI DISPOSITIVI DI 
TRASMISSIONE, DA INEVITABILI PERDITE 
O FUGHE DI DATI RISULTANTI DALLE 
SPECIFICHE TECNICHE DELLA TRASMISSIONE 
O DA PROBLEMATICHE RELATIVE ALLA 
SICUREZZA DI QUALSIASI TIPO.

•• A seconda dell’ambiente operativo, il 
sistema potrebbe risultare accessibile in rete 
a terzi non autorizzati. Prima di collegare 
l’apparecchio in rete, assicurarsi che la rete 
sia protetta in modo sicuro.

https://helpguide.sony.net/pro/network_security_c/v1/h_zz/index.html
https://helpguide.sony.net/pro/network_security_c/v1/h_zz/index.html
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•• Il contenuto trasmesso può essere 
intercettato da terze parti non autorizzate 
che si trovano in prossimità dei segnali 
senza la conoscenza dell’utente. Quando si 
utilizza la modalità di comunicazione LAN 
wireless, implementare adeguate misure di 
sicurezza per proteggere il contenuto della 
comunicazione.

•• Il collegamento del prodotto a una rete 
deve essere realizzato mediante un sistema 
in grado di fornire funzioni di protezione, 
ad esempio un router o un firewall. In caso 
di collegamento senza tale protezione si 
potrebbero verificare problemi di sicurezza.

•• Per garantire la protezione, quando si 
utilizza l’unità collegata alla rete, si consiglia 
di accedere alla finestra di controllo 
tramite un browser Web e di modificare le 
impostazioni della limitazione di accesso 
rispetto ai valori predefiniti (pagina 68).  
Si consiglia anche di modificare la password 
regolarmente.

•• Durante l’esecuzione di impostazioni o 
dopo aver eseguito impostazioni, non 
visitare nessun altro sito Web con il browser 
Web. Dato che le impostazioni di accesso 
permangono nel browser Web, chiudere 
sempre il browser Web dopo avere eseguito 
le impostazioni per impedire l’utilizzo 
dell’apparecchio da parte di terzi non 
autorizzati o l’esecuzione di programmi 
dannosi.
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Le impostazioni predefinite sono indicate in grassetto (ad esempio, 1920×1080P (Level A)).

[Note]
•• La risoluzione del formato di uscita è limitata dalle impostazioni delle voci Rec Format >Frequency, Codec e Video Format nel menu Project del menu completo (pagina 46).
•• L’immagine non viene emessa in uscita se è configurata una risoluzione superiore a quella dell’immagine di riproduzione.
•• Quando la frequenza di sistema è 50/59.94 Hz, l’uscita Monitor FHD sarà 1920×1080P Level-A.

Formati di uscita per il connettore SDI OUT/HDMI OUT

Impostazione della frequenza di 
impostazione
(Rec Format >Frequency nel menu Project)

Impostazione del codec
(Rec Format >Codec nel menu Project)

Risoluzione di registrazione Formato di uscita (Output Format nel menu Monitoring)

SDI1 SDI2 HDMI

50/59.94Hz X-OCN LT (6K 17:9)
(5.8K 17:9)
(4.3K 4:3)
(4K 17:9)

Monitor FHD Monitor FHD –

– – 4096×2160P

– – 1920×1080P

– – 1920×1080i

(6K 16.9)
(5.8K 16:9)
(3.8K 16:9)

Monitor FHD Monitor FHD –

– – 3840×2160P

– – 1920×1080P

– – 1920×1080i

XAVC Intra 4096×2160
(17:9)

Monitor FHD Monitor FHD –

4096×2160P1) 2048×1080P(A)1) 4096×2160P1)

4096×2160P1) 2048×1080P(A)1) 1920×1080P1)

4096×2160P1) 2048×1080P(A)1) 1920×1080i1)

1920×1080P(A) 1920×1080P(A) 1920×1080P

1920×1080P(A) 1920×1080P(A) 1920×1080i

1920×1080P(B) 1920×1080P(B) 1920×1080P

1920×1080P(B) 1920×1080P(B) 1920×1080i

1920×1080i 1920×1080i 1920×1080i

Formati di uscita e limitazioni
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Impostazione della frequenza di 
impostazione
(Rec Format >Frequency nel menu Project)

Impostazione del codec
(Rec Format >Codec nel menu Project)

Risoluzione di registrazione Formato di uscita (Output Format nel menu Monitoring)

SDI1 SDI2 HDMI

50/59.94Hz XAVC Intra
XAVC Long

3840×2160
(16:9)

Monitor FHD Monitor FHD –

3840×2160P1) 1920×1080P(A)1) 3840×2160P1)

3840×2160P1) 1920×1080P(A)1) 1920×1080P1)

3840×2160P1) 1920×1080P(A)1) 1920×1080i1)

1920×1080P(A) 1920×1080P(A) 1920×1080P

1920×1080P(A) 1920×1080P(A) 1920×1080i

1920×1080P(B) 1920×1080P(B) 1920×1080P

1920×1080P(B) 1920×1080P(B) 1920×1080i

1920×1080i 1920×1080i 1920×1080i

XAVC Intra
XAVC Long

1920×1080
(16:9)

Monitor FHD2) Monitor FHD2) –

1920×1080P(A)2) 1920×1080P(A)2) 1920×1080P2)

1920×1080P(A)2) 1920×1080P(A)2) 1920×1080i2)

1920×1080P(B)2) 1920×1080P(B)2) 1920×1080P2)

1920×1080P(B)2) 1920×1080P(B)2) 1920×1080i2)

1920×1080i2) 1920×1080i2) 1920×1080i2)

– – 720×480P2), 720×576P2)

25/29.97Hz X-OCN LT (8.6K 17:9)
(6K 17:9)
(5.8K 17:9)
(4.3K 4:3)
(4K 17:9)

Monitor FHD Monitor FHD –

– – 4096×2160P

– – 1920×1080P

(8.6K 16.9)
(6K 16.9)
(5.8K 16:9)
(3.8K 16:9)

Monitor FHD Monitor FHD –

– – 3840×2160P

– – 1920×1080P

XAVC H-I HQ
XAVC H-I SQ

8192×4320
(17:9)

Monitor FHD Monitor FHD –

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i

XAVC H-I HQ
XAVC H-I SQ
XAVC H-L

7680×4320
(16:9)

Monitor FHD Monitor FHD –

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i
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Impostazione della frequenza di 
impostazione
(Rec Format >Frequency nel menu Project)

Impostazione del codec
(Rec Format >Codec nel menu Project)

Risoluzione di registrazione Formato di uscita (Output Format nel menu Monitoring)

SDI1 SDI2 HDMI

25/29.97Hz XAVC Intra 4096×2160
(17:9)

Monitor FHD Monitor FHD –

4096×2160P1) 2048×1080P1) 4096×2160P1)

4096×2160P1) 2048×1080P1) 1920×1080P1)

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i

XAVC Intra
XAVC Long

3840×2160
(16:9)

Monitor FHD Monitor FHD –

3840×2160P1) 1920×1080P1) 3840×2160P1)

3840×2160P1) 1920×1080P1) 1920×1080P1)

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i

XAVC Intra
XAVC Long

1920×1080
(16:9)

Monitor FHD2) Monitor FHD2) –

1920×1080P2) 1920×1080P2) 1920×1080P2)

1920×1080PsF2) 1920×1080PsF2) 1920×1080i2)

23.98Hz X-OCN LT (8.6K 17:9)
(6K 17:9)
(5.8K 17:9)
(4.3K 4:3)
(4K 17:9)

Monitor FHD Monitor FHD –

– – 4096×2160P

– – 1920×1080P

(8.6K 16.9)
(6K 16.9)
(5.8K 16:9)
(3.8K 16:9)

Monitor FHD Monitor FHD –

– – 3840×2160P

– – 1920×1080P

XAVC H-I HQ
XAVC H-I SQ

8192×4320
(17:9)

Monitor FHD Monitor FHD –

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080P

XAVC H-I HQ
XAVC H-I SQ
XAVC H-L

7680×4320
(16:9)

Monitor FHD Monitor FHD –

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080P
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Impostazione della frequenza di 
impostazione
(Rec Format >Frequency nel menu Project)

Impostazione del codec
(Rec Format >Codec nel menu Project)

Risoluzione di registrazione Formato di uscita (Output Format nel menu Monitoring)

SDI1 SDI2 HDMI

23.98Hz XAVC Intra 4096×2160
(17:9)

Monitor FHD Monitor FHD –

4096×2160P1) 2048×1080P1) 4096×2160P1)

4096×2160P1) 2048×1080P1) 1920×1080P1)

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080P

XAVC Intra
XAVC Long

3840×2160
(16:9)

Monitor FHD Monitor FHD –

3840×2160P1) 1920×1080P1) 3840×2160P1)

3840×2160P1) 1920×1080P1) 1920×1080P1)

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080P

XAVC Intra
XAVC Long

1920×1080
(16:9)

Monitor FHD2) Monitor FHD2) –

1920×1080P2) 1920×1080P2) 1920×1080P2)

1920×1080PsF2) 1920×1080PsF2) 1920×1080P2)

24Hz X-OCN LT (8.6K 17:9)
(6K 17:9)
(5.8K 17:9)
(4.3K 4:3)
(4K 17:9)

Monitor FHD Monitor FHD –

– – 4096×2160P

– – 1920×1080P

(8.6K 16.9)
(6K 16.9)
(5.8K 16:9)
(3.8K 16:9)

Monitor FHD Monitor FHD –

– – 3840×2160P

– – 1920×1080P

XAVC H-I HQ
XAVC H-I SQ

8192×4320
(17:9)

Monitor FHD Monitor FHD –

1920×1080P 1920×1080P 1920×1080P

XAVC Intra 4096×2160
(17:9)

Monitor FHD Monitor FHD –

4096×2160P1) 2048×1080P1) 4096×2160P1)

1920×1080P 1920×1080P 1920×1080P

1)	 Non è selezionabile se la frequenza fotogrammi è 66 fps o superiore nelle riprese in modalità Slow & Quick Motion.
2)	Non è selezionabile se la frequenza fotogrammi è 240 fps nelle riprese in modalità Slow & Quick Motion.
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Tempi di registrazione e riproduzione dei clip
Le seguenti tabelle mostrano i tempi di registrazione e riproduzione quando si utilizzano schede di memoria Sony CFexpress Type B VPG400 da 960 GB (unità: minuti).

[Nota]
I tempi di registrazione e di riproduzione si riferiscono alla registrazione continua di un unico clip. I tempi effettivi potrebbero risultare inferiori a seconda del numero di clip registrati. I tempi di registrazione e riproduzione potrebbero essere 
diversi a seconda delle condizioni di utilizzo e delle caratteristiche della memoria.

Imager Scan 
Mode

Frequency Codec

X-OCN (LT) XAVC H-I HQ 
8192×4320

XAVC H-I HQ 
7680×4320

XAVC H-I SQ 
8192×4320

XAVC H-I SQ 
7680×4320

XAVC H-L 
7680×4320

XAVC-I 
4096×2160

XAVC-I 
3840×2160

XAVC-I 
1920×1080

XAVC-L 
3840×2160

XAVC-L 
1920×1080

FF 8.6K 17:9 23.98 74 130 – 194 – – – – – – –

24 74 130 – 193 – – – – – – –

25 71 125 – 186 – – – – – – –

29.97 59 104 – 155 – – – – – – –

50 – – – – – – – – – – –

59.94 – – – – – – – – – – –

FF 8.6K 16:9 23.98 69 – 130 – 194 239 – – – – –

24 69 – – – – – – – – – –

25 66 – 125 – 186 239 – – – – –

29.97 55 – 104 – 155 238 – – – – –

50 – – – – – – – – – – –

59.94 – – – – – – – – – – –

FFc 6K 17:9 23.98 149 – – – – – 494 – – – –

24 149 – – – – – 493 – – – –

25 143 – – – – – 473 – – – –

29.97 119 – – – – – 397 – – – –

50 71 – – – – – 241 – – – –

59.94 60 – – – – – 201 – – – –

FFc 6K 16:9 23.98 140 – – – – – – 494 1207 1145 2121

24 140 – – – – – – – – – –

25 134 – – – – – – 473 985 1140 2106

29.97 112 – – – – – – 397 981 1127 2070

50 67 – – – – – – 241 512 756 1939

59.94 56 – – – – – – 201 510 745 1878

FFc 3.8K 16:9 23.98 342 – – – – – – 494 1207 1145 2121

24 341 – – – – – – – – – –

25 328 – – – – – – 473 985 1140 2106

29.97 274 – – – – – – 397 981 1127 2070

50 165 – – – – – – 241 512 756 1939

59.94 137 – – – – – – 201 510 745 1878



7. Appendice: Tempi di registrazione e riproduzione dei clip127

Imager Scan 
Mode

Frequency Codec

X-OCN (LT) XAVC H-I HQ 
8192×4320

XAVC H-I HQ 
7680×4320

XAVC H-I SQ 
8192×4320

XAVC H-I SQ 
7680×4320

XAVC H-L 
7680×4320

XAVC-I 
4096×2160

XAVC-I 
3840×2160

XAVC-I 
1920×1080

XAVC-L 
3840×2160

XAVC-L 
1920×1080

S35 5.8K 17:9 23.98 164 – – – – – 494 – – – –

24 164 – – – – – 493 – – – –

25 157 – – – – – 473 – – – –

29.97 131 – – – – – 397 – – – –

50 79 – – – – – 241 – – – –

59.94 65 – – – – – 201 – – – –

S35 5.8K 16:9 23.98 154 – – – – – – 494 1207 1145 2121

24 154 – – – – – – – – – –

25 147 – – – – – – 473 985 1140 2106

29.97 123 – – – – – – 397 981 1127 2070

50 74 – – – – – – 241 512 756 1939

59.94 61 – – – – – – 201 510 745 1878

S35 4.3K 4:3 23.98 211 – – – – – – – – – –

24 211 – – – – – – – – – –

25 202 – – – – – – – – – –

29.97 169 – – – – – – – – – –

50 101 – – – – – – – – – –

59.94 84 – – – – – – – – – –

S35c 4K 17:9 23.98 321 – – – – – 494 – – – –

24 321 – – – – – 493 – – – –

25 308 – – – – – 473 – – – –

29.97 257 – – – – – 397 – – – –

50 155 – – – – – 241 – – – –

59.94 129 – – – – – 201 – – – –

S35 1.9K 16:9 23.98 – – – – – – – – 1207 – 2121

24 – – – – – – – – – – –

25 – – – – – – – – 985 – 2106

29.97 – – – – – – – – 981 – 2070

50 – – – – – – – – 512 – 1939

59.94 – – – – – – – – 510 – 1878
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Ricerca e risoluzione dei problemi

Alimentazione

Problema Causa Soluzione

L’unità non si accende. Non è montato un pacco 
batteria e non viene fornita 
alimentazione al connettore 
DC IN.

Montare un pacco batteria 
(pagina 14) o collegare alla rete 
elettrica mediante un adattatore CA 
(pagina 14).

Il pacco batteria è 
completamente scarico.

Sostituire il pacco batteria con uno 
completamente carico (pagina 14).

L’alimentazione si 
interrompe durante il 
funzionamento.

Il pacco batteria si è scaricato 
completamente.

Sostituire il pacco batteria con uno 
completamente carico (pagina 14).

Il pacco batteria si scarica 
velocemente.

La temperatura ambiente è 
molto bassa.

Tale condizione è dovuta alle 
caratteristiche della batteria e non è un 
difetto.

Il pacco  batteria non è 
caricato correttamente.

Ricaricare il pacco batteria 
(pagina 14).
Se il pacco batteria si scarica 
rapidamente anche dopo esser stata 
caricato completamente, potrebbe aver 
raggiunto la fine della sua vita utile. 
Sostituirlo con uno nuovo.

Registrazione/riproduzione

Problema Causa Soluzione

La registrazione non si avvia 
quando si preme il pulsante 
REC (avvio/arresto 
registrazione).

La scheda di memoria è 
piena.

Sostituire la scheda di memoria con 
un’altra che disponga di spazio 
sufficiente.

La scheda di memoria deve 
essere ripristinata.

Ripristinare la scheda di memoria 
(pagina 20).

La registrazione audio non è 
possibile.

Le manopole di regolazione 
AUDIO LEVEL (CH1/CH2) sono 
impostate sul livello minimo.

Regolare i livelli di registrazione audio 
con le manopole AUDIO LEVEL (CH1/
CH2) (pagina 106).

Il suono registrato è distorto. Il livello audio è troppo 
elevato.

Regolare i livelli di registrazione audio 
con le manopole AUDIO LEVEL (CH1/
CH2) (pagina 106).

Problema Causa Soluzione

Nell’audio registrato è 
presente un alto livello di 
rumore.

Il livello audio è troppo 
basso.

Regolare i livelli di registrazione audio 
con le manopole AUDIO LEVEL (CH1/
CH2) (pagina 106).
Quando è selezionato un microfono 
esterno, impostare anche la voce Audio 
Input >INPUT MIC Reference 
(pagina 61) nel menu Audio del 
menu completo.

Non è possibile riprodurre 
clip.

È in corso l’editing di un clip. Non è possibile riprodurre clip se sono 
stati modificati i nomi di file o delle 
cartelle oppure se il clip è in uso su un 
computer. Questo non indica la 
presenza di guasti.

È in corso la registrazione del 
clip su un altro dispositivo.

Potrebbe non essere possibile 
riprodurre clip registrati con altri 
dispositivi, oppure potrebbero essere 
visualizzati con dimensioni errate. 
Questo non indica la presenza di guasti.

Dispositivi esterni

Problema Soluzione

Il computer non riconosce 
l’unità.

Scollegare il cavo USB dal computer, quindi collegarlo di nuovo 
saldamente.

Scollegare il cavo USB dal computer, riavviare il computer e 
ripetere nuovamente la procedura nell’ordine corretto.

Collegare il computer e l’unità inserendo un cavo USB nel 
connettore USB-C o nel connettore USB/multi.

Non è possibile caricare clip sul 
computer.

Scollegare il cavo USB dal computer, riavviare l’unità e quindi 
eseguire nuovamente la connessione.

Un apposito software applicativo deve essere installato per poter 
caricare clip sul computer (pagina 118).
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Connessione LAN wireless

[Nota]
La presenza di ostruzioni o interferenze elettromagnetiche fra l’unità e il punto di accesso LAN wireless o il dispositivo 
terminale, oppure la configurazione dell’ambiente (ad esempio il materiale delle pareti), potrebbe ridurre il campo 
di comunicazione possibile o addirittura impedire completamente la connessione. Qualora si rilevino tali problemi, 
controllare lo stato della connessione o della comunicazione spostando l’unità in un altro luogo oppure avvicinandola 
al punto di accesso o dispositivo terminale utilizzato.

Problema Soluzione

Un dispositivo terminale non 
può accedere all’unità.

•• Controllare la connessione LAN wireless (indirizzo IP, ecc.).
•• Le impostazioni di comunicazione tra il punto di accesso e il 

client potrebbero non essere valide. Per informazioni dettagliate, 
fare riferimento alle istruzioni per l’uso del punto di accesso.

Non è possibile eseguire il login 
sull’unità.

Verificare il nome utente e la password impostati.

Connessione Internet

Problema Soluzione

L’upload del file non avviene 
correttamente.

Il nome utente e la password del server potrebbero non essere 
corretti.
Immettere nome utente e password corretti.

La funzione di upload di file 
potrebbe non essere disponibile.

Le condizioni del segnale potrebbero essere insufficienti.
Spostare il camcorder in un luogo diverso e riprovare.

Durante l’utilizzo del filtro ND

Problema Soluzione

Il filtro ND non si muove. Spostare manualmente il filtro sulla posizione Clear utilizzando la 
procedura descritta di seguito.

1	 Spostare il selettore ND STEP/VARIABLE (pagina 5) sulla posizione STEP e premere il 
pulsante giù del pulsante su/giù ND FILTER POSITION (pagina 5) in modo che la spia ND 
CLEAR si illumini.

2	 Spegnere l’unità.

3	 Rimuovere il coperchietto rotondo (2 posizioni) sul lato inferiore.

4	 Inserire un piccolo cacciavite nel foro (2 posizioni) e ruotarlo in senso antiorario.
•• Il filtro ND si sposta sulla posizione Clear ruotando in senso antiorario. Continuare a 

ruotare il cacciavite fino a raggiungere la posizione Clear.
•• Utilizzare un cacciavite con diametro massimo di 2,4 mm. La profondità di inserimento del 

cacciavite è di circa 3,0 cm.

Foro per il cacciavite  
(con il coperchietto rimosso)

[Note]
•• Non utilizzare questa procedura durante il normale funzionamento dell’apparecchio. Utilizzare questa procedura 

solo se il filtro ND non si muove. Il filtro ND potrebbe danneggiarsi se questa procedura viene utilizzata durante il 
normale funzionamento.

•• Dopo aver utilizzato questa procedura, rivolgersi a un centro di assistenza Sony per la riparazione dell’unità.
•• Dopo l’esecuzione di questa procedura, sarà possibile eseguire riprese anche se viene visualizzato un messaggio di 

errore.
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Messaggi di errore e avvisi
Qualora si verifichino avvisi, avvertenze o condizioni che richiedono una conferma, il monitor 
LCD dell’unità visualizza un messaggio, la spia di registrazione/tally inizia a lampeggiare e viene 
emesso un segnale acustico.
Il segnale acustico di avvertimento viene emesso sulle cuffie connesse al connettore cuffie.

Messaggi di errore

Qualora abbia luogo una condizione che causa la visualizzazione di un messaggio del tipo 
indicato di seguito, l’unità si arresta.

Errore visualizzato dal 
monitor LCD

Segnale 
acustico di 
avvertimento

Spia di 
registrazione/
tally

Causa e soluzione

E + codice d’errore Continuo Lampeggia 
rapidamente

L’unità potrebbe essere difettosa.
Spegnere l’unità e controllare la presenza di 
problemi nei dispositivi collegati, cavi o supporti 
di memorizzazione. Se il messaggio d’errore 
persiste anche dopo aver riacceso l’unità, 
rivolgersi al proprio rappresentante di assistenza 
tecnica Sony.
(Se non è possibile spegnere l’unità spostando 
l’interruttore di alimentazione sulla posizione  
(Standby), rimuovere il pacco batteria o la 
sorgente di alimentazione DC IN).
In base allo stato, l’unità potrebbe non emettere 
nessun avvertimento acustico né visualizzare un 
messaggio di errore.

Messaggi di avvertimento

Qualora vengano visualizzati i seguenti messaggi, eseguire le procedure indicate.

Avvertimento 
visualizzato dal 
monitor LCD

Segnale 
acustico di 
avvertimento

Spia di 
registrazione/
tally

Causa e soluzione

Battery Near End Intermittente Lampeggiante La carica rimanente del pacco batteria si sta 
esaurendo.
Ricaricare non appena possibile.

Battery End Continuo Lampeggia 
rapidamente

Il pacco batteria è scarico. La registrazione è 
disabilitata.
Arrestare le operazioni e sostituire il pacco batteria.

Temperature High Intermittente Lampeggiante La temperatura interna è elevata.
Spegnere l’unità e lasciarla raffreddare prima di 
utilizzarla nuovamente.

Media Temperature 
High

Intermittente Lampeggiante La temperatura della scheda CFexpress risulta 
elevata.
Sostituire la scheda o lasciarla raffreddare prima 
di utilizzarla nuovamente.

Voltage Low Intermittente Lampeggiante La tensione sul connettore DC IN è bassa (livello 1). 
Controllare la sorgente di alimentazione.

Insufficient Voltage Continuo Lampeggia 
rapidamente

La tensione sul connettore DC IN è insufficiente 
(livello 2). La registrazione è disabilitata.
Collegare un’altra sorgente di alimentazione.

Media Near Full Intermittente Lampeggiante La capacità rimanente sulla scheda di memoria si 
sta esaurendo.
Sostituire non appena possibile.

Media Full Continuo Lampeggia 
rapidamente

Non è possibile registrare o copiare clip perché la 
capacità rimanente sulla scheda di memoria è 
insufficiente.
Sostituire immediatamente.

Clips Near Full Intermittente Lampeggiante Ci si sta avvicinando al numero massimo di clip 
che possono essere registrati sulla scheda di 
memoria.
Sostituire non appena possibile.

Clips Full Continuo Lampeggia 
rapidamente

È stato raggiunto il numero massimo di clip che 
possono essere registrati sulla scheda di memoria.
Non è possibile registrare o copiare altri clip. 
Sostituire immediatamente.
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Avvertimento 
visualizzato dal 
monitor LCD

Segnale 
acustico di 
avvertimento

Spia di 
registrazione/
tally

Causa e soluzione

Last Clip Recording Intermittente Lampeggiante Il clip in corso di registrazione è l’ultimo clip che 
può essere registrato in quanto è stato raggiunto 
il numero massimo di clip consentito.
Preparare una nuova scheda di memoria.

Media(A)1) Life Near 
End

Intermittente Lampeggiante La scheda di memoria si sta avvicinando alla fine 
della sua vita utile. Sostituire non appena possibile.

Media(A)1) Life End Continuo Lampeggia 
rapidamente

La scheda di memoria ha raggiunto la fine della 
sua vita utile. Sostituire immediatamente.

Media(A)1) Near Full Intermittente Lampeggiante Quando si utilizza la funzione Simul Rec

Media(A)1) Full Continuo Lampeggia 
rapidamente

Quando si utilizza la funzione Simul Rec

Media(A)1) Clips Near 
Full

Intermittente Lampeggiante Quando si utilizza la funzione Simul Rec

Media(A)1) Clips Full Continuo Lampeggia 
rapidamente

Quando si utilizza la funzione Simul Rec

Media(A)1) Last Clip 
Rec

Intermittente Lampeggiante Quando si utilizza la funzione Simul Rec

Transfer Jobs Near 
Full

– – Si sta raggiungendo il numero massimo di 
processi di trasferimento file FTP consentito.

Transfer Jobs Full – – È stato raggiunto il numero massimo di processi di 
trasferimento file FTP consentito. Prima di 
aggiungere un altro processo, eliminare quelli non 
più necessari. 2)

1)	 Per la scheda dello slot B è visualizzato “(B)”.
2)	È possibile selezionare ed eliminare i lavori di trasferimento utilizzando File Transfer >View Job List (pagina 71) 

nel menu Network del menu completo. È possibile eliminare lavori di trasferimento anche nell’elenco dei 
trasferimenti dell’applicazione Monitor & Control.

Messaggi di avviso e operativi

Al centro dello schermo potranno essere visualizzati i seguenti messaggi di avviso e 
operativi. Seguire le istruzioni fornite per risolvere il problema.

Messaggio sul display Causa e soluzione

Battery Error
Please Change Battery

È stata rilevata un’anomalia nel pacco batteria.
Sostituire con un pacco batteria normale.

Backup Battery End
Please Change

La carica della batteria di backup è insufficiente.
Caricare la batteria di backup.

Unknown Media (A) 1)

Please Change
È stata inserita una scheda di memoria che è stata 
partizionata oppure una scheda di memoria contenente un 
numero di clip superiore al massimo gestibile da questa unità.
La scheda non può essere utilizzata nell’unità e deve essere 
sostituita.

Cannot Use Media (A) 1)

Unsupported File System
È stata inserita una scheda con un file system diverso oppure 
non formattata.
La scheda non può essere utilizzata nell’unità e deve essere 
sostituita oppure formattata con l’unità.

Media Error
Media (A) 1) Needs to be Restored

Si è verificato un errore sulla scheda di memoria e la scheda 
deve essere ripristinata.
Ripristinare la scheda di memoria.

Media Error
Cannot Record to Media (A) 1)

La scheda di memoria potrebbe essere danneggiata e non 
può essere utilizzata per la registrazione.
La riproduzione potrebbe rimanere possibile. Si consiglia 
quindi di eseguire una copia e sostituire la scheda di memoria.

Media Error
Cannot Use Media (A) 1)

La scheda di memoria potrebbe essere danneggiata e non 
può essere utilizzata per la registrazione o la riproduzione.
La scheda non può essere utilizzata nell’unità e deve essere 
sostituita.

Media (A) 1) Error
Recording Halted
Playback Halted

La registrazione o la riproduzione si sono arrestate a causa di 
un errore sulla scheda di memoria.
Se il problema persiste, sostituire la scheda di memoria.

Media Reached Rewriting Limit
Change Media (A) 1)

La scheda di memoria ha raggiunto la fine della sua vita utile.
Eseguire un backup e sostituire la scheda immediatamente. 
Se si continua a utilizzare la scheda è possibile che la scheda 
non consenta più l’esecuzione di registrazioni o riproduzioni.
Per ulteriori informazioni, consultare le istruzioni per l’uso 
della scheda di memoria.

The specified address is invalid. L’indirizzo specificato non è valido.
Controllare che l’impostazione sia corretta.
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Messaggio sul display Causa e soluzione

Cannot Use Specified Port Number Il numero di porta specificato non è valido.
Controllare che l’impostazione sia corretta.

Fan Stopped La ventola di raffreddamento si è arrestata.
Evitare l’utilizzo a temperature elevate. Scollegare 
l’alimentazione e contattare il rappresentante di assistenza 
tecnica Sony.

LENS Error È stato rilevato un errore nella comunicazione I/F dell’obiettivo 
quando è montato un obiettivo E-mount.
Controllare lo stato della connessione con l’obiettivo E-mount.

This Multi Term. acc is not supported 
by the device and cannot be used.
Please verify the compatibility.

È stato rilevato un accessorio incompatibile.
L’unico accessorio Multi Terminal supportato dall’unità è 
l’impugnatura di telecomando fornita in dotazione.

Failed. Questo errore potrebbe apparire se non è possibile ottenere 
un indirizzo con DHCP impostato su On.
Controllare le impostazioni del server DHCP.

Addition of auto upload job failed. È stato raggiunto il numero massimo di trasferimenti 
consentito.
Eliminare i trasferimenti non più necessari. Potrebbero essere 
errate anche le impostazioni della destinazione dell’upload 
automatico per i clip originali o i clip proxy. Controllare che 
l’impostazione sia corretta.

<SSID>Not found. Non è stato possibile trovare una rete (punto di accesso) con il 
<SSID> specificato.
Controllare che l’impostazione sia corretta.

<SSID>Authentication Failed L’autenticazione della connessione sulla rete (punto di 
accesso) con il <SSID> specificato non è riuscita.
Controllare che la password e le altre impostazioni siano 
corrette.

An IP address conflict has occurred. 
Please check the network settings.

È presente un conflitto tra gli indirizzi di rete nella modalità 
Station wireless o LAN cablata con tethering USB.
Modificare l’indirizzo manualmente o modificare le 
impostazioni del router di rete.

The IP address of the Wireless LAN 
Access Point Mode has been 
changed due to an IP address 
conflict.

L’indirizzo IP della modalità punto di accesso LAN wireless è 
stato cambiato a causa di un conflitto fra gli indirizzi di rete 
della modalità punto di accesso LAN wireless e tethering USB.
Verificare l’impostazione dell’indirizzo IP.

1)	 Per la scheda dello slot B è visualizzato “(B)”.



133 7. Appendice

Impostazioni salvate in file

Voci impostate nel menu completo

Si: impostazione salvata.
No: impostazione non salvata.
–: Non salvata (impostazione temporanea)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/EI Mode Sì No

ISO/Gain Sì No

Exposure Index Sì No

Shockless Gain Sì No

Base Sensitivity Sì No

Base ISO Sì No

ND Filter Display Mode Sì No

Shutter Mode Sì No

Shutter Speed On/Off Sì No

Shutter Speed Sì No

Shutter Angle Sì No

ECS On/Off Sì No

ECS Frequency Sì No

Iris Bokeh Control No –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Auto Exposure Level Sì No

Mode Sì No

Speed Sì No

Auto ND Filter Sì No

AGC Sì No

AGC Limit Sì No

AGC Point Sì No

Auto Shutter Sì No

A.SHT Limit Sì No

A.SHT Point Sì No

Auto Iris Sì No

Clip High light Sì No

Detect Window Sì No

Detect Window Indication Sì No

Custom Width Sì No

Custom Height Sì No

Custom H Position Sì No

Custom V Position Sì No

White White Select Sì No

Auto White Balance – –

ATW Sì No

Color Temp Sì No

Tint Sì No

R Gain Sì No

B Gain Sì No

Preset White Select – –

White Setting Shockless White Sì No

ATW Speed Sì No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Focus AF Transition Speed Sì No

AF Subj. Shift Sens. Sì No

Focus Area Sì No

Subject Recognition AF Sì No

Touch Function in MF Sì No

AF Assist Sì No

S&Q Motion Setting Sì No

Frame Rate Sì No

LUT On/Off SDI/HDMI Sì No

SDI Sì No

LCD/Proxy/Stream Sì No

LCD/HDMI/Px/Stream Sì No

Noise Suppression Setting(Custom) Sì No

Level(Custom) Sì No

Setting(Cine EI) Sì –

Level(Cine EI) Sì –

Flicker Reduce Mode Sì No

Frequency Sì No

Image Stabilization SteadyShot Sì No

PL Stabilization Sì No

Stabilization Adjustment Sì No

Focal Length Sì No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Base Setting Shooting Mode Sì –

Target Display Sì –

Rec Format Frequency Sì No

Imager Scan Mode Sì No

Codec Sì No

Video Format Sì No

Cine EI Setting Color Gamut Sì –

Embed LUT File Sì No

Simul Rec Setting Sì No

Proxy Rec Setting Sì No

Audio Channel Sì No

Interval Rec Setting No No

Interval Time Sì No

Number of Frames Sì No

Pre-Lighting Sì No

Picture Cache Rec Setting Sì No

Cache Size Sì No

Cache Rec Time – –

SDI/HDMI Rec Control Setting Sì No

Assignable Button <1> Sì No

<2> Sì No

<3> Sì No

<4> Sì No

<5> Sì No

<6> Sì No

<7> Sì No

<8> Sì No

<9> Sì No

<10> Sì No

<11> Sì No

Focus Hold Button Sì No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Assignable Dial Grip/Remote Dial Sì No

Grip Dial Direction Sì No

Multi Function Dial Default Function Sì No

User File Load from UTILITY SD – –

Save to UTILITY SD – –

File ID No No

Load Customize Data Sì No

Load White Data Sì No

All File Load from UTILITY SD – –

Load from Cloud(Private) – –

Load from Cloud(Share) – –

Save to UTILITY SD – –

Save to Cloud(Private) – –

Save to Cloud(Share) – –

File ID Sì No

Load Network Data No No

Paint/Look Scene File Recall – –

Store – –

Delete – –

Preset Recall – –

Base Look Select Sì Sì

Delete – –

Delete All – –

Import from Utility SD – –

Import from Cloud(Private) – –

Import from Cloud(Share) – –

Input Sì –

Output Sì –

AE Level Offset Sì –

Reset Paint Settings Reset without Base Look – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint/Look Black Master Black Sì Sì

R Black Sì Sì

B Black Sì Sì

Knee Setting Sì Sì

Auto Knee Sì Sì

Point Sì Sì

Slope Sì Sì

Detail Setting Sì Sì

Level Sì Sì

H/V Ratio Sì Sì

B/W Balance Sì Sì

Limit Sì Sì

Crispening Sì Sì

High Light Detail Sì Sì

Matrix User Matrix Sì Sì

User Matrix Level Sì Sì

User Matrix Phase Sì Sì

User Matrix R-G Sì Sì

User Matrix R-B Sì Sì

User Matrix G-R Sì Sì

User Matrix G-B Sì Sì

User Matrix B-R Sì Sì

User Matrix B-G Sì Sì

Multi Matrix Setting Sì Sì

Area Indication No No

Area Indication Control Sì No

Reset – –

Axis No No

Hue Sì Sì

Saturation Sì Sì
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

TC/Media Timecode Mode Sì No

Run Sì No

Setting No No

Reset – –

TC Format Sì No

TC Display Display Select Sì No

User Bits Mode Sì No

Setting No No

HDMI TC Out Setting Sì No

Genlock Reference Lock Type – –

Sync Shift Sì –

Sync Shift Value – –

Clip Name Format Camera ID No No

Reel Number No No

Camera Position No No

XAVC Root Folder Name Sì No

Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Utility SD – –

Monitoring Output Format SDI1 Sì No

SDI2 Sì No

HDMI Sì No

REF No No

De-Squeeze Ratio Sì No

SDI (Monitor FHD) Sì No

HDMI (FHD Output) Sì No

LCD Monitor Sì No

Output Display SDI Sì No

HDMI Sì No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Focus Mode Sì No

Focus Position Sì No

Network Status Sì No

File Transfer Status Sì No

Rec/Play Status Sì No

SDI/HDMI Rec Control Sì No

Tally Sì No

Battery Remain Sì No

Zoom Position Sì No

Image Stabilization Sì No

Media Status Sì No

Lens Info Sì No

Look Name Sì No

UWP RF Level Sì No

Focus Area Indicator Sì No

Subject Recognition Frame Sì No

Clip Name Sì No

Video Level Warning Sì No

Timecode Sì No

Gamma Display Assist Sì No

Video Signal Monitor Sì No

Imager Scan Mode Sì No

Frame Rate Sì No

Rec Format Sì No

Rec Look Sì No

Level Gauge Sì No

Audio Level Meter Sì No

Auto Exposure Mode Sì No

Auto Exposure Level Sì No

ND Filter Sì No

Iris Sì No

ISO/Gain/EI Sì No

Base ISO/Sensitivity Sì No

Shutter Sì No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off White Balance Sì No

Clip Number Sì No

Notice Message Sì No

Marker Setting Sì No

Color Sì No

Center Marker Sì No

Safety Zone Sì No

Safety Area Sì No

Aspect Marker Sì No

Aspect Mask Sì No

Aspect Safety Zone Sì No

Aspect Safety Area Sì No

Aspect Select Sì No

Custom Aspect Ratio Sì No

Guide Frame Sì No

100% Marker Sì No

User Box Sì No

User Box Width Sì No

User Box Height Sì No

User Box H Position Sì No

User Box V Position Sì No

LCD Monitor Setting Brightness Sì No

Color Mode Sì No

Gamma Display Assist Setting Sì No

Peaking Setting Sì No

Peaking Level Sì No

Color Sì No

Zebra Setting Sì No

Zebra1 Level Sì No

Zebra1 Aperture Level Sì No

Zebra2 Level Sì No

Focus Magnifier Focus Mag Button Target Sì No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Audio Audio Input CH1 Input Select Sì No

CH2 Input Select Sì No

CH3 Input Select Sì No

CH4 Input Select Sì No

INPUT1 MIC Reference Sì No

INPUT2 MIC Reference Sì No

Line Input Reference Sì No

Reference Level Sì No

CH1 Wind Filter Sì No

CH2 Wind Filter Sì No

CH3 Wind Filter Sì No

CH4 Wind Filter Sì No

CH3 Level Control Sì No

CH4 Level Control Sì No

CH3 Input Level Sì No

CH4 Input Level Sì No

Audio Input Level Sì No

Limiter Mode Sì No

CH1&2 AGC Mode Sì No

CH3&4 AGC Mode Sì No

AGC Spec Sì No

1kHz Tone on Color Bars Sì No

CH1 Level Sì No

CH2 Level Sì No

CH3 Level Sì No

CH4 Level Sì No

Audio Output Monitor CH Sì No

Volume No No

Headphone Out Sì No

Alarm Level Sì No

HDMI Output CH Sì No

SDI Out CH (Monitor FHD) Sì No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Clip Operations Display Clip Properties – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Clips Caption Sì –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Color Bars Setting No No

Type Sì No

ND Dial CLEAR with Dial Sì No

Rec/Tally Rec/Tally Lamp Sì No

Tally Control Sì No

Rec Start/Stop Beep Sì No

LOCK Switch Settings with Rec Button Sì No

with Hand Grip Remote Sì No

with LCD Monitor Sì No

Touch Operation Setting Sì No

Rec Review Setting Sì No

Zoom Zoom Type Sì No

Handle Zoom Setting Sì No

High Sì No

Low Sì No

Menu Settings User Menu Only Sì No

User Menu with Lock No No

Menu Page On/Off Project Sì No

Audio Sì No

Monitoring Sì No

Assignable Button Sì No

Information Sì No

Media Sì No

Network Sì No

File Transfer Sì No

RCP CNS Mode Sì No

Fan Control Setting Sì No

Lens PL-Mt Interface Position Sì No

PL-Mt Voltage Sì No

Zoom Ring Direction Sì No

Shading Compensation Sì No

Chroma Aberration Comp. Sì No

Distortion Comp. Sì No

Breathing Compensation Sì No

Distance Display Sì No

Zoom Position Display Sì No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Video Light Set Video Light Set Sì No

APR APR – –

Camera Battery Alarm Near End:Info Battery Sì No

End:Info Battery Sì No

Near End:Sony Battery Sì No

End:Sony Battery Sì No

Near End:Other Battery Sì No

End:Other Battery Sì No

Detected Battery No No

Camera DC IN Alarm DC Low Voltage1 Sì No

DC Low Voltage2 Sì No

Network Network Setup Setup for Mobile App – –

User Name No No

Input Password No No

Generate Password No No

Show Authentication – –

LAN Type Select Sì No

Wireless LAN WPS – –

MAC Address – –

AP Mode Settings Channel Sì No

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network ST Mode Settings Camera Remote Control Sì No

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password No No

DHCP Sì No

IP Address Sì No

Subnet Mask Sì No

Gateway Sì No

DNS Auto Sì No

Primary DNS Server Sì No

Secondary DNS Server Sì No

Manual Register

SSID Sì No

Security Sì No

Password No No

DHCP Sì No

IP Address Sì No

Subnet Mask Sì No

Gateway Sì No

DNS Auto Sì No

Primary DNS Server Sì No

Secondary DNS Server Sì No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network Wired LAN Camera Remote Control Sì No

Detail Settings

DHCP Sì No

IP Address Sì No

Subnet Mask Sì No

Gateway Sì No

DNS Auto Sì No

Primary DNS Server Sì No

Secondary DNS Server Sì No

MAC Address – –

USB Tethering Setting Sì No

Camera Remote Control Sì No

Device Name – –

IP Address – –

Subnet Mask – –

File Transfer Auto Upload Sì No

Auto Upload (Proxy) Sì No

Default Upload Server Sì No

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings1/Server Settings2/Server Settings3

Display Name Sì No

Service Sì No

Host Name Sì No

Port Sì No

User Name No No

Password No No

Passive Mode Sì No

Destination Directory Sì No

Using Secure Protocol Sì No

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Maintenance Language Select Sì No

Clock Set Time Zone Sì No

Date Mode Sì No

12h/24h Sì No

Date No No

Time No No

All Reset Reset – –

Reset without Network – –

Reset to Factory Defaults – –

Hours Meter Hours(System) – –

Hours(Reset) – –

Reset – –

Version Version Number – –

Version Up – –

Lens Version Number – –
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Diagrammi a blocchi
Fare riferimento alle voci relative in “Impostazione dell’audio da registrare” (pagina 106) e “Menu User” (pagina 37).

Audio Input (CH1&CH2)

INPUT1

L

R

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 − 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 − 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 − 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

*	 Impostare su Manual con ingresso audio da adattatore XLR.
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Audio Input (CH3&CH4)

L

R

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

[CH3 Input Level]
0 − 99

CH4

[CH4 Input Level]
0 − 99

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 − 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
CH4 Input Level
Level+CH4 Input Level
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
*	 Impostare su Manual con ingresso audio da adattatore XLR.
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Autio Output (formato di uscita video impostato su Monitor FHD)

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[SDI Out CH (Monitor FHD)]
CH1/CH2, CH3/CH4

[Output Format]
SDI1, SDI2, HDMI

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 − 50

[Alarm Level]
0 − 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

QoS
Streaming

CH2

CH3

CH4
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Autio Output (formato di uscita video non impostato su Monitor FHD)

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 − 50

[Alarm Level]
0 − 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

QoS
Streaming

CH2

CH3

CH4
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Aggiornamento del software di obiettivi E-mount
L’unità consente di aggiornare il software di 
obiettivi E-mount.
Fare riferimento al sito Web dell’obiettivo 
per informazioni sugli obiettivi che possono 
essere aggiornati e per ottenere il necessario 
software.

Verifica della versione

1	 Montare un obiettivo E-mount sull’unità 
(pagina 18).

2	 Selezionare Version nel menu 
Maintenance del menu completo per 
visualizzare Lens Version Number 
(pagina 72).
Il numero della versione software 
dell’obiettivo E-mount viene visualizzato 
sul lato.

Aggiornamento del software

Impostare l’unità sulla modalità 
memorizzazione di massa (pagina 118).
Aggiornare il software seguendo la procedura 
fornita con il software dell’obiettivo.
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Licenze

Licenza MPEG-4 AVC Patent 
Portfolio

QUESTO PRODOTTO È SOGGETTO A LICENZA 
AVC PATENT PORTFOLIO PER USO PERSONALE 
E NON COMMERCIALE DEL CLIENTE O ALTRI USI 
PER I QUALI NON SI RICEVE ALCUN COMPENSO 
PER
(i)	 CODIFICARE VIDEO IN CONFORMITÀ ALLO 

STANDARD AVC (“VIDEO AVC”) E/O
(ii)	DECODIFICARE VIDEO AVC CODIFICATI 

DA UN CONSUMATORE IMPEGNATO IN 
ATTIVITÀ PERSONALI E/O OTTENUTI DA 
UN FORNITORE DI VIDEO MUNITO DELLA 
LICENZA PER LA FORNITURA DI VIDEO AVC.

NESSUNA LICENZA È CONCESSA O È DA 
RITENERSI IMPLICITA PER ALTRO USO. 
ULTERIORI INFORMAZIONI SONO DISPONIBILI 
PRESSO MPEG LA, L.L.C. VISITARE IL SITO 
HTTP://WWW.MPEGLA.COM

Ottenere software sotto licenza 
GPL/LGPL

Questo prodotto utilizza software a cui si 
applicano le licenze GPL/LGPL. Si informa 
l’utente che ha diritto di accesso, modifica 
e ridistribuzione del codice sorgente di tali 
programmi software alle condizioni delle 
licenze GPL/LGPL.
Il codice sorgente è fornito su Internet. Per il 
download, utilizzare il seguente URL e seguire 
le istruzioni.
https://oss.sony.net/Products/Linux/

Preferiremmo non essere contattati 
relativamente al contenuto del codice sorgente.

Le licenze (in inglese) sono registrate nella 
memoria interna del prodotto.
Stabilire una connessione di tipo Dispositivo di 
memorizzazione fra il prodotto e un computer 
per leggere le licenze contenute nella cartella 
“PMHOME” - “LICENSE”.

CONTRATTO DI LICENZA PER 
L’UTENTE FINALE

Iniziando a utilizzare questo prodotto, l’utente 
accetta i termini del contratto di licenza del 
software.
Il contratto di licenza del software tra il cliente 
e Sony Corporation è disponibile sul nostro 
sito Web (https://rd1.sony.net/help/di/
el23/h_zz/).

Licenze software Open Source

Questo prodotto utilizza software Open 
Source sulla base di accordi di licenza tra 
Sony e i detentori dei diritti di copyright del 
software.
Per soddisfare i requisiti stabiliti dai detentori 
dei diritti di copyright sul software, Sony è 
tenuta a informare gli utenti del contenuto di 
dette licenze.
Le licenze (in inglese) sono registrate nella 
memoria interna del prodotto.
Stabilire una connessione di tipo Dispositivo di 
memorizzazione fra il prodotto e un computer 
per leggere le licenze contenute nella cartella 
“PMHOME” - “LICENSE”.

https://oss.sony.net/Products/Linux/
https://rd1.sony.net/help/di/el23/h_zz/
https://rd1.sony.net/help/di/el23/h_zz/
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Specifiche tecniche

Generale

Peso

	 Circa 2,9 kg (corpo, adattatore attacco PL)

	 Circa 2,4 kg (solo corpo, escluso adattatore 

attacco PL)

Dimensioni

	 Vedere pagina 149.

Alimentazione

	 12 Vcc (da 11 Vcc a 17 Vcc)

Potenza assorbita

	 Potenza assorbita nominale dell’unità: Circa 

50,0 W (obiettivo, 6K 17:9, 59.94P, 

registrazione X-OCN LT, ventola 

mod. auto, escluso impugnatura 

di telecomando e altri dispositivi 

periferici)

	 Potenza assorbita massima dell’unità: 

Circa 66,0 W (obiettivo, 6K 17:9, 

59.94P, registrazione X-OCN 

LT, temp. ambiente 40 °C, filtro 

ND (1/4), registrazione proxy 

attiva, Wi-Fi attivo, ventola mod. 

auto, compreso impugnatura di 

telecomando e altri dispositivi 

periferici)

Temperatura di funzionamento

	 Da 0 °C a 40 °C

Temperatura di conservazione

	 Da –20 °C a +60 °C

Tempo di funzionamento continuato

	 Circa 100 minuti (con batteria BP-GL95B)

Formato di registrazione video

	 X-OCN(LT)

	 XAVC H Intra HQ

	 XAVC H Intra SQ

	 XAVC H Long

	 XAVC Intra

	 XAVC Long

Formato di registrazione audio

	 LPCM 24 bit, 48 kHz, 4 canali

Frequenza di fotogrammi di registrazione

	 X-OCN(LT)

		  FF 8.6K 17:9/FF 8.6K 16:9 

29.97P, 25P, 24P, 23.98P

		  FFc 6K 17:9/FFc 6K 16:9/FFc 3.8K 16:9/

S35 5.8K 17:9/S35 5.8K 16:9/S35 

4.3K 4:3/S35c 4K 17:9

			   59.94P, 50P, 29.97P, 25P, 24P, 

23.98P

	 XAVC H Intra HQ

		  8192×4320/29.97P, 25P, 24P, 23.98P

		  7680×4320/29.97P, 25P, 23.98P

	 XAVC H Intra SQ

		  8192×4320/29.97P, 25P, 24P, 23.98P

		  7680×4320/29.97P, 25P, 23.98P

	 XAVC H Long

		  7680×4320/29.97P, 25P, 23.98P

	 XAVC Intra

		  4096×2160/59.94P, 50P, 29.97P, 25P, 

24P, 23.98P

		  3840×2160/1920×1080/59.94P, 50P, 

29.97P, 25P, 23.98P

	 XAVC Long

		  3840×2160/1920×1080/59.94P, 50P, 

29.97P, 25P, 23.98P

Tempi di registrazione e riproduzione

	 Vedere pagina 126.

Sezione videocamera

Elemento di acquisizione immagine

	 Sensore di immagine CMOS a singolo chip, 

equivalente 35 mm full frame

Numero di pixel

	 57,0M (totale)

Messa a fuoco automatica

	 Metodo di rilevamento: Rilevamento di fase/

rilevamento del contrasto

Filtri ND interni

	 CLEAR: OFF

	 ND a variazione lineare: Da 0.6 (1/4) a 2.1 

(1/128)

Sensibilità ISO

	 ISO 800/3200 (modalità Cine EI, Base ISO, 

sorgente di illuminazione D55)

Innesto obiettivo

	 Attacco PL (con adattatore attacco PL)

	 E-mount (senza adattatore attacco PL)

Lunghezza focale di flangia

	 Attacco PL: 52 mm

	 E-mount: 18 mm

Latitudine

	 16 stop

Velocità otturatore

	 Da 1/8000 sec. a 64F (23.98P)

Angolo otturatore

	 Da 5,6° a 360°, da 2 a 64 fotogrammi

Bilanciamento del bianco

	 Da 2000 K a 15000 K

Guadagno

	 Da –3 dB a +18 dB (in incrementi di 1 dB)

Sezione audio

Frequenza di campionamento

	 48 kHz

Quantizzazione

	 24 bit

Risposta di frequenza

	 Modalità MIC ingresso XLR: Da 20 Hz a 20 kHz 

(±3 dB o inferiore)

	 Modalità LINE ingresso XLR: Da 20 Hz a  

20 kHz (±3 dB o inferiore)

Gamma dinamica

	 Modalità MIC ingresso XLR: 80 dB (tipico)

	 Modalità LINE ingresso XLR: 90 dB (tipico)

Distorsione

	 Modalità MIC ingresso XLR: 0,08% o inferiore 

(livello di ingresso –40 dBu)

	 Modalità LINE ingresso XLR: 0,08% o inferiore 

(livello di ingresso +14 dBu)

Altoparlante incorporato

	 Mono

Microfono interno

	 Mono

Sezione ingressi/uscite

Ingressi
INPUT 1/2:

	 Tipo XLR, 3 pin, femmina

	 Selezionabile LINE / MIC / MIC+48V

	 MIC: Riferimento da –30 dBu a –80 dBu

TC IN:

	 Tipo BNC

REF IN:

	 Tipo BNC

Uscite
SDI OUT 1:

	 Tipo BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), 

HD-SDI 

SDI OUT 2:

	 Tipo BNC, 3G-SDI (livello A/B), HD-SDI

Cuffie (mini jack stereo):

	 –16 dBu (livello di uscita di riferimento, 

volume di monitoraggio massimo, 

impedenza 16 Ω)

HDMI:

	 Tipo A, 19 pin
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TC OUT:

	 Tipo BNC

REF OUT:

	 Tipo BNC

Altro
DC IN:

	 Tipo XLR, 4 pin, maschio (1), da 11 Vcc a 17 Vcc

REMOTE:

	 Tipo sub mini da 2,5 mm, 3 poli

Connettore impugnatura di telecomando:

	 Mini jack, 3,5 mm, 4 poli

USB-C:

	 USB 3.2 Gen 1

VF:

	 Tipo dedicato a 40 pin

Connettore di rete:

	 Tipo RJ45

Connettore della maniglia:

	 Tipo dedicato a 40 pin

Sezione display

Mirino (LCD)
Dimensione schermo

	 8,8 cm (3,5 pollici) in diagonale

Rapporto di aspetto

	 16:9

Numero di pixel

	 1280 (orizz.) × 720 (vert.)

Sezione slot supporti di memoria

Slot per schede CFexpress Type B (2)

Slot scheda Utility SD (1) 

LAN wireless

Standard supportati*

	 IEEE 802.11a/b/g/n/ac (modello WW279317)

	 IEEE 802.11b/g/n (modello WW057783)

Banda di frequenza*

	 2,4 GHz/5 GHz (modello WW279317)

	 2,4 GHz (modello WW057783)
*	 Fare riferimento alla targhetta sul lato inferiore 

dell’unità.

Protocolli di sicurezza supportati

	 WPA2-PSK (AES)/WPA3-SAE

Metodo di connessione

	 WPS (Wi-Fi Protected Setup™) / Manuale

Metodo di accesso

	 Modalità infrastruttura

Accessori forniti

Maniglia (con braccetto mirino) (1)

Viti di montaggio maniglia (4)

Monitor LCD (1)

Ingranditore per mirino (1)

Adattatore di montaggio del mirino (1)

Spessore (circolare) (1)

Spessore (1/3 di arco) (15)

Coperchietto E-mount (1) 

Coperchietto attacco PL (1)

Prima di usare l’apparecchio (1)

Libretto di garanzia (1)

Design e caratteristiche tecniche soggette a 
modifiche senza preavviso.

Note
•• Eseguire sempre una registrazione di 

prova, e verificare che il contenuto sia stato 
registrato correttamente. SONY NON SARÀ 
RESPONSABILE DI DANNI DI QUALSIASI 
TIPO, COMPRESI, MA SENZA LIMITAZIONE 
A, RISARCIMENTI O RIMBORSI A CAUSA 
DI GUASTI DI QUESTO APPARECCHIO O 
DEI SUOI SUPPORTI DI REGISTRAZIONE O 
QUALSIASI ALTRO SUPPORTO O SISTEMA 
DI MEMORIZZAZIONE PER REGISTRARE 
CONTENUTI DI QUALSIASI TIPO.

•• Verificare sempre che l’apparecchio stia 
funzionando correttamente prima di 
usarlo. LA SONY NON SARÀ RESPONSABILE 
DI DANNI DI QUALSIASI TIPO, COMPRESI, 
MA SENZA LIMITAZIONE A, RISARCIMENTI 
O RIMBORSI A CAUSA DELLA PERDITA DI 
PROFITTI ATTUALI O PREVISTI DOVUTA 
A GUASTI DI QUESTO APPARECCHIO, SIA 
DURANTE IL PERIODO DI VALIDITÀ DELLA 
GARANZIA SIA DOPO LA SCADENZA DELLA 
GARANZIA, O PER QUALUNQUE ALTRA 
RAGIONE.

•• SONY NON SARÀ RESPONSABILE PER 
RICHIESTE O RICORSI DI NESSUN TIPO 
PRESENTATI DA UTENTI DI QUESTO 
APPARATO O DA TERZI.

•• SONY NON SARÀ RESPONSABILE PER LA 
PERDITA, RIPARAZIONE O RIPRODUZIONE 
DEI DATI REGISTRATI SUL SISTEMA DI 
MEMORIZZAZIONE INTERNO, SU SUPPORTI 
DI REGISTRAZIONE O SU QUALSIASI 
ALTRO TIPO DI SUPPORTO O SISTEMA DI 
MEMORIZZAZIONE.

•• SONY NON SARÀ RESPONSABILE PER 
LA CANCELLAZIONE O LA MANCATA 
CONTINUAZIONE PER QUALSIASI CAUSA 
O CIRCOSTANZA DI SERVIZI CORRELATI A 
QUESTO APPARATO.
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Dimensioni esterne

Lato superiore, anteriore, comandi operatore, posteriore

14

2,3

73

3×UNC 3/8-16, 
profondità: 14

M2, profondità: 3,9 
(controforo ø5,3, profondità: 1,9)

6×UNC 3/8-16; profondità: 10

8×UNC 1/4-20; 
profondità: 103×UNC 1/4-20, 

profondità: 9

6×M3; profondità: 6

6×UNC 1/4-20, 
profondità: 9

UNC 3/8-16; 
profondità: 7

142,5

2712

70

14464,6

66,85

41,85 50 50

50 50

9

18
30,7 20 20

30 30

84

50,6

33,4

2×M3; profondità: 5

2×M3; profondità: 5

Unità: mm

218,1 184,25

212,5

13,5 UNC 1/4-20; 
profondità: 9

2×M3; profondità: 5

62 29 25 20

20

6,05

59,1

145,7

25

7,4

12,5

12,5

7,4

25
50
25

184

50 50 75

50 5041,85

66,85

65,4

73

69
58,6 58,6

86,5

69,5
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Lati connettori, inferiore

Unità: mm25
25
25

1,5

34,6

4×UNC 3/8-16, 
profondità: 9

4×UNC 1/4-20, 
profondità: 9

2×M3; profondità: 5

25
25
25

14
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Marchi di fabbrica

•• I termini HDMI e HDMI High-Definition 
Multimedia Interface e il logo HDMI sono 
marchi o marchi registrati di HDMI Licensing 
Administrator, Inc. negli Stati Uniti e in altri 
paesi.

•• USB Type-C® e USB-C® sono marchi registrati 
di USB Implementers Forum.

•• Tutti gli altri nomi di sistema e di prodotti 
sono marchi o marchi registrati dei rispettivi 
titolari. All’interno del presente documento, 
i marchi non sono riportati con i simboli ® 
o ™.
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